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Introduction

Welcome to the fascinating world of open source software that is Linux.
In this book, I introduce you to the wonders of the Linux operating
system, originally created as a labor of love by Linus Torvalds in the early
1990s. My goal is to initiate you into the rapidly growing ranks of Linux users
and enthusiasts busily rewriting the rules for the operating system market-
place.

If you've contemplated switching to Linux but find the prospect too forbidding,
you can relax. If you can boil water or set your alarm clock, you, too, can
become a Linux user. (No kidding!)

When this book appeared in its first edition, Linux was an emerging phenom-
enon that was neither terribly well known nor understood. In this edition —
for a new generation of Linux users — so much material is available that [ have
steered this particular title toward what Linux is and how you can make the
best use of it on your desktop. To that end, these pages contain various online
resources, tips, and tricks, as well as more general instruction. If you're look-
ing for material on servers, many other books can serve your needs.

[ keep the amount of technobabble to a minimum and stick with plain English
as much as possible. Besides plain talk about Linux installation, boot-up, con-
figuration, and tuning, I include many examples, plus lots of detailed instruc-
tions to help you build and manage your very own Linux machine with a
minimum of stress or confusion.

[ also include with this book a handy DVD-ROM that contains Fedora Core 3
and Knoppix, along with the CD-ROM images (the files you use to burn your
own CDs) for Linspire, Mandrake, SuSE, and Xandros. (To find out what exactly
is included on the DVD-ROM, see Appendix B.) If you have no idea of what
any of these items are, don’t worry. You'll know soon enough!

About This Book

Think of this book as a friendly, approachable guide to tackling terminology
and the Linux collection of tools, utilities, and widgets. Although Linux isn’t
terribly hard to figure out, it does pack a boatload of details, parameters, and
administrivia (administrative trivia, in Unixspeak). You need to wrestle those
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details into shape while you install, configure, manage, and troubleshoot a
Linux-based computer. Some sample topics you find in this book include the
following:

v Understanding where Linux comes from and what it can do for you
v Installing the Linux operating system

v Working with a Linux system to manage files and add software

v~ Setting up Internet access and surfing the Web

v Customizing your Linux system

v Managing Linux system security and resources

Although it may seem, at first glance, that working with Linux requires years
of hands-on experience, tons of trial and error, advanced computer science
training, and intense dedication, take heart! It’s not true! If you can tell some-
body how to find your office, you can certainly build a Linux system that
does what you want. The purpose of this book isn’t to turn you into a full-
blown Linux geek (that’s the ultimate state of Linux enlightenment, of course);
it’s to show you the ins and outs that you need to master in order to build a
smoothly functioning Linux system and to give you the know-how and confi-
dence to use it.

How to Use This Book

This book tells you how to install, configure, and customize a Linux desktop
system. Although you can do most things in Linux these days by pointing
and clicking, you still may want to try using Linux at the command prompt —
where you type detailed instructions to load or configure software, access
files, and do other tasks. In this book, input appears in monospace type

like this:

rmdir /etc/bin/devone

When you type Linux commands or other related information, be sure to
copy the information exactly as you see it in the book, including uppercase
and lowercase letters, because that’s part of the magic that makes Linux
behave properly.

A failure to follow instructions exactly can have all kinds of unfortunate,
unseemly, or unexpected side effects.

The margins of a book don’t give you the same amount of room as your com-
puter screen; therefore, in this book some URLs and lengthy commands at
the command prompt may appear wrapped to the next line. Remember that
your computer sees these wrapped lines as a single set of instructions, or as a
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single URL — so if you're typing a hunk of text, keep it on a single line. Don’t
insert a hard return if you see one of these wrapped lines. I clue you in that

it’s supposed to be all one line by breaking the line at a slash mark or a nat-

ural word break (to imply “Wait — there’s more!”) and slightly indenting the
overage, as in the following silly example:

www.infocadabra.transylvania.com/nexus/plexus/lexus/
praxis/okay/this/is/a/make-
believe/URL/but/some/real/ones/
are/SERIOUSLY/Tong.htm]

Note that as you dig your way into and through this book — and other sources
of Linux wit, wisdom, and inspiration that you're likely to encounter — you
may find some terms used interchangeably. For example, you may see the
same piece of software called a program, a command, a utility, a script, an
application, or a tool, depending on the source, the context, and the author
of the information you’re consulting. To a large extent, you can treat these
terms as interchangeable, and when an important distinction needs to be
made among them, I'm sure to point it out. Similarly, when you’re working
with various commands or configuration controls, you may also encounter
terms such as flag, switch, option, or parameter used more or less inter-
changeably. In this case, all these terms refer to ways in which you can
control, refine, or modify basic commands or programs to make them do
what you want. Again, wherever distinctions and clarifications may be
needed, I provide them.

Three Presumptuous Assumptions

They say that making assumptions makes a fool of the person who makes
them and of the person about whom those assumptions are made. (And
just who are they, anyway? I assume that [ know, but — never mind.) Even
so, practicality demands that [ make a few assumptions about you, gentle
reader:

»* You can turn your computer on and off.
v You know how to use a mouse and a keyboard.
v You want to install, configure, and use a desktop Linux system because

you're curious or interested or it’s your job to do so.

You don’t need to be a master logician or a wizard in the arcane art of pro-
gramming to use this book, nor do you need a Ph.D. in computer science.
You don’t even need a complete or perfect understanding of what’s going
on in your computer’s innards.

If you can boot a PC or install an application on your machine, you can
install, configure, and manage a basic Linux system. If you have an active
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imagination and the ability to solve rudimentary problems, that’s even

better — you have already mastered the key ingredients necessary to making
Linux work for you. The rest is mere details and a bit of patience. I can help
you with the details, but the patience is up to you!

How This Book Is Organized

This book contains six major parts, arranged in an order to take you from
Linux installation and configuration through keeping a Linux desktop system
up and running, if not purring like a cat in the sun! Most parts contain three
or more chapters or appendixes, and each chapter or appendix contains
modular sections. Whenever you need help or information, pick up this book
and start anywhere you like, or use the Table of Contents and the index to
locate specific topics or key words.

Following is a breakdown of the book’s six parts and what you find in
each one.

Part I: Getting Vour Feet Wet

This part sets the stage and includes an overview of and introduction to the
terms, techniques, and software components that make Linux the raging soft-
ware tiger that’s so ready, willing, and able do its thing. To be a little more
specific, I start out with a Linux overview that explains what Linux is, where
it came from, and how it works. Next, I tackle the various tasks and activities
involved in preparing for and installing Linux on a PC. If you’re not a diehard
Fedora Core fan, I also cover what’s involved in installing Linspire, Mandrake,
SuSE, and Xandros, but in a little less detail (or this book would be the size

of a set of encyclopedias!) After that, I tell you how to give Linux the boot —
not to get rid of it by any means, but rather, to fire up your brand-new system
to reach the heights of computing ecstasy (at least, I hope it’s as good for
you as it usually is for me)! Finally, I help you explore standard Linux tools
and interfaces, work with accounts, and get the skinny on various aspects of
distribution-related Linux tools.

If you don’t want to install but do want to try Linux, I also give you the option

of using what'’s called a LiveCD, or bootable distribution. Knoppix is probably
the most popular of these, so it’s covered here as well.

Part [1: Internet Now!

In this part, you explore the issues involved in connecting a Linux system to
the Internet, including configuring a modem, managing a dial-up connection
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to an Internet Service Provider (or ISP), and configuring the various Internet
protocols involved to make your Internet connection work. You also go
through the details involved in configuring and using a Web browser and
setting up and using an e-mail client and newsreader.

Part I1]: Getting Up to Speed with Linux

Linux includes a great many facilities and capabilities, so after you get past
the initial installation and configuration, you probably want to use your
system to do something. Here’s where the doing begins! In this part of the
book, you can read about the Linux file system and how to work with files,
directories, and related access rights — called permissions in Linuxspeak.
You discover how to move in, out, and around GNOME and KDE, the two
major graphical interfaces (GUIs) in Linux. In addition, I include an in-depth
exploration of the Linux command-prompt environments, also known as
shells. Part Il also contains important security information, along with how
to add software to your system and keep it updated.

Part JU: Getting Things Done

In this part of the book, you discover how to use a variety of software available
in Linux. Everything from plain text editors to full office suites is addressed,
as well as whiz-bang multimedia tools and Microsoft Windows-based file for-
mats and media. Even better, did you know that you can run many Windows
programs under Linux? [ show you how in this part.

Part U: The Part of Tens

In this book’s grand climax, I sum up and distill the essence of what you now
know about Linux and its inner workings. Here, you have a chance to revisit
some key troubleshooting tips and tricks for Linux systems and find out more
about how you can use Knoppix, the specialty “bootable” distribution included
with this book.

Part UI: Appendixes

This book ends with a set of appendixes designed to sum up and further
expand on this book’s contents. Appendix A delivers groups of Linux com-
mands, complete with syntax and explanations, arranged according to their
function. Appendix B lists details about what’s on the Linux For Dummies, 6th
Edition, DVD. As I note in this appendix, the materials on the DVD include the
Fedora Core 3 distribution.

5



Linux For Dummies, 6th Edition

Icons Used in This Book

\\J

Within each chapter, [ use icons to highlight particularly important or useful
information. You find the following icons in this book:

The Tip icon flags useful information that makes living with your Linux
system even less complicated than you feared that it might be.

[ sometimes use this icon to point out information you just shouldn’t pass
by — don’t overlook these gentle reminders. (The life, sanity, or page you
save may be your own.)

Be cautious when you see this icon — it warns you of things you shouldn’t do.
This icon is meant to emphasize that the consequences of ignoring these bits
of wisdom can be severe.

This icon signals technical details that are informative and interesting but not
critical to understanding and using Linux. Skip these paragraphs if you want
(but please come back and read them later).

Where to Go from Here

This is where you pick a direction and hit the road! Linux For Dummies, 6th
Edition, is much like 71001 Nights because it almost doesn’t matter where you
start out. You look at lots of different scenes and stories as you prepare your-
self to build your own Linux system. Although each story has its own distinc-
tive characters and plot, the whole is surely something to marvel at. Don’t
worry — you can handle it. Who cares whether anybody else thinks that
you’re just goofing around? I know that you’re getting ready to have the

time of your life.

Enjoy!
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In this part . . .

Flis part includes an introduction to the development
and capabilities of the Linux operating system. I also
cover the terms and tools that make Linux what it is,
along with detailed step-by-step instructions about what it
takes to prepare your computer for Linux and to install
Linux on your very own PC. For those interested in Linux
distributions other than Fedora Core 3, which is included
with this book, I also cover what’s involved in installing
four other popular distributions — namely, Linspire,
Mandrake, SuSE, and Xandros. [ even explain how to con-
figure this marvelous operating system to do what you
want it to do and how to boot your brand-spanking-new
system into a computing colossus — not to mention how
to shut it off properly so that you don’t lose any data. After
that, you find out what’s involved in working with stan-
dard Linux tools, the point-and-click GUI, accounts, and
printers, as well as get a quick tour of your distribution-
related Linux tools.




Chapter 1
Getting Acquainted with Linux

In This Chapter

Describing Linux

Telling Linux apart from the rest of the operating system pack
Depending on GNU and the GPL

Marveling at the Linux Company (or lack thereof)

Checking out popular Linux distributions

Ford, you're turning into a penguin. Stop it!

— Arthur Dent

Welcome to the world of Linux, the operating system developed by over
a thousand people around the world! In this chapter, you find out
about Linux itself — what it is, where it comes from, and why it gets so much
attention in the news these days. Prepare to have your assumptions about
how software must be developed and sold challenged, and your mind opened
to new possibilities.

Is Free Really Free?

Understanding Linux requires a radical shift of thought regarding the way
that you acquire and use computer software. (Note: By radical, | mean getting
to the root of the matter rather than putting on beads and camping out in the
administration building.) Your first step toward shifting your mind-set is to
alter your general connotation of the word free to represent freedom, rather
than free lunch. That’s right; you can sell “free” software for a fee . . . and
you’re encouraged to do so, as long as you relay the same freedom to each
recipient of the software.
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Don’t scratch your head too hard; these concepts are tough to grasp initially,
especially when you consider the conditioning you've received from the mar-
keting departments of the commercial software industry. Perhaps you don’t
know that when you purchase most proprietary, shrink-wrapped software,
you don’t actually own the software; rather, you're granted permission to use
the software within the bounds dictated by the licensor.

Linux also has a license, but the motives and purpose of the license are much
different from those of most commercial software. Rather than use the license
to protect ownership of the software, the GNU General Public License (GPL)
that Linux is licensed under ensures that the software will always be open to
anyone. No company can ever own or dictate the way in which you use or
modify Linux — though they can have their own individual copyrights and
trademarks on their various brands of it, like Red Hat. In essence, you already
own Linux, and you can use it for anything you like, as long as you propagate
the GPL freedoms to any further recipients of the software.

Linux: Revolution or Just Another
Operating System?

Contrary to popular belief, penguins are not the salvation of modern
technology. Neither do they throw parties for the urban proletariat.

— Anonymous

Author note: Cute quote . . . obviously Anonymous has never been to a
Linux convention!

Before going any further into Linux, I need to get some terminology out of
the way.

Tux is the formal name of the mascot penguin that represents Linux. Rumor
has it that Linux’s creator, Linus Torvalds, is rather fond of these well-
dressed inhabitants of the Antarctic.

An operating system is the software that runs your computer, handling all of
the interactions between you and the hardware. Whether you’re writing a
letter, calculating a budget, or managing your recipes on your computer, the
operating system provides the essential air that your computer breathes.
Furthermore, an operating system isn’t just one program,; it consists of hun-
dreds of smaller programs and utilities that allow us humans to use a com-
puter to do something useful. You then run other programs on top of the
operating system, like a word processor, to get everything done.



Chapter 1: Getting Acquainted with Linux

In recent technological history, Linux has evolved from water cooler techie
chatter to a rock-solid solution for the business enterprise. The same soft-
ware that was once dismissed as rogue is now being adopted and promoted
by industry leaders such as IBM, Hewlett-Packard, Motorola, and Intel. Each
of these computer manufacturers has, in some way, determined that Linux
provides value for their customers (as well as for their own operations). Of
these companies, the only one that has publicly denounced Linux is Microsoft.
Note that one doesn’t have to look very far to conclude that Microsoft is
merely running scared from the threat that Linux poses to its personal com-
puter operating system monopoly.

Linux has been accused of being “just another operating system.” On the sur-
face, it may appear so, but if you look deeper, you can see that this isn’t so.
The Linux project is a flagship leading the current trend toward open source
and free (as in freedom, not free beer) software within the computing indus-
try. A rock-solid operating system because of the model under which it was
(and continues to be) developed, Linux represents much that is good and
pure in software development.

Two fundamental distinctions separate Linux from the rest of the operating
system pack:

v Linux is licensed under the unique and ingenuous GNU General Public
License, which you can read about in the next section.

v Linux is developed and maintained by a worldwide team of volunteer
programmers, working together over the Internet.

Linux is great for many reasons, including the fact that the folks who built it
from the ground up wanted it to be:

v Multiuser: More than one user can be logged in to a single computer at
one time.

1 Multiprocess: True pre-emptive multitasking enables the operating
system core to efficiently juggle several programs running at once.
This is important for providing multiple services on one computer.

v Multiplatform: Linux currently runs on 24 platforms (hardware types),
including Intel-based PCs, Digital/Compaq Alpha, PowerPC-based Apple
Macintosh, Sun SPARC, Amiga, and StrongARM-based computers.

v~ Interoperable: Linux plays nice with most network protocols (languages)
and operating systems, allowing you to interact with users and comput-
ers running Microsoft Windows, Unix, Novell, both Mac OS 9 and the
generation beginning with OS X, and other, more niche groups.

1 Scalable: As your computing needs grow, you can rely on Linux to grow
with you. The same Linux operating system can run on a desktop com-
puter or a very large, industrial strength server system.

11
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v Portable: Linux is mostly written in the C programming language. Cis a
language created specifically for writing operating system-level software
and can be readily ported (translated) to run on new computer hardware.

v Flexible: You can configure the Linux operating system as a network
host, router, graphical workstation, office productivity PC, home enter-

tainment computer, file server, Web server, cluster, or just about any
other computing appliance that you can think of.

v~ Stable: The Linux kernel (the operating system itself) has achieved a
level of maturity that makes most software developers envious. It’s not
uncommon to hear reports of Linux servers running for years without

crashing.

v~ Efficient: The modular design of Linux enables you to include only those

components that you need to run your desired services. Even older
Pentium computers can utilize Linux and become useful again.

v Free!: To most people, the most intriguing aspect of Linux is the fact
that it’s often free. How (the capitalists murmur) can anyone build a
better mousetrap with no incentive of direct monetary return?

So, where did Linux come from?

To understand Linux, you need to take a peek at
its rich heritage. Although programming of the
Linux core started in 1991, the design concepts
were based on the time-tested Unix operating
system.

Unix was developed at Bell Telephone
Laboratories in the late 1960s. The original
architects of Unix created it back when there
were few operating systems, with the desire to
have one that shared data, programs, and
resources both efficiently and securely —
something that wasn’t available at this time.
From there, Unix evolved into many different
versions, and its current family tree is so com-
plicated it looks like a kudzu infestation!

In 1991, Linus Torvalds was a computer science
student at the University of Helsinki in Finland.
He wanted an operating system that was like
the Unix system that he’d grown fond of at the
university, but both Unix and the hardware it ran

on were prohibitively expensive. A Unix version
called Minix was available for free, but it didn't
quite meet his needs. So, as a computer sci-
ence student, Torvalds studied Minix and then
set out to write a new version himself. In his
own words (recorded for posterity on the
Internet since this was in an early version of an
online chat room), this was, “just a hobby, won't
be big and professional like gnu.”

Writing an operating system is no small task.
Even after six months of hard work, Torvalds
had made very little progress toward the gen-
eral utility of the system. He posted what he had
to the Internet and found that many people
shared his interest and curiosity. Before long,
some of the brightest minds around the world
were contributing to Linus's project by adding
enhancements or fixing bugs (errors in the
code).
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In this chapter, I intend to answer that last question for you. I also hope to
paint a picture of the open source software development model that created
Linux.

Anatomy of an Open Source
Software Project

Linux isn’t a product. Linux is an organic part of a software ecosystem.

— Michael Robinson, Netrinsics

To the casual observer (and some corporate IT decision-makers), Linux
appears to be a freak mutation — a rogue creature randomly generated by
anarchy. How, after all, can something so complex and discipline-dependent
as a computer operating system be developed by a loosely knit band of vol-
unteer computer geeks from around the world?

Just as science is constantly attempting to classify and explain everything in
existence, technology commentators are still trying to understand how this
open source model can create superior software. Often, the reasons have much
to do with the usual human desire to fill a need with a solution. When a pro-
grammer in the Linux world wants a tool, the programmer simply writes one
or bands together with other people who want a similar package to write it
together.

GNU who?

Imagine — software created out of need rather than projected profit. Even
though Unix ultimately became expensive proprietary software, the ideas and
motives for its creation were originally based on need. What people usually
refer to in the singular as the Linux operating system is actually a collection of
software tools that were created with the express purpose of solving specific
computing problems.

Linux also wouldn’t be possible without the vision of a man whom Steven Levy
(author of the book Hackers) refers to as The Last of the Great MIT AI-LAB
Hackers — the original meaning of the word hacker, which meant someone
who plays with code, not the current meaning implying criminal intent. This
pioneer and advocate of freedom software is Richard Stallman.
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The Massachusetts Institute of Technology (MIT) has long held a reputation
for nurturing the greatest minds in the technological disciplines. In 1984,
Stallman, a gifted student and brilliant programmer at MIT, was faced with a
dilemma — sell his talent to a company for a tidy sum of money or donate
his gifts to the world. He did what we’d all do . . . right?

Stallman set out on a journey to create a completely free operating system
that he would donate to the world. He understands and continues to live the
original hacker ethic, which declares that “information wants to be free.” This
concept wasn’t new in his time. In the early days of the computing industry,
many advancements were made by freely sharing ideas and programming
code. Manufacturer-sponsored user groups brought the best minds together
to solve complicated problems. This ethic, Stallman felt, was lost when com-
panies began to hoard software as their own intellectual property with the
single purpose of profit.

As you may or may not have gathered by this point, widespread and accessible
source code is paramount to successful software development. Source code is
the term for the human-readable text (as opposed to the unreadable ones
and zeros of binary code or an “executable”) that a programmer types to
communicate instructions to the computer.

Writing computer programs in binary is an extremely arduous task. Modern
computer software is usually written in a human-friendly language and then
compiled, or translated, into the computer’s native instruction set. To make
changes to this software, a programmer needs access to a program’s source
code. Most proprietary software comes only as precompiled, and the software
developer keeps the source code for those programs under lock and key.

After determining that his operating system would be built around the con-
ceptual framework of Unix, Stallman wanted the project name to distinguish
his system from Unix. So, he chose the recursive acronym GNU (pronounced
ga-new), which means GNU’s Not Unix.

To finance the GNU project, Stallman organized the Free Software Foundation
(FSF), which sold free software to help feed the programmers who worked on
its continuing development. (Remember, we're talking free as in free speech,
not free beer.) Although this organization and goal of creating a complete oper-
ating system was necessary and important, a much more important piece of
the puzzle had to be put into place to protect this new software from big
business pirates — a concern still all too relevant today as a former Linux
company tries to hijack ownership of decades of volunteer work from thou-
sands of people around the world.

The GNU General Public License (GPL) is a unique and creative software license
that uses copyright law to protect the freedom of the software user, which is
usually the opposite of how a copyright works. Generally, a copyright is an
enforceable designation of ownership and restriction from duplication by
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anyone but the copyright holder. When software is licensed under the GPL,
recipients are bound by copyright law to respect the freedom of anyone else
to use the software in any way they choose. Software licensed with the GPL is
also known as copyleft software. Another way to remember the GPL is through
its ultimate result: Guaranteed Public for Life.

Who's in charge of Linux anyway?

As an open source project evolves, various people emerge as leaders. This
leader is often known as the project’s benevolent dictator. A person who
becomes benevolent dictator has probably spent more time than anyone
else on a particular problem and often has some unique insight. Normally,
the words democratic and dictator are never paired in the same sentence,
but the open source model is a very democratic process that endorses the
reign of a benevolent dictator.

Linus Torvalds is still considered the benevolent dictator of the Linux kernel
(the operating system’s core). He ultimately determines what features are
added to the kernel and what features aren’t. The community trusts his vision
and discretion. In the event that he loses interest in the project, or the com-
munity decides that he has gone senile, a new leader will emerge from amongst
the very competent people working with him.

Einstein was a volunteer

Someone who is a volunteer or donates their time to a project isn’t necessar-
ily providing a second-rate effort or only working on weekends and holidays.

In fact, any human resource expert will tell you that people who choose to do
a job of their own free will produce the highest quality products.

The volunteers who contribute to open source projects are often leaders in
their field who depend on community collaboration to get useful work done.
The open source concept is no stranger to the scientific community. The
impartial peer-review process that open source projects foster is critical in
validating something as being technically correct.

Those who paint the open source community as copyright violators and
thieves often misunderstand or outright ignore these vital issues. Open
source programmers are very proud of their work and are also very con-
cerned about their own copyrights, not wanting their work to be stolen by
others — hence licenses such as the GPL. This concern creates an atmos-
phere with the greatest respect for copyright. Those who claim that they are
just being “open source” when they steal other people’s hard work are
grossly misusing the term to soothe their own consciences.
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Many have also pointed out that if copyright is violated in open source, it is
easy to tell. Watch the news and notice how often large software corporations
are convicted of stealing other people’s code and incorporating it into their
own work. Tracking down such copyright violations is incredibly difficult in a
closed source scheme.

Packaging Linux: The Distribution

What people call a Linux distribution is actually the culmination of the GNU
project’s tools, the Linux kernel, and any number of other open source
(and closed source) software projects that sprang up along the way:.

Robert Young, cofounder and current chairman of Red Hat, has coined an
analogy comparing Linux to ketchup. Essentially, the operating system called
Linux, with the GNU tools, Linux kernel, and other software, is a freely avail-
able commodity that, like ketchup, different distributors can package and
label in different containers. Anyone is encouraged to package and market
the stuff, even though the ingredients are fundamentally the same.

Linux is a complex, malleable operating system, and thus it can take on many
appearances. The greatest Linux advancement in recent years has been making
it easier to install. After all, the tools that today enable the casual PC user to
install Linux originally weren’t available. Companies such as Red Hat saw this
as an opportunity to add value to an existing product, and the concept took
off like gangbusters.

To draw again on the ketchup analogy, various distributions of Linux have a
slightly different flavor or texture; your distribution preference may be spicy,
mild, thick and gooey, or runny. However, you can rest assured that any of
the following distributions have the same Linux and GNU heart and soul.
Each short description includes a Web address where you can find more
information about each project:

v Debian GNU/Linux: This distribution is one of the oldest and is a recog-
nized favorite among advanced technical circles. Historically, it’s rela-
tively difficult to install. The Debian team works closely with the GNU
project and is considered the most “open” of the Linux distributions.
Easier to install (and use) distributions with Debian underneath are
Xandros and Linspire (formerly known as Lindows).

www.debian.org
www.xandros.com
www.linspire.com

v Mandrake: This distribution demonstrates the power of the GPL by
allowing this competing company to stand on the shoulders of giants.



Mandrake was originally based on Red Hat Linux, something that simply
could not happen in a closed source environment, but has since become
an excellent solution in its own right.

www.mandrakelinux.com

+” Red Hat and Fedora: Red Hat claims the prize for successfully mass
marketing the Linux operating system. Red Hat has validated Linux by
packaging the GNU and Linux tools in a familiar method of distribution
(shrink-wrapped) and has included value-added features to its product,
such as telephone support, training, and consulting services.

www . redhat.com
http://fedora.redhat.com/

v Slackware: Of all the more recognized surviving Linux distributions,
Slackware has been around the longest. In fact, until about a year ago,
the installation interface remained unchanged. Slackware has a very
loyal following, but isn’t well known. Like Debian in terms of spirit, the
Slackware crowd is respected in Linux circles as the weathered old-timers
who share stories of carrying around a shoebox full of diskettes.

www.slackware.com

v SuSE: (Pronounced soo-za) This distribution hails from Germany, where
it has a very loyal following. SuSE works closely with the XFree86 project
(the free X graphical server component of all Linux distributions). Conse-
quently, SuSE has a terrific graphical configuration tool called SaX.

Www.Ssuse.com

As you can see, many paths (in the form of distributions) lead to Linux. It’s
important to note that, regardless of which distribution you choose, you're
using the same basic ingredients: the GNU tools and the Linux kernel. The
major differences that you’ll encounter among distributions are

v~ Installation programs: Each distribution has developed its own installa-
tion program to help you achieve a running system. Some installation pro-
grams are designed for the casual computer user (hiding the technical
details), whereas others are designed with the seasoned system admin-
istrator in mind. Some of the simpler ones offer an “expert mode” for
those who want to have more control right from the beginning.

v~ Software versions: Different distributions may use different versions of
the kernel (the core of the operating system) and other supporting soft-
ware packages. Open source projects are dynamic and release new ver-
sions regularly, as opposed to the often sluggish development cycle of
traditional commercial software.

v Package managers: Even though one Linux program should be able to
run on any distribution, tools called package managers keep track of the
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software on your system and ensure that you have all the required sup-
porting software as well. Distributions are usually dependent on one
particular package manager. More recent in the grand scheme of things,
package management has also come to involve adding easy-to-use update
routines as well as the ability to add software without needing a computer
science degree.

It would be impossible to account for every possible installation of every
Linux distribution. Okay, maybe not impossible, but you would need a forklift
to bring your Linux For Dummies book home from the bookstore if I did.
Consequently, I try to summarize the concepts needed to install any Linux
distribution into this one book with enough detail to get you through the
process. As you can imagine, this is a bit of a challenge!

I chose Fedora Core as the sample distribution because Red Hat has become
arecognized Linux standard, and its Fedora Core project is specifically aimed
at home and small business users who cannot afford or have no need to pur-
chase higher-level products. Even better, if you do use Red Hat Enterprise
Linux (RHEL) in your office or organization, Fedora Core is a proving ground
for the technologies that will make their way into RHEL.

In addition to Red Hat coverage, I also include information about other popu-
lar distributions with beginners: Linspire, Mandrake, SuSE, and Xandros. |
certainly don’t wish to discount Slackware and Debian because these are
very powerful distributions. I just feel that they are more advanced than the
others and best left for your post-Linux For Dummies endeavors. Included
also is Knoppix, a Live CD that you can use to boot your computer into a full
desktop without having to install a thing!

In fact, the DVD that comes with this book contains more than just Fedora.
Check out Appendix B for a list of what you can find on the DVD.



Chapter 2
Prepping Your Computer for Linux

In This Chapter

Taking basic preinstallation steps

Using Linux and Windows on the same computer
Customizing disk partitions before installation
Knowing (and finding) your hardware information
Preparing for CD or floppy disk installation

M ost current Linux distributions automatically detect your hardware
and guide you through the installation process. In fact, some people
just dive right in and start installing. However, if you're setting up a machine
that will run both Windows and Linux (although not at the same time), don’t
leap in without at least reading the section “Preparing to Use Linux and
Microsoft Windows Together,” later in this chapter. You need to make sure
that you have the space to install Linux and that you don’t accidentally wipe
out your Windows installation.

Other people like to start with a bit more caution. You can save yourself
potential headaches — or make it easier to troubleshoot technical
problems — by becoming familiar with your computer’s hardware.

You should watch out for several issues when preparing to install Linux. In
this chapter, I address the tasks that prepare you for the Linux installation
process, such as setting up your system to install Linux directly from the
DVD or CD, or with an installation floppy disk, if you end up needing one.

Installation Considerations

You got to be careful if you don’t know where you are going, because you
might not get there.

— Yogi Berra

If you have a spare machine that’s only going to run Linux and nothing else,
you're in luck! You can skip all of the “Preparing to Use Linux and Microsoft
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Windows Together” section. In fact, if you're feeling brave, you might want to
skip right to Chapter 3 or 4 (depending on which distribution you’re using)
and start your installation. There’s troubleshooting information in Chapter 20
as well.

If you plan to run both Linux and Microsoft Windows on the same computer —
a scenario called dual booting — DO NOT PROCEED TO CHAPTER 3 without
reading the section “Preparing to Use Linux and Microsoft Windows Together.”
Sorry for yelling, but you can wipe out your whole Windows installation if
you don’t take some precautions!

Preparing to Use Linux and Microsoft
Windows Together

A\

\\J

If you're planning to run Linux and Microsoft Windows on the same machine,
the odds are that you've already got Windows installed and have been using
it for some time. Because I hate to hear screams of anguish all the way up
here in western Canada, take a moment to assess what you have and what
you need to do.

On the off chance that you actually don’t have Windows installed yet, you'll
want to install it before you install Linux. Otherwise, during installation,
Windows will overwrite the part of your hard drive that Linux uses to store
its boot menu. This can create a bit of a mess later when you want to boot
back into Linux! Those who are installing Windows first should skip down

to the section “Working with Disk Partitions” to find out how to set up your
Windows installation so that it causes the least amount of fuss when it’s time
to add Linux.

The majority of you, however, want to dual boot because you've got one
machine and it’s already running Windows. If you have a brand new hard
drive to work from that has nothing on it already, skip down to the section
I just mentioned (“Working with Disk Partitions”). You won’t need to do
anything funny with the hard drive that Windows is using. However, if you
need Linux and Windows to share the same hard drive and you already have
Windows installed, you have a bit of extra work to do if you're using Fedora
Core (the default choice in this book), Linspire, or Xandros — SuSE and
Mandrake can resize things for you, and Knoppix doesn’t install so you
don’t need to make room for it. The rest of this section focuses on getting
you through all this hassle.

Even if you're using SuSE or Mandrake, which can resize for you, you’ll want
to work through the appropriate “Seeing how much free space you have avail-
able” section, later in this chapter, for your version of Windows so that you
can decide how big you want to make your Linux partition when the installer
asks you.
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Removable hard drives

One way to handle multiple operating systems
is the removable rack hard drive. The installa-
tion entails placing a special carriage into one
of your computer's hard drive bays. This setup
can be installed in most computers by an expe-
rienced individual or a qualified technician.

After this component is installed, you can place
individual hard drives into the carriage, plugging
them in and pulling them out as you might do
with a CD-ROM — although you wouldn’t want
to just yank one out in the middle of doing some-
thing on your machine! Using a removable rack
hard drive setup allows you to have a separate
Windows drive and Linux drive. When you're
using Windows and want to switch to Linux, you
shut down Windows and pull out the drive. Then
you replace it with the Linux drive and boot as
though the Linux drive were always there.

If you're nervous about managing multiple
operating systems and don't have room for a

second hard drive in the machine, a removable
rack hard drive is a great alternative. You'll need
to make sure that your existing hard drive can
fit in the rack, as well as the new one, and it's
wise to buy more than one loading chassis
(used to slide the drive into the rack) so that you
can just leave your drives in the chassis when
they're not in the machine.

For more information, see PC Hardware in a
Nutshell, by Robert Bruce Thompson and
Barbara Fritchman Thompson, from O'Reilly &
Associates.

If you're new to computer hardware, | strongly
recommend that you seek assistance or have a
technician install an additional hard drive or
removable rack setup for you. Improper han-
dling of computer components can damage
your computer. In addition, you must keep
safety in mind when working with electrical
components.

CMBER

When you install Linux on a system that has Windows already installed, you
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can run only one operating system at a time. In other words, if you're using
Windows and you want to run Linux, you need to shut down Windows, allow
the computer to reboot, and then start Linux. However, with the use of addi-
tional software, you can run Linux on a Windows system at the same time
Windows is running. You can also run Windows software within Linux itself!
See Chapter 19 for more information.

Partitioning from scratch for a dual boot

If you plan to take a fresh hard drive and install both Windows and Linux on
it, be sure to install Windows first. While you’re going through the Windows
installation, you will be asked to partition your drives. Your hard drive can
have three primary partitions and one extended partition. Inside that
extended partition, you can have up to 12 logical partitions.

No matter what type of partition you use for Linux, make sure to leave at
least 3GB open for it. Typically, you’ll want even more, because you may like
to download big files like multimedia stuff.
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Make a note of the partition you leave open, with both the drive it’s on
(the first, second, third, and so on) and the partition number it is on the
disk (again, first, second, and so on). You'll need this information later,
when you start actually resizing your partitions.

If you're not installing a fresh machine, you may have to make some changes
to your current install. Proceed to the next section to find out how.

Peeking at your partitions from Windows

Before I get into actually changing anything, it’s important to collect some
information about your current setup. You need to know two major types of
data about your hard drives before you get started adding Linux. The first is
to know whether you have any unpartitioned space left on your hard drive(s),
and if so, how much space you have there. If you have at least 3GB of unparti-
tioned space, then you can skip straight to the “Gathering Information about
Your Machine” section later in this chapter. (If you want a really minimal instal-
lation without even any graphical interface, you don’t need nearly 3GB.)

However, if you don’t have any unpartitioned space, or you have too little
unpartitioned space available (for example, if you like to rip a lot of CDs,
you’ll want more than 3GB of space), the “Seeing how much free space you
have available” section can help you prepare to resize your existing partitions.

Peeking at your partitions in Window's
2000 and Windows XP

Windows 2000 and XP operating systems use accounts to control and secure
the files and folders, so to get information about the computer’s disk space
usage, you first need to be logged on to the system as the Administrator or
with an account that has administrative permissions. Once you have done so,
in Windows 2000/XP, you use the Computer Management application in the
Administrative Tools collection to find the details of the computer’s hard
drive usage. Follow these steps:

1. Open the Control Panel by choosing Start=>Settings=>Control Panel.

2. Open the Administrative Tools folder and double-click the Computer
Management icon.

3. In the left pane of the Computer Management application, click the
Disk Management folder icon.

Within a few seconds, the right pane displays the current status of the
storage devices on your computer, such as the hard drive(s), CD drives,
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DVD/CD drives, and so on. Figure 2-1 is an example of the Windows XP
Disk Management display, and Figure 2-2 shows the Windows 2000 Disk
Management interface.
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Figure 2-2 reflects a computer that has one hard drive and one DVD/CD drive.
The important thing to look for here is the word “Unallocated” in the middle
Disk listing — an example is shown in this figure. Unallocated partitions are
not assigned to any operating system, and so are free to use for your Linux

installation.

If you do find an Unallocated partition, like you see in both Figures 2-1 and
2-2, you're set if it’s 3GB or larger (see the previous section). Make a note of
which partition this is (what disk is it on and what partition on that disk and
skip ahead to the section “Running Windows and Linux together.” For example,
in Figure 2-1, the partition is on disk 1, and it’s partition 2.
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If you don’t have any (or enough) Unallocated space, keep this window open
and see the section “Making Space,” later in this chapter, for strategies of how
to proceed.

Checking your partitions in Windows 98

If you need Windows and Linux to share the same hard drive, I need you to
do some detective work before I move on. Windows 98 does not provide a
graphical tool like Computer Management. Instead it uses FDISK, which is a
command-line tool that indicates the partitions on your hard drive. To find
out the details about computer’s hard drive in Windows 98, follow these steps:

1. Open an MS-DOS prompt window by choosing Start=>Programs=>
MS-DOS Prompt.
2. Type FDISK and press Enter.

In Windows, you can enter FDISK in uppercase, lowercase, or any mixed
case you like as long as you spell FDISK correctly!

Depending on the size of your hard drive, you may be prompted to display
large disk information. If you don’t see the prompt, the FDISK menu
options appear similar to the ones shown in Figure 2-3.

3. If you see the large disk prompt, choose Y at this prompt and then
press Enter.

The FDISK menu options appear.

"% MS-DOS Prompt - FDISK

A plee) B =S Al
Microsett Windows %8
Fixed Disk Setup Program
(CICopyright Microsoft Corp. 1983 - 1998

FDISE Optiens

Current fixed disk drive: 1

Choose one of the following:

1. Create DOS partition er Logical DOS Drive
Sel active partition

2.
3. Delete partition or Legical DOS Drive
4. Display partition infermation

Enter choice: [ ]

Invalid entry, please enter 1-4.
Press Ese to exit FODISE

4. Display the current drive partition information.

If you have more than one hard drive in your computer, FDISK displays a
fifth menu choice to change between disks. To change to another disk,
type 5 and press Enter. The FDISK screen displays all the hard drives in
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your system. Type the number of the disk you want and press Enter.
The top of the FDISK menu screen displays the number of the drive
that FDISK is working with.

. To display partition information for the disk number displayed, type 4
and press Enter.

Figure 2-4 shows an example of the Display Partition Information screen
within FDISK.

"% MS-DOS Prompt - FDISK

B B =5 Al

Display Partition Information
Current fixed disk drive: 1
Partition Status Type Uolome Label Mbytes System Usage
[ | n PRI DS 3008  FAT32 b6i
EXT Dos 367 54

Total disk space is 6471 Mbytes (1 Mbyte = 1048576 bytes)

The Extended DOS Partition contains Logical DOS Drives.
Do you want to display the logical drive information (YW/H)...... M

Press Ese to return to FOISE Options

Figure 2-4 indicates that no free, unallocated disk space is on the drive. If
the disk had unpartitioned space, FDISK would display the amount of
space available.

However, in Figure 2-4, you see that a portion of the disk space is config-
ured as an extended partition EXT DO0S. Extended partitions can contain
what’s called logical partitions, so it’s possible that there might be free
space available inside the extended partition that you could use to install
another operating system, like Linux, or even another type of Windows.

Think of primary partitions as empty boxes that you put data into.
Extended partitions are those annoying boxes that have a collection of
smaller boxes stacked next to each other inside. You only put data into
the smaller boxes with an extended partition. These smaller boxes are
the logical partitions.

Unfortunately, FDISK doesn’t tell you anything about what’s inside this
extended partition. You have to dig deeper.

. To view the logical partitions within the extended partition, select the
EXT DOS entry and press Enter.

Figure 2-5 is an example of a logical partition setup. In this case, all
space within the extended partition is currently assigned. You can tell
whether there’s free space by totaling the Usage percentages for the
drive. If they total up to 100 percent, no space is available. (Leave this
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tool open and go to the section “Making space,” later in this chapter).
On the other hand, if there’s less than 3GB available, you don’t have
enough room, so also go to “Making space.” If you have 3GB or more
available, skip to the section “Preparing to Use Windows and Linux
together.”

"% MS-DOS Prompt - FDISK

B B =5 Al

Display Logical DOS Drive Information

Dre Uolume Label Mbytes System Usage
D: DaTa 3467 FaT32 100#

Tetal Extended DOS Partition size is 3&%b67 Mbytes (1 MByte = 1048576 bytles)

Press Esc to continue

Making space

You may have unallocated space, but less than 3GB worth, or you may have
none at all. Either way, you need to rearrange the data on your hard drive(s)
in order to make room for Linux, unless you decide to add a second hard
drive to the machine. If you're installing SuSE or Mandrake, these distribu-
tions can handle the resizing for you, so users of these Linux versions are
welcome to skip ahead to the section “Running Windows and Linux together.”
Everyone else is encouraged to keep reading.

Keep in mind that you may actually want more than 3GB of space. For exam-
ple, if you download lots of multimedia, you’ll eat up that space fast!

If it turns out that you have free/unallocated space on more than one spot on
your hard drive (maybe between various partitions), count this space up and
see how much the total is. You can move things around if you have to by
resizing the partitions.

If you don’t have any free/unallocated space, you’'ll definitely have to resize
your partitions. The key to doing this is to take a look to see how much of
your drive space you're really using. In Windows XP and 2000, you can deter-
mine how much of your Windows partitions are actually empty by looking at
the Capacity, Free Space, and % columns in the Computer Management tool.
In Windows 98 and 95:
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1. Double-click My Computer to open the Computer Management tool.
2. Choose Viewr>Web Page.
3. Highlight your first drive.

You see something like what is shown in Figure 2-6.

Determining how much space is enough for your Windows setup — you
don’t want to shrink it so much that you run out of space in Windows! —
also involves looking at how you use your machine. Again, if you download
a lot of multimedia stuff and you tend to save it, you need to keep enough
room around for your downloading habit.

If you find that your Windows drives are all too full, or you download and
save too much multimedia, it may be time to burn some of your files off onto
CDs so that you can delete them from your hard drive.

Once you have decided which partition you want to resize, make a note of
which hard drive it’s on and which partition it is (first, third, second, and so
on). You need this information when it comes time to tell the installer where
to put Linux.
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C )

Local Disk Printers Control Panel DialUp Scheduled ‘web Folders
Hetworking Tasks

Capacity: 1,50 GB
[ used: 1.30 GB

O Free: 205 Me

|Free Space: 205MB . Capaciy: 1.50GB | 21 My Camputer y

Commercial tools, such as Partition Magic, provide an easy way to resize and
work with the partitions on your hard drives. You can find information about
Partition Magic from the company’s Web site at www.powerquest.com. In the
next section, “Working with Disk Partitions,” you also find out how to get and
use a free alternative, qtparted.
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Working with Disk Partitions
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In the section “Preparing to Use Linux and Microsoft Windows Together” at
the beginning of this chapter, I discuss why you might need to set aside disk
space for Linux on a computer already running Windows. The techniques I
cover here assume that you have found free space that you can give to Linux,
after you resize your partitions. If you're installing on a fresh, additional hard
drive, are wiping out a whole hard drive to give it over to Linux, or have a
chunk of Unallocated/Free space bigger than 3GB already that you want to
use and so don’t need to resize anything, skip ahead to the section “Preparing
to Use Windows and Linux Together,” later in this chapter.

A cheap, additional hard drive can be worth its weight in gold if you're afraid
to change anything on your Windows drive.

Choosing a partitioning tool

Perhaps the easiest and safest way to adjust your existing partitions is
through the use of a commercial program such as Partition Magic. Partition
Magic enables you to view the partition information for your hard drive or
drives. The utility also includes the ability to resize, move, and add parti-
tions. However, you don’t have to go out and buy software just to resize your
partitions. Instead, you can download a free tool to do the job for you.

Before going any further, make a backup of anything you don’t want to lose off
your Windows installation! Things can go wrong during the various steps of
this process, even when using Windows tools on Windows.

If you create an open partition using Partition Magic, after resizing your
Windows partition, make a note of which drive and partition it is (first,
second, and so on). You'll need it when you're telling the installer where
to put Linux.

Getting and resizing partitions
with qtparted

A free resizing program you can use is called gtparted. This utility is capable
of working with both VFAT and NTFS partitions, so it can handle both of the
filesystems you may have used when you set up your machine in Windows.
This program comes with Knoppix, which is a Live CD — another term is
bootable distribution — which means that you can put this CD into your
CD-ROM drive, boot your computer with it, and it brings you into a full ver-
sion of Linux that you don’t have to install. Knoppix is handy for showing
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people Linux, but more importantly for my purposes, it’s useful for rescuing
machines that can’t boot and resizing partitions.

Knoppix comes on the DVD included with this book, which is pretty handy.

If you can’t use the DVD for whatever reason, see Chapter 4 for how to get
Knoppix on CD. Before proceeding, double-check that you backed up all your
important data before you proceed. Then, pull out any notes you may have
made in the section “Preparing to Use Linux and Microsoft Windows Together”
earlier in this chapter — about which partition(s) you want to change — and
then do the following:

1. Put your Knoppix CD or the DVD that came with this book into the
CD- or DVD-ROM drive and reboot your computer.

If you're using the book’s DVD, a boot menu appears — if you have
trouble booting into Knoppix from the DVD, see Appendix B. Just press
Enter to boot into Knoppix, and eventually the Knoppix welcome screen
appears. If you're using a plain Knoppix CD, your computer boots
directly to the Knoppix welcome screen.

2. At the boot: prompt, press Enter.

Lots of text scrolls by as Knoppix figures out all the hardware on your
system. It takes perhaps a minute for Knoppix to fully launch on many
machines, because it’s got to run entirely from CD-ROM. Once it’s up and
running, you see the Knoppix desktop (see Figure 2-7).
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If anything goes wrong during the KNOPPIX startup process, press Ctrl-
Alt-Del to reboot and try adding more of the possible boot options
shown with F2 and F3.

3. From the main menu, choose System~>QTParted.
The QTParted tool opens (see Figure 2-8).
4. On the left, select the drive you want to work with.

If necessary, refer to your notes (see the section “Preparing to Use Linux
and Microsoft Windows Together,” earlier in this chapter) to see
whether it’s the first, second, third, or so on of your hard drives. If you
have both IDE and SCSI hard drives, you can tell the difference by the
“hd” starting IDE names and the “sd” starting SCSI names. The order
they’re installed on the machine is indicated alphabetically. For exam-
ple, hda is the first IDE hard drive, hdb is the second, and so on. (It’s the
same for SCSI, sda and sdb.)

./} L qiparted v0.4.4 . =t (2 (X
Eile Qperations Disks Device OQplions Help
[v s o - w]®
The following drives have been detected: |
Device |
Oisks____ ...
- @ idevinds Mumber |Paﬂitinn |Type ]S!atus |Si29 |Used space IStart IEnd |Laha| I

Drive Info

Mo Drve Sefecled

| @TParted 1) [ by Zanac (c) 2002-2003 |

Once you have made your selection, the drive’s partitions and other
information appear in the bottom and right portions of the window (see
Figure 2-9).

5. On the right, select the partition you want to resize.

Again, refer to your notes from the section “Preparing to Use Linux and
Microsoft Windows Together,” earlier in this chapter, to see which parti-
tion you wanted to change.
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6. Choose Operations=>Resize to open the Resize Partition dialog (see

Figure 2-10).

Minimum Size: 1420 MB

Free Space Bafore; [100 Hive =]
Mew Size: |FENERIER 2[me =]
Frea Space After: [0.00 Hve |

Itis recommended to backup your data bafore dao this opaerafion!

7. Make your sizing changes.

Note that you have multiple options here. You can alter the Free Space
Before, the size (New Size), and the Free Space After. If you have smaller
pieces of blank space scattered through your drive between partitions,
you can start by changing the Free Space Before entries to zero, thus
squeezing things together more efficiently by moving all your free space
to the end of the drive. This concept is perhaps better illustrated with
an image, so see Figure 2-11.
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Figure 2-11:
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. Click OK to save the changes for that partition.

Your hard drive isn’t permanently changed just yet.

. Return to Step 5 if you have more partitions you want to change.

Otherwise, proceed to Step 11.
Choose File>Commit to put the changes into effect.
Now is when your hard drive is actually changed!

Double-check that you have given yourself at least 3GB, if not more, of
free space to install Linux in.

If not, resize things further.

Choose File>Quit to close QTparted.

You're now finished with your repartitioning.

From the Knoppix main menu, choose Logout.

From the End Session for Knoppix dialog box, choose Restart Computer.
Click OK to reboot the machine.

The computer may speak as it shuts down. When the shutdown process
completes, you're told to remove the CD, close the CD-ROM drive, and
press Return/Enter. Follow the instructions and just let the machine
boot back into Windows so that you can make sure nothing went wrong.
If it did, use your Windows system recovery media (such as your XP CD)
to try to repair the damage. Fortunately, such damage is very rare!

After you've finished your repartitioning, proceed to the next section so you
can get ready to do the actual installation.
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Gathering Information
about Your Machine

Most hardware these days works just fine with Linux. Sometimes, if you have
the very latest whiz-bang video card or some other fancy new type of electron-
ics, you may run into some trouble, so if you're an early-adopter sort of person,
you’ll want to go to your distribution’s hardware compatibility list and make
sure you're covered. If you like to be organized and check out hardware ahead
of time anyway, or if you run into problems and want to do some research to
see what’s wrong, you can go to three basic places get information:

v The most specific is the list for your particular distribution:

¢ Fedora: There’s no official Fedora hardware list as yet, though the
Fedora Hardware Project (http://people.ucsc.edu/~maxka/
fhp/) is working to correct this issue. In the meantime, you can
use the Red Hat listings at http://hardware.redhat.com/hcl/.
Keep in mind that this list focuses on business equipment rather
than home stuff and doesn’t entirely apply to Fedora users.

¢ Linspire: Check out www.1inspire.com/Tindows_hwsw_
compatibility.php.

e Mandrake: Go to www.mandrakelinux.com/en/hardware.php3.

e SuSE: The place to start is www.suse.com/us/private/support/
online_help/. From here, click the Hardware Database link to
search.

e Xandros: Check out http://support.xandros.com/
hcl-search.php.

For all these hardware lists, don’t worry about items being Certified or
not. Supported will do just fine most of the time.

\P
) If you're new to computers or aren’t that familiar with hardware definitions
and details, you can find a lot of information on the Internet. (One good Web
site is www.tomshardware.com.)

v If your hardware isn’t listed, don’t panic. You can also check the generic
Linux hardware list at www.t1dp.org/HOWTO/Hardware-HOWTO/.

v If you still can’t find the hardware listed, point your Web browser to
www.google.com/Tinux and do a Web search on the make and model
of the hardware, plus the word Linux. For example, you can search on
Innovision DX700T Linux to find out how other people are faring
with this particular brand and model of hardware (no endorsement of
any hardware mentioned as examples is implied here, of course).
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If worse comes to worse, you might not find support listed for a piece of hard-
ware. Try it anyway; it might work fine with a few minor caveats. For example,
you might not be able to use the very latest features of your latest-generation
video card, but you’ll be able to use it as a generic SVGA at the very least. Also,
sometimes older hardware is left off the lists but is still supported.

P When possible, keep your computer manuals (especially the ones for your
video card and monitor) handy, just in case you need them in order to
answer a question asked by the installer — most people won’t have to deal
with this at all, but some will. If the installer can’t detect your video card in
particular, then you’ll need to know exactly what it is, and what its specifica-
tions are — or just choose the Generic option. (I get to how to do this when
you install Linux.) If you’re determined to know what exactly is in your
machine or need to find out because you have to do some extra research,
you have the following options:

v Use an existing operating system to document your hardware. If your
computer is already running Windows, you can collect a lot of informa-
tion from the Windows environment. Use one of the following methods,
depending on your system:

¢ In Windows 98, choose Start=>Settings=>Control Panel=>System=>
Device Manager to access the dialog box shown in Figure 2-12.

¢ [In Windows 2000, choose Start=>Control Panel=>Systemr>
Hardware=>Device Manager to access the list of hardware
installed on your machine, as shown in Figure 2-13.
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¢ In Windows XP, choose Start=>Control Panel=>Printers And Other
Hardware. Here, you can select one of the items from the dialog
box under “or Pick a Control Panel Icon,” or you can look to the
“See Also” section and select System. If you choose System, from
there choose Hardwarer>Device Manager (Figure 2-14).

You can double-click each of the items within the Device Manager to dis-
play the corresponding details.

v Download PC hardware detect tools. If you don’t have any diagnostic
tools and you have a relatively current version of DOS, you can down-
load various PC hardware detect tools, such as PC-CONFIG, from the
Internet. The PC-CONFIG tool contains several screens of information
and menus to choose hardware areas and options. This tool is share-
ware, and the usage and fee information is available from the Holin
Datentechnik Web site (www.holin.com).

» Gather information by reading the screen when the computer starts. If
your system doesn’t contain any operating systems and you don’t have
any of your system’s documentation, you can resort to reading the screen
as your computer starts. On some systems, the video information is dis-
played as the computer boots. You may have to reboot several times to
read the information if it goes by too fast. Also, some systems display the
PCI components and their settings as the system is starting up. Again, you
may need to reboot several times to gather all the information.
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You can try pressing the Pause-Break key on your computer (it should

be near the Scroll Lock key) to get it to freeze during boot. You can then
unfreeze it by pressing any key.

v Access the Basic Input/Output System (BIOS) information. Stored in a
small area of memory and retained by a battery, this is sometimes
referred to as CMOS (Complementary Metal-Oxide Semiconductor),
which indicates the type of computer chip that can store and retain
information. The amount of information stored in the BIOS can be very

Laptop considerations

The current distributions of Linux do very well
on relatively new notebooks and laptops. (See
www.linux-Taptop.net for an excellent
research site for how Linux gets along with var-
ious makes and models.) If your laptop is a
common brand, you shouldn't encounter any
problems installing Linux. However, laptops
often contain WinModems. (Hardware labeled
with the Win prefix is for Windows, not Linux.)

If you plan on purchasing a laptop for Linux,
check out the modem and other hardware, such
as network cards, to make sure they’re not Win

branded. If the built-in or default hardware for
the laptop is Win labeled or you discover while
researching the machine that it contains a Win
product even if it isn't properly labeled, you
might be able to switch the offending hardware
fora PC (or PCMCIA) card. Most current laptops
contain atleast one PC Card slot so that you can
slip in a PC card modem, network card, or
combo modem-network card. As long as you
stick with a common brand of PC card, it should
be able to work well with Linux.
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little to quite a lot. Some newer systems may display several screens of
information about the computer’s hardware.

To access the BIOS, you need to do so before any operating systems load.
Most manufacturers indicate the keyboard key or key sequence to get into
the BIOS, or Setup, on the screen when the system is starting up — for
example, Press Del to enter Setup.If you can’t find the keyboard
sequence, check the manufacturer’s Web site. After you’ve entered the
BIOS, you typically navigate around with the arrow keys, Tab key, or Enter
key. In some BIOS environments, the function keys are also used. Look for
a list of function key options on the top or bottom of the screen.

You especially need to be cautious of labels on hardware boxes and Web sites
that include the term Win (as in Windows). These components, such as
WinModem, don’t contain all the configuration and software in the hardware —
even worse, there may be nothing on the packaging that suggests this limita-
tion. These components are designed to use the Windows operating system to
handle some of the load. Only a very slight chance exists that you can find a
Linux driver for Win hardware. If you do find one, copy it to a floppy before
installing Linux. If you can’t find a driver and you need to use a modem, put
down a little cash and get a modem that is supported properly. For more infor-
mation about WinModems, see Chapter 8.

Finally, Finally, Before You Get Started

\NG/
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No matter what Linux distribution you choose, it probably comes with a
bootable first CD (out of the CD set) or DVD — Fedora, the distribution
included with this book, comes on a bootable DVD, and if you use the coupon
to get the CDs, the first CD is also bootable. A boxed set might also come
with some floppy disks. You probably won’t need the floppy disks, but some
people do. If you've ever booted your system from a CD or DVD, you’ll have
no problem booting from the Linux installation CD. You can find this informa-
tion in your BIOS, in the section that lets you tell the machine which storage
devices (drives) to check at boot time. If CD-ROM or DVD-ROM isn't listed in
the options, Chapters 3 and 4 show you how to make an installer boot floppy
for your distribution.

If you have to make changes in your BIOS, make sure to save them when you
exit! It’s easy to forget and end up wondering why the machine isn’t doing
what you told it to do.

Now, before you go any further, there’s one more thing [ want you to do:
Locate your Linux distribution’s documentation. These manuals can help
you get past installation roadblocks and contain lots of useful information
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for after the install is finished. If you purchased your distribution, it probably
came with printed manuals. Otherwise, for the included distributions, you
can find their various help forums and interfaces at:

v Fedora: The Fedora Documentation Project (http://fedora.redhat.
com/docs) is still quite new, but its collection should grow over time.
In addition, there’s the Fedora Forum (www. fedoraforum.org), Fedora
News (www. fedoranews.org), and the Unofficial Fedora FAQ (www .

fedorafag.org).

v Linspire: The official Linspire support page is http://support.
linspire.com. Be sure to examine all the links because they contain
lots and lots of help pointers.

v Mandrake: The official Mandrake documentation page is www.mandrake
lTinux.com/en/fdoc.php3, and you can visit an additional help site at
MandrakeExpert.com.

v SuSE: The official SuSE support page is www.suse.com/us/private/
support/.

v~ Xandros: The official Xandros support page is http://support.
xandros.com/.

In general, another popular place to go for help is 1inuxquestions.org.If
you’re ready to install, proceed to Chapter 3 for Fedora and Chapter 4 for
Linspire, Mandrake, SuSE, Xandros, and more.



Chapter 3
Installing Fedora Core

In This Chapter

Considering some last issues before installation

Creating a Fedora installer boot disk
Installing Fedora as a personal desktop
Booting Fedora for the first time

Do, or do not. There is no “try.”

— Yoda, The Empire Strikes Back

No longer are arcane glyphs and complex sorcerer’s spells required to
install Linux. The graphical installation is now quite easy to perform
and will be familiar to users coming from another graphical operating system,
such as Microsoft Windows. This chapter provides the details.

If you're installing Linspire, Mandrake, SuSE or Xandros, proceed to Chap-
ter 4 — do the same if you want to use Knoppix without having to install any-
thing. Even if you're not using Fedora, however, you can still find out plenty
in this chapter, because all Linux distributions share common elements.

Things to Consider Before
You Begin Installation

You can install Fedora Core by

v Booting with the DVD-ROM included in this book and, when you see the
boot menu, typing 1inux and pressing Enter. If, for some reason, you
don’t see the boot menu, see Appendix B.

v Booting with the Fedora Core installation CD, which is CD number 1 if
you ordered the CD set using the included coupons at the back of this
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book, or from a third-party vendor such as those listed on the Fedora
Project’s vendors page at (http://fedora.redhat.com/download/
vendors.html).

v Booting with an installation floppy disk and having the remainder of the
installation files read from the DVD-ROM or CD.

To begin the installation from the DVD-ROM or CD-ROM, you must first change
your system to start, or boot, from a DVD-ROM or CD-ROM. In Chapter 2, I
cover how to configure a computer to boot from these devices.

If you want or need to make the installation floppy disk and have access to a
Windows system, perform the steps to create the installation floppy covered
in the next section, “Making a Boot Floppy (if Needed).”

After the floppy creation section, the instructions in this chapter tell you how
to follow the installation for Fedora Core 3. I concentrate on Fedora Core 3
and its installation for two main reasons:

v Fedora Core 3 is included on the DVD with this book, and the CDs you
can order with your coupon.

v Covering the installation of every Linux distribution in existence would
make this book into a set of encyclopedias.

I cover the Personal Desktop installation because it requires little or no hard
drive preparation and doesn’t use umpteen partitions like other installations
do. In addition, the Personal Desktop installation option installs the fun point-
and-click stuff that is commonly used on desktop and laptop systems. Server
or service-type applications, such as the Apache Web server and FTP server,
aren’t installed with the Personal Desktop option and aren’t covered in any
detail in this book. However, if you want to use them, you can add these to
your Personal Desktop package selection later in the installation process.

Please note that if you're installing Red Hat Enterprise Linux, a different ver-
sion of Fedora Core, or a different distribution of Linux, your screens will look
different from what is shown in this book (for Linspire, Mandrake, SuSE, and
Xandros, see Chapter 4). Each Linux distribution’s installation routine covers
the same basic tasks, but each action may be presented in a different order
or be customized to look different on the screen. For example, one distribu-
tion may present account creation before network configuration, and another
may have these two topics reversed.

With Fedora, up until you reach the About To Install (GUI install) screen, you
can back out of the installation without changing anything on your system.
None of the configuration options you make before the About To Install
screen are saved to your disks. After you continue beyond the About To
Install screen, data is written to disk, and your system is changed.
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Making a Boot Floppy (if Needed)

If you're having trouble booting from the DVD or CD, you can start the instal-
lation from a floppy disk. Because there is no boxed set for Fedora, however,
you'll have to make this disk yourself. You can find the disk image file — a
fancy way of referring to a snapshot of a floppy disk’s contents — on the DVD
or first CD in the /images directory. You can’t just copy this image onto the
floppy, however. You have to use a special program to make sure that every
tiny part of the image is written over exactly correctly. Assuming that you're
using Windows right now, the program I use for this purpose is RAWRITE,
which you can download from http://uranus.it.swin.edu.au/~jn/
Tinux/rawwrite.htm.

To make a boot disk on a Windows system using Fedora Core 3 and the DVD
(or CD) that came with this book, follow these steps (I focus on Windows XP
here, with notes for people using other versions of Windows):

1. Point your Web browser to http://uranus.it.swin.edu.au/~jn/
Tinux/rawwrite.htm.

2. Click the latest Binary release (at the time of this writing it’s the first
link on the page, rawwritewin-0.7.z1p) to download it.

3. When asked what to do with this file, click Save.

4. When the Save As dialog appears, navigate to where you would like to
save the file and click Save to download the file.

This is a small program, so even for dial-up users, it shouldn’t take all day!

5. Once the program is saved on your machine, open your file browser
and navigate to where you have saved it.

If you used the defaults in Windows XP, it’s in the My Documents\
My Downloads folder.

6. If you're using Windows XP or another version of Windows with a
program like WinZip (http://www.winzip.com/) installed, double-
click the rawwritewin file to open the archive.

If you don’t have a program that can open this file, download WinZip and
install it on your machine. You can then return to Step 6.

7. If you’re using WinZip, extract the files into the same folder or a new
one and skip to Step 9. If you’re using XP, click Extract All Files to the
left of the folder listing.

This action opens the Extraction Wizard.
8. Follow through the brief wizard, telling it where to extract the files.

When finished, you end up in a folder containing the extracted files.
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10

. Insert the DVD that comes with this book into the DVD drive and
make a note of the drive letter that corresponds to your DVD drive.

If you're using the CD set, insert the first CD.

. To create a boot disk, double-click the rawwritewin penguin icon in
the folder.

The RawWrite window appears (see Figure 3-1).

AR

awWrite

Rawf/rite for windows
wirkten by Johin Mewbigin

Foppydive [=iiia v

{Wite || Read | About | Help | Suppor |

U se this tab to wite an mage to floppy disk
Image file

Numbes of copiez [

bt s it swin sdu. sud i dlnug

—

frite ‘

0%

Esit

‘Windows NT 5.1 build number 2600
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12.

13.
14.

15.
16.

17.

. Next to the Image File text box, click the ... button to open the file
browser.

Navigate to your DVD-ROM or CD-ROM drive, depending on whether
you’re using the DVD from the book or a CD set for installation.

For many people, this is the D: drive.

Double-click the images folder to enter it.

Select the file diskboot.img and then click Open.

The file browser dialog closes.

Insert a blank 1.44MB floppy disk into the floppy drive.

Click the Write button to start writing the image to the floppy disk.
This process can take a few minutes.

Once the image has been written, the Image Successfully Written dialog
box appears.

Click OK and then click the Exit button to close the program.
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After you've created the installation boot disk, you need to configure, or
verify, that your computer is set to boot from the floppy drive. The easiest
way to do this is to insert a floppy disk into your main floppy drive, make
sure that no other drives have media in the machine (such as a DVD in your
DVD-ROM drive), and then reboot your computer. If your computer boots
from the floppy, you're set. You can then pull out the floppy and reboot into
Windows or proceed to the section “The Installation Process.”

If your computer seems to be ignoring the floppy drive as it boots, check in
your system’s BIOS (see Chapter 2.) Make sure that the floppy is listed first.
Then save your changes before exiting the BIOS; otherwise, the items you set
don’t take effect.

The Installation Process

In this chapter, I follow the graphical installation. If you can’t use the graphi-
cal installer for some reason (if Linux doesn’t support your video card, for
example), follow the text-based installation instead. The steps are the same,
it’s just not as pretty, and you don’t quite get all the options that you have
available in the point-and-click version.

To install Fedora Core 3, follow these steps:

1. If you want to boot and install from the Fedora DVD-ROM that comes
with this book, place the DVD in your DVD-ROM drive and reboot
your system.

Otherwise:

¢ Use CD 1 if you ordered or burned your own CD set, placing it into
the CD-ROM drive and rebooting the computer.

¢ Place the installation floppy disk (see the section “Making a Boot
Floppy (if Needed)” for details) in your floppy drive, put the DVD
or CD 1 in your DVD-ROM or CD-ROM drive, and reboot your
system.

Whether you start the installation from the floppy disk, CD-ROM, or the
DVD-ROM, the first installation screen, shown in Figure 3-2, appears,
though the screen for the DVD-ROM included with this book looks slightly
different than the one from the Fedora CD-ROM. No matter which version
you're using, this screen contains several options, which are each
described in the following list:

¢ Install Or Upgrade In Graphical Mode: The first option in the
graphical interface is for installing Fedora Core for the first time or
for upgrading an existing version of Linux. This installation probes
to detect your system’s hardware. The graphical interface is
designed to work with a mouse to select options. If you don’t have
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Figure 3-2:
The initial
Fedora Core
installation
screen.
From Fedora
CD-ROMs,
this screen
looks
slightly
different
than the one
you see on
the DVD-
ROM
included
with this
book.

a mouse, you can use the keyboard to navigate around the screens.
In most places, the Tab key or the arrow keys advance you to the
next option; the space bar toggles options off and on; and the Enter
key accepts the choices and moves to the next screen. In most
screens, if you want to change a previous setting, a Back button is
available to navigate to earlier selection screens. The graphical
installation screens also include help in the left panel. The content
changes to reflect information about the current configuration
screen. To install by using the graphical interface (which is what
most people do), type 1inux at the boot: prompt and press Enter.

Fedora

— To install or upgrade in graphical mode, presz the <ENTER> key.
— To install or upgrade in text mode, type: linux text <ENTER>.

— Use the function keys listed below for more information.

¢ Install Or Upgrade In Text Mode: The second option enables you
to install or upgrade Fedora Core using a text menu interface. This
interface presents the options in text menus, and you use the
arrow keys or Tab key to move to the selection area. In some areas,
the spacebar is used to turn options off and on. To install by using
the text interface, type Tinux text at the boot: prompt and press
Enter.

¢ Use The Function Keys: The last item listed points out the function
keys displayed at the bottom of the initial installation screen.

The F1 function key presents the initial installation screen, which
allows you to install or upgrade via graphical mode, install or
upgrade via text mode, or use the function keys labeled F2
through F5.
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The F2 function key includes options for disabling hardware
detection during installation (you must know the details of your
hardware before proceeding); testing the installation media before
proceeding (good option to use if you downloaded the Fedora Core
distribution from Red Hat’s Fedora Project Web site and burned
the software to CDs or a DVD); enabling rescue mode (this is also
the function of the F5 key); using a driver disk, CD, or DVD that
isn’t included with the Linux installation media; and updating your
existing Linux installation.

The F3 function key allows you to set the video options. If you have
experienced problems installing Fedora Core 3 with the graphical
interface, you may want to try a lower resolution. Type 1inux
Towres at the boot: prompt to use a lower graphic resolution to
install Linux. The Tinux lowres nofb command allows you to
turn off frame buffering, which can cause problems with some
video cards.

The F4 function key, labeled Kernel, enables you to enter parame-
ters when you install Linux. For example, some help files will tell
you to do something like “turn off autoprobing for your PCI hard-
ware bus.” Here’s where you find out what you need to type.

The F5 function key has two different functions, depending on
whether you're using the DVD-ROM inclued with this book or the
Fedora CD-ROM set. For the DVD-ROM, F5 shows you information
about the ISO files of other distributions included on the DVD-ROM
(see Chapter 4). Those using CD-ROM sets find an explanation of
rescue mode when pressing F5. Rescue mode (see Chapter 5)
includes many useful utilities to restore your system to a functional
state. To start rescue mode, type 1inux rescue at the boot:
prompt and press Enter.

2. If you haven’t done so yet and want to do a regular Fedora installation

using a nice point-and-click environment, type 1inux and press Enter
to start the graphical installation.

Many lines of information scroll past as the installer launches. During
this time, a mini version of Linux is loading.

If you downloaded the full version of Fedora Core and burned it onto
CDs or a DVD yourself, the CD Found (mediacheck) screen appears. This
screen allows you to check the integrity of the media that you're using
to install Linux. If this is the case, | recommend taking the time to per-
form this test on all the CDs or the DVD. It’s best to know now if one of
them is damaged or incomplete.

Because the DVD that accompanies this book contains not only a full
edition of Fedora Core 3 (minus the source code; see Appendix B), but
files for a number of other distributions, [ don’t recommend trying a
media check on this device. It will most likely fail even though the DVD
is probably fine.

b5
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Figure 3-3:
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Language
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Language Selection

Choose the language you would &
like to use during this installation. Bulgarian (Bwnrapcku)

Whether you check your media or not, after you're ready to move on,
the CD Found image disappears and additional text scrolls across the
screen. The last few lines load the graphic engine, a gray screen with a
small X in the middle appears, and then the Welcome To Fedora Core
screen appears. To the left of the screen is a set of instructions explain-
ing how to navigate through this installer.

. After you’ve finished with the material on the Welcome To Fedora

Core screen, click Next.

The Welcome screen disappears and is replaced by the Language
Selection screen, as shown in Figure 3-3. Linux supports many different
languages.

. Use the mouse or the T or | keys to select your language and click

Next.
The Keyboard Configuration screen appears, as shown in Figure 3-4.

Different languages arrange the keys differently on keyboards; you may
want to choose the matching language for your keyboard. (The default is
U.S. English.)

. Choose your keyboard configuration and click Next.

The Installation Type screen appears, as shown in Figure 3-5.

What language would you like to use during the installation
process?

Caralan (Catala)
Chinese(Simplified) ({8l {51 37)
Chinese(Traditional) (#5410
Croatian (Hrvatski)

Czech (Cestina)

Danish (Dansk)

Dutch (Nederlands)

English (English) |

Estonian (eesti keel)

Finnish (suomi)
French (Frangais)
German (Deutsch)
Hindi ()

Hungarian (magyar)
Icelandic (islenska)

Italian (ltaliano)

| BHide I:lelp| [9Release Notes | < Back » Next |
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Figure 3-4:
The
Keyboard
Configura-
tion screen.
|
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Figure 3-5:
The
Installation
Type

screen.
|

Keyboard
Configuration

Choose the layout type for the
keyboard (for example, U.S.
English) that you would like to
use for the system.

| BHide tlelp| [@Release Notes |

® Select the appropriate keyboard for the system.

Russian []
Russian (cpl251)
Russian (Microsoft)
Russian (rul)
Russian (ru2)
Russian (win)
Slovakian
Slovenian

Spanish

Swedish

Swiss French

Swiss French (latinl)
Swiss Geman

Swiss German (latinl)
Turkish

Ukrainian

United Kingdom

U.S. English

U.S. International

|‘ﬂ Back | |> ﬂext

Installation Type

Choose the type of installation
that best meets your needs.

An installation destroys any
previously saved information on
the selected partitions.

For more information conceming
the differences among these
installation classes, refer to the
product documentation.

| BHide tlelp| [@Release Notes

Personal Desktop

Perfect for personal computers or laptops, select this installation type to
install a graphical desktop environment and create a system ideal for
home or desktop use.

Workstation
This option installs a graphical desktop environment with tools for
software development and system administration,

Server
o) Select this installation type i you woukd ke to set up file sharing, print
i sharing, and Web services. Additional services can also be enabled,
and you can choose whether or not to install a graphical environment.

Custom
Select this nstallation type to gain complete control over the installation
process, inchiding software package selection and partitioning.

4 Back |
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Dealing with damaged CDs or DVDs

If your CD or DVD appears to have a problem,
what you do next depends on where you got the
DVD or CDs. If the DVD came with this book,
contact Wiley Customer Care at 800-762-2974 to
get them replaced. Do not contact Red Hat's
technical support to have the DVD replaced in
this case.

On the other hand, if you burned your own CDs
or DVD, you may be experiencing one of two dif-
ferent problems. Try burning the media again at
a slower speed. If these media also fail the
media check, download the images again. Or,
they may have been corrupted during the file
transfer, though it's unlikely.

You have four options:

¢ Personal Desktop: This option performs an installation for personal
desktop or laptop use and installs a graphical interface. If your
system already contains a copy of Linux, the default for the Personal
Desktop installation is to remove any existing Linux-related parti-
tions and use all the remaining free, unpartitioned disk space. If
you choose this default, any existing non-Linux partitions, such as
DOS/Windows, remain untouched. After installation, you can boot
to Linux and your other existing operating system or systems.

¢ Workstation: This option installs the graphical interface (X Window
System) and the desktop manager(s) of your choice, much like the
Personal Desktop installation, but also includes tools for software
developers and system administrators.

¢ Server: This option is designed for a basic Linux-based server for
file and print sharing and Web services. You can also enable other
services and choose to install a graphical environment. When you
select this option, the default disk-partitioning scheme is to remove
ALL existing partitions on ALL your hard drives. This means that all
partitions and operating systems of any type, Linux and others, are
removed, and all drives are erased.

Custom: This option enables the most flexibility to retain your
existing operating systems and configuration options. You can
choose the packages or applications/roles you want to install, the
size of your disk partitions, and how you want the system to boot.

I cover the Personal Desktop installation in this book for demonstra-
tion purposes, but you may select any of the other options that pertain
directly to your system. If you choose another option, keep in mind that
the instructions I include here may vary from your installation experience.

6. Click the Personal Desktop installation option to select it; then click
Next.

The Disk Partitioning Setup screen appears, as shown in Figure 3-6.
You're given the option to accept an automatic partitioning strategy, or
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Figure 3-6:
The Disk
Partitioning
Setup
screen.
|

you can define your own partition(s) manually. Your hard drive must con-
tain at least one Linux partition to continue with the installation. I choose
to cover automatic partitioning in this book. If you really, really want to

partition manually, see the nearby sidebar “Defining partitions manually.”

. Choose Automatically Partition; then click Next.

The Automatic Partitioning screen appears, as shown in Figure 3-7. You

can choose to remove all Linux partitions on your system, remove all
partitions on your system, or keep all existing partitions and use free
space. You also have the option of marking a particular hard drive to
work with. As I suggest in Chapter 2, be sure that you know which hard
drive you want to work with! As a hint, the first hard drive in your com-
puter is typically hda, the second is hdb, and the third is hdc. (With
some kinds of hard drive technology, the first drive will be hde, the
second hdf, and so on — just count from the lowest to the highest.) If
you have SCSI drives, you see sda, sdb, and sdc instead.

Be careful — you lose all data in existing partitions when you choose to
remove partitions. They won’t be immediately changed, however — not
until the final installation screen.

8. Choose the Remove All Linux Partitions On This System option; then

click Next.

A Warning dialog box appears asking whether you want to remove the

partition(s).

Disk Partitioning
Setup

One of the largest obstacles for
a new user during a Linux
installation is partitioning. This
process is made easier by
providing automatic
partitioning.

By selecting automatic
partitioning, you do not have to
use partitioning tools to assign
mount points, create partitions,
or allocate space for your
installation.

To partition manually, choose
the Disk Druid panitioning
tool.

Use the Back button to choose

perr = PR —

| BHide Help| [@Release Notes

Automatic Partitioning sets partitions based on the selected
installation type. You also can customize the partitions once
they have been created.

The manual disk partitioning tool, Disk Druid, allows you to
create partitions in an interactive environment. You can set the
file system types, mount points, partition sizes, and more.

® Automatically partition
) Manually partition with Disk Druid

[*]

|4 Ba |
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Automatic
Partitioning

Before automatic partitioning can be set up by the
installation program, you must choose how to use

Automatic partitioning allows Bata s vorka dmes:

you to have some control
concerning what data is

: | want to have automatic partitioning:
removed (if any) from your

partitions on this system.

To remove all partitions on

|
your hard drive(s) (this includes

Figure 3-7: partitions created by other L] Review (and modify if needed) the partitions created

The operating systems such as
. Windows 95/98/NT/2000),
Au’Fo_ma_t'c select Remove all partitions
Partitioning | on this system.
screen.

3|

system. ®) Remove all Linux partitions on this system
) Remove all partitions on this system
To remove only Linux partitions ) Keep all partitions and use existing free space
(partitions created from a 7]
previous Linux installation), Select the dnive(s) to use for this installation:
select Remove all Linux hda  B189 ME VMware Virtual IDE Hard Drive

| mHide ﬂelpl '___Qﬁelease Notes <d Back |

|b Next

9. Click Yes.

If you're really nervous, check the Review check box so that you can

double-check the partition assignments before the installer changes

anything.

s

The Boot Loader Configuration installation screen appears, as shown in
Figure 3-8.

The first option allows you to change the boot loader from the default of
GRUB to LILO or to choose no boot loader. Keep the default.

The second option allows you to boot to other operating systems than
Linux. If you have other operating systems installed on non-Linux parti-
tions, such as Windows, you can choose to boot to them.

The third option enables you to configure a boot loader password for
added security.

The last option allows you to select advanced boot loader options.

In your list of boot options (Fedora, Windows, and so on), make sure that
a checkmark appears in the box next to the option you want to boot into
by default — when you don’t manually make a selection from the menu.
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Boot Loader
Configuration
By default, the GRUB boot

loader is installed on the
system. If you do not want to

The GRUB boot loader will be installed on /dev/hda. |Change boot loader:

You can configure the boot loader to boot other operating
systems. It will allow you to select an operating system to
boot from the list. To add additional operating systems,
which are not automatically detected, click 'Add.' To
change the operating system booted by default, select
'Default’ by the desired operating system.

install GRUB as your boot

(if you have more than one)
should boot by default. Select
Default beside the preferred
boot partition to choose your
default bootable OS. You

| canot rova enwandin tha [] Use a boot loader password | Chang

Figure 3-8: installation unless you choose

The Boot a default boot image. [] Configure advanced boot loader options

Loader Con- You may add, edit, and delete

flguratlon the boot loader entries by o

screen. — —
| BEHide Ijelp‘ | ¥Release Notes | < Back ‘ | B> Next J

| E

loader, select Change boot |Deiault |La.be| Bevice Add

loader. ¥l  Fedora Core /dev/VolGroup00/LogVol00 Edit
. elen

You can also choose which OS REEG

A boot loader password prevents users from changing
options passed to the kemel. For greater system
security, it is recommended that you set a password.

If you choose to define partitions manually, you'll
be using Red Hat's Disk Druid. Disk Druid enables
you to delete existing partitions and add new par-
titions. If you don't know how to use Disk Druid, |
recommend that you not proceed any further.
Click Back to return to the Automatic Partitioning
screen and choose to review the automatic setup
Disk Druid suggests instead of starting from
scratch.

If you choose to Review and decide to change
things, there’s some things you'll want to know.
For example, there’s something called a mount
point, which is where a device (maybe the
first partition on your first IDE hard drive, which
would be /dev/hda1) attaches onto your filesys-
tem (a particular directory in your directory

Defining partitions manually

hierarchy). The start for your filesystem is the
“root directory,” which is shown as /. You need
to have a partition mounted as /, and you want
itto be as large as possible if you're not making
many partitions. You also want a partition
mounted as /boot, but it can be small, maybe
100MB. Finally, you want a partition around
twice the size of your memory that's assigned
the swap filesystem type, to act as your virtual
memory. (There's no mount point for swap, just
a filesystem type). Otherwise, when it comes to
Fedora, you'll be sticking with ext3 as your
filesystem type because it's the default. | get
more into these kinds of things in Chapter 10.
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10. After making any selections to the boot loader configuration settings,

11.

12.

click Next.
The Network Configuration screen appears, as shown in Figure 3-9.

If you’re using a modem and don’t have an Ethernet card in this
system, you won'’t see this screen at all, so skip to Step 13. If you're
using Dynamic Host Configuration Protocol (DHCP) on your network
to set the computer’s hostname, choose the Automatically Via DHCP
option. If you aren’t using DHCP to define the hostname, choose the
Manually option and enter a hostname.

First, make sure the ethO checkbox is checked so that your computer
activates its networking when it boots. Then, if you're using DHCP, this
setup allows another service or system to set all the networking parame-
ters for your computer so that it can communicate properly on a net-
work or on the Internet. If you're connected to a high-speed Internet
service, such as DSL, your computer is probably configured to use DHCP
for all the settings except the hostname, which gives an identity to your
computer. If your computer is part of a company network, the DHCP
services may provide the hostname in addition to the rest of the param-
eters. Check with the network administrator or IT department for the
appropriate information for your network.

To manually set the hostname of your Linux system (rather than letting
the DHCP server pick one for you), make sure that the Automatically Via
DHCP option is not selected and then configure the following:

e Type a name for your computer in the field to the right of the
Manually label. | recommend that you use only alphanumeric
(letters and numbers) characters for the name of your computer.
Sometimes, using other characters may interfere with an applica-
tion and make it difficult to access your machine from a network.

¢ [f you're not using DHCP for the other network settings, click the
Edit button to the right of the Network Devices list. In the Edit
Interface eth) window, remove the check next to Configure Using
DHCP. Enter values for the I[P Address and netmask settings and
click OK. After you enter these two values, the remaining fields
under the Miscellaneous Settings label are enabled. If you don’t
know what your IP address or netmask are supposed to be, ask
your administrator.

¢ Enter values in the Gateway and DNS fields that are valid for your
network. If your network has more than one DNS server, you can
enter up to three DNS server addresses.

I cover DHCP and other IP-related information in more detail in Chapter 7.
After you’ve made all your selections and entered your data, click Next.

The Firewall Configuration screen appears, as shown in Figure 3-10.
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Figure 3-9:
The
Network
Configura-
tion screen.
|

|
Figure 3-10:
The Firewall
Configura-
tion screen.
|

Network
Configuration

Any network devices you have
on the system are
automatically detected by the
installation program and shown
in the Network Devices list.

To configure the network
device, first select the device
and then click Edit. In the Edit
Interface screen, you can
choose to have the IP and
Netmask information
configured by DHCP or you
can enter it manually. You can
also choose to make the
device active at boot time.

If you do not have DHCP client
ACCess Or are unsure as to

BEHide Ijelp‘ [FRelease Notes

T3]

Network Devices

Edit |

Active on Boot | Device |IP/Netmask
eth0  DHCP

Hostname

Set the hostname:
® automatically via DHCP

O manually (ex. "host.domain.com”)

Miscellaneous Settings

Gateway i : 4 I
Erimary DN5: | | |
Secondary DNS : | |
Tertiary DNS. | |

Fedora’

Firewall
Configuration

A firewall sits between your
computer and the network, and
determines which resources on
your computer remote Users on
the network are able to access.
A properly configured firewall
can greatly increase the out-of-
the-box security of your system.

Choose the appropriate
security level for your system.

No Firewall — No firewall
provides complete access to
your system and does no
security checking. Security
checking is the disabling of
access to cerntain services. This
should only be selected if you

N e A R R s e

| BHide tlelp|

@Kelease Notes

A firewall can help prevent unauthorized access to your computer from the
outside world. Would you like to enable a firewall?

O N firewall
® Enable firewall

With a firewall, you may wish to allow access to specific services
on your computer from others. Allow access to which services?

] Remote Login (SSH)

[] Web Server (HTTP, HTTPS)
[ File Transfer (FTP)

[0 mail Server (SMTP)

Security Enhanced Linux (SELinux) provides finer-grained security
controls than those available in a traditional Linux system. It can be
set up in a disabled state, a state which only wams about things
which would be denied, or a fully active state.

Enable SELinux?: | Active |+ |

<] Eaad
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13.

14.

15.

16.

Firewalls protect your system from unauthorized access and discovery.
When you're connected to the Internet with a high-speed connection,
your computer appears as one of the hundreds of thousands of other sys-
tems on the Internet. [ wish that I could tell you that there aren’t tons of
nasty people and programs trying to break into your computer, but unfor-
tunately, there’s lots of them. A firewall is your first (but not only) protec-
tive barrier against cyber-hoodlums, viruses, worms, and a host of other
items that might try to skulk in through doors that should have been kept
closed; see the sidebar “Firewalls and you” for more information.

Unless you are 100-percent sure that this computer is safe from both
the Internet and other machines you may have on your home or office
network (keeping in mind that before viruses and worms, most busi-
ness computer break-ins happened from inside rather than outside),
leave Enable Firewall as your firewall setting.

If you are absolutely determined to have your firewall off, select No
Firewall. [ wish you luck!

Determine which of the available services you want to let through
your firewall.

[ recommend enabling Remote Login (SSH) so that you can access this
computer remotely using the techniques discussed in Chapter 12. While
[ don’t cover running your own Web server, if you intend to run one on
this computer, you’ll also want to enable the Web Server (HTTP, HTTPS)
entry; if you just want to browse the Web, you don’t need to enable this
one, it’s just if you want to run your own server on this computer. The
same goes for FTP (which can be handy for moving files around) and
SMTP. If you intend to run an FTP server or a mail server (SMTP), then
you’ll need to enable these.

Next to each item you want to enable, click in the box so that it has a
checkmark in it.

For my desktop machines, I tend to check the SSH and FTP entries.
For how to use an FTP client to get files off of this machine later, see
Chapter 8.

Determine whether you want to use SELinux or not.

SELinux (otherwise known as Security-Enhanced Linux) is explained in
great geekly terms at http://people.redhat.com/kwade/fedora-
docs/selinux-faqg-en/. For those who aren’t interested in reading
through such a document until their eyes cross, I give you a summary in
the sidebar “Introducing SELinux.” Keep in mind that if you've never
used Linux or another form of Unix, you may find it difficult enough to
learn your way through the usual user, group, and owner permission
system used to control file and directory access. You can turn on
SELinux later (I go more into SELinux in Chapter 12) if you decide it’s
time to get to know it.
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Firewalls and you

Anyone connected to the Internet, especially
using broadband (see Chapter 7 for more on the
different types of connections available; broad-
band tends to be DSL and Cable), really should
have a firewall of some sort. You can purchase
afirewall appliance (a special little box that you
use to connect to the Internet and then hook up
your other computer[s] to) or have a Linux box

doing your firewalling for just itself, or even for
your whole home or business network.
Although this is quite an extensive topic that
can easily take an entire book of its own, | cover
some of the basics in Chapter 7. In the mean-
time, protect at least this machine with a fire-
wall of its own.

A\

17.

18.

19.

20.

21.

If you intend to use SELinux, determine whether you want to actually
activate it or put it into a warning state; otherwise, under Enable
SELinux, select Disabled and skip to Step 19.

[ highly recommend that if you do intend to play with SELinux, you for
now set it to Warn. This way, you can see what it does without it getting
in your way, which is a handy method of learning how it works.

If you didn’t disable SELinux, select Active or Warn.
[ assume that you selected Warn for the remainder of this book.
Click Next to proceed to the next stage of your installation.

The Additional Language Support screen appears, as shown in Figure 3-11.
Your Linux system can support multiple languages at the same time. If you
add languages, be sure to set which you want for your default.

Select the languages for your Linux installation and click the Next
button to continue.

The Time Zone Selection screen appears, as shown in Figure 3-12. If you
don’t find the exact name of the city you'’re in, choose another city in
your same time zone that supports the same options, such as daylight
savings time. You can also click the UTC (Universal Time, Coordinated)
Offset tab at the top of the screen and select your offset from UTC time
and whether you use daylight savings time. If your computer uses UTC,
you can also choose this option.

If it turns out that your computer is (or isn’t) using UTC and you chose
the wrong way, you can change this value after you've installed the com-
puter, so don’t sweat this setting too much.

Choose the time zone in which your Linux system resides.

If you travel, set it to where you are now. You can change this setting
whenever you need to later.
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|
Figure 3-11:
The
Additional
Language
Support
screen.
|

|
Figure 3-12:
The Time
Zone
Selection
screen.
|
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Additional
Language Support

Select a language to use as
the defaultlanguage. The
default language is the
language used on the system
once installation is complete. If
you choose to install other
languages, itis possible to
change the default language
after the installation.

The installation program can
install and support several
languages. To use more than
one language on your system,
choose specific languages to
be installed, or select all
languages to have all available
languages installed on the
system.

| BHide tlelp| [@Release Notes

3]

Select the default language for the system: | English (USA)

Select additional languages 1o install on the system:

= Select Al
Select Default Only

]

[ English (Great Britain)
[ English (Hong Kang)
[ English (India)

[ English (Ireland)

1 English (New Zealand)
] English (Philippines)
L1 English (Singapore)
[ English (South Africa)
[ English (Zimbabwe) |
[ Estonian

[ Faroese (Faroe Islands)
] Finnish

[ French (Belgium)

[ French (Canada)

[ French (France)

] French (Luxemburg)

|3}

4 Back | |[B Nen

Time Zone
Selection

Set your time zone by selecting
your computer's physical
location.

On the interactive map, click on
a specific city (marked by a
yellow dot) and a red X
appears indicating your
selection.

You can also scroll through the
list of locations to select your
desired time zone.

You can also select the
System Clock uses UTC
option.(UTC, also known as
GMT, allows your system to
properly handle daylight-

| BHide tlelp|

[¥Release Notes

I#]

E|

Please select the nearest city in your timezone;

|J._oc ation

|Descrimior| |
America/Nassau |D
America/New_York Eastern Time

America/Nipigon Eastern Time - Ontano & Quebec - places tlJiE

[« 1 [3]

] System clock uses UTC

< pack | [P New |
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Introducing SELinux

Security-Enhanced Linux (SELinux) was devel-
oped by the USA's NSA (National Security
Agency, www.nsa.gov/selinux/)and gives
you more fine-grained control over everything
that's happening on your system than the stan-
dard user, group, and owner permissions used
by default in the Linux world. SELinux is not lim-
ited to Fedora Core; it's available as an exten-
sion in a growing number of Linux distributions.
In general, solid computer security policies
involve giving people and programs only the
amount of access that they strictly require, so
those who have a heavy need for limiting what
people and software can do because they're

running mission-critical servers or are operat-
ing in a realm that has a need for serious secu-
rity measures find that SELinux lets them have
far more control of who can do what on their
system. For the average home or small business
user’s desktop system, SELinux can be overkill,
though if you're looking to play with this tech-
nology and become familiar with it for your
resume or other reasons, your home desktop
can be anideal trial platform for such a purpose.
Because SELinux is quite extensive, | only touch
on it in Chapter 12, but | do give you enough
information to get you started.
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22. Click Next to proceed to the next step in your installation.
The Set Root Password screen appears.

23. In the Root Password screen, type the root (administrator) account
password into the Root Password field and then type the same pass-
word in the Confirm field.

You don’t see the password when you type it — just an asterisk for each
character. The asterisks prevent unauthorized individuals from seeing
the password. If you mistype something in one of the boxes, you're
warned when you try to move on to the next step of the installation and

NG/ have the chance to re-enter the values.
v?‘“\ !
S Don’t forget your root password! You need it to do to do any administra-

tion task on your Linux box.
24. After you’'ve entered your root password twice, click Next.

The Package Installation Defaults screen appears. You can choose to
install the current default list of packages or choose to customize the set
of packages

25. Choose the Install Default Software Packages option or the Customize
Software Packages To Be Installed option.

[ recommend selecting the Customize option so that you can have more
control over what you put on your system. I assume that this option is
the one you selected.
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Figure 3-13:
The
Package
Group
Selection
screen.
|

Once a package group has been
selected, click on Details to view
which packages are installed by

26. Click Next to proceed to the next item in the installation process.

The Package Group Selection screen appears (see Figure 3-13). There are
two different ways of selecting programs in the Fedora Core (and many
other Linux distribution) installer: by group or individually. You start by
choosing groups. For example, the first group is X Window System, which
you can think of as the wireframe of your point and click interface. The
second is the GNOME Desktop, which is one form of paper mache that
can be placed on top of the X Window System for a consistent look and
feel. Third is the KDE (K Desktop Environment), which is another version
of papier mache (see Chapter 6 for more on these and their differences).
If you want access to both environments, be sure to click the box next to
KDE to put a check in it.

Next to each group that you have marked with a check (or that’s
selected by default), you see the word Details with an underline beneath
it. If you click Details, a dialog box appears with two different lists of
packages: Base and Optional. The Base items are always installed when
you select this group of software. The Optional items are up to you.

If you want to try everything available the first time around, you can
scroll down to the bottom and select Everything (which in fact doesn’t
install everything, but mostly everything). Otherwise, play around and
pick and choose. You can add more software later (see Chapter 12) if
you realize you left something out.

Package Group

| o [4] X Window System [37/41]  Details ||
Selection [ ,ﬂ Install this group of packages to use the base graphical (X)
G user interface.
Select thhe package (ap?“ca“l‘l”]; [7] GNOME Desktop Environment [40/44]  Details
groups that you want to install. To ) : . .
: GNOME is a powerful, graphical user interface which
e
selecta package g_rou.p‘ click on @ includes a panel, desktap, system icons, and a graphical
the check box beside it. file manager.

[l KDE (K Desktop Environment) [o/14]

KDE is a powerful, graphical user interface which includes

iﬂ';; a panel, desktop, system icons, and a graphical file

manager.
default and to add or remove =
optional packages from that ClxFce loj15]
group. “mi¢ A lightweight desktop environment that works well on low

#¢cd end machines.

Applications
Editors [2/61 Details

Sometimes called text editors, these are programs that
d allow you to create and edit files. These include Emacs
= and Vi
and Vi. I+
Total install size: 2,510M

|mHid2ﬂelp| |@EeleaseNmes |Q Back | D‘ ﬂexr !
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27.

28.

29.

When you have selected all the packages and package groups that you
want to install, click Next.

First, a dialog box appears telling you that the installer is looking over
your list of selected software. If it discovers that you have left out pro-
grams that software you chose depends on, it offers you the chance to
add those, too. Say yes! Then, once that’s done, the About To Install
screen appears.

If you fear at all that your machine may be too slow to run a regular
desktop, make sure to click the XFCE box under Desktops. That way, if
you find that GNOME or KDE slows your computer down too much, you
can try using XFCE instead to speed things up. Chapter 6 explains more
about these various desktops.

If you want to stop your installation of Linux, the About To Install screen
is the last place where you can stop without changing anything on your
hard drive(s). To stop the installation, press Ctrl+Alt+Del, and your
system reboots. Be sure to pull out the DVD or first CD if you don’t
intend to restart your installation.

Once you’re ready to commit to the installation, click Next.

The Required Install Media dialog appears. This handy dialog tells you
exactly what DVDs (though there’s just one if you're using a DVD!) or
CDs (one through four) you need for the installation. If you're using CDs,
you may not need all four of them, depending on the software you
requested. Often, a desktop install only needs the first two.

Okay, you can still stop or restart the install at this point without chang-
ing anything on your computer! If you chicken out or realize you messed
something up, click Reboot.

When you're ready to proceed, click Continue.

The Installing Packages screen appears. The system first prepares for
the install and then starts the install. As the system is installing, you
see progress bars for each individual package being installed and total
installation progress. You're also given a “Remaining time” value that is
more or less accurate. Obviously, if it takes you five minutes to notice
that the installer has asked for another CD, then this delay adds to your
total installation time!

After the package installation has finished, you reach the final installation
screen, which has text beginning with “Congratulations, the installation is
complete.” The CD or DVD is automatically ejected (if not, manually eject
it); if you used a floppy disk, remove this as well. Once the media has all
been removed, click Reboot to restart your machine and proceed to the
next section, “Your First Boot.”
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VYour First Boot

|
Figure 3-14:
The Fedora
Core
Firsthoot
Welcome
screen.
|

The first time your Fedora Core system boots, you have the first chance to
see your new boot menu. Select the Linux entry and press Enter, or just sit
back and let it boot on its own. If for any reason your computer fails to boot
at this point, see Chapter 5.The first time your computer boots up, you see
the first boot Welcome screen, as shown in Figure 3-14. Do the following in
order to complete your machine’s initial setup:

1. Click Next to proceed to the setup routine.

The License Agreement screen appears, as shown in Figure 3-15.

2. Read through this text, select Yes, I Agree To The License Agreement
and then click Next.

The Date And Time screen appears.

3. If you’re on a computer network that is currently connected to the
Internet, and is usually connected to the Internet (or your network
administrator told you to use a time server), click the Network Time
Protocol tab. Otherwise, skip to Step 7.

Letting a time server control your date and time makes sure that your
computer gets regular input on what time and day it really is. Otherwise,
over time your computer’s clock actually drifts.

> Welcome ) Welcome

License Agreement

Date and Time There are a few more steps to take before your system is ready to use. The Setup
Display Agent will now guide you through some basic configuration. Please click the *Next"
button in the lower right comer to continue.

System User
Additional CDs
Finish Seup

G

Fedora

<@ Back ‘
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|
Figure 3-15:
The Fedora
Core

License
Agreement.
|

Welcome ) License Agreement

* License Agreement

[+

Date and Time LICENSE AGREEMENT
Display FEDORA(TM) CORE 3

System User

This agreement governs the download, installation or use of the
Additional CDs Software (as defined below) and any updates to the Software,
Finish Setup regardless of the delivery mechanism. The Software is a collective
work under U.S. Copyright Law. Subject to the following terms, Fedora —
Project grants to the user ("User") a license to this collective work
pursuant to the GNU General Public License. By downloading,

i lling or using the Softy User agrees to the terms of this
agreement,

1. THE SOFTWARE. Fedora Core (the "Software") is a modular Linux
operating system consisting of hundreds of software components.
The end user license agi for each is located in
the component’s source code. With the exception of certain image
files containing the Fedora trademark identified in Section 2
below, the license terms for the components permit User to copy,
modify, and redistribute the component, in both source code and
binary code forms. This agreement does not limit User's rights
under, or grant User rights that supersede, the license terms of
any particular component.

2. INTELLECTUAL PROPERTY RIGHTS. The Software and each of its

including the snurce code_doc B

[¢]

11*]

) Yes, | agree to the License Agreement

® No, | do not agree

4. Click the Enable Network Time Protocol check box to enable this fea-
ture and click the Use Local Time Source check box to disable local
time control.

5. In the Server drop-down list box, click one of the time servers avail-
able, or enter the address for the time server your network adminis-
trator gave you.

6. Click Add to choose this server.

If you intend to control the date and time on the machine manually,
verify that the date and time are accurate; if they’re not correct, fix
these settings now.

8. After you’ve finished adjusting the date and/or network time server,
click Next to proceed.

If you told the system to use the Network Time Protocol (NTP), it may
take a moment for the system to contact the server you selected. After a
few seconds, the Display dialog box appears, as shown in Figure 3-16.

9. In the Resolution drop-down list box, select the video resolution you
want to use.

You're only offered the resolutions the installer thinks your monitor and
video card support. If you find that you aren’t offered a full range, go
ahead and select the best you can get, and you can change the video set-
tings later. A popular setting is 1,024 x 768.

01
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|
Figure 3-16:
The Display
first boot
screen.

T & pisplay

License Agreement
Date and Time Please select the resolution and color depth that you wish to use:

+ Display
System User
Additional CDs

Finish Setup

10.

11.

12.

13.

14.

Monitor 1024x768 with VMWare | Configure... |
Resolution: | 1024x768 *]
Color Depth: | Millions of Colors +]

| <@ Back || B> Next |

If it looks like your graphics capabilities were guessed wrong or if a
specific monitor doesn’t appear next to the first button in this dialog
box, click the Configure button, which lets you open a set of dialog
boxes allowing you to choose your graphics card and/or monitor.

In the Color Depth drop-down list box, select the number of colors
you want to be able to use.

Again, you're offered what the installer thinks your system supports.
You’ll probably want Millions Of Colors.

Click Next to continue your firstboot machine setup.
The System User screen appears, as shown in Figure 3-17.

Type the name you want for your personal account into the Username
text box.

For example, zorro.
Type your name into the Full Name text box.
For example, Zorro the Dog.

Enter your account password both in the Password and Confirm
Password text boxes.
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|
Figure 3-17:
The System
User first
boot screen.
|

welcome System User

License Agreement

Date and Time It is recommended that you create a personal user account for normal (non-
Display administrative) use. To create a personal account, provide the requested information.

* System User
Additional CDs

15.

16.

17.

18.

" E—

Password: |

Confirm Password:

If you need to use network authentication such as Kerberos or NIS, please click the

Use Network Login button,
Use Network Login...

| < Back || > Next |

This password is the one for your personal account and has nothing to
do with your root (administrator) account. Feel free to use a different
password than you did for root. In fact, it’s a good idea to do so. If you
accidentally don’t type the password the same both times, you're
warned in Step 14 and returned to this step.

Click the Next button to proceed.
The Sound Card screen appears.

Make sure that your speakers or headphones are on and click the Play
Test Sound button.

You should hear a sound from the right channel, the left, and then both
at the same time.

When asked whether you heard the sound properly, click Yes if you
heard all three sounds and No if you did not.

If you didn’t hear the sounds properly, see Chapter 18 for help with get-
ting your sound working later.

Click Next to proceed.

The Additional CDs screen appears. You probably don’t have any extra
CDs you want to install things from at this point. If you do, go ahead and
click the Install button. I'll assume that you don’t.
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19. When you’re finished with the additional CDs, click Next to continue.

That’s it! Click Finish Setup. You've just survived the second Linux
gauntlet! Your computer now brings you to a graphical login prompt. See
Chapter 5 for instructions on how to proceed.



Chapter 4

Installing Other Linux
Distributions

In This Chapter
Loving Linspire
Demystifying Mandrake
Getting to know SuSE
Xapping your brain with Xandros
Discovering even more Linux!

f you read any of the chapters in the book, you understand that Linux

is more than just some newfangled computer program. Linux is a fully
equipped workshop of software tools and building materials that you can use
to construct any of a wide spectrum of computing solutions. Developing the
killer Linux distribution has been the Holy Grail of the Linux community. This
ultimate Linux distribution would provide all the support and capability that
the preschooler, the rocket scientist, the housewife, and the crotchety old
computer science professor would need to harness the power available with
Linux.

However, it’s just about impossible to make something that makes absolutely
everyone happy. In this chapter, I survey four more of the most popular and
easiest-to-install distributions. Some of these distributions are commercial
products, so my hope is that if you're considering getting one of those, this
chapter helps you decide which one of these (if not Fedora) meets your needs.
[ don’t cover every aspect of the commercial items, such as how much support
you get. For more information, see the appropriate Web sites.

Occasionally in this chapter, [ mention burning an “ISO image” onto a CD-ROM
or DVD-ROM. When this subject comes up, refer to the sidebar “Burning Your
ISOs” for tips. When I refer to ISO images included on this book’s DVD-ROM,
you find these images in the DVD-ROM’s distros folder.
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Burning your ISOs

If you end up needing to use the ISO files on the
DVD-ROM or that you download in order to
create distribution CD-ROMs or DVD-ROMs, |
have some handy tips that can make this process
easier for you. First, you need CD burning soft-
ware, such as the popular Nero program (www .
nero.com/en). Once you have a CD burning
tool, look at the file size of the ISO you need to
burn. While most ISOs can be burned onto a
standard 650MB/74 minute CD-R or CD-RW,
some are large enough that you need to pur-
chase 700MB/80 minute ones instead. Knoppix is
one that needs the larger CD-Rs. Another is
Mandrake.

When possible, use CD-RWs, because they're
rewriteable and you're able to download and
burn other distributions or newer versions onto
them later. CD-RWs are just a great way to avoid

having to throw out a lot of CDs to go to the land-
fills. However, your burner has to actually sup-
port rewriteable functions. Look on its front to
see whether it says CD-R (it can’t rewrite), or CD-
RW (it can rewrite).

As you prepare to burn your CD or DVD, make
sure that your software understands that you
want to burn an IS0 (often the word to look for
is image) and notjust a file. If you burn your CD
or DVD, putitinto the drive, open it up, and then
see only one file, you have burned itincorrectly.
An IS0 should be unpacked onto the CD or DVD
as a bunch of files and directories.

Finally, it's a good idea to burn these types of CDs
and DVDs at a speed of four or less. You reduce
your chance of introducing errors this way.

Kickstarting Linux with Knoppix

In Chapter 2, I explain that Knoppix is included on the DVD-ROM that came
with this book. You can boot with the book’s DVD-ROM and just press Enter
from its main menu to boot into Knoppix Linux, skipping any need to install
anything onto your computer. If you're concerned about messing up some-
thing on your computer with an installation, give Knoppix a try.
¥ If the DVD-ROM included with this book doesn’t work, see Appendix B. If you
don’t have a DVD-ROM drive, you can download the CD-ROM ISO image to
burn onto your own CD by going to www. knoppix.net/get.php.

Living Large with Linspire

Linspire (www.1inspire.com) — formerly known as Lindows — is especially
designed for people coming over from the Windows world to Linux. This
commercial distribution offers additional subscription services available that
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I describe in the “About the various Linspire versions” and “Recognizing
some special Linspire features” sections. Linspire is designed for ease of
installation and ease of adding new software and contains many tutorials to
help people get used to the system. Yet, Linspire isn’t designed in particular
for the aspiring Linux geek.

Linspire is built as a friendlier version of the more advanced, but popular,
Debian (www.debian.org) distribution.

If you're curious, you're in luck — an ISO file to create your own CD-ROM of
the full version of Linspire is included on the DVD-ROM that came with this
book! (It’s in the DVD-ROM’s distros folder.) In Chapter 12, you can sign up
for your free trial of the Click And Run Warehouse for getting and installing
software so that you can decide for yourself whether it’s worth paying for
membership after that.

If you decide to purchase Linspire, you have a number of options:
v Purchase it online and download it immediately from the Linspire Web
site.
v Purchase it online and have a physical box shipped.

v Purchase a boxed set in a store (www. 1inspire.com/lindows_feature_
reseller.php).

v Purchase a computer with Linspire pre-installed (www.1inspire.com/
lindows_feature_preinstall.php).

Linspire offers a nice FAQ on burning the CD at http://info.linspire.com/
installhelp/. The info is helpful whether you’re burning it from the DVD-
ROM that came with this book, or one you acquired from Linspire directly.

Installing Linspire

Linspire is primarily a commercial distribution, and you have access to this
through the ISO image included on the DVD-ROM that came with this book. I
cover this full Linspire 4.5 release. Differences between this and other ver-
sions are addressed in the “About the various Linspire versions” section.

To install Linspire 4.5:

1. Place the CD into your CD-ROM drive.
2. Boot the machine.

If the machine ignores your CD-ROM and tries to boot normally, see
Chapter 2 on how to make the necessary changes to your BIOS.
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WING/

|
Figure 4-1:
The Linspire
Install
Method
dialog box.
|

3.

5.

s Install Methods
Select one of the below methods for Installing Linspire: Plaasa BEAD THESE
C TAKE OVER AN ENTIRE HARD DISK OPTIONS GAREFLLLY

At the initial screen, click Install and press Enter.

Linspire starts doing all the standard pre-installation tasks, such as scan-
ning your computer’s hardware and starting the installer. After a bit, the
progress bar begins to fill. After it’s done, your screen turns black.
(Don’t panic! It’s supposed to!) You eventually reach the Install Method
dialog box, shown in Figure 4-1.

If you’re installing Linspire on a computer by itself or letting it
have an entire hard drive, select Take Over An Entire Hard Disk.
Otherwise, if Linspire has to share a hard drive with another
operating system, select Advanced Install.

Because the second option is more complex, | cover that one. If you
choose the first option, the next step asks you which hard drive you
want Linspire to use. Use the order that Windows sees them in, so the
first drive is C:, the second is D:, and so on. If you have to, you can look
in the BIOS at the sizes and other information to try to tell which is first,
second, or third.

You need existing free space before proceeding; otherwise, the installer
won'’t let you get to the partition selection screen. See Chapter 2 for how
to free up space.

Once you’ve made your selection, click Next to proceed.

The Advanced Install dialog box appears, as shown in Figure 4-2.

and choosa the Installation
method that is right for you|
After selacting the Next
button, you will be
presentad with additional
options before the
Installation begins.

Thiz method overwrites and installs Linspire on an entire hard drive, wiping out ALL
existing files on that drive. This method provides the best parformance and easiest
installation for Linspire. IMPORTANT! THIS CPTIOM WILL DELETE ALL EXISTING
FILES ON THE HARD DRIVE! (If your computer has multiple hard drives, you will
be asked In the next step to specliy which drive to Install Linspire on.)
 ADNVANCED INSTALL
This method is for advanced users and allows you to overwrite and install Linspire
‘on a drive or a specified, pre-configured partition, wiping out all existing files on that
drive or partition. IMPORTANT! THIS OPTION WILL DELETE ALL EXISTING
FILES ON THE DRIVE CR PARTITION SELECTED!

Bl oo | oo ) o |
¥
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|
Figure 4-2:
The Linspire
Advanced
Install

dialog box.
|

Advanced Install Advancadinatall
Please select the Disk or Partition you wish to install Linspire on. e salhcd
Disk Infermation: Advanced Install You must
Disk/Pautition EiBayem Size Usable ~elac sk o parion
Sy NIA B00GR that you want to install
[@Disk1 : ¥85 linspira on by highlighting

its entry in the list and
clicking Mext.

@ -HardDisk @ - Partlilon:

Warning: All contents of the selected Disk or Partition will be lost when you complete
this install process and the Disk or Partition is formatted. .

arcal | <ok ||
I

. From the list, select the hard drive (if you want to install onto an

entire drive) or partition (if you want to install in a particular emptied
partition) you want to install Linspire onto and then click Next.

The Computer Name And Password dialog box appears, as shown in
Figure 4-3.

. Type the name you want this computer to have into the Computer

Name text box.

For example, maybe you want to name your computer Fred.

. Type your administrative password into both of the Password text

boxes and then press Enter.

The Setup Confirmation dialog box appears.

. Read the values specified in the dialog box and then click Finish when

you’re ready to start the install.

Yes, that’s it! Your install now begins. You may be asked to verify that
you want to take over a hard drive or partition; if so, double-check the
information it shows you and answer appropriately.
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|
Figure 4-3:
The Linspire
Computer
Name And
Password
dialog box.
|

Computer Name Computer Name
(Required)

Name for this Computer: |
You must give your

computer a name,
Examples: johncloe, sally,
Password irontdesk, brucebanner,

Securlty Password: | {Recommandad) accountings, etc. (This is
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10. When the installation finishes, click OK.

The machine brings you to a screen that lets you remove the CD-ROM
from the drive.

11. When prompted, remove the CD from the drive and then press a key
to reboot the machine; to boot it, select Linspire from the options and
press Enter (or just let it do so on its own).

Recognizing some special Linspire features

One of the most talked about special features of Linspire is its CNR (Click
and Run) Warehouse. This online store allows you to surf through more than
a thousand software programs and purchase, download, and install them
with just a few clicks. Even better, if you subscribe to the CNR service — you
get a free one-year membership when you purchase Linspire — a lot of the
items in the Warehouse are free. (You don’t need to keep your CNR member-
ship up to date to keep using the software you downloaded; after you've got
it, it’s yours.) [ cover how to add software using this service in Chapter 11.

Another cool aspect of some versions of Linspire is the audio/visual tutorials.
After your installation is complete, the tutorials immediately launch to start
walking you through how to use the system. You can stop them and come
back to them at any time.
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About the various Linspire versions

The folks at Linspire are pretty creative about putting together packaging
options. In the section “Living Large with Linspire, earlier in this chapter, I
address the various ways you can purchase this distribution. In this section,

[ look at the various ways Linspire is packaged for boxed sets and downloads.
I'm not going to go into all the add-ons. (If I did that for every distribution,
this book would end up an encyclopedia!) Instead, I look at the main versions
available at the time of this writing:

v Linspire 4.5: The main Linspire product. This version has lots of soft-
ware included, as well as the Click And Run Warehouse (see Chapter 12)
and support. An ISO for this version is included in the distros folder of
this book’s DVD-ROM, though you do need to buy Click And Run Ware-
house access and support separately in the included version.

v~ Linspire 4.5 Laptop Edition: Includes extra support for hardware that’s
typically in laptop settings.

v~ Linspire 4.5 Developers Edition: Includes more than 100 software devel-
opment tools and utilities.

v~ Linspire 4.5 Desktop Enterprise Assessment Kit: A one-stop shop that
can help you evaluate whether your company is ready to move to Linux
on the desktop.

v Linspire Live!: A bootable CD-ROM that you can put in your hard drive,
reboot your machine, and immediately have access to a Linspire desk-
top without having to install anything.

Mayxin’ Out the Fun with Mandrake

Mandrake (www.mandrake-Tinux.com) has a huge, enthusiastic fan base.
This distribution, designed in 1998 with the goal of creating an easy and intu-
itive installation for everyone, specializes in ease of use for both server and
home/office installations. To accomplish this objective, the creators of
Mandrake focused on the goal of making an easy transition from your
Microsoft Windows or Mac skills to Linux.

In this section, [ focus on Mandrake Version 10.1. The ISO files required to
install this distribution are included within the distros folder on the DVD-
ROM that come with this book, so you just need to burn them onto CD-ROMs
to get started. You can also download this distribution for free (from www.man
drake-Tinux.com) if you can’t use the DVD-ROM, or you can purchase a
boxed set with manuals and more from the Mandrake online store (www.man
drakesoft.com). To download Mandrake:

1. Point your Web browser to www.mandrake-T11inux.com.

/1
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2. Click the Download link.

You are taken to the Mandrakelinux Downloads page. In this page, you're
asked whether you want to sign up for its users’ club (which, for a mini-
mal monthly fee, gives you access to all kinds of extras and early down-
loads), or whether you already are a member or are thinking of becoming
one. If you become a serious Mandrake fan, then joining the club is defi-
nitely something you’ll want to consider!

3. If you're not quite ready to join the club, click the Now button next
to I'm Already A Member Of The Club Or Plan On Registering Soon,
Please Send Me To The Download Page. Otherwise, go ahead and
register for the club and then return to Step 1.

This action brings you to the main download page.
4. Click the Mandrakelinux 10.1 Official ISOs/i586 link.

This action jumps down to the Mandrakelinux 10.1 Official ISO Images
For 1586 And Higher section of the Downloads page.

5. Look through the list of countries and click the download location
that’s physically closest to you.

6. Download the three Mandrakelinux10.1-Official-Download files.

Each of these files is a full CD-ROM’s worth of material, so if you're using
dial-up or have bandwidth limits, you may find it easier to purchase the
CDs from Mandrake or a third-party, such from www.cheapbytes.com. If
you do download them yourself, see Chapter 2 for advice on properly
burning Linux ISO files onto CD-ROMs.

In Chapter 2,  mention that Mandrake can resize your existing Windows par-
titions, so you don’t need to do this task ahead of time.

Installing Mandrake

After you've burned or purchased Mandrake on CD-ROMs or a DVD, install it
as follows:

1. Place CD 1 or the DVD into your CD-ROM or DVD-ROM drive and
reboot the computer.

If the computer ignores your CD-ROM and tries to boot normally, see
Chapter 2 on how to make the necessary changes to your BIOS. The ini-
tial installer screen appears.

2. Either press F1 to see more options (typically, if you know you need to
use a special option) or press Enter to start the installation.

[ assume that you press Enter. Lots of text scrolls by. The screen
changes to a black-and-blue motif, with blue dialogs appearing as vari-
ous devices are detected, and then finally you reach the Language selec-
tion dialog box, shown in Figure 4-4.
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3. If you want to use a language other than American English as your

default language, select the appropriate language in the list and then
click Next.

The License screen appears. Read the license, select Accept, and then
click Next. The Security screen appears.

. Leave your security level at Standard, unless you want to experiment

with High.

Going higher than High may make using the computer such a pain to use
as a client that you’ll be tempted to shut off security completely, which
defeats the purpose! Still, some people like to play with the really para-
noid level. It’s up to you. I assume that you stayed with Standard.

. If you want to have a particular nonroot user on the system (or e-mail

address) receive all security-related notifications (recommended),
enter the login account you’ll be creating for that user or the e-mail
address to use in the Security Administrator text box; if not, skip to
Step 6.

Remember, anything that reduces how much you have to log in as root is
good, as long as it doesn’t also reduce your security. | tend to choose an
e-mail address for this text box.
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6.

10.

11.

Click Next.

The initial disk partitioning screen appears. The options you see here
depend on what the partitioning program (DrakX) finds on your hard
drive(s), so you may see something different than what I'm seeing.

. Select the partitioning option you want to use.

Do not select Use Existing Partitions — if this option is even available —
unless you went ahead and set up the machine’s partitions ahead of
time. Typically, you want one of the other options. If you're giving over
an entire hard drive to Linux, then select Erase Entire Disk. If your Linux
install has to share a drive with another operating system (or you know
you want to set up your partitions a certain way) then select Custom
Disk Partitioning or select Use Free Space if you have free space avail-
able. Other options may also appear, depending on what’s currently on
your system. For example, you may see Erase Entire Disk, which lets you
wipe your Windows installation. If you choose Erase Entire Disk, accept
the default partitioning and skip to Step 10.

. Click Next.

The Partitioning screen appears. You can choose existing partitions

by clicking the partitions in the graphical listing. Each has a suggested
mount point (see Chapter 3 for more on mount points) already attached.
You can delete or resize a particular partition by clicking the appropri-
ate button below the partition graphics. If you already have a bunch of
free, unallocated space, you can click the Auto Allocate button to have
Mandrake suggest a set of new partitions for you. To create a new one,
click the empty space and then click Create. You can see an example
layout in Figure 4-5.

. After you're finished laying out your partitions, click Done.

As the warning that appears says, the changes are made to your hard
drive when you click Done. After the formatting is complete, the installer
scans through its list of software. Then, the installation media dialog box
appears.

Only three CD ISOs are available for download, so if you downloaded
those three, unselect CDs 4 and 5 in the list and then click OK. If you
do have a CD 4 and 5, just click OK.

The Package Group Selection screen appears (see Figure 4-6).
Choose the groups of packages that you want to install.

For a desktop, you might include each of the items in the Workstation
section, plus both KDE and GNOME in the Graphical environments if you
have the room. These items give you lots of software to play with.
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12. Select the Individual Package Selection box if you want to look inside
each group and choose what you want.

[ assume that you clicked this option.
13. Click Next.

The Choose The Packages You Want To Install dialog box appears.
14. Select and remove packages according to your needs.

In the left column, you can click a right-facing arrow to expand a cate-
gory and see all the groups beneath it, or you can click a down-facing
arrow to compress the category and clean up the list. A checkmark next
to a group means that you selected that group, and a checkmark next to
the category means you selected the whole category.

You also find arrows next to groups. Expand a group, and you can see on
the left all the software that will and won’t be installed — you won'’t get
everything from the group by default. You can then click any package in
the list to see a description on the right. If you find that a package that
you want isn’t being installed, click the empty box next to its name to
check it. If you don’t want to install something that’s checked, click the
checkmark to unselect it.

15. After you’re ready to move on, click Install.

The installation begins. You're given a projection of how much time it
will take. Keep in mind that if you need to swap CDs, you won’t know
until it asks you for the next one, so don’t just walk away and ignore the
system expecting it to be finished when you get back. You can click the
Details button to see the progress for each individual package.

As with most mainstream Linux distributions, Mandrake has tasks to take
care of after the main installation, before you start using the system. After the
main files are placed onto your system (but before rebooting), you're asked
to do things like enter your root (administrative) password. (See Chapter 3
for how to select a strong root (administrative) password and why you want
to do so.)

After you choose your root password, you're asked to create a regular user
account. When you do so, click the icon image and have fun selecting a pic-
ture to go with your user account. Speaking of users, do not configure the
computer to automatically log in any account unless no one else could possi-
bly have access to the machine. It’s not a very secure practice, and it’s a
great way to set yourself up for some annoying practical jokes.

When you reach the Summary screen — which isn’t entirely a Summary
because it lets you configure things that you haven’t looked at yet — make
sure that everything is set properly. In particular, the Graphical Interface
entry refers to your monitor and video card. If these devices aren’t config-
ured, then you’ll definitely want to change that. In the Security section, click
Configuration next to Firewall, uncheck the Everything checkbox, and add
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checks only next to the services you’ll run on this computer. For example,
you may want to check SSH, FTP, and Echo (ping).

Finally, when given the chance to download updated packages, select Yes if
you are already on a network that’s connected to the Internet. Otherwise, you
can do it later.

After you finish this part of the configuration process, you're asked to reboot.
Then, believe it or not, there’s a few more configuration tasks to take care of.
First you'll see a user survey. If you want to fill it out, fine, otherwise skip it by
just clicking Next. In the Choose Desktop dialog, click the dropdown list box and
play with the various desktops and themes. Selecting something shows you
what it will look like. After this, you can register for the Mandrake Club (www .
mandrakecTlub.com), and then finally you’re done and can use the machine!

About the various Mandrake versions

Mandrake offers both server and desktop solutions, but I focus on the desktop
here — which is considered by many to be Mandrake’s real strength. You can
see Mandrake’s full range of commercial products by going to www.mandrake
soft.com/products, and you can see the full range of download options by
following the instructions available in the earlier section, “Maxin’ Out the Fun
with Mandrake.” I also focus only on items, as usual, that include the desktop
itself rather than also covering add-ons.

At the time of this writing, you can purchase and/or download Mandrake for
the desktop in the following versions:

v Mandrake 10.1: The full download version included with this book. You
can use it for desktop, server, and everything in between.

v MandrakeMove: The LiveCD version of Mandrake, which allows you to
pop the CD-ROM into any PC, boot the PC with this CD-ROM, and find
yourself in a fully functional Mandrake environment without having to
install anything.

1 Mandrake 10.1 Discovery: A commercial package for people brand new
to Linux. This package includes MandrakeMove.

v Mandrake 10.1 PowerPack: The “regular” full-featured commercial desk-
top package.

v Mandrake 10.1 PowerPack+: The power-user commercial desktop
offering.

Mandrake also has commercial and/or free versions available for a number of
other hardware architectures, such as AMD64, PowerPC, and SPARC. In addi-
tion to this, if you're a bleeding edge kind of person — which is how geeks refer
to the “very latest and greatest that most people haven’t started using” — you
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may enjoy downloading the Mandrake Cooker (www.mandrakelinux.com/en/
cookerdevel.php3), which is the development (“beta”) version. Most people,
though, are better off sticking with the main version of Mandrake, because
betas, in general, are more full of bugs — hence, the term beta test.

Starting off with SuSE

The SuSE (“SO0-za”, www . suse. com) company and Linux distribution

were founded in 1992 and were purchased by Novell (www.novell.com)

in 2004. The distribution is named after a German acronym for Software und
Systementwicklung (Software and System Development). One SuSE claim to
fame is its international support (most major distributions provide a level of
support for users around the globe, but some have better language integra-
tion for particular groups than others; SuSE understandably excels in the
German and western European space).

SuSE is primarily a commercial distribution, though it has a limited free
option that I discuss in the section “About the various SuSE versions.” Rather
than compare a limited free version against other people’s full versions, |
walk you through the installation of the full SuSE Linux Professional 9.2. Also,
while most distributions have one form or another of integrated configura-
tion setup, SuSE’s YaST is particularly extensive, and is equally so without a
GUI — an unfortunate rarity. The manuals that come with the boxed versions
are also nice and thick, serving as a nice add-on for this book, online help,
user forums, and so on.

A Live CD containing SuSE 9.2 with KDE is included as an ISO file within the
distros folder on the DVD-ROM that comes with this book. No install is
required, so you can just burn the ISO onto a CD-ROM, put the CD into your
drive, and boot your machine to experience this version of SuSE Linux.

Installing SuSE

The SuSE Linux 9.2 Professional boxed set comes with two thick manuals,
five CDs, and two DVDs (for those who want to install instead from DVD). In
Chapter 2, I mention that SuSE can resize your existing Windows partitions, so
you don’t need to do this step ahead of time. If you're using the version of SuSE
included with this book, then you don’t need to go through this installation
procedure. I cover it here for those who purchased the full version of SuSE.

To install this distribution:

1. Put either CD 1 or DVD 1 (the one on the left) in your CD-ROM or DVD-
ROM drive.

If you're using the DVDs, make sure that Side A is facing up.
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Chapter 5
Booting and Stopping Linux

In This Chapter

Understanding what happens when you turn on your Linux machine

Identifying and isolating boot problems
Shutting down safely

I like work, it fascinates me. I can sit back and look at it for hours.

— Jerome K. Jerome

f you came here from Chapter 3 or 4, you likely just survived the first gaunt-

let of the Linux world: installing the operating system. I hope that booting
for the first time worked well. If it did and you decide that most of this chapter
isn’t for you, at least skip to the last section in this chapter, “Don’t Just Turn
Off the Machine!” Otherwise, if you're interested in learning about what your
machine does as it boots (this chapter can get pretty geeky!), read on.

Your Linux installation failing to boot properly is not necessarily an emer-
gency. Much of this chapter is designed to help you deal with any problems
you might run into. Before you curse Linux, remember that installing an oper-
ating system is no small task and that, because many technical variables are
associated with such an installation, many computer manufacturers insist on
performing the task at the factory. Companies such as Hewlett Packard and
Wal-mart (believe it or not) have been offering Linux pre-installed, so if you're
too discouraged at this point or are reading ahead and are too nervous to
give it a shot, you can either use Knoppix (see Chapter 4 for how to use
Knoppix without having to install it) or purchase a pre-installed machine
from a vendor or a local computer builder.

To unravel the mystery of a Linux system that won’t boot requires a bit of
understanding of how your computer starts up.
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Giving Linux the Boot

Let’s face it: As enjoyable as the experience of staring at a dormant computer
is, the real fun starts when you turn on the computer. As with any electronic
device, opening the electron floodgate is the first step to fun. A computer,
however, has much more stuff to do than your toaster oven. Rather than act
as a simple heating element, your computer has to check all those gizmos
that you (or the manufacturer) plugged into your computer’s motherboard.
After the initial power-up, the computer performs some simple hardware
tests (called the POST, or Power-Up Self Test) to determine whether those
various components are working properly.

Checking all your hardware is just the beginning. Between the time you turn
the computer on and the moment the glowing phosphor on your monitor
prompts you for a login name, the computer is building itself an empire. If
you listen and watch carefully, your computer and monitor show signs of the
boot process through bleeps, buzzes, whirring motors, clicks, messages on
the monitor, and blinking lights.

Although you have heard the cliché “Rome wasn’t built in a day,” the boot
process goes fairly quickly. This is pretty amazing, considering that the archi-
tecture of an operating system makes Rome’s look like a stack of cardboard
boxes and that each time you power up your computer, it must build its
whole operating system in memory. (Remember that an operating system is
the core software that makes your computer work.) This process can be
broken into four main steps, which I discuss in the following sections.

Step 1: Power-On Self-Test
(POST) leads to BIOS

The POST process really has nothing to do with the operating system. Your
computer performs this step whether you're running Linux or another oper-
ating system such as Windows XP.

Some symptoms of a failed POST include

v An unusual series of long and short beeps.
1 Nothing displayed on the monitor.
v No apparent activity other than the whirring fan on the power supply.

v A puff of smoke or the pungent smell of burning electrical components
from your computer case.

v An error message, displayed on the monitor, indicating a hardware failure.

If you encounter any of these problems, you have hardware troubles that
need to be resolved before you can proceed. Chances are, if your computer
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was running properly before you began your Linux installation, your com-
puter should be getting through the POST just fine — POST problems don’t
tend to be caused by installing a new operating system; they’re far more fun-
damental to the computer itself.

For all but the last of these errors, it’s time to question your nephew Mortimer,
who was last seen lurking around your computer with a screwdriver. (Or take
your computer into a computer repair shop!) If you see an error message indi-
cating a hardware failure, you might have a shot of fixing the problem in the
BIOS. As the POST does its thing and finishes up, it briefly displays (usually at
the bottom of the screen) instructions on how to enter “setup.” Typically, these
instructions mention pressing the DEL key or a function key such as F1. When
you press this key, if all goes well, you usually see a blue screen with black and
white text. From here, if you're familiar with your hardware, you can try to
figure out and fix the problem. However, many people would rather have a root
canal with no anesthesia than mess with this stuff, so you may want to grab the
nearest teenager or computer repair shop to take a look.

The good news is that if you can get to the BIOS at all, the problem may be
easier to fix than one where the computer fails before you reach the BIOS.

Step 2: The BIOS passes the
baton to the boot loader

After the BIOS gives the okey-dokey with a successful POST, the BIOS locates
the first hard drive in your system and reads the first sector of that disk, which
is often referred to as the MBR (Master Boot Record). On that first chunk of
disk is a small program called a boot loader. The boot loader doesn’t know
much about anything, except how to start loading your operating system.

Two boot loader programs understand how to load a Linux operating system:
LILO (LInux LOader) and GRUB (GRand Unified Boot loader). LILO has been a
tried-and-true boot loader for as long as Linux has been a gleam in a geek’s
eyeball. GRUB is a newer and much more sophisticated boot loader program
than LILO. Many distributions allow you to choose your boot loader. Typically,
most people just stick with the defaults, which are as follows for the five dis-
tributions discussed in this book:

Distribution Default Boot Loader

Fedora Core GRUB

Linspire LILO, with its own special routines on top of it.
Mandrake LILO

SuSE GRUB

Xandros LILO, with its own special routines on top
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Custom boot disks

You can protect against boot loader failures after
you get your installation working by making a
custom boot floppy disk, which you can use to
boot the system if the boot loader on your hard
drive gets corrupted. Many distributions have
special programs or tools available to make
custom boot disks for you, and some will offer to
make the disks during installation. The programs
to make a disk manually are mkbootdisk for
Fedora Core and Mandrake, drakfloppy for
Mandrake as well, yast for SuSE, and build-boot-
floppy for Xandros. However, a custom boot disk
won't help you if something goes wrong with the
later boot steps. It's only good for boot loader

problems. After you manage to boot with the
floppy, open a terminal window (see Chapter 14),
type su - to become the root (administrative)
user, and then double-check which boot loader
your distribution uses. For LILO, type Ti1o -v
to try to repair your boot loader on your hard
drive. For GRUB, look in the file /boot/grub/
menu. 1st and look for a line in the beginning
with the text “boot=" — for example, it may say
boot=/dev/hde. Then, type grub-install
bootdrive, where bootdrive is the hard drive
listed in the boot line, such as grub-install
/dev/hde. Now you can try rebooting without
the floppy in the floppy drive.

\\J

Sometimes “bad things” can happen to your boot loader. One common symp-
tom of boot loader problems is a message saying that the operating system
could not be found. Another hint that the problem is your boot loader is if you
never see your boot menu, which is a screen that comes up during the boot
process that lets you choose what operating system and version to boot.

The boot menu will look different from distribution to distribution.

If you suspect a boot loader problem, see the section “Entering Rescue
Mode,” later in this chapter. For another option, see the sidebar “Custom

Boot Disks.”

Step 3: The boot loader (GRUB or LILO)

loads the system kernel into memory

Every computer (and electronic device) requires an operating system to run.
The technical term for this operating system, or at least the core of it, is the
kernel. If the kernel is your maestro, orchestrating all the components of your
computer and delegating resources in a logical and cooperative manner, the
boot loader is the red carpet on which the maestro arrives.

P Many Linux distributions today actually put up a GUI progress screen during
the kernel loading and system initialization phase (after the kernel finishes
loading, when it finishes up the boot process). If you want to see what hap-
pens, you can typically click an icon or press a key. Just look for instructions
on how to “see details.”
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This list shows some symptoms of a missing, incorrect, or corrupt system
kernel — all would occur after you either make your menu selection and
press Enter, or just let the boot loader do its thing automatically without
choosing anything:

v The system freezes.

v A few dots appear across the top of the monitor, and then the system
freezes.

1 A few messages appear on the screen, and the final message reads
kernel panic.

v The system reboots automatically.
You know when the kernel is loading because you start to see crazy text like:

Uncompressing Linux... Ok, booting the kernel.
audit(1092566112,337:0): initialized

Recovering from a kernel loading failure (aside from “operating system not
found” — see previous section) is one of the more challenging issues in Linux.
This task is unfortunately not for the faint of heart. On the other hand, the
failed kernel may be an updated one. If you have more than one Linux option
in your boot menu, look at the version numbers for each of the options and
choose the second newest. Doing so lets you boot into the last working kernel
and have a working system. Then you can open up www.google.comand
search on the error messages or wait until the next kernel update comes out
and ignore the bad one for now.

In the case where it’s your original install that doesn’t properly start, you
unfortunately don’t have a fallback kernel option. If this is your problem, I
recommend either contacting your distribution’s support address (if you pur-
chased a commercial product) or joining the installation or beginner’s help
discussion list if you downloaded a free product. See Chapter 2 to find out
where to locate help for each distribution discussed in this book.

Step 4: Control is handed over to init

Once the kernel’s finished loading, it passes off the system initialization
process to a program named init. The init program is responsible for start-
ing all services and programs. You can see these processes starting as they
scroll up the screen with [0K] or [FAILED] on the right side of the monitor. If
you see these lines, you know that your kernel has finished loading.
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The main problems you may encounter with init are services (programs

that run in the background) that fail to start properly, as is indicated by the
[FAILED] status shown during the boot process. Many of these services don’t
keep you from logging in and using your system. Services usually fail because
of misconfigurations or unsupported hardware drivers. Sometimes a problem
service takes a long time to start up, so you may need some patience while you
wait it out. Once the machine boots up, you can use the techniques described
in Chapter 12 to shut off the problem service if it’s being a pain. If the machine
can’t boot because of this service, you'll need to access your distribution’s
rescue mode to shut off the service. Rescue mode is covered in the next sec-
tion. Entering Rescue ModeHeavy-duty system repair tends to happen in rescue
mode, which is a special boot selection that simulates your hard disk in what
is called a RAM disk, holding the files entirely in memory. The benefit of this
disk is that you can perform necessary system surgery without requiring util-
ities that are part of the installed system; everything you need is part of the
rescue disk. The drawback is that this is a purely command-line interface,
and you really have to know your stuff to find your way around.

Appendix A contains a list of Linux commands, roadmap to try to help you
out. Chapter 20 addresses, among other things, how to fix your boot loaders
from here if your problem is with the boot loader, and how to track down the
error messages your kernel might have left behind. You may also be able to
find helpful tips by reviewing your distribution’s documentation and help
forums.

Knoppix is quite popular to use for system rescues because it’s a whole dis-
tribution on a CD. (For more on Knoppix and live CDs, see Chapter 2.) See
Chapter 20 for more on using Knoppix for things like rescuing broken Linux
(and even Windows) systems.

Just about every Linux distribution includes a rescue mode. Due to space
restrictions, I have room to cover entering only Fedora’s rescue mode in step-
by-step detail, but at the very least, here’s a quick reference to how to find
the rescue mode in the distributions covered in this book:

v~ Linspire: The CD contains a rescue mode. When the installer starts, use
your arrow keys to select Diagnostics and then press Enter.

v Fedora: The DVD, or the first installation CD, contains a rescue mode
that you can enter by typing Tinux rescue at the installer’s boot
prompt.

v Mandrake: The first CD contains a rescue mode. When the installer
starts, press F1 to access the command prompt, type rescue, and press
Enter.
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v SuSE: The DVD, or the first installation CD, contains a Rescue System
menu option. Use your arrow keys to highlight this option and press
Enter.

v Xandros: The CD contains a rescue mode. When the installer starts,
press the Shift key. This action opens a list of menu options. Use the
arrow keys to select Rescue Console, and press Enter.

To enter rescue mode in Fedora Core, place the DVD or your first CD into
your DVD-ROM or CD-ROM drive and boot the machine. Then follow these
steps:

1. When the disk first loads, type linux rescue at the boot prompt.
This action begins booting the system into maintenance mode.
2. Select your language and press Enter.

3. Select your keyboard type and press Enter.

The rescue system does its thing for a while, perhaps a minute or two on
a slow system.

4. When asked whether you want to start the network interfaces, answer
No unless you know you need to download something.

5. At the Rescue screen, select one of the three options offered and then
press Enter.

Your three options are

¢ Continue: The rescue interface tracks down your installed Fedora

0 Core system for you.
h\
If you select this option (or the next) and it fails, you may need to

reboot and restart the rescue system. After restarting, choose Skip.

¢ Read-Only: The same as Continue, but you aren’t able to make any
changes to your hard drive installation.

e Skip: Don’t bother trying to locate the filesystem, just give me a
prompt!

[ assume that you chose Continue. If so, a shell prompt (the rescue
command-line interface) appears, and you now have access to the
rescue interface.

6. If the rescue process was able to load your Fedora installation, type
chroot/mnt/sysimage to be able to use your system without having
to type /mnt/sysimage in front of everything.
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Don’t Just Turn Off the Machine!

Even when you’re not tapping the keyboard or clicking buttons, Linux is still
running along in the background and doing lots of housekeeping chores.
Some of these chores may involve swapping cached data to and from the
fixed disk — a geeky way of saying that it’s actually jotting down things onto
your hard drive that before it had just been making sure to remember in
RAM. When you shut off the power out of the blue, anything the computer
was remembering but hadn’t written is lost, kind of like when you or I fall
asleep before making a to-do list for the next day.

If you're used to Windows 98, you need to recondition yourself from just
shutting off the power when you’re finished. For one thing, many Linux users
leave their computers on when they’re not using them; they just log out of
their accounts so that no one can mess with their stuff and shut off the moni-
tor because monitors draw a lot of power. When you do decide to turn off
your Linux machine, for whatever reason, you must shut down the computer
in an orderly manner.

You can use one of these methods to shut down Linux properly:

v If you're in the GUI, log out of your account using the main menu’s Log
Out option and then click the display manager option that says,
strangely enough, Shut Down.

v If you have a command prompt open, enter the halt command at the
shell prompt (#) followed by the root password, and Linux shuts itself
down and tells you when it’s all right to turn off the machine.

v If you have a command prompt open, enter the reboot command, and
Linux goes through the motions of shutting itself down and then immedi-
ately reboots the machine.

v If you have a command prompt open, entering shutdown -f now is the
most traditionally accepted method. The shutdown command optionally
allows you to send messages to logged-in users and determine how long
until the shutdown takes place. Another method is the poweroff com-
mand, which is just an alias to the previously mentioned halt command.

If you do accidentally cut the power to your Linux box, take heart; all is not
lost. More often than not, you can reboot your computer and pick up where
you left off. However, you may have to pay for your error by waiting during a
quick file system check while the machine makes sure that nothing was dam-
aged. This process is similar to the one in Windows, where, if you power off
incorrectly, the operating system may need to scan its hard drives to make
sure that everything is okay.
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If you're plagued with brief power outages or spikes that cause your com-
puter to reboot, look into getting a UPS (Uninterruptable Power Supply) for
your computer. These heavy recharging batteries can not only protect your
computer from damage — read the box to see what features a particular UPS
offers — but can also provide an extra five minutes or more of power to give
you a chance to properly close your files and shut down a machine when the
power goes out. Better yet, for those really brief spikes, the only inconven-
ience you’ll have to deal with if you have a UPS in place is listening to it com-
plain with beeps. Your computer won’t be affected by the spike at all!

Removing Linux from Your System

\\3

Although I'd hate to see you go, I'd also hate to see you get trapped in Linux
if you don’t want to use it! How to most easily get rid of Linux depends on
what you want to do:

v If you want to replace Linux with Windows, just install Windows on the
machine. It will overwrite all of Linux, including the boot menu.

v If you want to remove Linux from a dual boot setup, then boot into your
Windows option, access a command prompt, and type fdisk /mbr. This
action removes the Linux boot loader. It doesn’t erase Linux, but you
can then format the Linux drive(s) or partition(s) for Windows.

Windows XP and Xandros users have a special command they can use to
remove this distribution. Boot your machine using your XP CD-ROM into the
Recovery Console. Change to the Windows directory and then type fixmbr.



1 04 Part I: Getting Your Feet Wet




Chapter 6
Checking Out Those Desktops

In This Chapter

Finding your way around Fedora

Kicking around Knoppix
Looking around Linspire
Messing around with Mandrake
Seeing what’s what with SuSE

Xightseeing around Xandros

A bus station is where a bus stops.
A train station is where a train stops.
On my desk, I have a workstation. . . .

— Steven Wright

A lot of people like to characterize Linux as a DOS-like environment,
where all you can do is operate in this antique-feeling world where you
have to type a lot of cryptic stuff and can’t see any pretty pictures. However,
the Linux desktop offers you quite a nice working environment, as you see
throughout this chapter. The cool thing is that most of it is configurable.
Those who like to customize their systems can have way too much fun
changing things around.

Introducing the Interfaces

Linux has two interface types: the command-line interface and the graphical
user interface (GUI). If you use other computer systems, such as Windows or
the Macintosh, you’re already familiar with a GUI. Most Linux distributions
include different versions of the GUI (which takes up the majority of this
chapter), which you can heavily customize.
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If you've been using computers for many years, you may also be familiar
with the command-line interface, which usually consists of a black screen
with white text. The initial release and early development of Linux was all
command-line-oriented; GUIs then grew as the icing on the Linux cake,
making it a lot more colorful to use and easier for people who would
rather point and click than type.

In choosing between the command-line and the GUI, you need to consider a
number of factors. For a lot of people, this decision is pretty much a no-brainer
issue. They have no intention of leaving GUIs behind. That’s fine, but at the
very least, you may want to become familiar with what’s under the hood. Some
day, your GUI might break and leave you at the ever-dreaded login prompt!

Deciding Which Interface to Use

One important factor when choosing between the command-line interface
and a GUI is speed. Keep in mind that if you're a programmer who needs to
compile programs or a scientist who needs to run software that does heavy
number crunching, the GUI slows down your system. You also need to typi-
cally shut off the GUI when using Linux as a server, because it’s mostly a
waste of RAM and processing speed — more often than not, a server just
does its thing with no one sitting there watching over it.

Readability can also be a big issue when choosing between the GUI and
the command prompt. If you have a hard time reading text in those small
command-prompt windows from within the GUI (Chapters 14 and 20 cover
various ways to switch around), you can either make the windows and the
font bigger, or work directly with the command prompt outside of the GUIL
However, on a desktop that you want to use for word-processing or editing
images, you’ll want a point-and-click environment. This setup is the type I
focus on, but [ don’t leave you without any clue about the command-line,
just in case!

You also can choose from two major GUI versions: GNOME and KDE. Some
people prefer one, and some the other, and I'm not here to tell you which to
use. If you stuck with the defaults for your distribution, then you’'re using

v Fedora: GNOME

v Knoppix: KDE

v Linspire: KDE

1 Mandrake: KDE

v+ SuSE: KDE

v Xandros: KDE
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Most distributions come with both KDE and GNOME, so most users simply
choose their preferred desktop. While it may look from here as though KDE is
particularly popular compared to GNOME, this isn’t necessarily the case.
Both are excellent desktops with strong fan bases. It’s a pretty personal pref-
erence, so | encourage you to install and experiment with both and to see
which you like better. The cool thing is that you can run most KDE programs
under GNOME and vice versa. This ability is vital when it comes to making it
easier on developers (and users) in the Linux community. When you ask
people why they chose one over another, often they really can’t give you
much of a good answer aside from “That’s what I've always used.” Keep this
in mind when people try to convince you that one or the other is the best
thing since sliced bread!

I cover how to switch between KDE and GNOME later in this chapter in the
section “Switching between GNOME and KDE.”

Making the Best of the Command Line

The Linux command-line interface provides a quick and easy way of entering
commands and executing actions. Even if you're mostly a “GUI person,” after
you get the hang of using the command line, you discover that it’s faster to
perform some tasks at the command line than with a mouse in the GUI envi-
ronment. However, if you prefer to use a GUI interface as your working
environment, you can easily open a terminal window, which is a command-
prompt window, to perform your command-driven tasks without having to
completely leave the point-and-click environment (see Chapter 14).

There are some interesting things that you might find useful to know about
using the command-line interface. One difference between the Linux com-
mand line and other interface command lines, such as the Windows MS-DOS
prompt, is that Linux commands are case sensitive. Typing LS is completely
different from typing 1s, and, in fact, gives you an error because there is an
1s command but there is no LS command. The Linux command line also has
an autocompletion feature. If you know the first few characters of a command
or filename, type part of it and press Tab to complete the rest automatically.
For example, if you're trying to use the 1ess command to view the contents
of the file /home/bob/grocery_1list, you can type less /home/bob/gro
and press Tab to try and complete the filename. However, if you also have the
subdirectory (folder) /home/bob/group_projects, you hear a beep. You
can press the Tab key again, like double-clicking a mouse, to see the output:

grocery_list group_projects
The cool thing here is that the command prompt beneath these items still

has the text 1ess gro so that you don’t have to retype it! You can then see
that typing a ¢ makes it clear that you're referring to grocery and not group,



1 08 Part I: Getting Your Feet Wet

A\

so you just add a ¢ to make Tess groc and press Tab again to finish the
autocompletion. This technique can save you a ton of typing, especially with
really long filenames!

Most Linux distributions also keep a running history of the most recently
used commands. To use this list, press the up-arrow key on your keyboard.
This action pulls up the last command you typed. As you continue to press
the up-arrow key, you step through the most recently entered commands
from the most to least recent. If you accidentally pass what you're looking
for, use the down-arrow key to go back. When the command you want appears
at the command prompt, press Enter to execute the command, or edit it and
then press Enter.

In Chapter 14, I cover the command-line environment in more detail.

When you installed Linux, you added a graphical login by default. (This addi-
tion is true for all the versions discussed in this book.) Some versions of Linux
give you the option of choosing a graphical or command-line login, which can
cause a lot of confusion for folks who accidentally choose the command-line
option. If you did so (or think you did) and find yourself lost after the machine
boots up, see Chapter 19.

GNOME Basics

a\\S

GNOME stands for the GNU Network Object Model Environment — not that
this expansion tells you much! Suffice it to say that GNOME is a full graphical
environment. | focus here on Fedora since it is the only distribution I'm cov-
ering that uses GNOME by default. Figure 6-1 shows you what you see once
you log into the system and the GUI finishes launching.

To find out more about GNOME, visit the main GNOME site, at www.gnome.org.

Keep in mind that the programs you have depend on the type of installation
you chose and what customizations you made; if what you have is different
from what you see in descriptions or the figures, don’t panic!

The GNOME desktop environment is essentially broken into four separate
parts:

v The menus

v The menu and icon panel at the top of the screen

v The desktop panel on the bottom of the screen

v The icons on your desktop
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The menus

There are two primary menus in GNOME and Fedora Core 3. One of these is
accessible through the Applications button on the upper panel, and the other
is available by clicking Actions next to it. The Applications menu contains the
options shown in Table 6-1, and the Actions menu’s contents are shown in
Table 6-2.

“&N\BER
& Menu items that have an arrow on their right offer submenus, which you can
open by holding your mouse on that menu choice. Often, the submenus have
their own submenus within that offer even more programs.

Table 6-1 Fedora Applications Menu Contents,
Listed in the Order That They Appear

Menu Choice What You Find

Accessories Small, specific-function GNOME and X programs.

Contains a calculator, character map, dictionary, file
roller, Pilot/Handspring tool, and text editor.

Games A collection of games.

(continued)
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Table 6-1 (continued)

Menu Choice What You Find

Graphics A variety of graphics programs, including The GIMP.

Internet A few Internet tools, such as Evolution (e-mail and calen-
dar program), Gaim (instant messenger), and Mozilla
(Web browser).

Office The OpenOffice.org suite of applications (word-processing,
drawing, and more).

Preferences Access to programs to control the look and feel of the
GNOME and Linux graphical interface.

Sound & Video Programs, such as a CD player and sound recorder, for

working with your computer’s multimedia hardware.

System Settings

Many tools for working with your computer’s hardware,
such as display settings and packages to view and con-
figure the software packages installed on your system.

System Tools

Many tools for managing, monitoring, and updating your
system, such as the Internet Configuration Wizard, Red
Hat Network, and a System Logs viewer.

File Browser The Nautilus file manager, defaulting to your home
folder’s contents.
Help The Help Browser, for exploring the electronic documen-

tation included in the Linux distribution.

Network Servers

The Nautilus file manager, defaulting to your network for
file browsing — for example, your Windows network.

Table 6-2 Fedora Actions Menu Contents,
Listed in the Order That They Appear
Menu Choice What You Find

Run Application

The dialog box you can use to run a specific
program without opening a virtual terminal.

Search for Files

The Search Tool window, for locating files in the
file system.

Recent Documents

A selection of the last files you opened from the
file manager.

Take Screenshot

Capture a PNG format image of your desktop.
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Menu Choice What You Find

Lock Screen The capability to set your machine so that no
one can use your GNOME login without enter-
ing your password. This feature is a good one if
you need to walk away from the computer for a
while (but don't want to log out of your account)
and other people are around.

Log Out The capability to exit the GNOME session, shut
down, or reboot the computer — if you know
the password of the root account.

The Run Application tool

After you choose the Run Application tool on the main menu, the Run Appli-
cation dialog box appears, as shown in Figure 6-2. You can make this dialog
box friendlier by clicking the Show List Of Known Applications arrow at the
bottom of the dialog box, which gives you a point-and-click way to choose.

Run Application

C* o

~ Show list of known applications

@ About Myself ﬁ
B Accessibility

% Add/Remove Applications ‘
IR AisleRiot Solitaire [+

Select an application to view its description.

| & Help | | % Cancel || & Ru |

To run a program using this dialog box:
1. Either select the application from the Known Applications list or type
its full path by hand.
For example, you might type /usr/bin/gimp.

2. If you want this program to operate on a particular file, click the Run
With File button. Otherwise, skip to Step 5.

The Choose A File To Append To This Command dialog box appears (see
Figure 6-3).
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3. If the file is in your user home directory, navigate down to it. If the
file is elsewhere on your system, double-click the Filesystem button
and navigate to it.

4. After you have the file selected, click OK.
This action returns you to the main dialog box.

5. Click the Run button to run the program.

The Lock Screen tool

If you have your screensaver turned on (from the main menu, choose
Preferences=>Screensaver to change this setting) and choose the Lock Screen
option from the main menu, your screen fades to black, or your screen saver
appears. Then, if anyone moves the mouse or uses your keyboard, a dialog
box appears with your login name in it and a password field. You can get back
to work by entering your password. Until then, you're safe in knowing that no
one else can mosey up to your computer and send off a joke e-mail to your
boss while pretending to be you. Note that if you're logged in as the root

user, the Lock Screen option doesn’t work.

I'm referring to just the GUI here, not the whole machine. Folks who know
how to sidestep out of GNOME (something I discuss in Chapters 14 and 20)
can start a virtual terminal session and do whatever they want. If you left
yourself logged into one of the virtual terminals, they can then do something
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there without trouble. Don’t think of this feature as something that completely
secures your computer! Your best bet if you're walking away is to check all
the virtual terminals and make sure that you're not logged into any of them.
Then you can either log out of your GUI or just use the Lock Screen option.

The Log Out tool

After you choose the Log Out option on the main menu, the screen darkens
and the Are You Sure You Want To Log Out? dialog box opens. To use this
dialog box, follow these steps:

1. If you want GNOME to remember which items you have open and
return you to its current state after you log back in, make sure that
you select the Save Current Setup check box.

This feature doesn’t work with all programs, just some (mostly the ones
that are actually part of GNOME).

2. Click Log Out, Shut Down, or Restart The Computer to set the appro-
priate action into motion or click Cancel if you don’t want to do any
of them.

These options do the following:
¢ Log Out: Closes GNOME and returns to a login prompt.
e Shut Down: Shuts the machine down and then off.

¢ Restart The Computer: Shuts down the machine and then brings it
back up.

3. Click OK to go through with your choice or Cancel if you change your
mind.

The Panels

Along the top and bottom of your GNOME desktop lives a pair of panels.
Since these bars are neatly divided into sections, take a look at what’s in each
section from left to right, starting with the top panel. On the far left side of
the top panel is the Applications button discussed earlier in the section “The
menus.” To its right is the Actions button, also discussed in the same section.

As you continue your journey to the right, you run into the standard set of
Fedora tools (refer to Figure 6-1). You can reach all these items through the
main menu, but they’re placed on the Panel so that you can find them quickly
and easily:

113
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v Firefox: The Worldplanet-with-a-mouse pointer icon opens the Firefox
Web browser. See Chapter 9 for more.

v Evolution: Just to the right of the Web browser button; launches an
e-mail and calendar program. See Chapter 9 for more.

1 OpenOffice.org Writer: Resembles two pieces of paper (and a pen) and
opens the OpenOffice.org Writer word-processing program. See Chapter
17 for more.

v OpenOffice.org Impress: Opens the OpenOffice.org Impress presenta-
tion creation program. See Chapter 17 for more.

v OpenOffice.org Calc: Opens the OpenOffice.org spreadsheet program.
See Chapter 17 for more.

Then you see a large blank space where you can add new icons. After the
blank space, you find, from left to right:

v Updater applet: This icon alerts you to available updates for your
system. (See Chapter 12 for more information.)

v Date and Time applet: Here you can see the day and time.

1 Master Volume Control applet: Click this to open the master volume
control.

Now for the bottom panel. From left to right, you find on this panel:

v~ Hide/Restore Desktop Applications: This button lets you minimize all of
your running programs immediately and then re-open them again with
just one click.

v~ Taskbar: In this large space, you find entries for each program running
on your desktop. You can change a program’s status by using the boxes
as indicated:

e [f a program is minimized, you can open its window by clicking its
panel task box.

e If a program is maximized but buried under another program, click
its task box on the panel to bring this program to the front.

e If a program is maximized and on top, you can minimize it by click-
ing its panel task box.

1 Workspace Switcher: Allows you to work in four different desktop envi-
ronments during a single login session. Each desktop environment has
the same menus, panels, and background, but you can run different pro-
grams in each of the environments. It’s an easy way to remain organized
while you're working in multiple programs. Try it out. It’s like having four
monitors in one!
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Want to move a program from one workplace window to another? Click the
little arrow in the program’s upper right corner and select one of the follow-
ing options:

v Put On All Workspaces: Makes the window show up on all four.

v Move To Workspace Right: Slides the window horizontally to the right,
into the “next door” workspace.

v Move To Another Workspace: Gives you the option of specifying
Workspace 1 (far left), 2 (second in from the left), 3 (third in from
the left), or 4 (far right).

You can see which workspace an open window is in at a glance by looking at
the Workspace Switcher and spotting the little windows that match how your
desktop is laid out.

The Panel menu

It’s time to take a look at how to change the look and feel of your panels. You
can customize your upper and lower panels individually through the Panel
menu, which you open by finding free space on the panel you want to work
with and then right-clicking to pull up the Panel’s context menu. For a list of
what this menu’s items offer, see Table 6-3.

If you have so many programs open that you're using the whole width of the
task box section, you may not have any free space to right-click in. You may
need to close an application or two to open up space.

Table 6-3 GNOME Panel Menu Contents

Menu Choice What You Find

Add To Panel The applets, menus, and other objects you can add
to your main panel

Delete This Panel The capability to delete a secondary panel but not
the main icon panel

Properties The options for setting this panel’s behavior

New Panel The options for creating new panels that sit on
different parts of the screen

Help The Help browser for GNOME

(continued)
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Table 6-3 (continued)

Menu Choice What You Find

About Panels A dialog box with some basic Panel information
About GNOME A dialog box with some basic GNOME information

The Add To Panel menu option

The Add To Panel dialog box (see Figure 6-4) is accessible from the Panel menu
(see the previous section). This dialog box contains a list of applets — small,
specialized programs you can use to add particular functionality to a panel.
To add one of these applets to your panel, open the dialog box, select the
applet you want to use, and then click Add. The applet now appears on your
panel. If you right-click the applet and choose Move, you can then slide the
applet along your panel until you have it where you want it and then click to

release it.

m Add to Bottom Panel

Select an item to add to Bottom Panel:

E@J Application Launcher...
Launch a program that is already in the GNOME menu

Battery Charge Monitor
Monitor a laptop's remaining power

Character Palette
Insert characters

7 Clock

Get the current time and date

Command Line

@ CD Player
Panel applet for playing audio CDs
=

I

Mini-Commander

Custom Application Launcher
Craate a new lanncher

& Help |8Qam:e||| < Back || & Add

Playing with desktop icons

Your initial desktop icons form a vertical line along the top left of your screen

(refer to Figure 6-1). In order from top to bottom:
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v Computer: Opens the Nautilus file manager (see Chapter 10) with a list
of your CD-ROM drive(s), hard drive(s), and more.

v Home: Opens the Nautilus browser (Chapter 10) with your home
directory’s contents displayed.

v Trash: A GNOME shortcut that opens the Nautilus file manager to the
Trash folder, which contains files that you dragged into it because you
weren’t sure if you wanted to delete them or not.

To use the trashcan, drag into it any files you want to delete. Later, if you're
sure that you want to be rid of them, you can empty the trash in one of three
ways:

v Empty the entire contents by right-clicking the trashcan icon and choos-
ing Empty Trash from the context menu. When asked for confirmation,
click Empty.

v Open the trashcan by double-clicking the icon. Then delete the entire
contents of the trashcan by choosing File>Empty Trash.

v Open the trashcan by double-clicking the icon. To delete an individual
item from the Trash, right-click it to pull up the Trash context menu, and
choose Delete From Trash from the pop-up menu. When asked whether
you're sure, click the Delete button to finish the job.

You can select more than one item by holding the Ctrl key to individually
select them even if they’re not next to each other; holding the Shift key
to select a range of items; or left-clicking and then dragging to collect all
the items that are in a box together.

A\

v Another way to remove items from the trashcan is to delete them manu-
ally from ~/.Trash.

KDE Basics

KDE, the Y, is the default in most of the distributions covered here. Therefore,
I break out sections for each of the distributions so that you can see the dif-
ferences and find your way around. I skip Fedora here because I'm only cov-
ering default desktops (Fedora, Mandrake, and SuSE all give you the option of
choosing between GNOME and KDE if you installed both), and instead focus
on Knoppix, Linspire, Mandrake, SuSE, and Xandros.

All the distributions share similarities, yet each one is organized in a unique
way that its particular vendor or project group feels makes the most sense
® for their user base.

To find out more about KDE, visit the main KDE Web site, at www . kde.org.
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Knoppix KDE

The default Knoppix desktop is shown in Figure 6-5. From the top to bottom,
the desktop icons you see (with some variations depending on what drives
you have on your machine) include

v Trash: Where you put those files that you aren’t quite sure yet that you
want to delete.

v CD-ROM: If you have a CD-ROM or DVD-ROM drive, it likely appears
next. You can click this icon to open the Konqueror file manager (see
Chapter 10) to the contents of your CD-ROM.

v Floppy Disk: Even if you don’t have a floppy drive, this icon appears. You
can click this icon to open the Konqueror file manager (see Chapter 10)

to the contents of your floppy disk.

v Hard Disk Partition [hdal]: You have one of these icons for each hard
drive partition on your system. Chapter 11 makes it more clear how to
tell them apart.

v+ KNOPPIX: Click to open Konqueror to information about Knoppix.
At the bottom of your screen is your panel — if you came here from the

“GNOME Basics,” earlier in this chapter, note that KDE has only one panel
compared to GNOME'’s two. Table 6-4 details the Knoppix panel’s contents.

|
Figure 6-5:
The default
Knoppix

3.6 KDE
desktop.
|
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Table 6-4 The Knoppix 3.6 Panel Icons

Icon What It Opens

Main Menu The Knoppix main menu.

Knoppix Menu A special menu with just the Knoppix-specific items,
which contains the same entries as the main menu=>
KNOPPIX menu.

Window List Pops up a menu helping you to organize your desktop
windows.

Show Desktop Minimizes or maximizes all open programs.

Personal Files

Opens the Konqueror file browser to your home
directory’s contents.

Terminal Program

Opens a command-line window.

Web Browser

Opens the Konqueror program, which also serves as a
Web browser.

Mozilla Browser

Opens the Mozilla Web browser.

Open Office

Opens the OpenOffice.org Writer word processor
(see Chapter 17).

Workspace Switcher

Lets you pretend to have four different monitors, by
running different programs in different workspaces. You
can move programs from one workspace to another by
clicking the down arrow in their upper left corner and
selecting To Desktop.

Taskbar

Contains an entry for each program you currently
have open.

KLaptop applet

If you're using a laptop, the KLaptop applet shows if your
laptop is plugged in or not and what its battery level is.

Language applet

Shows you what language you are set to and lets you
change languages. See Chapter 15 for more on applets.

Monitor Settings applet

Lets you change your screen resolution and other display
information.

KMix applet

Launches the KDE mixer (see Chapter 18).

Time and Date applet

Shows you the time and day.

\\3

The right-facing arrows to the left and right of the Panel allow you to contract
it to the left or right, so you can use the extra screen real-estate.
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When you open the Knoppix main menu, you're faced with an impressive
amount of software when you consider that it’s all got to run off of a single
CD-ROM. This main menu includes

v Recently Used Applications: The recent programs you opened using
the menu so that you don’t have to go digging for them again.

+ Development: Software development tools.

v Editors: Various text editors.

v Edutainment: Educational games.

v Emulators: Software used to emulate other platforms.

v Games: Lots of games.

v Graphics: Image editors.

v+ Help: The help menu.

v Internet: Internet-related software.

v KNOPPIX: Knoppix-specific menus.

v Multimedia: Sound, video, and other multimedia software.

v Office: Various office productivity programs.

v OpenOffice.org 1.1.2: The OpenOffice.org office suite (see Chapter 17).

v~ Settings: Various system settings.

v System: System and administration tools.

v Toys: Silly but fun stuff.

v~ Utilities: More interesting tools.

v~ Find Files: The search program.

v Help: The help interface.

1+ Home: The Konqueror file manager open to your home directory.

v WINE: The Windows software handler (see Chapter 19).

v Bookmarks: Bookmarks you've set in your Web browser(s).

v Quick Browser: Quick way to open various points in your filesystem in
Konqueror (see Chapter 11).

v Run Command: An interface for starting programs by hand.
v Lock Screen: The same as the lock screen application in Table 6-2.

v Logout: Log out of your account, reboot the machine, or shut it down.
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Linspire KDE

The default Linspire desktop is shown in Figure 6-6. From top to bottom, the
desktop icons you see on your default installation are shown in Table 6-5.
Some of these icons are similar or identical to what you find in Knoppix KDE,
and others depend on what hardware you have on your system (such as the
CD-RW/DVD-ROM item in the table).

Table 6-5 The Linspire 4.5 Desktop Icons
Icon Name What It Launches
My Computer The Konqueror file manager with a list of places in

your computer including your desktop, documents,
programs, network shares, and your system (the base
directory of your computer’s filesystem).

My Documents

The Konqueror file manager with your My Documents
directory.

Network Browser

The Konqueror file manager with your network
shares, if you have any available.

CD-RW/DVD-ROM

The Konqueror file manager with the contents of your
CD-ROM, DVD-ROM, or whatever you have if you have
one inserted; otherwise, the session this icon opens is
empty. This icon is named according to what kind of
drive you have.

Floppy

The Konqueror file manager with the contents of the
floppy disk inserted if you have one inserted. Other-
wise, the session this icon opens is empty. Even if you
don't have a floppy drive, this icon appears.

Printers

The KDE Printer Control Module. (See the Printing
section for more information.)

Trash

The KDE trash can. Its works similarly to the GNOME
trash can, which | cover in the earlier section “Playing
with desktop icons.”

Internet Connection Tools

Opens the Konqueror file manager to a collection
of various connection tools. (For more detail, see
Chapter 8.)

Mail

Opens the Linspire Internet suite to its e-mail
program (see Chapter 9).

(continued)
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Table 6-5 (continued)

Icon Name What It Launches

Web Browser Opens the Linspire Internet suite to its Web browser
(see Chapter 8).

CNR Opens the browser to the Click N Run Warehouse
(see Chapter 12).

Looking at the Linspire Panel, you see, from left to right:

v The Linspire main menu.

v The Linspire help menu, which has a number of help options available.
v The Konqueror file manager (see Chapter 10).

v The Click N Run Warehouse, Web browser, and e-mail client (see Table 6-5).
v The GAIM instant messenger (see Chapter 9).

v The Desktop icon, which instantly minimizes everything.

v The task box section (see the earlier section, “The Panel”).

v The CNR icon again.

o IR
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v The VirusSafe icon (see Chapter 13).

v The SurfSafe icon (see Chapter 13).

v The volume controller.

v The battery level indicator if you're using a laptop.

v A top/bottom pair of icons. The top is the Lock Screen tool (refer to
Table 6-1). The bottom is the End Linspire Session tool where you can
select whether you want to Logout, Shutdown, or Restart. The Quick
Restart option is an automated logout that logs you right back in.

v The clock and calendar applet.
v A rightfacing arrow that lets you contract your Panel so that you can
use the rest of your screen’s real-estate.

When you click the main menu icon (the fancy L on the left of your Panel),
you see the menu items shown in Table 6-6.

Table 6-6 The Linspire 4.5 Main Menu
Menu Entry What You Find
Programs All the applications on your system.

My Documents

Your default document saving directory.

Settings

Your system settings.

Search

A tool to search your filesystems.

LindowsHelpAndSupport

All the Linspire help options, the same as you
find if you click the Help icon on the Panel.

Recent Documents

The documents you opened most recently
through your file manager.

Run Command

The Run Command dialog box, which is similar to
that covered in the section “The Run Application
tool.”

Configure Panel

Panel configuration options (see Chapter 15).

Terminate Application

A cool program that finds and stops a program
that has hung and is just sitting there, frozen.

Lock Screen

The same as the Lock Screen menu item dis-
cussed in Table 6-1.

Logout/QuickRestart

The same logout utility used in the Linspire
Panel.
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Mandrake KDE

The default Mandrake desktop is shown in Figure 6-7. From top to bottom,
the desktop icons you might see on your default installation are

v Home: The Konqueror file browser with the contents of your account’s
home directory.
v Welcome: The Welcome To Mandrake Linux utility.

v Floppy: The Konqueror file browser with the contents of your floppy
disk, if you have one in your floppy drive.

v Trash: The KDE trash can. It works similarly to the GNOME trash can.
(see the earlier section, “Playing with desktop icons.”)

[ofare

|
Figure 6-7:
The default
Mandrake
10.1 KDE

desktop.
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The contents of the Panel are, from left to right:

v The main menu star icon.

v Instantly minimize or maximize every window on your desktop.

v The Emacs text editor.

v The command-line terminal.

v The system configuration program.
The tiny little up arrow to the right of the system configuration program
opens the task bar menu, which lets you slide the section of your Panel that
shows the icons for open programs in order to make room for more Panel

shortcuts. Next is the task bar itself, where you see a box for each program
you have open. After the task bar appears, again from left to right, you see
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v The Workspace Switcher. (See the earlier section “The Panel.”) The tiny
arrows to the left and right of the Pager bring up the Pager context menu,
which you can use to move and configure this tool.

v The network connection status tool.

v The MandrakeOnline launcher, for keeping your system current
(see Chapter 12).

v The master volume control, which launches the KDE audio mixer
(see Chapter 18).

v The KDE Organizer calendar tool.

v The screen adjustment tool.

v The KDE CD player (see Chapter 18).

v The amaroK audio player (see Chapter 18).

v The Kaffine media player (see Chapter 18).

v The clock applet, which also has tiny arrows next to it to allow you to

pull up its configuration menu.

Mandrake’s main menu is detailed in Table 6-7. Many of these contents may
be familiar if you have read the GNOME and other KDE sections in this chap-
ter. As usual, exactly what you find here depends on the software you selected
when you installed Mandrake.

Table 6-7 The Mandrake 10.1 Main Menu’s Contents
Menu Entry What You Find

Office Work-related utilities such as word-processors.
Internet Internet-related tools, like IRC and FTP clients.
Multimedia Graphical, sound, and video tools.

System Configuration-related tools and utilities.

More Applications Less popular but just as important programs, including

software development tools, games, text editors, and
financial tools.

Home The Kongueror file manager open to your home directory’s
contents.

Find The search interface.

Recent Documents A menu of the documents you opened most recently

through your file manager.

(continued)
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Table 6-7 (continued)
Menu Entry What You Find
Run Command The Run Command dialog box, which is similar to the one

covered in the earlier section “The Run Application tool.”

Start New Session A secondary GUI login, which is great if you need to let
someone log in for a moment to do something without
having to shut off all your programs.

Lock Screen The same as the Lock Screen menu item discussed in
Table 6-1.
Logout The chance to End Session Only (log out), Turn Off

Computer (shut down), or Restart Computer (restart).

SuSE KDE

Figure 6-8 shows you the default SUSE KDE desktop. If you put many of these
the KDE desktops side by side, you would notice a lot of similarities. As with
Knoppix, SuSE is set up for you to open desktop items with a single-click rather
than a double-click in many cases, which is default KDE behavior but not used
by Mandrake, Linspire, or Xandros.

i ©
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The desktop icons are, starting with the horizontal row on the left:
v Trash: The KDE trash can, which works similarly to the GNOME trash.
(See the section “Playing with desktop icons,” earlier in this chapter.)
v SuSE: The Welcome to SuSE Linux 9.2 tool.
v Office: The OpenOffice.org launcher (see Chapter 17).

Beneath the horizontal row is another row of desktop icons, which are (from
left to right):

v Netword Browsing: Opens the Konqueror file manager to a list of all
your network file shares, including Windows Network shares.
v My Computer: Opens the Konqueror file manager to a list of removable

media, such as your CD-ROM drive.

Beneath these icons, you see the Printer icon, which opens the KDE print
manager.

Moving down to your panel, you find, from left to right, many familiar items if
you look up at the Mandrake section:

v The SuSE main menu.

v The Konqueror file manager opening your home directory.

v The KDE command-line terminal.

v The SuSE Help Center.

v The Konqueror Web Browser.

v The Kontact e-mail program (see Chapter 9).

v The Workspace Switcher (described many times throughout this chapter).

v The taskbar, where each program has an entry.

v~ A sextet of tiny icons. The top left is the battery monitor if you're using
a laptop. The bottom left is the Klipper clipboard tool. The top middle
is the PCMCIA profile manager. The bottom middle is the SuSEWatcher
updater tool. The top right is the volume control, and the bottom right
is the SuSE hardware management tool.

v The KDE clock.

The SuSE main menu is detailed in Table 6-8. As always, what you find in this
menu depends on which software you have installed.
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Table 6-8 The SuSE 9.2 Main Menu Contents

Menu Entry What You Find

Games Games!

Graphics Drawing tools, image editors, and more.

Internet Internet-related tools.

Multimedia CD, DVD, jukebox, TV and other multimedia tools.

Office Work-related office tools.

System Tools for managing your system.

Utilities Handy utilities.

Control Center The KD!E Control Center, which is a great central place to
customize your system.

Find Files The filesystem searching utility.

Home The Konqueror file browser open to your home directory.

SuSE help-center SuSE help information.

Bookmarks Your Web browsing bookmarks.

Run Command The Run Command dialog box, which is similar to the one
covered in the GNOME section “The Run Application tool.”

Switch User The same as Mandrake’s “Start New Session” option.

Lock Session The same as everyone's Lock Screen option.

Logout The same as Mandrake’s Logout option.

Xandros KDE

Figure 6-9 displays the default Xandros desktop. As you can see, Xandros
offers another customized version of KDE.

A vertical row of icons sits to the left of your desktop. These icons are, from
top to bottom:

v Trash: The KDE trash can, which works similarly to the GNOME trash
can. (See the earlier section “Playing with desktop icons.”)

v Home: The Xandros File Manager (see Chapter 10) opening to your
home directory’s contents.
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v Quick Start Guide: Launches the Xandros Quick Start Help guide.

v Web Browser: Launches the Mozilla Web browser (see Chapter 9).

v Xandros Networks: Launches the software update and adding tool
(see Chapter 12).

Your Xandros Panel, from left to right, launches

v The main menu.

v Mozilla Web browser.

v The Mozilla e-mail client.

v The Xandros file manager to your home directory.
v Xandros Desktop Help.

v The desktop clearing tool, letting you minimize everything on your
desktop all at once.

v The task bar, where the programs you’re running appear.

v The Workplace Switcher, as discussed earlier in this chapter in the
section “The Panel.”

v The desktop locking tool.
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v The logout, restart, or shut down tool.

v The Switch User tool, as discussed in the “Mandrake KDE” section.

v The clock and calendar.

v The Panel compression arrow.

Table 6-9 breaks down the Xandros main menu.

Table 6-9 The Xandros 2.5 Main Menu

Menu Entry What You Find

Applications All your programs.

Find Two search utilities, one to search your filesystem and

the other to search for particular computers if you're on a
large network.

Control Center

The Xandros/KDE Control Center, which is great for
customizing your system.

Xandros File Manager

The file manager, open to your home directory.

Xandros Networks

The system updater and software installation interface.

Help

The Xandros Desktop Help Center.

Recent Documents

Menu to open documents you recently opened using the
file manager.

Run Command

The Run Command dialog box, which is similar to the one
covered in earlier section “The Run Application tool.”

Switch User

The same as Switch User in the previous sections.

Log Out

The same as Log Out in the previous sections.

Switching between GNOME and KDE

When a distribution offers you a choice between desktops, and you installed
both desktops, you can typically select which one to use when you log in.
Here’s how you do so from the login window in the distributions that support
this feature:
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v Fedora Core: Click the Session icon on the lower part of your login
screen to bring up a dialog box where you can choose which GUI you
want to use.

v+ Mandrake: After you select your username, you're given more login
options. Choose the GUI you want to use from the Session Type drop-
down list box.

v~ SuSE: After you enter or select your username, click the Menu button to
open its context menu. Choose Session Type and then, from that sub-
menu, choose GNOME, KDE, or one of the others if you want to play
around with your options.
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Chapter 7
Configuring Linux

In This Chapter

Creating user accounts
Setting up your printing

Finding cool configuration tools

The doctor can bury his mistakes but an architect can only advise his client
to plant vines.

— Frank Lloyd Wright (1869-1959)

u nlike both the architect and the doctor, the computer user isn’t stuck
with configuration mistakes. You can tweak and change things until
you’re happy with them! Because the first thing a lot of people like to do with
a new system is get it set up just right, I thought I'd spend this chapter shar-
ing some of the core bits of knowledge that can help you do just this. You
start by finding out more about user accounts and why [ am so insistent that
you create a special one for your own personal use in Chapter 3. Then, you
find out how to set up your machine to talk to your printer. I also show you
where the cool configuration tools are for your distribution so that you can
get down to some serious customization.

Accounts Great and Small

Linux is a multiuser operating system. It allows everyone to have a unique
account and allows more than one user to log on at the same time. Typically,
even if you're the only user on a system, you need an account of your own
that isn’t the root user’s. (I explain why in the next section). In addition,
having multiple accounts is especially fun for experimenting with different
user setups. That way, you can create a main account to be more careful with
and a goofing around account to completely mess around with.
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Avoiding root

The root user, also known as the superuser or just root, has access to anything
and everything on your machine. There is no blocking root from a directory,
file, command, or device. Because of this factor, many Linux beginners figure
that they may as well use the root account all the time because it’s so
convenient.

However, for lots of good reasons, you shouldn’t use the root account for
everyday use:

v You don’t always need root-level access.

1 Root-level access is as much a curse as it is a blessing. If you mess up as
a regular user, you mess up only the stuff in your account. If you mess up
as the root user, you can wipe out everything — all the files on your entire
Linux system! That’s why some Linux distributions like SuSE give you a
nasty red background when you're in the root account (in the GUI) — as
a dire warning. In fact, Mandrake doesn’t even give you root as one of
the options to select in the GUI login. SuSE doesn’t give you a graphical
option for root, but you can type it into the Username text box.

QNING/ Don’t think that you can wipe out everything? Many experienced Linux
$V~ s X
administrators tell horror stories about the day they made a fatal typo
or weren’t paying attention to what they were doing and completely
destroyed an installation.

v If you send e-mail or news posts as root for anything other than serious
administrative business, people think that you don’t know what you're
doing or are showing off.

v Root comes with too much temptation. The superuser can read other
people’s e-mail messages and files, which introduces a few “tiny” ethical
issues.

Linspire has a slightly different philosophy. You have only one account when
you’re using Linspire, by default. However, in the next section, I show you
how to create new accounts so that you don’t have to use root — or let
someone who’s borrowing your computer for a moment to browse the

Web do it under root!

Creating user accounts

Most Linux distributions include a graphical interface application for creating
and managing user accounts. Here’s how you can find this application for
your distribution:

v Fedora Core: Choose Applications=>System Settings=>Users And Groups
opens the User Manager.



|
Figure 7-1:
The User
Manager
application,
in Fedora
Core 3.
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v Knoppix: From the main menu, choose = System=>KUser to open the KDE
User Manager.

v Linspire: From the main menu, choose Settings=>User Manager opens
the KDE User Manager.

v Mandrake: From the main menu, choose System=>Configuration=>
Other=> User Administration opens the Userdrake tool.

v SuSE: From the main menu, choose System=YaST opens up YaST. (See the
upcoming section “SuSE tools” for more on YaST.) On the left, choose
Security and Users. Then, on the right, choose Edit And Create Users to
open the User And Group Administration dialog.

v Xandros: Choose Launch=Control Center opens up the Xandros Contol
Center. From here, click the plus next to System Administration to expand
this menu and then click User Manager to open the KDE User Manager.

While these tools aren’t identical from distribution to distribution, they’re all
quite similar and work in essentially the same way. After all, each application
has pretty standard steps to creating user accounts. [ walk you through how
to create user accounts in Fedora Core, and most of the same steps apply
elsewhere.

To create a new user account in Fedora:

1. Choose Applications=>System Settings=>Users And Groups.

Because you’re (hopefully) using a regular user account, the Password
for root dialog appears.

2. Enter the root password and click OK.

The User Manager window opens, as shown in Figure 7-1. When the
application opens, the user account you created during installation
already appears.

[~ | User Manager [= =]
File Preferences Help

2 B8 &
Add User Add Group Froperties Delete Help Refresh
Search filter: | . Apply filter
U;ers-|Grgup5|
User Name | User ID ~ |Primary Gmup| Full Name | Login Shell| Home Directory
dee 500 dee Dee-Ann LeBlanc /binfbash  /home/dee
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3. Click the Add User button.

The Create New User dialog box opens, as shown in Figure 7-2.

Create New User [-=]x]

User Name: |

Full Name:
Password:

Confirm Password:

Login Shell: |/bin/bash [+]
| : T
Figure 7-2: | 4 create home directory
The Create Home Directory: | home/
dialog box in [¥] Create a private group for the user
the User | [ Specify user ID manually
Manager ;500
application,
in Fedora
Core 3. # Cancel | | & OK |
|
4. Enter a name for your new user in the User Name field.
“\gN\BEI? In Linux, the case of the user account is important, so note the case as
>J he information. Typicall le use all lower oth
¢ you type the information. Typically, people use all lowercase so that
they don’t have to keep track.
5. Fill in the user’s full name (as you want it to in an e-mail From header,
for example) or nickname in the Full Name field.
6. Enter the password in both Password fields.
Creating good passwords
Good passwords consist of the following: v~ Six or more characters

v A combination of numbers, letters, and even & No family or pet names, friends’ names,
punctuation marks birthdays, anniversaries, or other items that

someone can easily guess about you

v Uppercase and lowercase characters v y

v No dictionary words
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The remaining items are more advanced, so you can ignore them
for now.

7. Click OK to save the new account.

8. If you want to create another account, repeat Steps 3 through 7; if
you’re finished, choose File=>Quit to close the user creation program.

Printing

Unless you live in a paperless environment, you most likely need to print
something (such as a letter, a picture from your digital camera, or an invoice)
from time to time. Therefore, you need to set up your Linux system to print. It
can be helpful to know, before you continue, the make and model of your
printer and how it’s connected to your computer:

v Is it a local printer, meaning that it’s connected directly to your computer
through a parallel, serial, or USB port?

v Is it a network printer, meaning that it doesn’t have to be connected to a
computer and sits on the network as its own machine?

v s it a remote printer but not a network printer, meaning that it’s connected
to another computer on your network? If so, is this a Windows, Linux, or
OS X computer?

You can find your printer configuration tool by:

v Fedora: Choose Applications=System Settings=>Printing to open the
Printer Configuration tool.

v Knoppix: From the main menu, choose KNOPPIX=>Configurer>Configure
Printer(s) to open the Configure - Printers tool.

v Linspire: Double-click the Printers desktop icon to open the Printers KDE
Control Module and then click the Add Printer/Class button (the icon on
the left in the top row) to open the Add Printer Wizard.

v Mandrake: From the main menu, choose Systemr> Configuration=>
Configure Your Computer items to open the Mandrake Control Center.
Within this dialog box, click Hardware and then Printers to start
Printerdrake.

v SuSE: From the main menu, choose System=>YaST to open the YaST tool
discussed later in this chapter, in the section “SuSE tools.” From here,
select Hardware on the left, and then Printer on the right, to open the
Printer Configuration tool.
















































Chapter 8: Connecting to the Internet

¢ The fancy modem thing is powered on. (These contraptions often
have their own power supplies.)

v External modem: If you have an external modem (one that’s indepen-
dent of your computer case), you need to verify that:

* A cable is securely connected from the modem to the proper port
on the computer.

e The modem is powered on. (External modems have their own
power supply.)

¢ One end of a telephone cable is plugged into the wall jack, and the
opposite end is plugged into the modem.

v Internal modem: If you have an internal modem, you need to verify that:

¢ The modem is not a software modem. See the sidebar “Beware of
devices posing as modems” if you're not sure what a software
modem is or whether you have one.

¢ One end of a telephone cable is plugged into the wall jack, and the
opposite end is plugged into the phone plug on the back of your
computer.

v Wireless cards: If you have a wireless card, you also have to have a
wireless router to collect and direct your wireless traffic between com-
puters and/or bridge to let your wireless card talk to your Ethernet net-
work. How far and through what (walls, floors, and so on) a wireless
router or bridge can be from the card depends on the technology you're
using. Some handy primers on wireless hardware and setup include

e How WiFi Works: http://computer.howstuffworks.com/
wireless-network.htm

¢ Creating a Wireless Network: www.wi-fi.org/OpenSection/
design.asp?TID=2

Okay, now you can climb back into your chair.

Selecting an Internet Service
Provider (ISP)

Because of the meteoric rise in the popularity of Linux, many ISPs are training
their support staff in the ways of Linux. If you already have a dial-up service,
give one of them a call to let them know of your Linux pursuits. Chances are,
that person already has information pertinent to Linux subscribers and can
provide you with that information. If you’re shopping for a new ISP, this sec-
tion offers some practical selection advice.
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@“\NG! Some ISPs provide their own proprietary software that you must install on
5 your PC to connect to the Internet. The software they provide is likely to run
only on Windows. Several free dial-up services don’t work with Linux because
of this fact. The proprietary software meddles with the operating system to
ensure that banner advertising isn’t hidden or that you stay dialed in for only
a specified duration.

If you're shopping around for an ISP, consider these questions:

+* Can you get local dial-up numbers across the country and around the
world? If you travel often and need Internet access from different cities,
this service is a handy money (and headache) saver.

v Does it provide technical support for Linux? If you're planning on run-
ning Linux, this consideration is an important one. However, it doesn’t
have to be a deal breaker.

1 Can you get a recommendation? Ask a friend. An ISP’s best friend is an
endorsement from a satisfied customer.

v Will you have trouble dialing in? Although a subscriber-to-line ratio of
7-to-1 (an average of seven or fewer subscribers per line) or better isn’t
an entirely accurate measure of how often you’ll get busy signals, it’s
probably the easiest measure for consumers.

Getting Information You Need
from Your ISP

Most reputable ISPs provide you with a customer information sheet after you
sign up for its services. This sheet should include the following information at
the minimum:

v Local telephone dial-in numbers

1 User login name

v User login password

v E-mail address

v E-mail outbound host or Simple Mail Transport Protocol (SMTP) server

v E-mail inbound host or Post Office Protocol (POP) server

v News host

v Whether your computer address will be

e Static: You always have the same IP address. Static addresses are
more common for servers than for desktops. If you're using static,
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your ISP needs to give you your nameserver IP addresses, your
gateway address, the network address, and the netmask. This
information should all be on the customer information sheet.

e Dynamic: Your IP address changes each time you connect, or at
regular intervals. On most desktops, you just don’t always need to
have the same address, and it makes life easier on ISPs. It also
makes life easier for computer like laptops, which get moved
around often from network to network. If you’re using dynamic
addressing, you're told that you need to connect using DHCP.

With this information, you can establish an Internet connection by using your
Linux system.

Hooking Up

Fortunately, the Linux vendors provide tools that reduce the complexity of
hooking up with Linux. It’s not that networking has changed, but rather that
many of its details have been hidden so that you just have to click here and
press a key there. Not long ago, configuring dial-up networking (in particular)
on a Linux machine was nothing short of debugging a defective Rube Goldberg
contraption.

The Internet connection configuration tools available in the distributions
covered within this book are:

v~ Linspire: Double-click the Internet Connection Tools icon on your desk-
top to open the Connection Tools folder. Then double-click the appropri-
ate icon from there.

v Fedora: Choose Applications=>System Settings>Network to open the
Network Configuration dialog box. Click New to start the Configuration
wizard.

v Mandrake: From the main menu, choose System=>Configuration=
Configure Your Computer to open the Mandrake Control Center. Choose
Network & Internet=>New Connection to access the Connection Creation
wizard.

v SuSE: From the main menu, choose System=>YaST to open the YaST con-
figuration tool. On the left, select Network Devices. On the right, choose
the type of hardware you have in order to start configuring your setup.

v Xandros: From the main menu, choose Control Center to open the
Xandros Control Center. Click the plus next to Network to expand that
menu and then choose Internet Connection to open your connection
listing — you might need to click the Administrator button to enter
your root password. Click New to launch the Connection Wizard.
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Sometimes the choice isn’t as obvious as you think. For example, maybe you
have DSL, but because the DSL connection is going through your Ethernet
card, your system sees it as a LAN/Ethernet connection. So if you can’t get
your connection to work, play with these factors.

Again, because [ have only so much space, | walk you through setup using
Fedora. Many of the decisions and required pieces of information are the
same from distribution to distribution, so again, if you're not using Fedora,
read through this section and use what you find out here to work on your
own computer.

Configuring Your Connection

|
Figure 8-1:
The
Network
Configu-
ration

dialog box

in Fedora
Core 3.

With your ISP’s information in hand and a glowing monitor in front of you,
follow these steps to configure your dial-up connection to the Internet in
Fedora:

1. From the GUI desktop, choose Applications=>System Settings~>Network.

2. Enter your root password in the dialog box, if necessary.

If you're logged in as a regular user (not root), you’re prompted to enter
the root password.

The Network Configuration dialog box opens (see Figure 8-1).

[~] Network Configuration ==
File Profile Help

B & B @& ¢ =n

New Edit Copy Uelet Activate Deactivate

Devices | Hardware | IPsec , DNS | Hosts |

.oy You may configure network devices associated with
3 o physical hardware here. Multiple logical devices can be
“~ associated with a single piece of hardware.

PruﬁlSlalus i Device |Nic kname |Type I

[ & Active - eth0 eth0 Ethernet

|Active profile: Common

3. In the Network Configuration dialog box, click the New button.
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The Select Device Type dialog box appears, as shown in Figure 8-2.
Because I can’t cover all network connection types at once, and the
dial-up modem is the most complicated, I follow the dial-up option
from here. Choose the right hardware type for yourself and proceed.

Add new Device Type

Select Device Type

Device Type

I &4 ISDN connection

- . & Modem connection
Flgure 8-2 @ Token Ring connection
The Select =9 Wireless connection

Device Type 2% xDSL connection

| Create a new ethernet connection.

dialog box in
Fedora Core
3's Network
Configur- _
ation tool. | - 1
# Cancel | «§ Bacl | | > Forward |
|
4. To set up a dial-up modem, select Modem Connection from the Device
Type list box and then click the Forward button.
After you click Forward, the tool probes for your modem. If your modem
can’t be found (again, I follow through the most difficult option), the
Select Modem dialog box appears, as shown in Figure 8-3. I assume that
you're staring this dialog box in the face. If it doesn’t appear, proceed
through your configuration until it matches these steps again.
[~ | Add new Device Type ===
Select Modem =
Modem Properrie_s )
Modem device: /dev/modem B
Baudrate: 115200 [v]
EEE— Flow control:  Hardware (CRTSCT:E|
Fig“re 8-3: Modem volume:
The Select . ..
Modem
dialog box in
the Network
Configu-
ration tool. . % Cancel | | <] Back | ’m‘
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5. Select the proper device from the Modem Device drop-down list.

|
Figure 8-4:
The Select
Provider
dialog box in
Fedora Core
3's Network
Configu-
ration tool.
|

If you know your modem is on COM1 or COM2 in Windows, translating
this techno-talk to Linux isn’t hard: You just need to subtract 1. So, it’s

ttyS0O for COM1 and ttyS1 for COM2. If you’re not using a USB mouse

(it has a flat, rectangular connector), then your modem is probably on

COM2. If you're using a USB mouse, your modem is probably on COM1.

. Select your modem’s speed from the Baud Rate drop-down list.

If you were told to use a specific speed, choose that speed here.
Otherwise, choose the highest number available. The key is to try the
highest setting and, if that doesn’t work, start choosing slower and
slower ones until you’re able to properly make the connection.

Leave the Flow Control setting alone. Only change this setting if you're
having a hard time getting your modem connection to work, or you're
told by your ISP that you specifically need to select either Software Flow
Control or No (None) Flow Control.

7. Turn on your modem volume so that you can hear what it’s doing

while testing it.

You’ll want to come back later and shut off the volume. (Well, most
people do; some like to leave it on. I think the 56.6kbps modems sound
like an alien game of Pong, personally, while they’re connecting). It’s up
to you how loud you want to set the sound, as long as you can hear it.

Leave Touch Tone Dialing activated unless you live in an area that only
supports rotary phones.

8. Click Forward to proceed.

The Select Provider dialog box appears, as shown in Figure 8-4.

Add new Device Type

Select Provider

Phone Number
Prefix: Area code: Phone number:
i ws Czech Reput
G ™= Cermany

© é== Slovenia
B United Kingd | provider name:

T-Online Account Setup

Login name:

Password:

% Cancel | | < Back | | bfd;wardw
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10.

11.

12.

13.

14.

15.

16.

17.

18.

. Enter your ISP information and then click Forward.

The default list of countries that your ISP may be from is pretty limited.
If you live in one of these regions, select your country, then the ISP — at
which point the dialing entries are completed for you — and then skip to
Step 16. Otherwise, proceed to the next step.

In the Prefix text box, enter any dialing prefix you have to dial before
the actual phone number.

This prefix may be a long distance item, such as 1 for North American
long distance calls, or a 9 to dial out of your building — or even 91 if you
need to dial 9 to get out and you're dialing long distance. If you don’t
need a prefix, leave this box blank.

In the Area Code text box, enter the area code your modem needs to
dial if it needs to dial one.

In some places, you have to dial the area code even if you're dialing a
local number. If you don’t have to use an area code, leave this box blank.

In the Phone Number text box, enter the phone number (minus prefix
and area code) your modem needs to dial.

Dashes aren’t necessary.

In the Provider Name text box, type the name of your ISP.

You just use this name as a description for this dial-up entry.

In the Login Name text box, enter your dial-in account login name.
In the Password text box, enter your dial-in account login password.
Click Forward.

The IP Settings dialog box appears, as shown in Figure 8-5.

In the IP Settings dialog box, select the appropriate radio button for
whether your modem needs to obtain its IP addressing information
from the ISP (DHCP, as discussed in the section “Getting Information
You Need from Your ISP,” earlier in this chapter) or whether you need
to tell it what its IP data is (static).

Your ISP should have given you which of these you require. DHCP is the
default. If you choose Static, the lower portion of the dialog box
becomes available.

If you selected DHCP, and your ISP told you to automatically get your
nameserver settings from its equipment, leave the Automatically
Obtain DNS Information From Provider box checked. Otherwise,
uncheck it.
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|
Figure 8-5:
The IP
Settings
dialog box

in Fedora
Core 3's
Network
configu-
ration tool.
|

[~ | Add new Device Type ==

IP Settings
Encapsulation mode: J

® Automatically obtain [P address settings

PPP Settings
[¥] Automatically obtain DNS information from provider

) Statically set IP addresses:

Manual IP Address Settings

. % Cancel || <1 Back ||B*Eorward

19. If you selected static, fill in the Address, Subnet Mask, and Default
Gateway Address as given to you by your ISP.

20. Click Forward to proceed to the summary dialog box and then click
Apply to add the modem you have just set up to your main Network
Configuration dialog box.

You now have a modem entry (look in the Type column) in your
Network Configuration tool.

Connecting to (and Disconnecting
from) the Internet

To connect to the Internet, highlight the modem entry you just created
(see preceding section) and click the Activate button. With any luck, your
modem springs to life with some beeps and then buzzes along with a dialog
box indicating that a connection is being made. After a successful connec-
tion, the Network Configuration dialog box appears again; this time, the
Status column of the modem device reads Active. Congratulations; you're
now connected to the Internet!

To disconnect, click the Deactivate button in the Network Configuration
dialog box. Your settings remain; the next time you want to connect, just
open this dialog box and click Activate. If all is not well, skip to the section
“It’s All Fun and Games until Something Doesn’t Work” to find out how to
get help.
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It’s All Fun and Games until
Something Doesn’t Work

NNG/
&

In a perfect world, the dial-up configuration steps in the preceding section
would work 100 percent of the time. The Linux vendors have truly hidden all
the mystery that has traditionally surrounded networking. Unfortunately, in
many situations (mostly related to modems and hardware), a simplified con-
figuration doesn’t work. If you can’t connect to the Internet after following
these steps, an excellent site to find help is LinuxQuestions.org (www. Tinux
questions.org). It’s simply impossible for me to anticipate the wide range
of problems people can run into, and this site is well known for its helpful
community members.

Also, go to your favorite Web search site and search on the error message
you're getting from the system, or some keywords involved with the error,
such as the network hardware’s make and model, and the name of your
distribution. You can use two cool tools when you're trying to figure out
what’s wrong with your network connection or trying to gather information
that can help someone else figure out what’s wrong: the handy command line
programs ping and traceroute. Together, you can use these commands to
figure out where the problem might be when you can’t reach something over
a network. These commands are discussed in the next two sections.

Some firewalls block the kind of traffic sent with pings and traceroutes, so
these commands don’t always work as expected, even with a good connection.

Checking whether you can talk
to a specific address with ping

The ping command is akin to a submarine using sonar to detect other
objects in the ocean. Sonar sends out a ping signal, which reflects off a hard
surface. By measuring the amount of time between sending the ping and the
ping’s return, the submarine’s engineer can determine whether an object is
out there and how far from the submarine the object is.

The ping command in Linux provides information similar to what sonar pro-
vides. If you consider the Internet to be your ocean, you can determine, by
pinging, what other network computers exist and also how long it takes for
your ping to return. You use this command in the format ping hostname or
ping 7paddress, suchas ping bob.example.comor ping 192.168.1.5.1If
you can’t ping another computer in your house or office (assuming that you
have them all connected with Ethernet and not on separate dial-up connec-
tions), then something is wrong with the machine you're pinging from. On the
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other hand, if you can ping another machine in your house or office but you
can’t ping a machine elsewhere on the Internet, then something may be
wrong with your connection to your ISP.

Latency, or the amount of time it takes for a signal to travel on the Internet,
has little to do with physical distance. Rather, factors such as network traffic,
bandwidth, and network hardware all contribute to a slow latency. These fac-
tors determine whether a ping to your neighbor’s computer takes longer
than pinging a host at the South Pole.

For example, try pinging Yahoo! by opening a command prompt (see
Chapter 14) and typing the following command:

ping www.yahoo.com

Press Ctrl+C to stop the ping; otherwise, your computer continues to ping
the target.

The output, as shown in Figure 8-6, provides information about what ping is
doing. If the ping can’t reach the host, you receive a message that the host is
unreachable. If the ping can reach the host, you receive feedback that provides
how long it takes — in milliseconds (ms) — for the signal from your computer
to get to the destination computer and back again — the lower the numbers,
the better. For computers connected through Ethernet, a ping time of 1 ms to 3
ms is an acceptable response time. For dial-up connections, expect somewhere
around 150 ms. When you start seeing ping times climbing to 900 ms or higher,
the network is likely under heavy use (or you have something wrong with your
cables).

Following in your traffic’s
footsteps with traceroute

Another fun command is traceroute, which allows you to see all the com-
puters your data goes through on its way to a destination. Simply type the
command traceroute hostname, such as traceroute bob.example.comor
traceroute 192.168.1.5. After a few moments, you receive a list of all
computers between you and the designated hostname and how long it took
for the data to travel to each one of them in turn, as shown in Figure 8-7.

Try Yahoo.com! again as an example. Open a command prompt (see Chapter
14), type traceroute yahoo.com, and press Enter. It can take a moment for
the data to start filling in, but when it does, each line of your traceroute
results represents a hop. Each hop represents a physical machine your data
must travel through in order to get where it’s going. You can identify heavy
network congestion and other problems by making note of the larger num-
bers in the list.
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Figure 8-6:
Sample
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Figure 8-7:
The end of a
set of
results from
the trace
route
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% evani?localhost~ - L3

File Edit Vew Temninal Go Help
[evan@localhost evan]$ ping yahoo.com
PING yaheoo.com (66.218.71.198) from 192.168.1

7]

101 : 56(84) bytes of data.

64 bytes from wl.rc.vip.scd. yahoo.com (66.218 71.198): icmp_seq=1 ttl=247 time=60.2 ms
64 bytes from wl.rc.vip.scd.yahoo.con (66.218.71 198): icmp_seq=2 tt1=247 time=68.3 ms
64 bytes from wl.rc.vip.scd. yahoo.com (66.218.71.198): icmp_seqg=3 ttl=247 time=103 ms
64 bytes from wl.rc.vip.scd. yahoo.con (66.218.71.198): ilcmp_seq=4 tt1=247 time=144 ms
64 bytes from wl.rc. vip. scd yahoo.conm (66.218.71.198). icmp_seq=5 tt1=247 time=123 ms
64 bytes from wl rc vip. scd yahoo.com (66.218 71 198)° ilcmp_seq=6 tt1=247 time=81.7 ms
64 bytes from wl.rc.vip.scd.yahoo.con (66.218.71.198): lcmp_seq=7 ttl=247 time=225 ms
54 bytes from wl.rc.vip.scd.yahoo.con (66.218.71.198): icmp_seg=8 ttl=247 time=63.7 ms
64 bytes from wl.rc.vip.scd. yahoo.con (66.218 71.1898): ilcmp_seq=9 ttl=247 time=165 ms
64 bytes from wl.rc.vip.scd. yahoo.con (66.218.71 198): icmp_seq=10 tt1=247 time=81.2 ms
--- yahoo.com ping statistics --- I

10 packets transmitted, 10 received, 0% loss, time 9024ms
rtt min/avg/max/mdev = 60 201/111 797/225 992/50 873 ms
[evan@localhost evan]$ D

[«]

dee@elizabeth:~
File Edit View Terminal Tabs Help

ms
8 rc2ch-pos7-0.il.shawcable.net (66.163.76.174) 72.130 ms 71.263 ms 71.954
ms
9 ge-2-3-0.r02.chcgil0l.us.bb.verio.net (129.250.10.17) 70.757 ms 67.887 ms
72.727 ms
10 p16-5-0-0.r01.chcgilOl.us.bb.verio.net (129.250.2.220) 72.795 ms 68.525 ms
71.042 ms
MPLS Label=411408 CoS=5 TTL=1 S$=0
11 pl16-2-0-0.r01.chcgilO6.us.bb.verio.net (129.250.5.70) 73.312 ms 67.217 ms
73.919 ms
MPLS Label=557745 CoS=5 TTL=1 S$=0
12 pl6-1-1-2.r20.nycmnyOl.us.bb.verio.net (129.250.2.123) 97.724 ms 97.245 ms
97.486 ms
13 ge-0-0-0.a04.nycmny0l.us.ra.verio.net (129.250.26.8) 95.130 ms 95.937 ms
97.367 ms
14 ge-0-0-0.a05.nycmny0l.us.ra.verio.net (129.250.26.9) 96.365 ms 100.263 ms

pl6-2-0-0.a05.nycmny03.us.ra.verio.net (129.250.126.18) 95.975 ms

15 ge-0-0-0.a06.nycmny03.us.ra.verio.net (129.250.126.215) 98.743 ms pl1l6-3-0-0

.a06.nycmny03.us.ra.verio.net (129.250.126.66) 97.716 ms 98.237 ns

16 d3-0-3-1.a06.nycmny03.us.ce.verio.net (165.254.16.242) 96.576 ms
95.873 ms

17 63.250.9.66 (63.250.9.66) 100.662 ms 101.590 ms 101.770 ms

18 207.178.67.111 (207.178.67.111) 104.326 ms 110.226 ms 107.364 ms

[dee@elizabeth ~1%

95.927 ms
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Sometimes, especially when you're troubleshooting the reason that you can’t
access your intended Web site, you perform a traceroute that times out
somewhere along the way. This situation usually indicates that a “traffic acci-
dent” has occurred somewhere along the information superhighway. Give it a
few minutes and try again. If you get this problem consistently, it may mean
that a site is down or that a firewall is blocking the traffic.

After You're Connected

After you're connected, you'll probably want to leap straight to Chapter 9 for
how to use the various Internet programs available to you. In the meantime,
let me offer you a number of sites you might find useful when you need help,
have questions, or otherwise want to explore the Linux world further —
some of these are pretty geeky, but you’ll grow into them! You also may want
to update your machine (see Chapter 12), add new software (also Chapter
12), and give extra thought to system security (see Chapter 13) to protect
yourself from nasty people and programs.

Useful sites include

¥ www.linuxsecurity.com: A somewhat geeky but useful place where
you can track what’s going on in the world of Linux security.

v www.kerneltraffic.org: Everything you never wanted to know about
what’s happening with the Linux kernel but were afraid to ask. This place
is great for tracking what new features are being added, if you’re inter-
ested in things like bleeding-edge hardware or just like to be “in the know.’

9

v www.linuxquestions.org: [ mention this one elsewhere in the book,
but it’s worth a mention again. This site is a popular hangout for people
who have questions to ask, and those who like to help them.

v http://Tinux-newbie.sunsite.dk/: The Linux Newbie Administrator
Guide is a massive collection of information that you may find useful.

v www.tuxfiles.org: A collection of short help files on individual topics
of interest.

v www.t1dp.org: Contains lots of help documentation written for various
user levels.

v www.slashdot.org: Uber-geek (with a rather hostile culture, unfortu-
nately) hangout with lots of pointers to interesting articles online. Best
used to view the articles and skip the arguments in the comments
section.

In addition to these recommendations, your favorite search site can be very
handy.



Chapter 9
Using the Internet

In This Chapter
Browsing the Web
Reading newsgroups
Checking and sending e-mail

Sending instant messages

Give a man a fish and you feed him for a day; teach him to use the Net, and
he won'’t bother you for weeks.

— Anonymous

Fe Internet is a vast network of computers that spans the globe. Many dif-
ferent types of computers and operating systems work together to allow
you access to information across the Internet. Linux, along with its related
Unix operating system, has long supported and worked with the Internet.
Practically all the different services available on the Internet are available
from your Linux desktop.

When you install Linux (see Chapters 3 and 4), one or more Web browsers,
mail programs, and instant messaging tools are placed onto your new system.
In this chapter, I introduce you to some tools you can use to access different
services on the Internet, such as accessing Web sites, using e-mail, investigat-
ing newsgroups, and utilizing FTP — assuming that your Internet connection
is configured (see Chapter 8).

Meet the Popular Browsers

Many people attribute the explosive growth of the Internet to the graphical
Web browser. The Internet has been around for much longer than the invention
of the browser. It’s just that most of the work done on the Internet was in plain
old text, which held little attraction for those people who like pretty pictures.
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A number of graphical Web browsers are available for Linux. The default
browser included with each of the distributions covered in this book is:

v Fedora: Firefox (www.mozilla.org/products/firefox, based on
Mozilla)

+ Knoppix: Konqueror (www. konqueror.org), though Mozilla is also
included by default

v Linspire: Customized Mozilla

1 Mandrake: Konqueror, though Mozilla and Epiphany (www.gnome.org/
projects/epiphany, which is based on Mozilla as well) are also both
included by default

v SuSE: Konqueror
v Xandros: Mozilla

You can easily add the browsers that aren’t included by default to most of
these distributions (see Chapter 12). Another popular browser in Linux is
Opera (www.opera.com).

Many browsers are based on Mozilla, aren’t they? And Mozilla is a branch off
of Netscape. Because Mozilla is included with so many of these distributions
(and can be easily added to the rest), [ focus on it here. Mozilla is actually
more complex than both its Epiphany and Firefox love-children, and so you’ll
find those other options easier to figure out — and Epiphany and Firefox also
work very similarly to Mozilla. In fact, Firefox doesn’t have the same huge
pile of configuration routines in its Preferences dialog box because it doesn’t
have mail and news to contend with.

Mozilla, Firefox, and Opera are all available for Windows and OS X as well!

Configuring Mozilla

You can start surfing right now, if you want. You don’t need to customize your
browser. However, you may want to take a moment to tell Mozilla your prefer-
ences, such as the default Web site to show when it starts up, what font sizes

to use by default, what colors to use, and many other options.

The following steps introduce you to the Preferences window, where all the
Mozilla configuration parameters are stored:

1. Start Mozilla.

How you start Mozilla depends on which distribution you’re using.
Typically it’s either a shortcut on your Panel (Knoppix, Linspire, and
Xandros) or is available in the Internet portion of your main menu. Be
patient; Mozilla is a large program, and it usually takes a few seconds
to start up.
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2. Choose Edit~>Preferences.

The Preferences window appears, as shown in Figure 9-1. While this
dialog box may look different from distribution to distribution, I've

double-checked that all the options are the same and point out any
place where they aren’t.

Notice that many configuration options are available. Throughout the
rest of this chapter, I guide you through configuring a few of the essen-
tial settings. In addition, I encourage you to explore the many other
options available along the way!

. Use the left pane of the Preferences window to access the various

preferences categories.

You can expand any of the major categories by clicking the small plus
sign (+) or right arrow next to them, and contract them again by clicking
the small minus sign (-) or down arrow. Each category has a main menu
and submenus, so don’t forget to click the category names as well as the
subcategories.

. If you get tired of reading through menus, just click OK (if you made

changes you want to keep) or Cancel (if you made no changes or don’t
want to keep your changes) at any time to close the Preferences
dialog box and get back to surfing.

Preferences [}

# Appearance

ENavigator - Display on | Navigator Startup |:|
History
Languages O Blank page

Internet Search
Tabbed Browsing - Home Page
Downloads S 1
= Composer Clicking the Home button takes you to this page or group of
+ Privacy & Security REges.
# Advanced Location: | file:/jjusr/share/doc/HTML/index.html | !Qhoose File...

Helper Applications
Smart Browsing

O Last page visited

| Select the buttons you want to see in the toolbars
v Bookmarks [+] Search
[]1Go [¥] Print
lv] Home

OK 11 Cancel | | Help
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Figure 9-2:
The Mozilla
Appearance
Preferences
window in
Fedora

Core 3.

Appearance preferences

Selecting the Appearance main menu option — Figure 9-2 — allows you to
determine how you want Mozilla to look and act when it loads. Its basic setup
is governed by three separate sections: When Mozilla/Internet Suite Starts
Up, Open; Show Toolbars As; and the miscellaneous section at the bottom.
The first section determines what parts of Mozilla should launch when you
start up the browser. The options here are

v~ Navigator: The browser itself. This one is selected by default.
v Composer: The Web page creation part of Mozilla.
v Mail & Newsgroups: The e-mail and newsgroups part of Mozilla. (This

one is only available in some distributions by default.)

You can have more than one of these selected at a time, and all the ones you've
chosen start when you open your browser. Or, you can choose to launch the
additional pieces separately through the Window menu, just when you need
them.

The second section allows you determine how you want to see your toolbars:

v~ Pictures and text: Show buttons on your Mozilla toolbars and text with
them.
v~ Text only: Don’t bother showing the pictures.

v Pictures only: Don’t bother showing the text.

{~] Preferences [=]

Fonts When Mozilla starts up, open
ol [v| Navigator
Themes
Languages/Content L] Composer

i Nawigasor  Show toolbars as

+ Composer

# Privacy & Security @ Pictures and text

 Advanced O Pictures only

) Text only

[+] Show Tooltips

[#1 Show Web Site Icons

[ Use smooth scrolling

[ Resize large images to fit in the browser window

OK 11 Cancel . | Help
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Finally, the bottom section of this dialog box allows you to make a few more
customization tweaks:

v Show Tooltips: When you hover your mouse pointer over a Mozilla
option, a little tip pops up onto your screen.

v Show Web Site Icons: Grabs and uses the tiny little icons some Web
sites put next to their URLs, showing them in your bookmarks next to
the labels.

v Smooth Scrolling: Makes sure that when you scroll, you’re doing so.
Available in Fedora Core 3 but not Linspire or Xandros.

1~ Resize Large Images To Fit In The Browser Window: Doesn’t force you
to scroll around a big image to see the whole thing at once, but instead
fits it into the window. Underneath Appearances, the remaining menu
entries are:

v~ Fonts: Enables you to set your preferred typeface. For desktop resolu-
tions of 1024 x 768 and higher, [ recommend jacking up your font sizes
immediately. (Otherwise, become very familiar with the key combina-
tions Ctrl-+ to make all the fonts in the browser bigger, and Ctrl— to
make them smaller. Use the + and — on your number pad and not your
main keyboard.)

v Colors: Sets your text colors and whether you want to override explicit
Web page settings. This setting is an important one for color-blind
people.

v Themes: Allows you to put a custom paint job on your Mozilla
installation.

v~ Languages/Content: Allows you to set the sidebar preferences of your
browser to a particular locale’s language.

If you aren’t sure about how to use a particular setting, click the Help button
to open the Mozilla help interface.

Navigator preferences

The Navigator category (see Figure 9-1) enables you to select the behavior of
your browser when it’s first started. These settings are divided into three sec-
tions: Display On, Home Page, and Select The Buttons You Want To See In The
Toolbars. In the first section, the first thing you do is choose which aspect of
Mozilla you're setting by choosing one of the following from the drop-down
list box above the radio buttons:

v~ Navigator Startup: Specify what to do when the main browser window
opens.

v New Window: Specify what to do if you click a link that launches a new
window or choose FileoNewr>Navigator Window.
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v New Tab: Specify what to do if you have your browser/Navigator set
to use tabbed browsing and open up a new tab or choose File=>New=>
Navigator Tab. Tabbed browsing reflects the latest craze in Web browser
capabilities, especially among those who hate having their desktop clut-
tered with windows. It allows you to have multiple surfing destinations,
all in one window, and change between them by clicking tabs. See later
in this same section for more on tabbed browsing.

After you've selected which item you’re configuring, you can then choose one
of the following for its default behavior when it launches:

1 Blank Page: Open this item without opening any pages.
v Home Page: Open this item to my home page.

v~ Last Page Visited: Open this item to a copy of an open page or the last
one | visited.

In the Home Page section, you can specify the home page to use for the times
that you want to have a default page loaded. You have one of the following
options for choosing this page:

v Enter the URL you want to use in the Location text box.

v Click Choose File and browse to the file (on your computer) that you
want to use as your default and then click Open to add it to the Location
text box.

v Surf to the page you want to use for your home page and click the Use
Current Page button to add it to your Location text box.

»* Open up multiple tabs and, in each of them, surf to the pages you want
to open by default. Then click Use Current Group to have all these tabs
added to the Location text box. (It actually says “Home Page Group Is
Set” in the text box.)

v Change the home page back to the last setting you had by clicking Restore
Default. For me, it defaults to the hard-coded Fedora Project page.

Finally, in the bottom section, you can choose which buttons should show
up in your top two Mozilla toolbars, from Bookmarks (lower toolbar), Go
(upper toolbar), Home (lower toolbar), Search (upper toolbar), and Print
(upper toolbar).

You can actually control what’s in the lower toolbar with quite a bit of detail,
by choosing Bookmarks~>Manage Bookmarks and then changing what you
find in the Personal Toolbar Folder. That’s a really fun option to play with!
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Underneath Navigator, you can also check out:

v History: The History text box enables you to designate how many days
you want your browser to remember where you’ve been. You can click
the Clear History button to clear the history manually at any time, or
click the Clear Location Bar button in this same dialog box to remove
the list of sites it suggests whenever you're trying to type a new URL.

v Languages: No, this option doesn’t automatically translate the content
of a Web page into the preferred language. Rather, some Web page
authors provide their Web pages in more than one language. If it’s an
option, this one merely lets you decide language preference.

v~ Helper Applications: In this table, you designate applications to intercept
special file types. An example is a . pdf file, which requires the Adobe
Acrobat Reader in order to view it. You can specify the application and
optional arguments that need to be passed to the program.

+ Smart Browsing: With this option, you can set the characteristics of the
What’s Related tab, which is on the Sidebar (located in the left pane of
the browser window). The What’s Related tab provides a drop-down
menu listing sites that may be related to the displayed Web site.

1+ Internet Search: Search engines have become an integral part of Web
browsing. To accommodate searching, Mozilla can integrate your
favorite search engine right into your browser. You can click the drop-
down button under Default Search Engine and choose your preference.

v~ Tabbed Browsing: You can customize how your tabbed browsing func-
tions, if you like to play with this feature.

v Downloads: Mozilla provides you with a helpful download manager that
lets you watch the progress of multiple files, all in a single window. You
can even see the last items you downloaded.

Other preferences

Other preferences you may want to check out before you start using Mozilla
include

v Composer: If you like to build Web pages, you may want to check out
Mozilla’s Composer feature and its preferences. Of course, other Web
page-building programs are out there. Your version of Linux probably
offers one or more of the following: Bluefish (http://bluefish.open
office.n1/),NIVu (www.nvu.com/), Quanta Plus (http://kdeweb
dev.org/), or others.

1 Mail & Newsgroups: If you intend to use Mozilla for your e-mail and
newsgroups (the default in Linspire and Xandros), you can set up cos-
metic and other look-and-feel issues for how these features behave in
this section. However, you actually tell Mozilla what your e-mail account
is and what newsgroups to read, among other things, elsewhere.

171
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v Privacy & Security: Network security has become a very big issue for
everybody connected to the Internet. Although the typically nontechnical
media often sensationalizes this issue, security should still be a considera-
tion for all users of the Internet. Every time you send an e-mail or click a
Web site, you're exchanging information across a network. Although you
don’t need to lose sleep over it, you should be conscious of every request
you make on the Internet. Even though completely securing your informa-
tion is impossible, you can feel reasonably confident that your exchanged
Internet information is safe because of the default options that Mozilla has
provided. See the Popup Windows portion in particular for how to keep
these annoyances from cluttering your screen!

v Advanced: This category provides options that affect the entire Mozilla
user environment. Options include whether you want to enable Java
applets or XSLT Web pages. This area is also where you can flush your
cache — your browser’s memory of what you’'ve been doing and where
you've been, but not your bookmarks — and establish your proxy set-
tings in the Cache and Proxies submenus. (If you’'ve never before been
told to use a proxy, you don’t need one.)

Them dad-gum browser plug-ins

Do you ever get irritated at those Web sites that insist that you download a
plug-in, or additional piece of software, just to view the site? The difference
between a plug-in and an external program is this: A plug-in displays the results
in the browser, and an external program runs outside the browser. Although
these plug-ins are annoying if you're just looking for some basic information,
they can provide some pretty cool stuff, such as streaming video and music
through your Web browser.

Plug-ins provide browser capability extensions, which are programs that inter-
face with the browser to provide nonstandard features, such as sound and
video. The digital age is still in its infancy, so the industry hasn’t yet adopted
these multimedia formats as standard. In turn, the developers have chosen
not to build support into the Mozilla browser. Rather, the plug-in architecture
enables software developers to innovate without requiring the supporting
browser to know what to do with newly emerging media formats.

Chapter 12 explains how to add the popular plug-ins (like Macromedia’s Flash
plug-in) to your system for each of the distributions covered in this book.
You may also be interested in is “helper applications,” (programs Mozilla
launches to handle particular types of contents, like PDF viewers) which you
can configure in the Preferences dialog box by opening up the Navigator
menu and choosing Helper Applications. This section lets you tell Mozilla
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what programs to launch in order to open particular types of files, so if you
find that you're often having to do something manually, you can go into this
dialog box to automate the process of accessing file types you use all the
time.

Surfing the Web

Mozilla is your viewing window into the wonderful World Wide Web. Mozilla’s
primary purpose is to fetch Web pages on your command, download all their
graphics and related files into your computer’s memory, and, finally, render
the page for your interactive viewing pleasure.

If you're used to using Internet Explorer or Netscape, using Mozilla should be
a snap. It has all the familiar navigation tools, such as an address bar; Back,
Forward, Reload, and Stop buttons; and a feature that stores links to your
favorite Web sites (bookmarks).

Mozilla, like Netscape, also has a Sidebar feature — press F9 to show and
hide it (see Figure 9-3) — which you can use to find sites related to the one
you're visiting, search for a word or phrase on the Internet, access book-
marked Web pages, or access a Web page you recently visited (through the
History option).

redhat.com | Documentation - Mozilla
File Edit View Go Bookmarks Tools Window Help
st Reaad g‘ [ M hitp:jwww.redhat.comjdocs/ [Fll2-search Pfli:n - [

| “Home | “Bookmarks #Red Hat, Inc. #*Red Hat Network iSupport (55hop ZiProducts i Training
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Navigating Newsgroups
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Figure 9-4:
The Mozilla
Account
Wizard in
Knoppix 3.6.
|

Although e-mail is usually directed at an individual, you can think of news-
groups as public-message bulletin boards where people with similar interests
come together to discuss a topic. Newsgroups (like Web forums) are also
great places to find technical support.

Newsgroup support isn’t included in Firefox, but you can use the information
in Chapter 12 to install Thunderbird (www.mozilla.org/products/thunder
bird, an e-mail and newsgroup reader based on Mozilla, so it’s similar to
what’s shown in this book) or Pan, which is another popular choice.

Configuring Mozilla to read newsgroups

With the newsgroup server information that your ISP provides, follow these
steps to access the world’s largest cork board:

1. Choose Window=>Mail & Newsgroups (Fedora users, choose Window=>
Composer).

The first time you open this menu option, you immediately see the
Account Wizard, shown in Figure 9-4. After you set up your newsgroups,
selecting this option brings you to the (mail and news) message center
window with your Inbox selected by default.

2. Select the Newsgroup Account radio button and click Next.

MNew Account Setup

In order to receive messages, you first need to set up a Mail or
Mewsgroup account,

This Wizard will collect the information necessary to set up a
Mail or Newsgroup account. If you do not know the information
requested, please contact your System Administrator or
Internet Senvice Provider,

Select the type of account you would like to set up:

() Email account

O Newsgroup account

[Next: l[ Cancel ]
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3. Enter your full name or the nickname you want to use into the Your
Name text box.

4. Enter your e-mail address into the Email Address text box.

Because spammers harvest (collect) e-mail addresses of people to spam
through newsgroup postings, many people like to “mangle” their e-mail
address in their posts so that humans can make changes but a computer
can'’t easily tell what the real e-mail address is. Typically, you would set
your e-mail address to something like meatexampledotcom and leave a
note at the end of all your posts (in your signature, usually) to convert

it — for this example, it would be me@example.com.

5. Click Next and then enter your newsgroup server address into the
Newsgroup Server text box.

If your ISP didn’t give you this information already, check its Web site or
contact its support team to find out what to use here.

6. Click Next and then type a descriptive name in the Account Name
text box.

7. Read the summary and verify that it’s correct. If not, click Back and
go fix what’s wrong. If correct, click Finish.

The Mail & Newsgroups portion of Mozilla opens (see Figure 9-5).

BN % mail & Newsaroups ) = & (%]
. Eile Edit Wiew Go Message Tools Window Help
S F 88 R B E
s Get MsgsCompose
ﬂ?fﬂ‘.?éfﬂ View: Subject or Sender contains:
=) news.telus.net e z =
b g Local Folders 5| subject | &] sender | o] Date | priority |z
;
@ & &f E)  Done I
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Figure 9-6:
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Subscribing to newsgroups

To read newsgroups, you first must subscribe to the ones you want to check
out, and then you have to load their new posts (individual messages). To acti-

vate

1.

L)
. Eile

these subscriptions:

Click your newsgroup server in the list on the left (the Local Folders
entry beneath it is your e-mail interface).

The settings and configuration screen appears, as shown in Figure 9-6.

. Click Manage Newsgroup Subscriptions.

The Subscribe dialog box appears. The first time open this dialog box,
you're in for a wait as an index of all the newsgroups downloads to your
browser. Tens of thousands of newsgroup titles are out there, so even
though the browser is downloading only the newsgroup names, the
process takes some time. The status bar at the bottom of the dialog box
indicates progress.

. After all the newsgroup titles have loaded into your browser, scroll

through the list for topics of interest. When you find a newsgroup you
want to subscribe to, click in its Subscribe box in the listing to put a
checkmark in it.

13

x

& news telus.net - Mozilla |
Edit Wiew Go Message Tools Window Help

G o 88 8 B s

Geat MsgsCompose

S

Name

i Mozilla News - news.telus.net
EElnews. telus.net
I & Local Folders Newsgroups
A i
£.=_,i| Manage newsgroup subscriptions
Accounts
BE \View settings for this account

Create a new account

| =
Advanced Features
QA Search messages
% Manage message filters

B

offline settings

I & 97 D | Done
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Newsgroups tend to be in hierarchies, so when you see a triangle to a
listing’s left, click it to expand and see the subgroups inside that group.
The section comp.o0s.Tinux (so that’s compos=linux) contains a
number of Linux newsgroups you may be interested in.

4. Click OK.

You’re now back at the Manage Newsgroup Subscriptions dialog box.

Reading news

To read your news after you’'ve configured Mozilla for this purpose (by
following the instructions in the previous section):

1. From the main Mail & Newsgroups dialog box or the Manage
Newsgroup Subscriptions dialog box, click the newsgroup you
want to read.

The Download Headers window pops up with a message stating that
needs to load headers (for each post, the name of the person who
posted and the subject assigned to the post) for this group. If it’s a busy
newsgroup or it’s the first time you’ve read this one, you may be
prompted for the number of message headers you want to download.

2. If you are asked how many headers to download, select either
Download All Headers or specify how many headers to download.

The default of 500 is a good number. If you don’t want to see any of the
others (not a bad idea when you’re just starting in a group, or you'll
never get to the new stuff), click the Mark Remaining Headers as Read
checkbox.

3. Click Download.

The program goes to the news server and grabs the basic information
about the news posts. You can now scroll through the messages and
read or contribute to this newsgroup by clicking one of the headers.
Seeing what your peers are doing around the world is educational, if
nothing else!

P You need to be aware of the written and unwritten rules for newsgroup eti-
quette, which vary wildly from group to group. I recommend that you read
the Frequently Asked Question (FAQ) page for the newsgroup and lurk for a
while before posting questions and comments.

Evolving into E-Mail

While most people think of the Web when they think of the Internet,
e-mail may, in fact, be the most used and beloved of Internet applications.
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A multitude of e-mail programs is available for Linux users. The defaults in
the various distributions discussed in this book are

v Knoppix: KMail (http://kmail.kde.org/), although Mozilla Mail is
also included

v Fedora: Evolution (www.novell.com/products/evolution

v Linspire: Mozilla Mail

v Mandrake: Kmail, with Kontact and Evolution also installed

v SuSE: Kontact (www . kontact.org)

v Xandros: Mozilla MailEvolution and Kontact should both remind you
very much of Outlook, so if you like being able to integrate your calen-
dar, address book, task manager, and e-mail, you should like these
programs. Mozilla Mail and KMail are more single-purpose. Because
Evolution is the default client in the distribution included with this book
(Fedora Core 3), I cover this program in the most detail in this chapter.
This program should also be simple to add (see Chapter 12) to most dis-
tributions because it’s so popular.

Another popular mail program is Thunderbird (www.mozilla.org/
products/thunderbird), which is a spin-off of Mozilla Mail.

Setting up Evolution

The first time you open Evolution, the program walks you through the setup
process, so be sure to have the following information on hand:
»* Your assigned e-mail address, in the format username@example.org.
v The type of mail server used for incoming mail: for example, POP.

v The name of the mail server used for incoming mail, in the format
servername.example.org.

v The type of mail server used for outgoing mail: for example, SMTP.

v The name of the mail server used for outgoing mail, in the format
servername.example.org. This name may be the same as for the
incoming mail server.

v Any special type of authentication required, for both mail coming in and
going out. This authentication is typically just passwords for incoming
mail and may be nothing for outgoing mail.

After you start Evolution for the first time, the Evolution Setup Assistant
launches.
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Click Forward to proceed past the Welcome screen, after which the Identity
dialog box (see Figure 9-7) opens. To fill in this dialog box, complete the fol-
lowing steps:

1. Change the Full Name field, if you want.

Some people don’t want to use their real name and opt to use a nick-
name. There may or may not be default values assigned, depending on
what other programs you’ve configured on your machine.

2. Change the E-Mail Address field if it doesn’t match the address your
ISP gave you (it probably doesn’t).

3. If you want this particular account to be your default mail account,
make sure the Make This My Default Account check box is checked.
Otherwise, make sure it is unchecked.

4. Click Forward to proceed.
The Receiving Mail dialog box opens.

5. In the Server Type list box, select the type of incoming e-mail server
your ISP uses.

Evolution Setup Assistant

Identity

Please enter your name and email address below. The
"optional" fields below do not need to be filled in, unless
you wish to include this information in email you send.

Required Information
Full Name: Scruffy the Dog

Email Address: | scruffy@example.net|
Optional Information

[+! Make this my default account

Reply-To:

Organization:

# Cancel | | < Back | | > Forward
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Leave it as None if you don’t want to receive e-mail on this computer —
this setting is useful if you only want to be able to send or only want to
use the calendar and task management features in Evolution. Depending
on which item you choose, the dialog box changes to ask for the appro-
priate information. [ assume that you’re using a POP mail server to
receive mail, so what you’ll see when you select POP is shown in Figure
9-8. If you’re not using POP, then complete the dialog box you do see and
then proceed to Step 17.

The latest versions of Evolution have support for Microsoft Exchange

\\J
servers available. If you need this, it may or may not be already installed
in your distribution. For Fedora, use the information in Chapter 12 to
add the “evolution-connector” package to your system and then restart
the Evolution setup process.
6. Enter the full name for your POP mail server in the Host text box.
The name may be something like pop.example.com.
7. Enter your login name for checking mail in the Username text box.
If your e-mail address is jane@example.com, your username is jane.
8. If you were told to use SSL for security, in the Use Secure Connection
(SSL) drop-down list box, select either Always or Whenever Possible,
depending on what your ISP has specified.
Evolution Setup Assistant
Receiving Mail
Please enter information about your incoming mail
server below. If you are not sure, ask your system
administrator or Internet Service Provider.
Server Type: | POP '|
Description: For connecting to and downloading mail from POP servers.
Configuration
— Host: '|
Figure 9-8: Username: |scruffy
The ——
Evolution Scury
Receiving Use Secure Connection (SSL): | Never ¥
Mail dialog Authentication Type
box, with Password | 5 |
POP
selected [] Remember password
in Fedora
Core 3. | % Cancel | 4Back || B rorward
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Figure 9-9:
The
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Evolution
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Mail dialog
box, for POP
mail users
in Fedora
Core 3.

9.

10.

11.

12.

Receiving Mail Bz

Under Authentication Type, select the appropriate authentication
option.

If you don’t know what kinds of authentication your mail server uses,
click the Check For Supported Types button. Typically, it’s just
Password.

Check the Remember This Password checkbox so that you don’t have
to enter your e-mail password every time you check mail.

If you're going to walk away from your computer and someone else may
possibly access it, protect yourself from outgoing prank e-mails by going
to the main menu and selecting Lock Screen. Doing so makes sure that
no one can use your GUI until you type in your login password.

You have to have your screen saver turned on for this feature to work.
Screen savers are on by default.

Click Forward to proceed to the secondary Receiving Mail dialog box
(see Figure 9-9).

Whether or not this dialog box exists is determined by which type of
incoming mail server you're using. If you're not using POP and you get a
secondary dialog box, it may not match the one shown here, though it
does share some of the options shown.

If you want to check for new e-mail automatically, check the
Automatically Check For New Mail check box.

Evolution Setup Assistant

Please select among the following options

Checking for New Mail

[] Automatically check for new mail every io : minutes

Message storage

[ Leave messages on server

I Disable support for all POP3 extensions

% Cancel <4 Back ' P> Forward
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Evolution
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13.

14.

15.

16.

Sending Mail =4

If you don’t have a permanent connection to the Internet, you may
prefer to check mail manually. If so, leave the box unchecked and skip to
Step 14.

In the Minutes text box, set how often you want to automatically
check for new e-mail.

If you check mail from multiple computers, you may want to check the
Leave Messages On Server check box so that you can access the same
messages from all your machines.

If you select this option, you’ll end up with copies of messages on multi-
ple machines, but it also means that you’ll have access to your e-mail no
matter where you’re checking it from. Keep in mind that occasionally
you’ll need to uncheck this box and check mail, just to clear out all the
space that your e-mail is taking up on the server. You don’t want to run
out of space.

If your ISP told you not to use POP3 extensions, then check the
Disable Support For All POP3 Extensions check box.

Click Forward to proceed.

You're now finished setting up for incoming mail. In the Sending Mail
dialog box, shown in Figure 9-10, do the following:

Evolution Setup Assistant

Please enter information about the way you will send
mail. If you are not sure, ask your system
administrator or Internet Service Provider.

Server Type: | SMTP '|

Description: For delivering mail by connecting to a remote
mailhub using SMTP.
Server Configuration
Host:

[[] Server requires authentication

Security
Use Secure Connection (SSL): | Never "|
*| [Check for Supported Types |
| scruffy
] ]

% Cancel <4 Back B Forward
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17.

18.

19.

20.

21.

22.

23.

24.

25.

26.
27.

28.

29.

Change the Server Type entry if yours isn’t SMTP.

[ assume that you're sending e-mail with SMTP.

Enter the full name of the SMTP mail server in the Host text box.
The name may be something like smtp.example.com.

If you were told to use SSL for security, in the Use Secure Connection
(SSL) drop-down list box, select either Always or Whenever Possible,
depending on what your ISP has specified.

If you were told to use additional authentication for sending mail,
check the Server Requires Authentication check box.

Typically, nothing is required here. If you don’t check this box, skip to
the next set of instructions. Otherwise, proceed to the next step.

Under Authentication, select the appropriate type as instructed by
your ISP.

If you're not sure, click Check For Supported Types.

Under Username, enter the login name you’re supposed to use to
authenticate with your outgoing mail server.

This name may be different from the one you use for incoming mail.

Check the Remember Password check box so that you don’t have to
enter your password each time you send mail.

Just make sure, again, to log out or use the Lock Screen option so that
no one can send joke e-mails at your expense!

Click Forward to proceed.
You have now reached the wonderfully simple Account Management
dialog box.

Either leave the Name entry as it is (your e-mail address) or change it
to something descriptive so that you can tell which account you're
looking at if you have a list of accounts you need to use.

It’s common for your e-mail address to appear in this final box as some-
thing like jane@computer5.example. com. If this happens for you, you'll
want to edit this entry so that it matches your real e-mail address, which
in Jane’s case is jane@example.com.

Click Forward to proceed to the Timezone dialog box.

Click a city that’s in the same time zone you’re in or use the drop-
down list box to select your location or time zone.

Click Forward to proceed to the Done dialog box.
Here you see just a quick message saying that you're finished.
Click Apply to save your settings.

The Evolution program opens, as shown in Figure 9-11.
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Sending and checking e-mail

The following steps outline how to create a new e-mail message and send it:

1. Click New.

A Compose A Message window opens, as shown in Figure 9-12. If you
want to open another new item such as a new contact list entry or a new
calendar appointment, click the arrow next to New to open the list of
options to choose from.

2. Type the recipient’s e-mail address (such as bob@example.net) or a
list of addresses separated by commas (such as bob@example.net,
tom@example.org) in the To text box.

3. If you need to add a CC (Carbon Copy) or BCC (Blind Carbon Copy) to
the list of recipients, open the mail message’s View menu and select
the appropriate field(s) to appear and then enter the appropriate
address(es) into those fields.

4. Type the topic of your e-mail into the Subject text box.



Chapter 9: Using the Internet ’ 85

Compose a message
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5. In the lower window, type the body of your e-mail.

Use the handy formatting buttons and the Format menu if you want to
“pretty up” your e-mail. If you want to use the formatting buttons, set
your Format type to HTML first.

6. If you want to add a signature to the bottom of your e-mail, click the
drop-down list box next to Signature and select Autogenerated.

To create custom signatures, go to the main Evolution window and
choose Tools=>Settings to open the Evolution Settings dialog box (see
Figure 9-13). Select the account you want to create the signature(s) for
and then click the Edit button to open the Evolution Account Editor. In
this dialog box, in the Identity tab, click Add New Signature. Here, you
can create and format your new signature, and after you click the Save
and Close button, you can choose which signature should be the default
in the Identity tab’s Signature drop-down list box. Get rid of the extra
dialog boxes by clicking OK or Close on each one.

7. When you finish typing your message, click the Send button.
The e-mail is now added to your Outbox, where you can edit it if you want.
8. Click the Send/Receive button.
Your e-mail goes out, and Evolution checks for new incoming mail.
Take some time to really explore Evolution. As you can see just from the fig-

ures in this chapter, this program has many features, including the ability to
filter junk mail.
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Taking Advantage of Instant Messaging

Instant messaging between people is like using a telephone — except that you
type your conversation rather than speak it. In addition, you can simultane-
ously hold multiple instant messaging conversations without the need for
additional connections to the Internet. America Online (AOL) provides one
popular instant messaging service, named AOL Instant Messenger, or AIM.
Others are ICQ and MSN. A wide variety of computer operating systems,
including Linux, support these various services (and, in fact, GAIM runs on
more than just Linux).

The distributions covered in this book use the following instant message pro-
grams by default:

v Fedora: Gaim (http://gaim.sourceforge.net/)

v Knoppix: Gaim

v Linspire: Gaim

v Mandrake: Kopete (http://kopete.kde.org/)

v SuSE: Kopete

v~ Xandros: Kopete (http://kopete.kde.org/)
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Because Gaim is the default in Fedora, that’s what I cover in detail.

Using the Gaim Instant Messenger

You launch Gaim with the following menu selections:

v Fedora: Choose Applications=Internet=>IM (GAIM Internet Messenger).

+* Knoppix: From the main menu, choose Internet=>Gaim Instant
Messenger.

v Linspire: From the main menu, choose Programs=Internet=>Instant
Messenger.

After the application starts for the first time (see Figure 9-14), its main and
account management dialog boxes both appear. To tell GAIM about one of
your IM accounts:

1. Click the Add button in the Accounts dialog box.

The Add Account dialog box, shown in Figure 9-15, appears.

gai 3
s oW
.\_

Account:

P
14

& ® @

Accounts Preferences Signon

Screen Name |0n|ine |Auto—lngin Protocol '

#Add || uodify || @oelete || % Close
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2. In the Protocol drop-down list box, select the IM network you want

to use.

Your options are AIM/ICQ (if you need to use either AIM or ICQ, choose
this option), Gadu-Gadu, Groupwise, IRC, Jabber, MSN, Napster, SILC,
Yahoo, and Zephyr.

3. In the Screen Name text box, enter the login name for your IM

account.

If you're using ICQ, use your membership number.

4. In the Password text box, enter your IM password for this account.

5. In the Alias text box, enter the name you actually want to have show

up in people’s IM clients, unless you want to use your screen name.

6. Click the Remember Password check box to put a check in it so that

you don’t have to enter your password every time you connect to this
IM service.

Remember to log out or use the Lock Screen option if you walk away
from your computer, just in case someone gets it in his head to go play a
trick on you and send messages to people using your IM client.

7. Check the Auto-Login box if you want GAIM to automatically log this

account on when you start it.
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8. If you get e-mail through this service and want to know when new
mail has arrived, check the New Mail Notifications check box.

9. If you want to use a tiny picture as a buddy icon (of yourself, your
dog, or whatever else you might want to use), click the Open button
next to the Buddy Icon label and then navigate to the picture you
want to use.

10. If you want access to the more advanced options for this IM service,
click the Show More Options arrow to expand the Add Account
dialog box.

11. When you finish entering your information, click Save to add this IM
account to your accounts list.

Go through this process for each account you want to use with GAIM. Then,
in the main dialog box , click Sign On to log into all the accounts that you
selected as Auto-Login. You can also open the Accounts dialog box by click-
ing Accounts from the main dialog box and then clicking the individual check
boxes next to the accounts to log into them one by one. After you connect,
you can alter your preferences in the Buddy List dialog box by choosing
Tools>Preferences. Again, GAIM has more to it than this, so it’s definitely
worth playing around with this tool.

Troubleshooting your IM connections

If you've been using most of these IM clients with other operating systems,
after your Linux system has successfully connected to the IM service, your
existing buddy lists are automatically imported. If you haven’t ever used AIM
or MSN, you can now set up buddy lists. Buddy lists contain the usernames of
people you want to communicate with through the instant messaging service.
Your buddy list lets you know when your “buddies” are online and available
to receive an instant message.

Sometimes, your Linux system is unable to connect properly to the IM ser-
vice. When this problem happens, an error message pops up on your screen
and indicates a failure to connect. You may be unable to connect to the IM
service for several reasons:

v You may have entered the wrong password for your IM account or
chosen the incorrect IM account name.

v Your computer may not be connected to the Internet. Try opening your
Web browser to see whether you can get to a Web site, which tells you
whether you're connected to the Internet.
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v If you can open a Web site but can’t get IM to work, the IM system may
be unavailable. This problem occurs at times because of maintenance of
the IM service or an excessive amount of traffic on the Internet or on the
IM service.

v If you attempt to access the IM service from your computer at work,
your company or organization may block the IM service for security or
productivity reasons. If using IM at your work is permitted, check with
your network administrator to see whether he can help you out.

v Often, companies use firewalls between the company’s network and the
Internet to keep out unwanted traffic on the company’s network. If the
firewall is configured to block IM traffic, you cannot use IM across the
Internet.

Working with Other Internet Tools

You may want to explore a variety of other types of tools, depending on your
needs. This section covers some pointers to get you started, so if you go to
Chapter 12 and want to add the appropriate software (or find yourself digging
through menus and wondering what the program may be called), you aren’t
completely lost.

v FTP programs: If you want to FTP, a commonly used program in the
Linux world is GFTP. This program is available for all five distributions
discussed in this book, although it’s only installed by default in
Mandrake. The KDE equivalent is KBear.

+ IRC programs: While the IM clients support IRC these days, you may
prefer a program that’s used only for IRC. Common programs for this
purpose are X-Chat and KIRC.

v~ File sharing: LimeWire is a popular one if you want to use the Gnutella
network.

v RSS readers: Firefox has a number of RSS extensions designed for it. In
addition, Straw is a popular RSS program.

In general, if you're not sure what programs to use, do a Web search on the
type of thing you want to do (like RSS) and the word Linux. So, to find all the
Linux-based file-sharing programs that handle BitTorrent (a popular network
for distributing, among other things, legal copies of Linux distributions), you
can search on

file sharing bittorrent Tinux
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In this part . . .

n this part of the book, I expand my coverage of Linux

beyond what’s part and parcel of the operating system
to include its many other facilities and capabilities. These
components are critical to making Linux the raging mon-
ster of productivity that a well-constructed, properly con-
figured system can represent.

Here you read about the Linux file system and how to
manage its constituent files and directories, as well as how
to control which users or groups are permitted to access
these vital system resources. You also can read about
using the Linux command-prompt environment, known as
the shell, along with some key capabilities that should be
part of any savvy Linux user’s standard repertoire.

In addition, you find out how to keep your system current
and install new software. You also get the inside scoop on
all that security stuff that computer experts are always
going on about. Those who like working without a net can
dabble with working on the command line, while those who
want nothing to do with (gasp) typing can leap straight to
the fun of customizing the look and feel of your GUIL.




Chapter 10

Manipulating Files
and Directories

In This Chapter

Encountering Linux file types

Managing Linux file permissions

Maneuvering through the file system

Working with file system contents

Referring to multiple files at once using wildcards

There is no need to do any housework at all. After the first four years, the
dirt doesn’t get any worse.

— Quentin Crisp

Fere’s no avoiding it. At some point, you have to work with the files and
directories in your system. Fortunately, after you get familiar with the
rules and commands, you feel more comfortable (even if you find yourself
being reminded from time to time of working in good old MS-DOS). Because
many people find that working at the command line is easier when dealing
with files, in this chapter I cover both the typed commands and the graphical
tools you have at your disposal.

Working with Files in the GUI

People who prefer to stay graphical like to work with the GUI file managers
offered in Linux instead of having to access a command prompt to work with
files. A file manager is a program, such as Windows Explorer, that enables you
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to dig through and manipulate your files and directories with your mouse and
sometimes just a bit of typing. In this section, I take you on a tour of the file
managers that, by default, come with popular Linux distributions.

Sailin’ with Nautilus

In the GNOME desktop environment (so in Fedora Core if you're using the dis-
tribution defaults), the file manager is Nautilus. To find this program, double-
click the Home icon on your desktop. Figure 10-1 shows an example of what
you can see with Nautilus open in an example home directory.

If you want to play with a more sophisticated version of Nautilus, select
Applications=>File Browser.

Finding your way around

Moving through the file system in Nautilus involves a couple of different
skills. In the first place, you need to know where you want to begin. This
factor decision isn’t as difficult as it sounds, however. In the Places menu,
you find the following options:

v Home: Your home directory, which is where all (or most of) of your files
and documents go.

v Computer: All your hard drives, floppy drives, CD and DVD-ROM drives,
and other permanent and removable storage devices.

v Templates: Your document templates. Copy or move a document into
this section (I tell you how in the section “Copying and moving files,”
later in this chapter). When you right-click on your desktop and choose
Create Document from the context menu that appears, you're able to
choose the items in your Templates folder as a basis for the document
that you want to make.

v Trash: The contents of your trash bin. [ address how to empty it in the
section “Taking out the trash,” later in this chapter.

v CD Creator: Your CD waiting room. If you want to make a CD that con-
tains a bunch of files (as opposed to creating an ISO image), move those
files to this location. You can find out about creating CDs in Chapter 18,
because many people create CDs in the context of multimedia.

After you choose one of the preceding commands, a separate window opens,
leaving the window you were already working in open as well. You can close
the original window if you want by choosing Filez>Close or clicking the X in
the window’s upper right corner.
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Navigating your filesystem

To open a directory in Nautilus, locate its name in the list and double-click it.
A new folder that contains the directory’s contents opens. As you move
through subdirectories, a new folder opens each time. If you find that you've
got way too many directories open, choose one of the following commands:

v Filer>Close Parent Folders: Closes all the folders used to get to this
directory.

v~ Filer>Close All Folders: Closes all the file browser folders you have open.
v Filec>Close: Closes just this folder.

You can also return to a folder previously accessed, if you want. (For exam-
ple, maybe you’re in /home/jane/documents/invoices and want to go back
to /home/ jane without opening and closing multiple folders). To do so, look
at the very bottom of the folder window to find the name of the subdirectory
you’re in (such as invoices). Click that name, and you open a list that has all
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the parent directories plus the current one. The list might look like the fol-
lowing for the example:

home

jane
documents
invoices

Then, to back up, you can select the spot in the directory tree (for example,
jane to go to /home/jane) you want to move to.

Setting how much you see in a folder

Are you getting too much information about each file or not enough?
Experiment with the View menu. The major listing options under the View
include the following commands

v View As Catalog: This command is available only when images are in the
folder, as shown earlier in Figure 10-1. It shows all the images as though
you're looking through a photo album and doesn’t show anything else.

v View As Icons: This default option shows all files as icons with names
beneath them (see Figure 10-2).

v View As List: This command gives you a list of information about the
file, as well as its icon and name (see Figure 10-3).

File Edit View Places Help

o

Desktop 579371 fg0601.tif

[ ——|

579371 fg0602.tif 579371 fg0603.tif

579371 fg0702.tif 579371 fg0703.tif

dee » 28 items, Free space: 2.2 GB
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Along with these View menu commands, you can also use

v Reload: If you just created a file and don’t see it in the folder, select this
option.

v Show Hidden Files: All files in Linux whose names start with a dot (for
example, .profile) are hidden files, meaning that you have to explicitly
tell Linux you want to see them.

v~ Visible Columns: Opens the folder’s Visible Columns dialog box, which
you can use to pick the information (and its order) that appears when
using View As List.

Along with these commands, you can choose the View menu’s Zoom In, Zoom
Out, and Normal Size options if you need to change the size of the folder’s
contents.

Opening files and running programs

To open a file or run a program in Nautilus, double-click it. That’s it! Well, not
entirely. You can also right-click a file to open the context menu and then
choose one of the following from the context menu:

v Open with program: If the file is associated with a particular program
already, choosing this option is the same as double-clicking the file.
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More than one of these options may be listed, if your system knows that
you have more than one program installed that can do the job.

1 Open with Other Application: Choosing this option opens a submenu
that (often) contains a list of installed programs that can handle this file.
You can select one of these programs or choose Open With Other Appli-
cation to open the Open With dialog box. From this dialog box, you can

¢ Type in the full path to the application (the full directory path, like
/usr/bin/konqueror)

e Click the Browse button to open a file browser and surf to the pro-
gram you want to use

After you select the program to open the file with, click Open to proceed.

Copying and moving files

You can copy and move items using two different methods in Nautilus. The
first is by using the usual method you’re probably familiar with from Windows
or the Mac OS — clicking and grabbing a file or folder and then dragging it
where you want to go. You can click and drag between folder windows and
into folder icons. Following are some handy tips:

v Hold down the Ctrl key while you drag if you want to make a copy rather
than just move the file.

v If you want to drag the file into a folder icon, make sure that the folder
icon is highlighted before you release the mouse.

v~ If you want to drag the file into a folder window but not into one of the
folder icons, make sure that the folder icons are not highlighted before
you release the mouse.

The other method for copying and moving files and directories involves the
following steps:
1. Right-click the file or directory you want to copy or move.

2. From the context menu that appears, choose Cut File if you want to
move the file or Copy File if you want to copy it.

The file doesn’t disappear after you make your selection if you're trying
to move it.

3. Select the folder you want to move the file into.
Don’t double-click it; just click it.
4. Do one of the following:

e [f you want to move or copy the file into a folder window, right-
click inside that window (just make sure that nothing is high-
lighted) and then choose Paste Files.
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e If you want to move or copy the file into a folder icon, right-click
the icon and then choose Paste Files Into Folder.

Creating files and folders
To create a new file or folder in Nautilus:

1. Browse to the folder you want to create the item in.

You need to open a window for that folder and work from within that
window.

2. Right-click on an empty spot inside that folder.

Make sure that you didn’t highlight anything in the folder.) A context
menu appears.

3. Depending on what you want to accomplish, choose either Create
Folder or Create Document.

The Create Folder command creates a new folder in this directory. The
Create Document command opens the submenu that lets you choose to
create either a document from a Template (top section, if you already
have templates created) or an Empty File.

The folder or file appears, highlighted.

4. Type the name you want to assign to this folder or file and then press
Enter.

The name is assigned to the folder or file.

Deleting files and folders

To use Nautilus to delete either a file or a directory from the file system,
follow these steps:
1. Browse to the file or directory’s location.
2. Select the file(s) or folder(s).
You can select the file or folder by doing one of the following:
e Clicking the item to highlight its name.

¢ Holding Shift down and then clicking at the end of the row or column
you want to select. (These items all must be lined up straight.)

¢ Holding Ctrl down and clicking each individual item you want to
select.

¢ Clicking and dragging your mouse button so that you make a box
that contains all the items you want to select.

3. Press the Delete key or right-click and select Move To Trash.

The file or folder vanishes from view. Keep in mind that if the folder con-
tains other files or folders, they go right along with it.

199
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,‘f These deleted items aren’t fully deleted yet. Deleting with Nautilus puts the
files in the Trash folder, which you can open by double-clicking the Trash
icon on your desktop or choosing Placest>Trash in the Nautilus window.

Taking out the trash
You can permanently delete the contents of your Trash folder by following

these steps:
1. Right-click the Trash icon.
This action opens a shortcut menu with options listed.
2. Choose Empty Trash from the shortcut menu.
A confirmation dialog box opens.

3. Click Empty in the confirmation dialog box to delete the contents of
the Trash folder.

Linux permanently removes the items in the Trash folder. You can tell
whether the Trash folder is by looking at the Trash waste can. If it’s
empty, it contains no files. If you see papers in it, it contains trash.

Viewing and changing permissions

Every file in Linux (and other forms of Unix) has a set of permissions that
govern who is allowed to view it, run it, delete it, and so on. These permis-
sions are used to make sure that people can’t mess with the system’s or each
other’s files, so they’re pretty important. In this section, I focus on how to
work with files in the GUI. See the section “A permissions primer,” later in
this chapter, for a breakdown of how file permissions work.

To view and change a file or directory’s permissions in Nautilus, you need to
follow these steps:
1. Browse to the file or directory’s location.
Opening the folder window that contains this item is sufficient.
2. Right-click the file or directory.
A context menu appears.
3. Choose Properties from the context menu.
The Properties dialog box appears with the Basic tab open.
4. Click the Permissions tab.

The Permissions portion of the Properties dialog box appears, as shown
in Figure 10-4.
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5. Set the new permissions and ownerships.

See the section “A permissions primer,” later in this chapter, for a break-
down of what all this stuff means.

6. Click Close to close the dialog box.

The file’s permissions are now changed.

Rulin’ with Konqueror

In KDE (and thus Linspire, Mandrake, and SuSE), the default file manager is
Konqueror, shown in Figure 10-5. You can access this program in these distri-
butions by doing the following:

v Linspire: Double-click the My Documents icon.

v Mandrake: Double-click the Home icon.

v SuSE: Single-click the My Computer icon.
Keep in mind that Konqueror looks slightly different from distribution to dis-
tribution and may have different default settings as well. For example, SuSE
has a little side pane, while Linspire and Mandrake do not. You can turn the

side pane on and off by pressing F9 or choosing Window=>Show Navigation
Panel.
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Navigating your filesystem

Moving through the file system in Konqueror mostly involves being familiar
with the main row of icons beneath the top menus. These icons are, from left
to right:

v Up arrow: Go up a directory. For example, from /usr/binto /usr.

v~ Left arrow: Go back to the last directory you visited.

v~ Right arrow: If you went back previously, takes you to the directory you
went back from.

v Home: Shows the contents of your home directory.
Some of the distributions, such as SuSE, offer extra shortcuts in the Go menu.

To open a directory in Konqueror, locate it in the list and click or double-click
it, depending on how your system is set up to behave. (In Linspire and
Mandrake it’s double-click, while in SuSE, it’s just a single click.) The window
changes to that folder’s contents.

Setting how much you see in a folder

If you want to see more or less information about each file, experiment by

choosing View=>View Mode (or find the icons to the right of the Konqueror
icon bar, below the menus). The major listing options in Views>View Mode
may include (depending on the version of Konqueror you're using):

v Icon View: Shows all files as icons with names beneath them (refer to
Figure 10-5). It’s the default option

+* MultiColumn View: Lines your icons up in columns instead of rows.
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Figure 10-6:
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option in
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directory in
SuSE9.2.
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v Tree View: Shows a list of information about the file, as well as its icon
and name (see Figure 10-6). You can expand each folder in this list by
clicking the plus sign next to it; to collapse the list, clicking the minus
sign next to it.

v Info List View: Shows the icons and names in small list format.

v Detailed List View: Works like Tree View, but lacks the ability to expand
and collapse directories.

v Text View: Works like Detailed List View but without the pretty icons.

v GwenView Image Browser View: Lets you use an image browser embed-
ded in your file browser (Figure 10-7). If you choose this view option, use
the left hand tabs to click on the Home icon and browse to the folder
you want to view.

v~ File Size View: Shows a funky graphical representation of your filesys-
tem (Figure 10-8), with directories in blue, files in brown, and programs
you can run in green. It’s not available in all the distributions covered in
this book, as this feature is pretty new. When you add new files, they
don’t show up unless you choose Viewr>Reload or click the Reload icon.

[ drives:/ - Konqueror .53

Along with these View menu settings, you can also use

v Reload: If you just created a file and don’t see it in the folder, choose
this option.

v Show Hidden Files: All files in Linux whose names start with a dot (for
example, .profile) are hidden files, meaning that you have to explicitly
tell Linux you want to see them.

v~ Specialty menus: Each view type has an additional configuration menu
available toward the bottom of the View menu.
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Figure 10-7:
Konqueror
with the
GwenView
Image
Browser
View option
indee's
home
directory in
SuSE9.2.

Figure 10-8:
Konqueror
with the
FSViewPart
option in
dee’s home
directory in
SuSE9.2.
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Figure 10-9:
Konqueror's
Open With
dialog box in
SuSE9.2.
|

Opening files and running programs

To open a file or run a program in Konqueror, single or double-click it,
depending on the distribution you're using and how it’s set up. That’s it! Well,
not entirely, Konqueror itself may not support the file format. You can also
right-click a file to open the context menu and choose Open With. From there,
you can either choose one of the suggested options in the context submenu,
or you can choose Other to access the Open With dialog box (Figure 10-9). To
use this dialog box:

1. Either browse in the lower section to select which program you want
to use to open this file or type the full path to the application (the full
directory path, like /usr/bin/konqueror) in the text box.

If you need to browse the filesystem, click the little folder icon to the
right of the text box to open the browser.

2. If you want to always use this application to open files of this type,
check the Remember application association for this type of file
checkbox.

3. Click OK to open or run the file.

/2= file:/home/dee/579371 fg0608.tif B3 e

Open with:

B |®

| Known Applications

=
+
| - 7) Applications
| % Qt Settings

+- 5| Development
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, -« Graphics
+-@diInternet

; <& Multimedia
+-¢ Office

+ i System

-l

[/ Run in terminal
|}
| Remember application association for this type of file

| & cancel |

Copying and moving files

You can copy and move items using two different methods in Konqueror. The
first is by using the usual method you’re probably familiar with — clicking
and grabbing a file or folder and then dragging it where you want to go. The
Tree View is handy for this method because you can open up folders until
you find the one you want to copy into and then click and drag the file or
folder into it. When you do so, a little context menu pops up asking whether
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you want to move the file, copy it, link it (see the section “Understanding
directory contents” to find out more about links), or cancel and not do
anything.

The other method for copying and moving files and directories involves the
following steps:

1.
2.

3.

Right-click the file or directory you want to copy or move.

In the context menu that appears, choose Copy To if you want to move
the file or Move To if you want to copy it.

A new menu appears.
Select the folder you want to move the file.
You can do so by:

¢ Navigating through the submenus until you find the location you
want and choosing Copy Here or Move Here from inside the folder
you want to use.

e Clicking the Browse button and using the file browser to navigate to
where you want to copy or move the file to and then clicking OK.

Creating files and folders
To create a new file or folder in Konqueror:

1.
2.

Browse to the folder you want to create the item in.
Right-click inside that folder.

Make sure that you didn’t highlight anything in there. A context menu
appears.

. Choose Create New.

A submenu appears.

. Depending on what you want to accomplish, choose either Folder or

File.
These commands do the following:
¢ Folder: Creates a new folder in this directory.

e File: Opens the submenu that lets you choose to create a new
HTML File (Web page), Link To Application (program shortcut),
Link To Location (Web link), or Text File.

. In the query dialog box, enter the name for the folder or file you’re

creating.

. Click OK to finish the creation process.
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Deleting files and folders

To use Konqueror to delete either a file or a directory from the file system,
follow these steps:

1. Browse to the file or directory’s location.
2. Choose the file(s) or folder(s) you want to delete.
You can do so by:

¢ Holding Shift down and then clicking at the end of the row or
column that you want to select. (These items all must be lined
up straight.)

¢ Holding Ctrl down and clicking each individual item you want to
select.

e Clicking and dragging your mouse button so that you make a box
that contains all the items you want to select.

3. Delete your file or folder.
To do so, either:

¢ Press the Delete key and say that yes, you want to move this item
or these items to the Trash.

¢ Right-click over the item(s) and choose either Delete to perma-
nently remove the file or Move To Trash to give yourself the option
to back up and pull it back out of the Trash later.

Taking out the trash

You can permanently delete the contents of your Trash folder by following
these steps:

1. Right-click the Trash icon.
This action opens a shortcut menu.
2. Choose Empty Trash Bin.

Linux permanently removes the items in the Trash folder. You can tell
whether your waste can is empty by looking at it. If nothing’s in there,
it’s empty; if you see papers in it, you have files in the Trash.

Viewing and changing permissions

Every file in Linux (and other forms of Unix) has a set of permissions that
govern who is allowed to access it, run it, delete it, and so on. These permis-
sions are used to make sure that people can’t mess with the system’s files,
or each other’s, so they’re pretty important. See the section “A permissions
primer,” later in this chapter, for a breakdown file permissions in general. |
focus here on how to work with them in the GUIL








































































Chapter 11: Checking Out the Linux Filesystem 2 3 1

\NG/
&VQ‘“

10.

11.

12.

13.

You never, never, never, never, never want to run the command I'm
about to use on a partition you’re using or you will mess it up badly!

. Type df -h again to make sure that this partition is no longer listed.

In the example, you should now see:

Filesystem Size Used Avail Use% Mounted on
/dev/hde? 54G  27G  24G 54% /

none 506M 0 506M 0% /dev/shm
/dev/hdf3 54G  39G 13G  76% /mnt/FC1

See, no /boot partition!

. What you type now depends on what type setting /boot had:

¢ ext2 or ext3: Type e2fsck -fy partition,suchase2fsck -fy
/dev/hdel

¢ reiserfs: Type reiserfsck --fix-fixable partition,such
as reiserfsck --fix-fixable /dev/hdel, and if this gives
you more errors, follow with reiserfsck --rebuild-tree
partition,suchas reiserfsck -rebuild-tree /dev/hdel

. Type exit and let the machine try to reboot.

If the machine can reboot, you're done, yay! If not, return to Step 6 and
run through the process again. Sometimes, you actually need to try
the fix more than once. If you reboot again at the end and it still fails,
proceed.

Repeat Steps 1 and 4, but this time look for the lines that correspond
to the / directory.

In my example, / is mounted from /dev/hde?2 and is formatted using
ext3. Unfortunately, you can’t remove the / filesystem since it’s got all of
your commands! But, there is still a safe way to do this.

Type mount -o remount,ro /.

This command releases the root (/) partition and then adds it again, but
this time as read-only so things won’t be changing as you’re working on
it. That makes what you’re about to do safe.

Repeat Step 8 for the / partition.

So, for my example, the / partition is /dev/hde?2, so you'd be starting
with ext2fsck -fy /dev/hde2 or reiserfsck --fix-fixable
/dev/hde2

Repeat Step 9.

Again, if it fails to reboot, repeat Steps 10 through 12 to see whether that
fixes things.

Unfortunately, at this point, if the problem still occurs, it could be many,
many things. Now is a good time to go to your local Linux Users’ Group (see
Chapter 4) or online help site.
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Don’t run out of room!

One of the most insidious problems that all computer users run into from time
to time is a lack of disk space. The scope of this problem really depends on a
number of things. The primary issue is that, if your root partition becomes 99
or 100 percent full, you need to use emergency rescue techniques (refer to
Chapter 5) to boot the machine and clean it out. That’s no fun, is it?

In the beginning, you’re probably not in danger of filling the drives, unless
you barely had enough room to install Linux in the first place. However, over
time, you may forget about watching the drives for remaining space. Even
experienced administrators run into this problem, so certainly you're for-
given if you do it too!

Really do try to make doing the following a habit:

1. Open a command prompt window (see Chapter 14).

2. Type df -h.
That’s it! As you can see earlier in the section “If your machine fails to
reboot,” though you ignored it at the time, the columns include

v Size: How big the partition is.

v Used: How much of the partition has been used already.

v Avail: How much is left.

v Use%: So we don’t have to do mental math, a % of how much of the par-

tition has been used up.

When you start reaching 90 percent, it’s time to start doing some
housecleaning!



Chapter 12
Adding Software to Linux

In This Chapter

Recognizing tarballs, RPMs, and compressed files

Creating tarballs and archives

Compressing files

Opening tarballs, archives, and compressed files
Installing and removing RPMs

I will make you shorter by the head.
— Queen Elizabeth I

Wlen you start using a new operating system, one of the most frustrating
things is trying to figure out all the goofy file extensions. The Windows

world has .exe and .zip. The Macintosh world has .bin and . hgx. What
about the Linux world? It certainly has its fair share of bizarre extensions,
but, really, they make a great deal of sense after you know the programs that
make them. In this chapter, you find out all about .tar, .gz, .tar.gz, .tgz,
.bz2, and . rpm. Anyone up for a game of Scrabble with alphabet soup?

After you've got the letter jumble all figured out, you’ll be happy to find that
Linux offers a number of cool tools for working with these crazy files, updat-
ing your system, adding new software, and more.

Opening Downloaded Files

The Linux and Unix worlds are full of strange terms and acronyms. For exam-
ple, if someone comes up to you out of the blue and starts talking about tar-
balls, you probably get a mental image of sticky, smelly balls of tar, maybe
rolled in feathers. Yet a tarball is something you run into regularly in the Linux
world, especially when you’re looking for software or you need to save your-
self some space. A tarball is a bunch of files (and possibly directories) pack-
aged together in a tar file and then compressed by using the gzip utility.
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WinZip can open tarballs with no problem on a Windows computer.
Fortunately, all you need to know is how to double-click a file in order to
access the many types listed in Table 12-1. Once you double-click the file,
your File Manager shows you what’s inside.
While Table 12-1 mentions operating systems, ‘it doesn’t contain hard and
fast rules. People tend to use whatever kind of programs they’re comfortable
with no matter what operating system they’re on.
Table 12-1 Potential Formats for Downloaded Files
Extension Meaning Program(s)
Involved
.bz Older form of .hz2. bzip, bunzip
.bz2 Extensive Linux and Unix compressed file. bzip2, bunzip2
.deb Not a file to “open;” see the “Installing New apt
Software” section, later in this chapter.
.gz Typical compressed file for Linux and Unix. gzip, gunzip
.iso A CD-ROM or DVD-ROM “image,” whichis a See Chapter 18.
single file that contains a CD or DVD’s entire
contents. You have to tell your CD or DVD burner
software that this file is an image so that it knows
not to just place a copy of this file onto the media.
.rpm Not a file to “open;” “““see the “Installing rpm
New Software” section, later in this chapter.
tar A bunch of files bundled together. tar
tar.bz2 A tarball, which in this case is a .tar file inside tar, bzip2,
a .bz2 file. bunzip2
tar.gz A traditional tarball, which is a .tar file tar, gunzip, gzip
inside a .gz file.
tgz A traditional tarball, which is a .tar file tar, gunzip, gzip
inside a .gz file.
Z 0ld-style Unix compressed file. compress,
uncompress
.zZip Windows ZIP file. zip, unzip
\\J

WinZip (www.winzip.com) can handle .gz, .tgz, and .tar.gz files (along with
the .bz2 versions) for Windows users.
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Compressing and Packaging
Files to Share

Life isn’t all about “take, take, take” (or at least I should hope not!) Sometimes
you've just gotta give. Creating care packages to share with other folks
involves learning how to tell Nautilus (GNOME users) or Konqueror (KDE
users) that you want to do so. However, because the overall process is so
similar, I don’t break these steps down into separate sections.

To package up and compress files for sending off to other people, navigate to
the location where you’ve stored the file(s) — see Chapter 10 for how to
move about — and then:

1. Determine whether you want to compress or package a single file, a
group of files, or a whole folder.

If the files and folders that you want to bundle together are flung all over
the place in your folders, you may want to create a new folder and copy
the items you want to bundle together into it. Chapter 10 shows you
how to do so.

2. Select the item(s) you want to package.

Chapter 10 explains how to do so. If you want to select a whole folder,
navigate into its parent folder and just select the folder’s icon instead of
entering it.

3. Right-click over the item(s) (or if you’re using Nautilus, you can also
choose the Edit menu).

The context menu appears if you right-clicked or, in Nautilus, the Edit
menu opens.

4. Create your archive.
How you create your archive depends on what distribution you’re using:

¢ Fedora: In the context or Edit menu, choose Create Archive. In
both cases, the Create Archive dialog box appears, suggesting a
tarball (see Table 12-1) version of the file. If this is what you want,
leave it alone, or change the file extensions (as discussed in the
table) to match what you want. Then click Create, and you're fin-
ished with these steps.

¢ Knoppix and Mandrake: In the context menu, select Actions and
then the appropriate Create option as guided by Table 12-1: Create
gzipped tar Archive means to make a .tar.gz or .tgz file; Create
bzipped tar Archive means to make a .tar.bz2 or .tbz2 file; and
Create zip Archive means to make a .zip file.

¢ Linspire: You cannot use the file browser in Linspire 4.5 to create
an archive. Instead, you’ll have to go to the main menu=~>Programs=
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Utilities=>Archiving Tool to open the Ark program (which is avail-
able with most of the distributions listed here as well).

e SuSE: In the context menu, select Compress>Compress As. See
Table 12-1 to help you determine which format you want to use.

¢ Xandros: In the context menu, choose Add to ZIP Archive if you're
sharing with Windows users, or Create TGZ Archive to make a tar-
ball, as discussed in Table 12-1.

5. If you want to rename the file or change where it should go in your
filesystem, do so now.

Leave the .tar.gz or .gz part alone. Just change the first part. For
example, if you're archiving the Files folder, then the suggested name
might be Files.tar.gz. If you wanted to use Files100305.tar.gz for
the actual name, you would just add the date into the existing name.

6. Click OK.

The archive is created.

Updating Vour Software

a\\S

In the last couple of years, updating your operating system and software in
Linux has become easier and easier. Each Linux distribution has its own way
of handling updates, so I cover how to do update each one in its own section.
The cool thing is that you're actually updating your operating system and its
software all at once. Be sure to be connected to the Internet before you try to
update!

[ don’t cover how to update Knoppix, however, because if you're using
Knoppix, you didn’t install anything to update! If you're interested in
installing and updating Knoppix, see Chapter 21.

Updating Fedora

If you look to the right of your upper Fedora panel, you see a big red circle
with a white exclamation point inside or a blue circle with a checkmark. This
is your updater, and once you configure it, the red circle warns you that
you’ve got updates available that you haven’t applied yet. Click this icon,
and the Red Hat Network (RHN) Alert Notification Tool dialog box appears
(see Figure 12-1). You can see the updates available in the main (Available
Updates) tab, where you can decide whether you want to launch the updater.

To update your system from the RHN Alert Notification Tool:

1. Click Launch up2date.
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Red Hat Network Alert Notification Tool
Available Updates |Ignored Packages

Figure 12-1: Your system currently has up2date-4.3.38-1.1 installed, but the latest available
The Red Hat || version is up2date-4.3.40-1. It is recommended that you upgrade to the latest
Network up2date before updating any other packages.
Alert
Notification
Tool dialog
box,
Available

Updates tab. Launch up2date... | | X Close |
I

This action opens either the Red Hat Network Configuration dialog

box, shown in Figure 12-2, or the Red Hat Update Agent, depending on
whether you've already configured this tool — either way, you may first
be asked to enter your root (administrative password). If you get the
Configuration dialog box, then proceed to Step 2. If you get the Update
Agent, skip to Step 10.

2. If your ISP or employer requires you to use a Web proxy, then click
the Enable HTTP Proxy check box to put a check in it; otherwise, skip
to Step 6.

3. Enter the address for your proxy in the associated text box.

4. If the proxy requires authentication, click the Use Authentication box.
If not, skip to Step 6.

5. Enter your proxy login and password in the Username and Password
text boxes.

Red Hat Network Configuration [=I=0x]
Network Settings
Select a Red Hat Network Server to use
https://xmirpc.rhn.redhat.com/XMLRPC | ﬂ &' Refresh

If you need a HTTP proxy, enter it here in the format HOST:PORT
— e.g. squid.mysite.org:3128
Figure 12-2: [ Enable HTTP Proxy: |

The General [ Use Authentication
tab of
Red Hat
Network
Configura-
tion dialog
box.
—

# Cancel & 0K
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|
Figure 12-3:
The
Package
Exceptions
tab of the
Red Hat
Network
Con-
figuration
dialog box.
|

[ am going to skip the Retrieval/Installation tab because I recommend
that you keep all the defaults anyway. If you want to find out more about
what’s available in this tab, point a Web browser to www.redhat.com/
docs/manuals/RHNetwork/ref-guide/3.4 and click section 2.4.1,
“Using the Red Hat Update Agent Configuration Tool.”

. Click the Package Exceptions tab to move to this section of the dialog

box (see Figure 12-3).

Red Hat Network Configuration

General I Retrieval / Installation| Package Exceptions

Package Names to Skip
Add new: | | Add ‘
kernel*

Edit

Remove

File Names to Skip
Add new: | | | Add |

Edit

|| Remove
| # Cancel & 0K

10.

11.

. Click kernel and then click Remove.

You’re now able to automatically update your operating system as well
as your software.

. Click OK to proceed.

A Question dialog box opens. It asks you about creating a GPG (www .
gnupg.org) security key.

. Click Yes.

You’re now able to have your updater verify that the updates sent to you
are from Red Hat and not from some nasty place! Now the Welcome To
Red Hat Update Agent dialog box appears.

Click Forward to proceed.
The Channels dialog box, shown in Figure 12-4, appears.
Click Forward to proceed.

A progress window appears, showing you a slider bar as the updater
checks to see what’s available. Once the available updates are recorded,
the Available Package Updates dialog box appears.



|
Figure 12-4:
The update
agent's
Channels
dialog box.
|

Up2date - Channels

Description Channel

fedora-core-3 fedora-core-3
updates-released-fc3 updates-released-fc3

To subscribe or unsubscribe from channels, or for
more information about the channels available, see:
https:/rhn.redhat.com
Channel Information

iyum channel fedora-core-3 from http:/fedora.redhat.com/download/up2date-mirrors/fedora-
ore-3

% Cancel | [ @aci | [P Eorward

12. Click Select All Packages.

If you want, you can individually pick the items you want to update. If
you want to know why an update is available, click the item in the list
and look in the bottom section to find out what that item is for; then
click View Advisory to see why the update is available.

13. When you’re ready to proceed, click Forward.

The system makes sure that all dependencies are met, and then the
Retrieving Packages dialog box appears. Two progress bars, one for indi-
vidual packages and one for the total set of downloads, show you how
much longer you have to go. When the downloads are finished, the
Forward button becomes available.

14. Click Forward when the download is done.

The Installing Packages dialog box appears. The system now installs all
the updates it just grabbed and then offers you the Forward button
when you’re done.

15. Click Forward when the installation is complete.
The All Finished dialog box appears.
16. Click the Finished button, and you’re done.
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Figure 12-5:
The Linspire
CNR Client.

Sometimes this process can be slow, freeze up, or be downright ornery. If any
of this happens to you, cancel out of the update and restart it (though first
give it a few minutes to see whether the program unfreezes on its own).

Updating Linspire

Here’s where you get to meet Linspire’s Click And Run Warehouse (CNR)! It’s
pretty cool stuff, especially for folks new to Linux. To update your system
using CNR:

1. Double-click the CNR icon on the bottom left of your desktop, or
single-click the icon on the left of your panel.

These two icons look identical — they’re running men on a green back-
ground. When you activate this icon, the CNR-Client dialog box appears
(see Figure 12-5).

2. If you’re using a free version of Linspire, click Get Membership and
then Start Free Trial to sign up. If you're using a version you pur-
chased, choose Settings~>Login/Logout.

I’'m going to stick with the purchased instructions, because they’re going
to apply to free users as well once you’ve got your trial membership
information. The My.Linspire Login screen appears.
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|
Figure 12-6:
The My
Products
tab of
Linspire 4.5
CNR Client.

3. Enter your e-mail address in the Email Address text box.

4. If you haven’t set up your CNR account yet, then click No, I Need To

Create A New Account. Otherwise, click Yes, I Have An Account
Password and enter that password in the text box.

I'm going to cover created accounts, because it’s just an issue of filling
out forms to set up for CNR.

. Click Go! to proceed.

Remember, I'm assuming that you’ve set up your account at this point.
After you click Go, you suddenly start seeing notices that you have
updates available. When these messages appear, notice that a new icon
appears to the right of your panel. It’s a green circle with a blue arrow
pointing up. You can click this icon to load the update for that piece of
software immediately rather than proceeding through the rest of these
steps. I'm going to focus on updating the whole system at the moment
because you may have more than one update available.

. Click the My Products tab.

The My Products section appears (see Figure 12-6).

. Click Available Updates to see what software updates are available.

You may not have many at all, or you may have a lot.

. Select the update(s) you want to apply.
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v FTP and FTPS: FTP server stuff; you don’t need it if you're not running
an FTP server.

v SSH: Select this one to keep open. I explain it in the next section.

Additional “security” products from Linspire include (in their Click And Run
Warehouse under Services) SurfSafe parental controls and VirusSafe antivirus
software.

The Secure Shell game (SSH)

One cool thing about Linux is that you can use the command line to connect
to your account from anywhere, as long as you have the right software (and
the machine you're connecting to isn’t behind some kind of blocking soft-
ware). Some people tell you to use the telnet program to do this, but [ beg
you not to. Do not open the Telnet port in the security tool and do not use
the telnet program. It sends information across the Internet in nice, raw text
that anyone can snoop through.

First, you need to make sure that you enable SSH in your firewall. (See the
section “Controlling and adjusting your firewall,” earlier in this chapter). In
Linspire, you need to add the program to connect out from your machine
using SSH:

1. Open the CNR Warehouse (see Chapter 12).
2. Choose Install CNR Warehouse->Utilities=>Security & Encryption=>
Secure Shell.

In some other distributions, you need to do the following to let people ssh
into the machine (the distributions not mentioned here are set up to do so by
default):

v Knoppix: From the main menu, choose KNOPPIX=>Services=
Start SSH Server.

v Mandrake: Use the software installer (see Chapter 12) to add the
openssh-server program. Then, use the services control interface (see
the section “Controlling your services,” earlier in this chapter) to acti-
vate sshd.

v~ Xandros: Do the following:
1. Choose Control Center->Services.

2. Click the Administrator button and enter your root (administra-
tor) password.

3. Select ssh in the list.
4. Click Properties.
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5. In Start Mode, select System Startup.
6. Click OK.

7. If in the Status column, the ssh row doesn’t say Running, click
Start to start the server.

8. Choose File>Quit.

Installing a Windows SSH program

If you want to connect to your SSH-enabled Linux box — or, actually, to any
computer set up to accept SSH connections, not just a Linux one — from a
Windows computer, go to www.siliconcircus.com/penguinet/ and get
the PenguiNet telnet and SSH client for Windows (please don’t use this for
telnet, just SSH). A 30-day trial version is available, and if you like it, the full
version is only around $25.

To install PenguiNet under Windows after downloading PN2setup.exe, just
follow these steps:

1.

Open your file manager (such as Windows Explorer), browse to where
you saved the download, and double-click the PN2setup . exe program.

This action opens the PenguiNet Setup Wizard.

. Click Next to proceed.

The License Agreement dialog box opens.

. After you read the agreement (something you should always do), click

I Accept This Agreement and then click Next to proceed.

The Select Destination Directory dialog box opens. I usually just stick
with the defaults.

. After you select the directory in which to install PenguiNet, click Next.

The Select Start Menu Folder dialog box appears.

. After you select the proper folder, click Next.

The Select Additional Tasks dialog box appears. If you want to create a
desktop icon or Quick Launch button, select the appropriate check boxes.

. After you have chosen your additional tasks, click Next.

The Ready To Install dialog box appears.

. Click Install to begin your PenguiNet installation.

An installation progress dialog box appears. When the installation is fin-
ished, the final installation screen appears.

. Select one or both of the final items.

[ recommend that you check at least Run PenguiNet. You may also want
to select View The PenguiNet Documentation if you like to get familiar
with programs by reading their manuals.
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Figure 13-3:
The
PenguiNet
connection
programin
Windows.
|

|
Figure 13-4:
The
PenguiNet
Connection
Profiles
dialog box.
|

9. Click Finish.

The PenguiNet window appears (if you checked Run PenguiNet), as
shown in Figure 13-3.

(@ Penguitet Laﬁlﬁ*ﬂ

- Session Edit View Format Tools Window Help

R Mo SE A E BRE| @

Setting up and making your SSH connection in Window's
Either you have PenguiNet open from having installed it, or you need to open
it now from your desktop shortcut or the Start menu. After you have done so,
follow these steps:

1. Choose Session->Connection Profiles.

The Connection Profiles dialog box opens, as shown in Figure 13-4.
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. Click Add to open a new profile.
. Enter the name for this profile in the Profile Name text box.

. Enter your Linux box’s IP address in the Host text box.

V1 & W N

. Enter your Linux login name in the Username text box.

You cannot use the root account here. Doing so is terribly bad for security.

[=2]

. Enter your Linux login password in the Password text box.
7. Click Connect to make the connection to your Linux machine.

The Host Key Not Found dialog box opens the first time you connect
this way. Click Connect and save the host key. You don’t have to do this
step again from this Windows machine. Check out Figure 13-5 to see a
Linux command-line interface window on a Windows box! (I'm not sure
why this default font is so “freehand”; you can change it for all your
sessions by choosing Format=>Change Font or per Connection Profile
in the Preferences menu by selecting the profile and clicking the
Appearance tab.)
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§- Session Edit View Format Tools Window Help -
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x |
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Figure 13-5:
Your Linux
command
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. Connected
Windows!
£ Main 55H
I

When you're finished, type logout at the command line, and your connection
closes.
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Connecting to your Linux box from another Linux box with SSH

Yes, you can connect from another Linux box, too. This task is a bit less com-
plicated. Open a terminal window (see Chapter 14) and follow these steps:

1. Type ssh username@ipaddress to open the connection.

For example, type ssh dee@192.168.1.6. After you do this step, the
following text appears:

The authenticity of host '192.168.1.6 (192.168.1.6)"
can't be established.

RSA key fingerprint is
ed:68:0f:e3:78:56:c9:b3:d6:6e:25:86:77:52:a7:66.

Are you sure you want to continue connecting (yes/no)?

2. Type yes and press Enter.
You now see these lines:

Warning: Permanently added '192.168.1.6' (RSA) to the
list of known hosts.
dee@192.168.1.6"'s password:

3. Enter your login password and press Enter. Now you’re in!

Close the connection by logging out of the account (type logout).

Connecting to your Linux box from a
Macintosh running 0S X with SSH

The process from a Macintosh is similar to that under Linux. Go to
Applications=>Utilities> Terminal.app, which opens a command line window
for you. Then type

ssh IPaddress

to access the same user account on the remote machine, or type
ssh login@IPaddress

if you want to access the account login instead of the same account you're
using on the Mac.

Software holes

When someone is already in your system — whether or not they’re allowed
to be there — you have additional security concerns to keep in mind. One of
these involves what software you have on the machine. Believe it or not, each
piece of software is a potential security hole. If someone can get a program to
crash in just the right way, they can get greater access to your system than
they should. That’s a very bad thing!
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One way to close software holes is to remove all programs you don’t need.
You can always add them later, if necessary. How exactly you do this task
depends on the package-management scheme your distribution runs:

v Fedora: You can use yum at the command line or gyum’s Remove tab
(see Chapter 12).

+* Knoppix: You run it off CD, so it’s hard to remove anything!

v Linspire: Open the CLICK and Run client (Chapter 12), click the My
Products tab, select the program you want to remove from the list, and
then click Uninstall Selected.

v Mandrake: From the main menu, choose System=>Configuration=
Packagingr>Remove Software. In the dialog box, check the boxes for the
programs you want to remove. When you're ready to proceed, click
Remove.

v SuSE: Choose System~>YaST=>Softwarer>Install And Remove Software.
Locate the program you want to remove (see Chapter 12). Installed soft-
ware has a checkmark next to it. Click the mark until it becomes a trash
can and then click Accept.

v Xandros: Open the Xandros Networks client as discussed in Chapter 12.
Choose Installed Applications, browse to the program you want to
remove, and click the Remove link.

If it turns out that, as a result of dependencies, you lose other software that
you want to keep, make sure to cancel the removal.

Introducing SELinux

SELinux, or Security-Enhanced Linux (www.nsa.gov/selinux/index.cfm)
was developed by the National Security Agency (NSA) in the United States to
add a new level of security on top of what'’s already available in Linux. To use
SELinux in your distribution:

v Fedora: Open the firewall control tool (see the section “Controlling and
adjusting your firewall,” earlier in this chapter) and click the SELinux
tab. If you want to just see what SELinux would do, check the Enabled
check box (if it isn’t already checked). If you want to enforce the policies
you've created, check the Enforcing Current check box. To completely
deactivate it (which will probably speed up your boot time), make sure
that both boxes are unchecked. My best advice for playing with this
advanced feature is to go and read the site mentioned at the beginning
of this section and then the Fedora-specific FAQ at http://people.red
hat.com/kwade/fedora-docs/selinux-faqg-en/.

+ Knoppix: Not available.
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v Linspire: If you open the CNR client (see Chapter 12) and search for
selinux, you find a number of options. These packages are still in devel-
opment as of this writing.

v Mandrake: Use the software installation tool (see Chapter 12) and install
the program libselinux — this step requires you to have added external
repositories (see Chapter 12). However, utilizing this tool has been left a
fairly advanced exercise for the truly curious.

v SuSE: Installed by default.

v Xandros: Not available.

SELinux is overkill for the average desktop user, but using it on your desktop
can be useful when it comes to learning how SELinux works.

Keeping an Eye on Vour Log Files
with the System Log Uiewer

A\

One other security issue you may want to configure concerns log files. Your
network programs, kernel, and other programs all run log files, which contain
records of what has been happening on your system. You may be amazed at
just how much information gets put in them! They’re mostly in /var/Tog;
take a look sometime.

Fortunately, tools are available that can help mere mortals sift through the
wheat to look for the chaff of bugs and intruders.

To find your distribution’s System Logs viewer:
v Fedora: Choose Applications=>System Tools>System Logs (see
Figure 13-6).
* Knoppix: None.
v Linspire: From the CNR Warehouse (see Chapter 12), choose Utilities=
XWatch.

Sometimes the fastest way to find a program in the CNR Warehouse is to use
the Search text box.

v Mandrake: Using Chapter 12, install swatch. Then, from the main menu,
choose System=>Monitoring=System Log.

v SuSE: Use Chapter 12 to install kwatch, and then start it by choosing the
main menu=>Systeme>Monitor~>kwatch.

v Xandros: None.
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File Edit Help

Cron Log

This log file contains the boot messages.

Mail LOQ Oct 3 21:17:17 elizabeth cups-config-daemon: cups-config-daemon &

News Log Oct 3 21:17:18 elizabeth haldaemon: haldaemon -TERM succeedec
Oct 3 21:17:18 elizabeth messagebus: messagebus -TERM succee|

REM Fackages Oct 3 21:17:18 elizabeth atd: atd shutdown succeeded

Security Log L Oct 3 21:17:18 elizabeth cups: cupsd shutdown succeeded

Kernel Startup Log

System Log Oct 3 21:17:18 elizabeth xfs: xfs shutdown succeeded
Oct 3 21:17:19 elizabeth gpm: gpm shutdown succeeded
E—— Update Agent Log Oct 3 21:17:19 elizabeth sshd: sshd -TERM succeeded
X.Org X11 Log Oct 3 21:17:19 elizabeth sendmail: sendmail shutdown succeeded
Flgure 13-6: Oct 3 21:17:19 elizabeth sendmail: sm-client shutdown succeeded
The Fedora Oct 3 21:17:19 elizabeth smartd: smand shutdown succeeded |_|
System dl : &
Logs Filter for: | [SlFilter | &Reset
watcher.
|

Locating Security Resources

You can find a plethora of information on the Internet about desktop, net-
work, and Linux security. Because of the massive volume of information avail-
able, I list some Web sites I like for security issues:

» www.sans.org: One of the major security-related sites on the Internet.

v http://grc.com/intro.htm: Provides some interesting tools, such as
tools to test which ports are open on a system. Also, this site features
many excellent articles dealing with system and network security:.

v http://seifried.org/1lasg/: Contains the Linux Administrator’s
Security Guide.

v www.linux-firewall-tools.com/Tinux/: Offers tips for firewalls and
security on Linux systems.

v www.linuxsecurity.com/: Presents a plethora of information from
Linux Security.com.

v www.securityspace.com/sspace: Has lots of information about secu-
rity issues and tools for different operating systems
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Working without the GUI

In This Chapter

Understanding the user shell environment

Customizing the bash environment
Working with commands

Tinkering with variables

Using redirection and pipes

Using yet more wildcards

Using a variety of commands

Whom computers would destroy, they must first drive mad.

— Anonymous

M any computing old-timers speak fondly of the command line. Others
who developed their skills by pointing and clicking refer to the com-
mand line as some antiquated tool used by crusty old-timers. The truth is
that most skilled computing professionals recognize the merits of both the
graphical user interface (GUI) and the command-line interface (CLI). You
must understand that the command line provides a powerful lever for operat-
ing your computer. If you ever watch over the shoulder of a skilled Linux
geek, you notice that, after logging in, he doesn’t take long to start tapping
out seemingly cryptic instructions on a command line.

In this chapter, I explore the Linux program that provides the CLI, which is
called the bash shell. Although many shells are available for Linux, bash is
the most common, and for good reason. Basically, the creators of bash rolled
many good features of other shells into one terrific package.

Each shell has its own way of handling commands and its own additional set
of tools. I start by explaining what a shell really is, and when you understand
that, you're ready to get down and dirty with bash. I cover specifically

what you can do with some of the best features of the bash shell. Then, I con-
tinue with working at the command prompt and get into bash shell interior
decorating.
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Shells come equipped to perform certain functions. Most of these features
have evolved over time to assist the command-line jockey with myriad
tasks. Although I only scratch the surface here, you're encouraged to read
the man page for bash because it’s likely one of the more complete and read-
able man pages in existence. You can read all about how to use man pages
(the online Help system in Linux) in the “Help!” section, later in this chapter.

Playing the Shell Game

You need a way to tell the computer what you want it to do. In Linux, one of
the ways to communicate with the computer is through something called the
shell. A shell isn’t a graphical thing; it’s the sum total of the commands and
syntax you have available to you to do your work.

The shell environment is rather dull and boring by graphical desktop stan-
dards. When you start the shell, all you see is a short prompt, such as a §$,
followed by a blinking cursor awaiting your keyboard entry. (Later in this
section, I show you a couple of methods for accessing the shell.)

The default shell used in Linux is the bash shell. This work environment is
based on the original Unix shell, which is called the Bourne shell and is also
referred to as sh. The term bash stands for the Bourne again shell. The bash
shell comes with most Linux distributions.

If you installed your Linux distribution to log in to a graphical desktop, such
as GNOME or the KDE environment, you're likely not looking at a shell prompt.
Rather, you interact with your computer via a mouse. You can start a bash
session from within the GUI desktop in a couple ways.

The quickest method to activate a bash session is to:
v Fedora: Right-click on your desktop and choose Open Terminal from the
context menu that pops up.

v Mandrake: Click the Terminal Program icon on your Panel. (It looks like
a computer monitor.)

v SuSE: Click the Terminal Program icon on your Panel. (It looks like a
computer monitor with a shell on it — get it? shell?)

Notice that not all the distributions covered here offer a shortcut on the panel
or desktop. Instead, you can also choose commands from each program’s
main menu unless otherwise specified:

v Linspire: Choose Programsr>Utilitiesw>Console.

v Fedora: Choose Applications=>System Tools=> Terminal.
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v Mandrake: Choose System=>Terminals=>Konsole.
v SuSE: Choose System=> Terminal=>Konsole.

v Xandros: Choose Applications=>System=>Console.

Often, your shell prompt includes helpful information. For example, if you're
logged in as evan on the machine deepthink in Fedora Core 3, your prompt
looks like this:

[evan@deepthink evanl$

Before surveying a few of the shell capabilities, I need to tell you about another
method for starting a shell session. First of all, notice that your shell prompt

is merely inside a window that is part of your GUI desktop. Suppose that you

want to start a shell session in a character-only or text environment.

To switch to a text environment, press Ctrl+Alt+F2. Don’t be alarmed when
your familiar graphical desktop disappears. It’s still running in the background,
and you can get back to where you left off in a moment. But first, a few words
about the boring text screen you're looking at now (I hope).

You're looking at a virtual terminal, one of several available with your default
installation. You probably see something like this:

deepthink Togin:

Go ahead and type your username and password, which you’re prompted for.
You see a message indicating your last login date followed by the bash prompt:

[evan@deepthink evan]$

Notice the similarity between this prompt and the open window you left
behind in the GUI desktop. Both prompts are an indication that you have a
bash session open. Note that, although it’s accurate to say they’re both the
results of using the bash shell, they’re distinct and separate instances of the
same program. In other words, the environment you’re working with here is
exclusive of the bash environment you still have open in the GUI terminal
window.

Are you wondering where your GUI desktop has gone? Just to settle your
nerves a bit, do some jumping around. The GUI desktop is located at virtual
terminal (VT) number 7 by default. You now have VT-2 open. Position your
piano-playing fingers and strike the chord Ctrl+Alt+F7. Within a second or
two, your screen should flash and return you to your graphical desktop. Neat,
huh? And guess what? The bash session you left open on VT-2 is still there;
you never logged out. Go back again by pressing Ctrl+Alt+F2. Voila! — right
where you left it. Feel free to jump back and forth a few times and try some
other VTs (F1 through F6). Whoopee! This virtual terminal stuff rocks.
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Okay, when you have grown weary and bored with this little trick, exit (liter-
ally, type exit) to log out from each VT you may have opened and return to
the graphical desktop and your bash prompt. Then you can explore what all
the fuss is about with this shell doohickey.

Understanding bash Command
Syntax and Structure

Many people happily skip through their Linux use without understanding the
fundamentals of commands in the bash shell. Note that this approach makes
you lose out on some cool capabilities available in bash. The more you know
about how this shell’s “language” works, the more interesting things you can
do with it.

The basics of using bash at the command prompt often involve typing a com-
mand and any of its flags and values. For example, you enter the 1s -Ta ~
command to see a long-format listing of all files in your home directory, includ-
ing those that start with a dot (), which are hidden files. That other mysteri-
ous squiggle character is technically called a tilde. The tilde is a bash shortcut
character that points to a user’s home directory. For this example, [ merely
list the contents of my home directory.

You can break a command into three distinct components:

v The command name
v The options or flags

v The arguments
Consider this example.

Start with a simple command. The du command lists the contents of the
directory you're now in, and its subdirectories, and how much hard drive
space each item takes up, with a total at the end. Try typing just the du
command by itself:

du

That’s neat, but it probably raises more questions than it answers. The
output gives you a long listing of data, but of what? Are those numbers in
bytes, kilobytes, or messages from outer space? To clarify, try adding a
simple option to your command:

du -h
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You're still issuing the same command, but now you’re providing additional
direction on what you want displayed. The -h option tells du to show you the
information in terms that humans can read more easily. Now Ms, Ks, and Gs
appear next to the numbers so that you can see how big these numbers actu-
ally are. But, wait — there’s more. What if you just want to know the total
amount of disk space this directory and its subdirectories are taking up?
That calls for the -s flag:

du -s

What if you want the total for a different directory? Or just one of your subdi-
rectories? In my case, I keep a Music subdirectory for the items I have copied
from my CDs into Oggs (see Chapter 18). I can type the following command to
see how much hard drive space that directory takes up in a human-readable
way rather than have to count zeroes:

du -sh ~/Music

In this example, du is the command name, -sh indicates the flags (options),
and ~/Music is an argument. The -sh flags can be accompanied by many
more flags that provide various options applicable to the command.

Are you wondering where to find all the available options and arguments of a
particular command? Most commands offer man pages, which are discussed
in the “Help!” section, later in this chapter. Another good place to turn is

the --help option, available with many commands. Note that - -help dis-
plays a terse list of options, but it’s nice and quick if you already know about
an option but just can’t remember exactly which one it is. Try it by entering
the following command:

du --help

Cool, huh?

Starting Programs from the Shell

The most obvious, but perhaps not so apparent, use of the shell is to start
other programs. Most utilities you use in Linux are separate and distinct exe-
cutable programs. Users need a method to start these programs. In the GUI,
you can associate an icon with a particular program, and the graphical envi-
ronment contains the intelligence to start the program. Note that programs
often require information drawn from environment variables, which are a
part of the shell environment. (I discuss environment variables in more detail
in the section “Working with Variables,” later in this chapter.) For this reason,
the GUI often calls the intended program via the bash shell. So you see, even
the GUI finds the shell a necessity — although the GUI does its best to hide
this detail from users.
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For example, in the GUI after you have a terminal window open, type the fol-
lowing command at the prompt:

mahjongg

After a few seconds, the Mahjongg game is displayed. You can start any pro-
gram at a command prompt that you can click from the GNOME menu if you
know what the underlying program name is. Note that if you're in a virtual
terminal (press Alt+F1) instead of the GUI, you may see an error message.
Some programs require a graphical environment in which to run, which a
character-based terminal obviously doesn’t have.

Putting Wildcard Expansion to Good Use

Computing life would be tedious if you had to repeat the same command on
multiple files. After all, aren’t repetitive tasks what the computer was designed
to do? Wildcard expansion refers to the ability of one command to be executed
against many files. The asterisk (*) and the question mark (?) are two wildcard
characters that are used to match any filename, or a portion of a filename. For
example, you can use the following command to see a long directory listing
that includes only files that end with a . doc filename extension:

1s -1 *.doc

The files listed may include resume.doc, cover_letter.doc, and
to_editor.doc, for example.

Working with Long Commands

As you become used to the command line, you should learn some shortcuts
to ease your typing chores. In this section, I show you some features of the
bash shell designed to make your life on the command line as pleasant as
possible. These features include command-line completion, editing, and using
the history of previously entered commands.

Asking Linux to complete a command
or filename for you

Considering that you do much more typing on the command line in Linux
than you may normally do in a GUI environment, a feature that provides
typing shortcuts wherever possible is great. Command completion is a
function of the shell that completes filename and system commands.



Chapter 14: Working without the GUI 283

The capability of the Linux file system to deal with practically unlimited sizes
of filenames means that many filenames can become huge. Typing these long
filenames can become cumbersome. Fortunately, with command completion,
typing a command or a long filename is short work.

You may want to use command completion in two situations: to enter a com-
mand or to complete a filename.

Completing a command

Suppose that you want to type a command, but you can remember only that
it begins with the letters up and is supposed to return the length of time that
has passed since the system was rebooted. Type up at the command prompt
and then press Tab:

[evan@deepthink evanl$ up[TAB]
One of two things happens:

v~ If only one matching command is in the search path (directory locations
for searching for programs; type echo $PATH to find out what yours is),
your command line is completed with that command, and the system
waits for you to press Enter to execute the command.

v If you hear a beep, it means that more than one command begins with
up. Simply press Tab a second time, and all the possibilities are displayed.
Locate the command on the list and continue typing it until the first let-
ters are unique, at which point you can press the Tab key to complete
the command.

Completing a filename

Command-line completion isn’t only for commands; if you're typing a file-
name on your command line, you only need to type the first few characters
and then press Tab. The shell usually searches the current working directory
for filenames that match what you have typed and subsequently completes
the filename on the command line. This feature behaves the same way as the
command-completion feature in that, if more than one file contains the letters
you type, you hear a beep and need to press Tab again to see a list of choices.

It takes a little getting used to, but after you have control of the Tab key and
the shell command-line completion feature, you may wonder how you ever
got along without it.

Accessing your command history

It’s nice of the shell to remember what you have done, for better or worse.
Having the shell keep track of the commands you enter makes it easy to
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return to those gawd-awfully long commands you pecked at a while ago —
even days ago! Let me give you an example. Suppose that yesterday you man-
aged to issue a command to find all the core dump files in your system (core
dump files are massive files containing debugging data that only an expert
programmer or your computer can understand) and delete them. The com-
mand looked something like this:

find / -name core -exec rm {} \;

To re-execute the command, all you need to do is fish it out of your shell his-
tory and rerun it. The simplest way (if you're repeating the exact same version
of the command you used last time, which in this case would be the find
command) is to type ! find and press Enter. Doing so tells your system to
look through your history and rerun the last instance of find in the list.

On the other hand, if you have run the find command more than once and
want to make sure that you're re-executing the right version, you need to
read through your command history. You can do so line by line by pressing
the up-arrow key repeatedly until you locate the command you want to
re-execute. Then just press the Enter key to run the command again.

The history command lists your last 20 commands (by default) when you
enter it at the prompt, in case you're curious about what they were.

Working with Variables

Variables in the bash shell are words or strings of text that computers use to
represent a piece of data. An example of using a variable is setting the variable
fruit to contain the text apple. A number of standard variables contain
information about your account and environment settings.

Variables versus environment variables

The first thing [ need to make clear is that the bash shell has two classes of
variables:

v Variables: A variable can be referenced in a program or shell session,
but it’s visible and available to only that session or program.

+* Environment variables: An environment variable can also be referenced
by the shell or program. However, it has the added behavior of having
its value copied to any other program or shell that is created from its
environment.
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Saving your work as you go

To save your file’s contents without closing it (so that you can keep working
on it):
1. Press Ctrl-O to Write Out.

A prompt appears toward the bottom of the screen, asking for the name
of the file and offering the current name as the default option.

2. If you want to use the same name, press Enter. If you want to change
the name, make your changes and then press Enter.

The lower part of your screen now displays that it wrote (saved) a cer-
tain number of lines.

3. Get back to work!

Saving and moving on with your life

To save your file’s contents and close it (because you're done working on it
for now) — or to close the file and not save the changes — do the following:

1. Press Ctrl-X to Exit.
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A prompt appears toward the bottom of the screen, asking whether it
should save the modified buffer. This question is a fancy way of asking
whether you want to save your changes.

2. Press Y to save your changes or press N to not save them.

If you press Y, you're asked for the name of the file and offered the cur-
rent name as the default option. If you press N, nano closed and exited,
so you're finished with these steps.

3. If you want to use the same name, press Enter. If you want to change
the name, make your changes and then press Enter.

The nano editor closes, and your file is saved.

Going with gedit

You're not stuck with just command-prompt-based text editors in Linux. Lots
of graphical options are available. In this section, I cover gedit because it is
the default GUI text editor for Fedora, which is on the DVD included with this
book. The default GUI editors for the full range of distributions covered are as
follows:

v Fedora: Access gedit by choosing Accessories>Text Editor (see
Figure 16-2).

1 Knoppix: Access KWrite or Kate by choosing Editors=>KWrite or
Editors=>Kate.

v Linspire: Access KWrite by choosing Programs=Business & Financew>
Text Editor, or KWrite in Programs=>Software Development=>Advanced
Text Editor.

1 Mandrake: Access Kate or KWrite by choosing More Applications=>
Editors=>Kate or More Applications=>Editors=>KWrite.

v SuSE: Access Kate by choosing Utilities=>Editor.

v Xandros: Access KWrite (very similar to gedit and Kate) by choosing
Applicationst>Accessoriesw>Text Editor.

Entering and editing text in gedit

gedit is strictly a text editor, in that you use it to generate raw text, whereas
a word processor creates marked-up text that can be opened only by pro-
grams that can read that word processor’s file formatting. If you want to add
bold, italics, underlines, or any other special features to your document, pro-
ceed to the next chapter.
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To enter text in gedit, just click within the big white space and start typing.
You have access to the standard collection of editing tools, such as cut,
paste, and copy. To use these, select the text you want to work with and then
click the appropriate button on the gedit toolbar (or right-click and choose
the appropriate command from the context menu).

The really interesting thing about this particular text editor is its plug-ins.
To use these features, you need to follow these steps:
1. Choose Edit=>Preferences in gedit.
This action opens the Preferences dialog box.
2. Click the Plug-Ins tab.
The Plug-Ins tab’s contents appear.
3. Click an item you’re interested in within the Plug-Ins tab.
4. Click the About Plugin button to get more information.

The information is contained within the small About window that
appears.

5. Click Close to get rid of the About window.
6. If you want to use this plug-in, click in its check box.

The plug-in is activated if a check appears in the check box.



3 ’4 Part IV: Getting Things Done

7.

9.

10.

If the Configure Plug-In button becomes active for the plug-in you just
selected, click the button to open the tool’s plug-in configuration
dialog box.

This dialog box will be different depending on which plug-in you're
using.

. When you’re finished with the individual plug-in’s configuration, click

OK to return to the Preferences dialog box.

If you want to examine more plug-ins, return to Step 3.

When you’re finished selecting plug-ins, click Close to close the
Preferences dialog box.

You can now access the plug-ins from your gedit menus. Each one is placed
in its appropriate location: for example, Change Case appears on the Edit
menu.

Saving your work

As with most programs, you have two choices for saving your work. You can
save your work and keep going or save it and then close the program. To just
save the file and keep going, follow these steps:

1.

Click the Save button.

This button looks like a floppy disk. If you haven’t ever saved this file,
clicking it opens the Save As dialog box.

. Click the right-facing arrow toward the bottom left.

The filesystem browser opens.

. Browse through the directories in the left or right pane until you’re in

the directory where you want to save the file.

Double-click the name of a directory to enter it or click the . . in the left
pane’s listing to move up a level in the directory tree.

4. Type the file’s name in the Selection text box.
5. Click OK to save the file.

The dialog box closes.

To close gedit, follow these steps:

1.

Choose File~>Quit.

If you haven’t saved this file since the last time you changed it, the
Question dialog box appears.



Chapter 16: Putting the X in Text

2. If you see the dialog box, click Save to save your work or click Don’t
Save to abandon it.

The program closes, unless you have more than one file open, in which
case you see the Question dialog box for each file you have altered but
not saved.

Taking a Quick Look at Kate

|
Figure 16-3:
The Kate
editorin
SuSE9.2.

Kate (see Figure 16-3) is the default editor in KDE and works much the same
way as gedit does. However, Kate is actually a bit fancier than gedi t, offer-
ing features such as exporting to HTML (choose Filec>Export), filtering vari-
ous types of markup and coding to help spot errors (choose Tools=
Highlight Mode), and more.
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Chapter 17

Word-Processing and More
with OpenOffice.org

In This Chapter

Installing the OpenOffice.org suite
Word-processing with OpenOffice.org Writer
“Spreadsheeting” with OpenOffice.org Calc
Presenting with OpenOffice.org Impress
Drawing with OpenOffice.org Draw

Formulating with OpenOffice.org Math
Configuring printing for the OpenOffice.org suite

Words fly, writing remains.

— Spanish proverb, from Dictionary of Proverbs, by Delfin Carbonell Basset

Fese days, just about everyone who has a computer has at least one
office suite at their fingertips. If they’re Microsoft Windows users, this
suite is probably Microsoft Office, although it may be another worthy con-
tender, such as Corel WordPerfect Office. In Linux, typically the suite is
OpenOffice.org. This suite comes with Calc (a spreadsheet), Draw (diagrams
and figures), Impress (for presentations), Math (a word processor for writing
mathematical formulas), and Writer (for word-processing).

After you figure out how to use one of the programs in this suite, you may be
happy to find that the others are designed to look and work in very similar
ways. You can even open and save files in Microsoft Office format, if you need
to share them with people using it — and you can edit the Office files people
send you, too.

That’s enough about OpenOffice.org. In this chapter, you can actually use it!
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Other office suites available for Linux users are the OpenOffice.org relative
StarOffice (www.sun.com/staroffice), Applixware Office (www.vista
source.com/products), KOffice (www. koffice.org), and GNOME Office
(http://www.gnome.org/gnome-office/).

Word-Processing with
OpenOffice.Org Writer

Word processors are almost required equipment these days. Kids use them
to write letters to their grandparents. Grandparents use them to write letters
to their grandkids. Whether you’re working on the great American novel or a
school book report, OpenOffice.org Writer has all the best features you'd
expect to find these days in a word processor.

Starting it up

To start OpenOffice.org Writer in the distributions covered in this book, do
the following:

v Fedora Core: Choose Applications=Officer>OpenOffice.org Writer. Or
you can click the OpenOffice.org Writer button on your upper panel.

v Knoppix: From the main menu, choose = Office=>OpenOffice.org Writer.

v Linspire: From the main menu, choose = Programs=Business &
Financer>OpenOffice.org 1.1.0c>OpenOffice Writer.

v Mandrake: From the main menu, choose
Office>Wordprocessors>OpenOffice.org Writer.

v SuSE: From the main menu, choose Officer>Word processor.

v Xandros: Choose Launch=>Applications=>OpenOffice.org->Word
Processor. Xandros users who purchased the product also have the
option to install StarOffice through Xandros Networks (see Chapter 12),
which is the commercial version of OpenOffice and contains additional
fonts, templates, and more.

When you first open OpenOffice.org Writer, you may see a Paragraph Styles
dialog box. Click the X in the upper-right corner to close this box and to get it
out of the way for now.

Taking a tour of OpenOffice.org Writer

Before you proceed, take a look at the GUI layout shown in Figure 17-1.
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Main toolbar

Along the left side of the window is the main toolbar. Each icon in this series
represents a different functionality. If a button is extensible (it has a little
arrow on it), you can click it to open a tiny dialog box containing the options
therein. Each icon is described in Table 17-1; for an example of what you see
when you click an extensible button, see Figure 17-2. If you determine that
you want to remove this toolbar, choose View>Toolbars=>Main Toolbar.
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Table 17-1 The OpenOffice.org Writer Main
Toolbar, from Top to Bottom

Button What You Can Do Extensible?

Insert Place an element (a table, another document, Yes
or a picture, for example) at the cursor’s current
location.

Insert Fields Place a text element (current date, subject, or Yes
author’s name, for example) at the cursor’s
current location.

Insert Object Place an object (a chart, a mathematical formula, Yes
or an applet, for example) at the cursor’s current
location.

Show Draw Access the many OpenOffice.org drawing utilities.  Yes

Functions

Show Form Build forms with their respective special Yes

Functions features (text boxes, radio buttons, and more).

Edit AutoText Adjust the various settings for commonly Yes
used phrases to recall at the click of a button.

Direct Cursor Add or remove special functionality that auto- No

On/Off matically formats text and objects according to
where you click on the page (clicking in the
middle centers the item, for example).

Spellcheck Run the spell checker on your entire document No
or the selected text.

AutoSpellcheck  Activate or turn off the automatic spell checker No

On/Off feature.

Find On/Off Open or close the Find and Replace dialog box. No

Data Sources Open or close the Data Sources dialog box, No
which lets you access databases previously
specified by using the dialog box accessed
by choosing Tools_Data Sources.

Nonprinting Show all spaces, returns at the ends of para- No

Characters graphs, and other characters that you don't

On/Off normally see in your documents.

Graphics On/Off ~ Show embedded images, or just show place- No
holders so that you can see where they are
without seeing the images.

Online Layout Tell OpenOffice.org Writer to show your No

document as a Web page.
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Menu bar

Along the top of the window is the menu bar, something you should be used
to if you typically work in Microsoft Windows. OpenOffice.org Writer has all
the features you’d expect from a modern word processor. It has too many
menu options to cover in depth, so I give you instead a (nonexhaustive) sum-
mary of what you find on each major menu:

v~ File: The usual Open, Save, Save As, Print, and Print Preview (under the
term Page Preview) commands, along with a set of wizards (under the
term AutoPilot) plus the ability to send documents through e-mail,
create templates, and create Web pages

v Edit: The usual Select All and Find commands, along with change track-
ing, document merging, and document comparing

v View: The usual Zoom functions and toolbars, along with the abilities to
show or hide formatting characters, to see what the document would
look like as a Web page, and to access your database information

v Insert: The usual page breaks and special characters, along with
indexes, tables, bookmarks, headers, footers, and cross-references

v Format: The usual character, paragraph, and page settings, along with
styles, autoformatting capabilities, and columns

v Tools: The usual spell-checking and thesaurus entries, in addition to

hyphenation, autocorrection, an image gallery, and a bibliography
database

These menus have more features than what is listed here. Go through and
take a look; you may find a new favorite feature in there somewhere.

Function bar

Directly below the menu bar in a default setup is the function bar, which you
can remove at any time by using the View menu. This series of icons allows
you single-click access to the most commonly used File and Edit features,
among others. Table 17-2 lays out, from left to right, what you find on the
default Function bar. The extensible items can all be opened to show a fur-
ther set of options.

Table 17-2 The OpenOffice.org Writer Function
Bar, from Left to Right
Button or Item What You Can Do Extensible?
New Open new documents of various types. Yes
Open File Open an existing file for reading or editing. No

(continued)
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Table 17-2 (continued)

Button or Item

What You Can Do

Extensible?

Save Document

Save the current document. If you haven't saved

No

this document before, the Save As dialog box opens.

Edit File Edit the displayed Web page. No

Export Directly Opens a Save As dialog box with PDF selected No

as PDF as the file type.

Print File Directly  Send a file to the default printer. No

Cut Remove the selected text from the document No
and save itin memory.

Copy Make a copy of the selected document textand  No
save it in memory.

Paste Place the text from memory into the document No
atthe cursor’s current location.

Undo Undo the last change you made to the document. Yes

Redo Reinstate the last change to the document after  Yes
using Undo to cancel it.

Navigator On/Off ~ Open or close the Navigator window, which No
allows you to jump to specific features within
your document.

Stylist On/Off Open or close the Paragraph Styles window, No
which allows you to select the particular style
to apply to selected text.

Hyperlink Dialog ~ Open or close a dialog box that you can use to No
build complex hyperlinks.

Gallery Open or close a dialog box that provides access  No
to clip art.

Zoom Alter how large the document shows on No
your screen.

Object bar

The object bar is directly below the function bar in a default OpenOffice.org
setup. As usual, you can remove the object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down
list boxes that represent standard word-processing functions, such as styles,
fonts, font sizes, and formatting instructions. Most features on this bar are
identical to what you see in most modern word processors. The button for
paragraph background formatting is the only one that’s particularly unusual.
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P This toolbar actually changes depending on what you’re doing. If your cursor

is within a table, for example, then the object bar contains useful buttons for
working with tables.

Ruler

Directly below the object bar in a default OpenOffice.org setup is the ruler. All
modern word processors offer this item, which marks out the margins and
tabs, for example, of your document in the measuring system of your choice.
To change which system you want to use, right-click the ruler to open the
Measurements pop-up dialog box.

VYour document

Oh, yeah — that big, blocked-off white space takes up most of the window.
That’s where you work on your documents! Just click in there and start
typing. You can also access a Formatting shortcut menu by right-clicking in
the document section.

OpenOffice.org Writer supports the following file formats (and more): its own
“text” format that it uses in common with StarWriter (.SXW), Microsoft Word
95, 6.0, 97, 2000, and XP (.DOC), Rich Text Format (.RTF), Text (.TXT), and
Web Page (HTML).

Spreadsheets with OpenOffice.Org Calc

Some people like to balance their checkbooks by hand. When I first gradu-
ated from a university, I decided that it was time to get hold of my finances,
and a spreadsheet was the way to do it. These days, I use spreadsheets to
keep track of my “time card” when I'm doing consulting or contract work,
help me manage project teams, and complete other tasks. I'm sure that you
have your favorite uses for spreadsheets. The following sections take a look
at OpenOffice.org Calc so that you can get to work.

Starting it up

To start OpenOffice.org Calc in the distributions I cover in this book, do the
following:

v Fedora Core: Choose Applications=>Office>OpenOffice.org Calc. Or you
can click the OpenOffice.org Calc button in the lower panel.

v Knoppix: From the main menu, choose Offices>OpenOffice.org>Open
Office.org Calc.

v Linspire: From the main menu, choose Programs=Business & Financew>
OpenOffice.org 1.1.0->0OpenOffice Calc.
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|
Figure 17-3:
The
OpenOffice.
org Calc
layout.
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v Mandrake: From the main menu, choose Officer>Spreadsheets=
OpenOffice.org Calc.

v SuSE: From the main menu, choose Officer>Spreadsheet.

v Xandros: Choose Launch=>OpenOffice.orge> Spreadsheet.

Taking a tour of OpenOffice.org Calc

Much of what you see in OpenOffice.org Calc should look familiar, between
looking through OpenOffice.org Writer and other spreadsheet programs you
have used. Take a look at the GUI layout shown in Figure 17-3.

Main toolbar

Along the left side of the window is the main toolbar, which you can remove
at any time by choosing View=>Toolbars=>Main Toolbar. Each icon in this
series represents a different functionality. Just as with OpenOffice.org Writer,
if a button is extensible (it has a little arrow on it), you can click it to open a
dialog box containing the options contained within. Each icon is described in
Table 17-3.
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Table 17-3 The OpenOffice.org Calc Main
Toolbar, from Top to Bottom
Button What You Can Do Extensible?
Insert Place an element (a table, another document, Yes
or a picture, for example) at the cursor’s current
location.
Insert Cells Place a cell (or column or row) at the cursor’s Yes

current location.

Insert Object Place an object (a chart, a mathematical Yes
formula, or an applet, for example) at the
cursor’s current location.

Show Draw Access the many OpenOffice.org drawing Yes

Functions utilities.

Show Form Build forms with their respective special features Yes

Functions (text boxes, radio buttons, and more).

AutoFormat Quickly format a collection of cells in one of a No
variety of ways.

Choose Themes  Quickly assign a color-coordinated look No
to a sheet.

Spellcheck Run the spell-checker on your entire document ~ No
or the selected text.

AutoSpellcheck  Activate or turn off the automatic spell-check No

On/0ff feature.

Find On/Off Open or close the Find and Replace dialog box. ~ No

Data Sources Open or close the Data Sources dialog box, No

which brings up the same dialog box as the
Toolsc>Data Sources menu selections.

Menu bar

Along the top of the window is the menu bar, a standard in the GUI world no
matter which operating system you’re using. OpenOffice.org Calc has all the
features you would expect from a modern spreadsheet system. It has too
many menu options to cover in depth, so, instead, here’s a (nonexhaustive)
summary of what you find on each menu:

v~ File: The usual Open, Save, Save As, Print, and Print Preview (under the
term Page Preview) commands, along with a set of wizards (under the
term AutoPilot) plus the ability to send documents through e-mail,
create templates, and create Web pages
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v~ Edit: The usual Select All and Find commands, along with change track-
ing, headers and footers, and plug-in loading

v View: The usual Zoom functions and toolbars, along with the options for
showing or hiding column and row headers and accessing database
information

v Insert: The usual page breaks and special characters, along with cells,
rows, functions, and external data

v Format: The usual cell and row formatting, cell merging, and page set-
tings, along with conditional formatting

v Tools: The usual spell-checking and thesaurus entries, in addition to
hyphenation, autocorrection features, an image gallery, and a bibliogra-
phy database

v Data: The usual data selection, sorting, and grouping routines in one
easy place for quick access.

These menus have more features than those listed here. Go through and take
a look; you may find a new favorite feature in there somewhere.

Function bar

Directly below the menu bar in a default setup is the function bar, which you
can remove at any time by using the View menu. This series of icons allows
you single-click access to the most commonly used File and Edit features,
among others. The function bar in OpenOffice.org Calc is identical to that
shown in Table 17-2 for OpenOffice.org Writer.

Object bar

The object bar is directly below the function bar in a default OpenOffice.org
setup. As usual, you can remove the object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down
list boxes that represent standard spreadsheet functions, such as styles,
fonts, font sizes, and number formatting instructions. Most features on this
bar are identical to what you see in most modern spreadsheets.

Formula bar

Directly below the object bar in a default OpenOffice.org Calc setup is the
Formula bar. Table 17-4 lays out what you find in this short collection of
entries. This bar actually changes depending on what you're doing, offering
you buttons for particular tasks, so don’t panic if you look here and this table
doesn’t match what you see on your own Formula bar.
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Table 17-4 The OpenOffice.org Calc Formula Bar, from Left to Right

Button What You Can Do

Sheet Area Shows what row and column you're in. Type the coordinates
and press Enter to jump directly to a cell.

AutoPilot: Click to open the AutoPilot: Functions dialog box and browse to

Functions find the particular spreadsheet function you're looking for.

Sum Click to start a SUM (addition) function in the Input Line.

Function Click to place an = in the Input Line to signal that you're about to
enter a function.

Input Line Assign values or enter functions to fill a spreadsheet cell.

Vour document

The document area is where you work on your spreadsheet. Just pick a cell
and start typing. You can also access a Formatting shortcut menu by right-
clicking in the document section.

OpenOffice.org Calc supports the following file formats (and more): its own
spreadsheet format (.SXC); Data Interchange Format (.DIF); dBASE (.DBF);
Microsoft Excel 95, 5.0, 97, 2000, and XP (.DOC); text-based comma-separated
values (.CSV), Symbolic Link (SYLK), and Web Page (HTML).

Presentations with OpenOffice.Org
Impress

Most people would rather eat glass than speak in front of a group of people.
Still, if you have to, you may as well have some cool presentation software to
back you up. This program is what [ use when I speak at conferences. (I use
it even when my clients want me to send in my presentation in Microsoft
PowerPoint format. Shh! Don’t tell — they don’t know the difference!) Give
OpenOffice.org Impress a chance to impress you.

Starting it up

To start OpenOffice.org Impress in the distributions I cover in this book, do
the following:

v Fedora Core: Choose Applications=>Officer>OpenOffice.org Impress. Or,
you can click the OpenOffice.org Impress button on your lower panel.
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v Knoppix: From the main menu, choose Office>OpenOffice.orge>
OpenOffice.org Impress.

v Linspire: From the main menu, choose Programs=Business & Finance=
OpenOffice.org 1.1.0c>0OpenOffice Impress.

v Mandrake: From the main menu, choose Officez>Presentations>
OpenOffice.org Impress.

v SuSE: From the main menu, choose OfficecoPresentation.

v Xandros: Choose Launch=>Applications=>OpenOffice.org=>Presentation.

Using the Autolilot Presentation Wizard

When you open OpenOffice.org Impress, the first thing that launches is the
AutoPilot Presentation wizard (see Figure 17-4), which you can also open
later manually by choosing File>AutoPilot. If you don’t want this wizard to
show up the next time you open OpenOffice.org Impress, then click the Do
Not Show This Dialog Again box.

To use this wizard, follow these steps:

1. Leave the Empty Presentation option selected (unless you have a tem-
plate you need to work from) and click Next.

Dialog 2 appears.

AutoPilot Presentation

Type
® Empty presentation
) From template

) Open existing presentation

Figure 17-4:

The Open
Office.org 4] Preview

AutoPilot ["] Do not show this dialog again
Presenta-
tion wizard. Help ‘ ‘ Cancel ] ‘ << Back ‘ ‘
|
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. If you want to select one of the default slide backgrounds that come

with OpenOffice.org Impress, you can do so by looking to the Select a
slide design drop-down list box, choosing Presentation Backgrounds,

and then clicking the various options to see what they look like to the
right of the dialog box.

By default, there aren’t many background templates. This is one area
where Sun’s StarOffice offers added value.

. If you want to select a presentation (content) layout template that was

designed specifically for the template you chose in this dialog box’s
screen 1, you can do so by looking to the Select A Slide Design drop-
down list box, choosing Presentation(s), and then selecting the pre-
sentation type you want to use.

Again, you find limited options here by default.

. If you want your presentation ultimately to appear on something

other than a computer screen, adjust the Select An Output medium
to match its intended setting.

Your choices are Screen, Overhead Sheet, Slide, and Paper.

. Click Next to proceed.

Dialog 3 appears.

. Under Select a slide transition, experiment with the various options in

the Effect and Speed drop-down list boxes to narrow down how you
want to move from one slide to another.

OpenOffice.org Impress animates these transitions for you as long as the
Preview box is checked.

. If you want to navigate manually from one slide to the next (the

Default option) while you give your presentation, skip to Step 10. If
you want to have your presentation advance automatically, click the
Automatic option.

8. In Duration Of Page, set how long you want each slide to stay up.

9. In Duration Of Pause, set how long of a blank gap you want to have

10.

between slides.

If you have Show Logo checked, the OpenOffice.org logo appears during
the blank pauses.

After you have your settings selected, click Create to proceed.

OpenOffice.org Impress opens, as shown in Figure 17-5. You may find it
useful to click the X in the upper right of the Modify Slide dialog box so
that you can actually see the application for now!
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Figure 17-5:
The Open
Office.org

Impress
default look.
|
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Taking a tour of OpenOffice.org Impress

Before you proceed, take a look at the GUI layout shown in Figure 17-5. The
little Presentation dialog box may look like clutter to some, but I personally
find it helpful as I'm creating and editing presentations. If you don’t need it,
just click the X in the upper right corner of the dialog box to get rid of it. You
can bring it back at any time by choosing View=>Toolbars=>Presentation.

Main toolbar

Along the left side of the window is the main toolbar, which you can remove
at any time by choosing View=>Toolbars>Main Toolbar. Each icon in this
series represents a different functionality. If a button is extensible (has a little
arrow on it), you can click it to open a dialog box and see the options con-
tained within. Each icon is described in Table 17-5. As you can see, this main
toolbar is significantly different from the other OpenOffice.org programs
because of the different needs you have in this context.
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Table 17-5 The OpenOffice.org Impress Main Toolbar,
from Top to Bottom

Button What You Can Do Extensible?

Select Set the mouse pointer to select a particular No
element or section of a slide.

Zoom Use a set of options that let you zoomin and out  Yes
on the slide.

Text Use a variety of methods for entering text Yes
on a slide.

Rectangle Easily draw various forms of rectangles. Yes

Ellipse Easily draw various forms of ellipses. Yes

3D Objects Easily draw spheres, cubes, and more. Yes

Curve Easily draw curvy lines and even freeform. Yes

Lines and Arrows Use a selection of connector lines and arrows.  Yes

Connector Use another set of connector symbols and lines.  Yes

Rotate Rotate a selected object on a specific axis. No

Alignment Shift the selected object to a specific alignment ~ Yes
on the page.

Arrange Move objects higher or lower in the stack. Yes

Insert Insert items, such as graphs. Yes

Menu bar

Along the top of the window is the menu bar. OpenOffice.org Impress has the
many features you'd expect from a modern presentation package. It has too
many menu options to cover in depth, so I give you instead a (nonexhaus-
tive) summary of what you find on each menu:

v File: The usual Open, Save, Save As, Print, and Print Preview commands,
along with a set of wizards (under the term AutoPilot) plus the ability to
send documents through e-mail and create templates

v Edit: The usual Select All and Find commands, along with the ability to
quickly duplicate a slide

v View: The usual Zoom functions and toolbars, along with the ability to
select whether you’re looking at just slides, notes, or another section

v Insert: The usual new slide, along with charts, frames, graphics, and
spreadsheets
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v Format: The usual text formatting features, along with layout, graphics,
and style formatting

v Tools: The usual spell-checking feature, in addition to hyphenation, auto-
correction, an image gallery, and a bibliography database

v Slide Show: The usual slide show controller menu

These menus have more features than those listed here. Don’t forget to do
some exploring on your own.

Function bar

Directly below the menu bar in a default setup is the function bar, which you
can remove at any time by using the View menu. This series of icons allows
you single-click access to the most commonly used File and Edit features,
among others. The Function bar in OpenOffice.org Impress is the same as
that in OpenOffice.org Writer, shown earlier in Table 17-2.

Object bar

The object bar is directly below the function bar in a default OpenOffice.org
setup. As usual, you can remove the object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down
list boxes that represent standard presentation-software functions, such as
arrow styles, colors, line styles, and other formatting instructions. Most fea-
tures on this bar are identical to what you see in most modern presentation
programs.

View switchers

Along the top of your right-hand scrollbar, and along the left of your bottom
scrollbar, you find a series of tiny buttons. Each button represents a different
View available in OpenOffice.org Impress, and you can use these buttons to
easily switch between various views. Table 17-6 outlines the available views
and what you find in them.

Table 17-6 Available OpenOffice.org Impress Views
View What You Find

Drawing Individual slide view in which you can add art to your slide.
Handout Four slides per page, as you might print it for handouts.

Layer Allows you to switch between various slide layers. By default,

your choices are the Default (top) layer and the Background
Objects layer where you can create and edit backgrounds without
altering your slide content.

Master Individual slide view in which you can apply master formatting
that will apply to all slides.
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View What You Find

Notes Individual slide view in which you can see a small version of the
slide plus your notes about that slide.

Qutline All-slides view with the slides listed in order for easy stepping
through. Along the side, the slides are shown in thumbnail mode in
a separate window as you navigate.

Slide Right column: All-slides view with as many slides packed in as
possible in columns and rows.

Bottom row: Allows you to use the views on the right.

Ruler

Directly below the Object bar (and to the right of the main toolbar) is your
pair of rulers. These items mark out margins and tabs,. To change measuring
systems, right-click the appropriate ruler and select what you want to use.

VYour document

Oh, yeah — that big white space takes up most of the window. That’s where
you work on your slides! Just click there and start typing. You can also access
a formatting shortctut menu by right-clicking in the document section and
choosing Slide>Page Setup.

OpenOffice.org Impress supports the following file formats (and more): its
own presentation format (.SXI), and Microsoft PowerPoint 97, 2000, and XP
(.PPT or .PPS).

Fine Art with OpenOffice.Org Draw

Whether you're an aspiring graphic artist or just need a tool that lets you
generate simple graphics for use on their own, in a presentation, or else-
where, OpenOffice.org Draw provides a host of drawing functions. If nothing
else, it’s a whole lot of fun to play with! Not everything in life has to be
practical.

Starting it up

To start OpenOffice.org Draw in the distributions I cover in this book, do the
following:
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|
Figure 17-6:
The
OpenOffice.
org Draw
layout.
|

v Fedora Core: Choose Applications=Office>OpenOffice.org Draw.

v Knoppix: From the main menu, choose Office>OpenOffice.orge>
OpenOffice.org Draw.

v Linspire: From the main menu, choose Programs=Business &
Finance=>OpenOffice.org 1.1.02>OpenOffice Draw.

v Mandrake: From the main menu, choose Officem>Drawing=>
OpenOffice.org Draw.

v SuSE: From the main menu, choose Graphics~Vector Drawing.

v Xandros: Choose Launch=>Applications=>OpenOffice.org>
Drawing Editor.

Taking a tour of OpenOffice.org Draw

Before you proceed, take a look at the GUI layout shown in Figure 17-6.
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Main toolbar

Along the left side of the window is the main toolbar, which you can remove
at any time by choosing View=>Toolbars=>Main Toolbar. Each icon in this
series represents a different functionality. If a button is extensible (has a little
arrow on it), you can click on it to open a dialog box with the options con-
tained within. Each icon is described in Table 17-7. As you can see, this main
toolbar is more similar to that in OpenOffice.org Impress than to the one in
OpenOffice.org Writer.

Table 17-7 The OpenOffice.org Draw Main
Toolbar, from Top to Bottom

Button What You Can Do Extensible?

Select Set the mouse pointer to select a particular No
element or section of a slide.

Zoom Use a set of options that let you zoomin and out  Yes
on the slide.

Text Use a variety of methods for entering text Yes
onto a slide.

Rectangle Easily draw various forms of rectangles. Yes

Ellipse Easily draw various forms of ellipses. Yes

3D Objects Easily draw spheres, cubes, and more. Yes

Curve Easily draw curvy lines and even freeform. Yes

Lines and Arrows Use a selection of connector lines and arrows. Yes

Connector Use another set of connector symbols and lines.  Yes

Effects Open the Special Effects dialog box to rotate, flip, Yes
and otherwise manipulate your images.

Alignment Shift the selected object to a specific alignment ~ Yes
on the page.

Arrange Move objects higher or lower in the stack. Yes

Insert Insert items, such as graphs. Yes

3D Controller Open the 3D Effects dialog box. No

Menu bar

Along the top of the window is the usual menu bar. OpenOffice.org Draw is a
typical “vector” graphics program, meaning that it relies on lines rather than
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dots or other techniques. See Chapter 18 for discussion of the software used
for editing photographs and other heavy-detail work.

OpenOffice.org Draw has too many menu options to cover in depth, so I give
you instead a (nonexhaustive) summary of what you find on each menu:

v File: The usual Open, Save, Save As, Print, and Export commands, along
with a set of wizards (under the term AutoPilot) plus the ability to send
documents through e-mail and create templates

v Edit: The usual Find and Replace, Image Map, and other such editing
commands

v View: The usual Zoom functions and toolbars, along with the ability to
select the display quality and place the program in Preview mode

v Insert: The usual charts, frames, graphics, and spreadsheets, along with
scanning functions

v Format: The usual brush and graphics formatting, along with layers and
style formatting

v Tools: The usual spell-checking, as well as hyphenation, autocorrection,
an image gallery, and an eyedropper for grabbing colors

v Modify: Various options for altering the appearance of an object.

These menus have more features those listed here. Go through and take a
look; you may find a new favorite feature in there somewhere.

Function bar

Directly below the menu bar in a default setup is the function bar, which you
can remove at any time by using the View menu. This series of icons allows
you single-click access to the most commonly used File and Edit features,
among others. The function bar in OpenOffice.org Draw is identical to that
in the other OpenOffice.org applications (refer to Table 17-2).

Object bar

The object bar is directly below the function bar in a default OpenOffice.org
setup. As usual, you can remove the object bar at any time by using the View
menu. This series of icons allows you to click buttons and expand drop-down
list boxes that represent standard presentation software functions, such as
arrow styles, colors, line styles, and other formatting instructions. This one
is identical to the one you found in OpenOffice.org Impress.

Ruler

Directly below the object bar (and to the right of the main toolbar) in a
default OpenOffice.org setup are the rulers. These items mark out the mar-
gins and tabs, for example, of your document in the measuring system of
your choice. To change which system you want to use, right-click the ruler
and change the Measurements to your preferences.
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VYour document

Click in that big white space and start doodling. You can also access a format-
ting pop-up menu by right-clicking in the document section.

OpenOffice.org Draw appears at first glance to have the most limited file type
support for saving when you use the Save As dialog box , but in fact, it sup-
ports a wide range of graphics formats. You can save images to a format
other than the OpenOffice.org Draw format (.SXD) by choosing File=>Export.

Supported graphics formats are BMP, EMF, EPS, GIF, JPEG, MET, PBM, PCT,
PGM, PNG, PPM, RAS, SVG, SWF (Flash), TIFF, WMF, and XPM.

Layout with OpenOffice.Org Math

There’s nothing like trying to type a math or science report and having to
either use multiple lines to show your equations (which never looks right!)

or write them by hand. OpenOffice.org Math is a great solution to this prob-
lem. You can lay out your equations and more in this program and then insert
them into any of your OpenOffice.org documents. Whether you’re a middle
school student or a professional engineer, OpenOffice.org Math just may
thrill you.

Many OpenOffice.org Math functions are different from what you're used to if
you have looked at all the other OpenOffice.org programs. However, in many
ways this program is less complex than some, thanks to its special-purpose
nature. Keep in mind that it’s not a calculation program. It’s for laying out
complex formulas on paper or the screen.

Starting it up
To start OpenOffice.org Math in the distributions I cover in this book, do the
following:

v Fedora Core: Choose Applications=>Officer>OpenOffice.org Math.

v Knoppix: From the main menu, choose Office>OpenOffice.orge>
OpenOffice.org Math.

v Linspire: From the main menu, choose Programs=Business & Finance=
OpenOffice.org 1.1.0c>OpenOffice Math.

1 Mandrake: From the main menu, choose Offices>-Wordprocessors=>
OpenOffice.org Math.

v SuSE: From the main menu, choose Office>Office Suite. When the
Templates And Documents — New Document window appears, choose
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|
Figure 17-7:
The
OpenOffice.
org Math
layout.
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New Document=>Formula and then click Open. You can also open any
type of document from any of the OpenOffice.org tools.

v Xandros: Choose Launch=>Applications=>OpenOffice.orgr>
Formula Editor.

Taking a tour of OpenOffice.org Math

Before you proceed, take a look at the GUI layout shown in Figure 17-7.

Close the Selection dialog box by clicking the small X in the upper right
corner of its window for now, to keep things as uncluttered as possible. You
can get it back at any time by choosing View>Selection.

Main toolbar

Along the left side of the window is the main toolbar, which you can remove
at any time by choosing View>Toolbars=>Main Toolbar. Each icon in this
series represents a different functionality. You're likely to find this main tool-
bar quite different from those in the other OpenOffice.org programs. Mostly,
it’s just smaller. Each icon is described in Table 17-8.

I

100% |
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Table 17-8 The OpenOffice.org Math Main
Toolbar, from Top to Bottom

Button What You Can Do

Zoom In Enlarge the contents of the document section.

Zoom Out Shrink the contents of the document section.

Zoom 100% Shrink or enlarge to the contents’ original size.

Entire Formula  Enlarge or shrink the formula so that it fits in the full screen.

Refresh If you have Viewr>AutoUpdate Display enabled, update the docu-
ment area to match the Commands area.

Formula Click within the formula in Document view so that your cursor

Cursor automatically moves to that position in the Commands area.

Symbols Open the Symbols dialog box, which contains both Greek and

other special-purpose mathematical symbols.

Menu bar

Along the top of the window is the menu bar, a standard in the GUI world no
matter which operating system you’re using. OpenOffice.org Math may be
unlike any program you may have used already, so [ don’t say anything about
what you may expect to find there. I just give you a (nonexhaustive) sum-
mary of what you find on each menu:

v File: The usual Open, Save, Save As, and Print commands that you find
in most GUI programs, along with a set of wizards (under the term
AutoPilot) and the ability to send documents through e-mail, create
templates, and create Web pages

v Edit: The usual Select All and Find commands, along with specialized
commands for moving within the formula

v View: The usual Zoom functions and toolbars, along with screen update
features and more

v Format: The usual font type, font size, spacing, and alignment features
and more

v Tools: The usual Configure and Options entries for customizing the pro-
gram’s setup and behaviors, in addition to formula importing and access
to the symbol catalog

Function bar

Directly below the menu bar in a default setup is the function bar, which you
can remove at any time by using the View menu. This series of icons allows
you single-click access to the most commonly used File and Edit features,
among others. Again, the function bar here is the same as that in Table 17-2.
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Document section
Things get tricky here if you've never used formula-editing software. You can’t
type anything in the main (upper) document window in OpenOffice.org Math.
Instead, you type in the Commands (lower) window. Right-clicking in the
Commands window opens a shortcut menu. To help you get used to working
with the formulas, I suggest that you play around with this tool. For example,
if you have never used software like this, you might follow these steps:
1. Right-click in the Commands window.
The main shortcut menu opens.
2. Select a submenu to open.
For example, Formats

3. Select a formula component within this submenu.

I'm a geek, and I fondly remember taking a class on matrices, so I chose
matrix {...} as an example. Immediately, the code that’s needed in order
to add a matrix to my formula appears in the Commands dialog box. A
moment later, because I'm letting the program refresh the rest of the
screen as [ work, I see what the matrix looks like in the document
window. The combination is shown in Figure 17-8.
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4. Replace each of the <?> entries with the proper letters and numbers
for your formula.

When I change matrix{<?> # <?> jHf <2> # <?>} to matrix{A # B ##
C # D}, I see the result shown in Figure 17-9.

5. Continue adding components to the formula until you’re finished.

Suppose that you want to multiply the matrix by 3. To find out how,
press Enter to go down to the next line in the Commands window (to use
as “scratch paper”), right-click to display the pop-up menu, and choose
Unary/Binary Operators=>a Times b. This choice adds the phrase <?>
times <?> beneath the matrix code. Now you know how to format a
multiplication, so erase this phrase and use it as a guideline to change
your formula to:

3 times matrix{A # B 44 C # D)

This line gives the result shown in Figure 17-20. [ could go on, but I hope
by now that you're eager to start with your own explorations!
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|
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OpenOffice.org Math supports (among others) its own format (.SXM) and
MathML 1.01 (MML), which isn’t a program. MathML is a standard, similar to
HTML for working on the Web, and 1.01 is a specific version of this standard.
For this particular version of MathML, see www.w3.0rg/TR/REC-MathML/.
The main standard page is available at www.w3.0rg/Math/.If you need to
add formulas to Web pages, this site can be quite an interesting read!

Configuring Printing for OpenOffice.org

Before you can print from OpenOffice.org, you may need to set up printing
for this suite. If you already set up your printing in Chapter 7, try printing a
page from any of the OpenOffice.org applications and see whether it works.
For those that are unable to print from OpenOffice.org but can print from
other applications, open the OpenOffice.org print tool from:

v Fedora: Integrated with the main print manager, so you don’t need to do
anything.

v Knoppix: From the main menu, choose Office>OpenOffice.orge>
OpenOffice.org Printer Administration.
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v Linspire: From the main menu, choose Programs=>Business & Finance=

OpenOffice.org 1.1.0=>0OpenOffice Printer Administration.

v Mandrake: Integrated with the main print manager, so you don’t need to

do anything.

v SuSE: Integrated with the main print manager, so you don’t need to do

anything.

v Xandros: Choose Launch=>Applications=>OpenOffice.org>Printer

Administration.

Then do the following:

1.

Click New Printer.

The Choose A Device Type dialog box appears.

. Make sure that Add A Printer is selected and then click Next.

The Choose A Driver dialog box appears.

. Scroll through this screen and locate the make and model of your

printer or choose Generic Printer.

. After you make your selection, click Next.

The Choose A Command Line dialog box appears.

. Click Next to skip this item.

The Choose A Name dialog box appears.

6. Change the name for this printer if you want.

7. If you want to use this printer as your default, click the Use As Default

Printer box.

. Click Finish to add this printer to your list and then Close to close the

printing tool.

Before you close the tool, you may want to click Test Page to see whether
you can print a test page.
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Chapter 18
Multimedia Wow!

In This Chapter

Listening to music

Using, recording to, and ripping from CDs

Creating and modifying high-powered graphics with The GIMP

Watching movies

A\

The price of freedom is responsibility, but it’s a bargain, because freedom is
priceless.

— Hugh Downs

n these days of computing in noisy Technicolor, it just doesn’t feel like a

computer unless you can make it sing and dance. This used to be a weak
point for Linux, but these days there’s little that [ can’t do on my Linux desk-
top machine. From listening to CDs to watching QuickTime movies, you can
do just about anything. Sometimes it just takes a bit of elbow grease to get
things working.

Time to take a trip on the wild side and get your Linux box doing the Macarena.

Because legal complications surround a number of multimedia programs and
their use in countries like the United States of America, some multimedia capa-
bilities had to be removed from some Linux distributions. However, these
capabilities are still available if you know where to look — and if you're in a
legal jurisdiction that allows listening to MP3s, watching DVDs, or other touchy
subjects under patent laws and the DMCA. Chapter 12 shows you how to add
many of the features discussed throughout this chapter.
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Checking Your Sound Card

Before you can listen to tunes, you have to make sure that your sound card is
working properly. After the configuration issues are dealt with, you can move
on to the fun stuff like listening to CDs and Internet radio and downloading
tunes.

Many distributions ask you to test your sound as part of the installation or
immediate post-installation routine. Just in case you skipped this step, the
first thing to do here is locate the sound-testing program (if one exists) to see
whether yours is working:

v Fedora: Choose Applications=>System Settings=>Soundcard Detection to
see whether the card is correctly detected and plays test sounds.

v Knoppix: From the main menu, choose KNOPPIX=>Configures>Soundcard
Configuration to start the sound configuration utility.

v Linspire: From the main menu, choose Settings=>Control Panel~>
Advanced Settings=>Information=>Sound to see whether the card is
correctly detected.

v Mandrake: From the main menu, choose System=>Configuration=>
Configure Your Desktop=>Sound=>Sound Systemr>Hardware to see
whether the card is correctly detected.

v SuSE: From the main menu, choose Control Center=>Sound &
Multimedia=> Sound System=>Hardware to see what card has been
found.

v Xandros: Choose Launch=>Control Center=>Hardware Information=>
Sound to see what sound card the operating system found.

Looking into Your Mixer

If the card seems to be detected properly, then a look at your mixer is the
next important step. Sometimes cards are picked up right, and yet the mixer
for some reason by default has things muted, or other strange things are set.
To find the mixer:

v Fedora: Choose Applications=>Sound & Video=>Volume Control.

v Knoppix: From the main menu, choose MultimediaroKMix.

v Linspire: From the main menu, choose Programs=Audio & MP3=>
Volume.
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v Mandrake: From the main menu, choose Multimedia=>Sound=>KMix.

v SuSE: From the main menu, choose Multimedia=>Volume Control. You
may find other programs useful in this menu as well.

v Xandros: Choose Launch=>Applications>Multimediac®>Sound Mixer.
Mixer terms of interest include the following:

v Lock: When two slider bars appear for a setting, this option just makes
sure that they’re always level with one another.

v Mute: No sound comes from this section.
v PCM: Control the volume for audio files as opposed to, say, CDs.

v Volume: Control the overall volume.

Finally, many of the distributions have a little volume control icon on the
panel. If everything else looks right but you get no sound, click it and make
sure that it hasn’t been pulled down to the bottom.

Investigating Troublesome Sound Issues

If your sound isn’t working, your card may not be supported. The following
strategies can help you to track down a potential solution:

v Proceed to the manufacturer’s Web site and locate the page for the spe-
cific card that you have. This page often has a link to technical support,
drivers, and downloads. If it does, follow these links and see whether a
driver (the piece of software that tells your operating system how to talk
to each piece of hardware) is available for your card in Linux. If drivers
are listed by kernel version — the version of the Linux core that you're
using — type uname -r to see your version number and then choose
the closest driver that you can. You also might have to try the central
tech support page on that site if there isn’t one dedicated to the hard-
ware in question.

v Search on www.google.com for the make and model of your card, plus
the word Linux. For example, I might search for

Yamaha YMF-744B Linux

You may be lucky enough to find a nice, simple solution to your problem.
Or, you may find one that requires you to have a degree in Geekspeak. If
so, see the Web sites that I mention in Chapter 1 for where to go for help
that you can understand.
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v Two special sound-related projects in Linux also might be able to help
you. One is Advanced Linux Sound Architecture (ALSA), which you can
find at www.alsa-project.org/. The other is Open Sound System (OSS)
at www.opensound.com/. There’s also the Linux Sound & MIDI site at
http://1inux-sound.org/.

Listening to CDs

Most of the distributions automatically open up CD players when you place a
music CD into the drive. You can, of course, also open the CD player manually
if you choose, from:

v Fedora: Choose Applications=>Sound & Video>CD Player (see
Figure 18-1).

Figure 18-1:
The plain-

Usume Taiko Ensemble - Borrowed Time
0:12 /4:30
& -

[=[=][x]

Jane CD ||Usume Taiko Ensemble
Player in Every Part of the Animal
Fedora | ——
cD pl‘;v\l/::gé | ?€| 1- Borrowed Time %
_N”«]”““"D||’i‘”!’ﬂ”é

v Knoppix: From the main menu, choose Multimedia=>KsCD, with the minor
caveat that you need to have a second CD drive to use it because the
main CD drive has Knoppix in it!

v Linspire: From the main menu, choose Programs=>Audio & MP3=>CD
Player.

v Mandrake: From the main menu, choose Multimedia=>Sound=>KsCD.

v SuSE: From the main menu, choose Multimediaz>CD Player (see
Figure 18-2).

:
- _—
Figure 18-2: | © Eauas "
The KsCD in | & Stop O Eject
SuSE with a () Previous | () Next
CD playing. Random Loop = | cDDB & Extras -
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v Xandros: Choose Launch=>Applications=>Multimediaz>CD Player. In most
cases, if the CD in question is registered in the CD DataBase (CDDB), the
title and the song names load so that you can see what you're listening
to. (CD DataBase is one of the services that tells your media players
what the name of your CD is and what songs are on it; you can find out
more at www.gracenote.com/.)

If CDDB doesn’t recognize your CD, you can add it to the database by:

v Fedora: In the row above the bottom, click the Track Editor button to
open the CDDB Track Editor (see Figure 18-3), type the pertinent infor-
mation, and then click Save. You can click the right-facing arrows to
expand this dialog box to enter even more information.

v] CDDB Track Editor x|
Artist: i_ Tea Partv
Disc Title: Alhambra
+ Show advanced disc options
|Tit|e Length > Show advanced track options
I 1 The Grand Bazaar 3:56
Figure 18-3: 2 Inanna (acoustic version) 3:18
The CD 3 Silence (acoustic version) 3:55
P|ayer's 4 Turn The Lamp Down (acoustic version) 4:58
CDDB 5 Time 6:57
Track Editor | 6 Sister Awake Remix 4:37
dialog box
in Fedora. @ Help % Cancel | | L3 save |
—

v Knoppix, Mandrake, and SuSE: Click the CDDB button, type the perti-
nent information, and then click Upload.

v Linspire and Xandros: In the row one above the bottom, click the freedb
Dialog icon, type the pertinent information, and then click Upload.

Other menus are available in these players as well. Take a moment to explore
and set up their default behavior so that it matches what you like.

Listening to Internet Radio

Listening to Internet radio stations in Linux is not always the simplest thing
in the world, depending on your distribution. Because of various laws, patents,
and licensing problems, some formats like MP3 are not always supported out
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of the box. The best way to see what you're set up to support right now is to
simply try and listen. After you're sure that your sound is set up properly,
you can try many Web sites with your default browser:

v SHOUTcast for finding links to thousands of online stations, at
www.shoutcast.com/

v Radio-Locator for finding “regular” radio stations offering online
versions, at www.radio-locator.com/

The first place to try is SHOUTcast. When you find a station that you want to
listen to:

1. Click the Tune In! button.

If you already have your software set up, you can listen automatically.
However, you probably don’t if you haven’t listened to online radio
before. If you've never listened to this program’s format before, you will
be asked what program to open the content with.

2. If a program is suggested, click OK to proceed. Otherwise, you will
need to navigate through your filesystem to manually choose the
program.

If you have never used this program before, it probably has a setup rou-
tine it will want you to go through before you continue.

3. If required, walk through the program’s setup routine.

Even after all of this you might be told that the file format isn’t supported.
Fortunately, you are told here what format this is (for example, mpeg).

4. If your software doesn’t support the file’s format, install a program
that does.

For mpeg and VFS, go to Chapter 12 and find how to add RealPlayer. For
ASX and ASF, which are Windows Media Player formats, use Chapter 12
to install mplayer-plugin or Kaffine, or see Chapter 19 for products that
let you run Windows software under Linux.

Software you're likely to encounter as you experiment with Internet radio
includes

v Amarok: A full-featured audio player that’s got some really cool features
like the ability to load images of your album covers.

v Rhythmbox: This is just called the Music Player in Fedora. See how to
add MP3 support to this program in the section “Listening to down-
loaded music.” It can play CDs, Internet (streaming) radio, and
downloaded music.

v RealPlayer: The all-too-familiar program from other operating systems.
It can play Internet (streaming) radio and downloaded music.
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v HelixPlayer: A version of RealPlayer without the pieces that have to be
handed with pay licenses (like MP3s). It can play Internet (streaming)
radio and downloaded music.

v MPlayer-Plugin: A browser plug-in that you can use at times to listen to
formats that other players may not support, including Windows formats.
Least likely to be legal if you're in the United States.

v XMMS: A Winamp clone that can play Internet (streaming) radio and
downloaded music. Sometimes comes with MP3 support and sometimes
doesn’t, but typically ‘you can add MP3 support regardless through your
distribution’s extra repositories (see Chapter 12).

1~ Kaffeine: A full-featured audio/video media player for Internet (streaming)
radio, downloaded files, CDs, DVDs, and so on. Again, this program is of
questionable legality in the United States. In SuSE, if you get a complaint
about “demux” not being included, install the oggmtools package (see
Chapter 4).

v Xine: A fullfeatured audio/video media player for Internet (streaming)
radio, downloaded files, CDs, DVDs, and so on. Again, this program is of
questionable legality in the United States. In SuSE, if you get a complaint
about “demux” not being included, install the oggmtools package (see
Chapter 4).

Listening to Downloaded Music

Downloading music from the Internet is a fun activity. A lot of people like to
pretend that it’s both legal and ethical, when, in fact, it’s often theft, depend-
ing on where you grabbed the music. I leave that ethical issue between you
and your belief system of choice, but because my own ethics say that it’s
theft, 'm going to focus on showing you music that you’re welcome to down-
load — legally and ethically! Take a look at strategies for finding such music,
along with how to listen to it.

One place to find such material is on a band’s own Web site. Many groups
today realize that offering free downloads of their work is a great PR move —
if people love the sample songs, they’re more likely to go out and buy the
album. For an example, [ use one of my own favorite bands, Evanescence
(www.evanescence.com).

Evanescence, like many other bands, has its page done mostly with
Macromedia’s Flash tool. (See Chapter 12 for how to add this functionality
to your distribution.) To listen to music files in general:

v Fedora: Choose Applications=>Sound & Video>Music Player.

v Knoppix: From the main menu, choose Multimedia=>Sound=>XMMS.
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v Linspire: From the main menu, choose Programs=Audio & MP3=>CNR
More>Lsongs to download this tool, and install it in the Audio & MP3
menu.

v Mandrake: From the main menu, choose Multimedia=>Sound=>Amarok.
v SuSE: From the main menu, choose Multimedia=>Audio Player.

v Xandros: Choose Launch=>Applications=>Multimedia=>Media Player. After
you'’re done, to see whether you can listen to any music here, click the
Music link. The songs are in the Flash window on the left. You have the
option of clicking real for RealPlayer, windows for Windows Media
Player, or 1yrics to see the words for this song.

Ripping Music Tracks from CDs

|
Figure 18-4:
The Sound
Juicer

CD Ripper

in Fedora.
|

This is another topic that’s impossible to cover without at least acknowledg-
ing that both ethics and legal issues are involved. I'm not going to get into
legalities here, but my personal ethics are that it’s fine to rip (copy) music
off my own CDs for my own use. If | want to pull my favorite songs off CDs
that I purchased and set them up so I can listen to them collectively in a
random playlist off of my computer’s hard drive, | don’t see a problem with
this. However, doing this and then taking the CD back for a refund is theft, in
my opinion.

So, with that said, a number of music ripping programs are available in Linux:

v Fedora: Choose Applications=>Sound & Video=>Sound Juicer CD Ripper
(see Figure 18-4).

[~ | = =R ES

CD Edit Help
Title: Alhambra
Artist: The Tea Party

Genre: | Alternative 2 |

Duration: 27:48

]Extract |Track |Tit|e Artist |Duration |
1 The Grand Bazaar The Tea Party  3:57

‘ M2 Inanna (acoustic version) The Tea Party  3:19

| E 3 Silence (acoustic version) The Tea Party  3:56

l 4 Turn The Lamp Down (acoustic version) The Tea Party  4:59
¥ 5 Time The Tea Party  6:58

i M 6 Sister Awake Remix The Tea Party  4:39

| §Revread || OExtract
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v Knoppix: None, though you'd need a second CD drive anyway!

v Linspire: From the main menu, choose Programs=Audio & MP3=>CNR
Morer>G-Rip, and add this program, which is then kept in the Audio &
MP3 menu.

1 Mandrake: From the main menu, choose Multimedia=>Sound=CD Ripper
(KAudioCreator).

v SuSE: From the main menu, choose Multimedia=>CD/DVD Tools.

v Xandros: None, though you can use the Xandros File Manager to burn
CDs. (See the section “Burning CDs and DVDs,” later in this chapter.)

To rip songs, with the Sound Juicer, from a CD that you've already inserted:

1. For each song that you don’t want to rip, uncheck the Extract check
box, next to the song.
The check mark disappears for each song that you don’t want to digitize.

2. Choose Edit>Preferences.

The Preferences dialog box appears, as shown in Figure 18-5.

Preferences

CD Drive
'HL-DT-STDVD-ROM GDR81618
[ Eject when finished

Music Folder

/home/dee [/Browse...

Track Names

Directory Hierarchy: ‘ Album Artist, Album Title b ‘
File Name: ‘Numher-TitIe "‘
Example Path: Album Artist/Album Title/09 - Track Title

] Strip special characters

Track Format
—

] ® Ogg Vorbis O MP3
Figure 18-5: | . Ac O Wave
The Sound )
Juicer | Quality

Preferences | Coming soon!

dialog box. & Help % Close
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. Select your preferred sound format.

[ highly suggest Ogg Vorbis because this format is easily handled on
Linux machines without any inherent legal problems and is also better
compressed than MP3 for equivalent sound.

. Use the Browse button to select where you want your sound files

saved.

. In the Output Name section, select how you want Sound Juicer to

name and arrange the files in subdirectories.

6. Make any other configuration changes you want to make.

7. When finished making changes, click Close.

10.
11.

The dialog box closes.

. Click Extract.

The Progress dialog box appears, showing you what track you’re on and
how far within that track you are.

. Choose CD~Eject.

The CD tray opens.
Remove the CD and close the tray.

Close Sound Juicer.

Burning CDs and DVUDs

A CD burner is a great way to make data backups (especially if it’s a rewrite-
able), save and share your digital photos, put together multimedia memento
scrapbooks, and more. Many tools are available that allow you to burn CDs
under Linux:

v Fedora: Choose Applications=>Sound & Video=>K3b if you have KDE

installed, or add grip (see Chapter 12).

v Knoppix: From the main menu, choose Multimedia~>K3b.

v Linspire: From the main menu, choose Programs=Audio & MP3=>

CD Burner.

v Mandrake: None installed by default. Using Chapter 12, look for the

programs arson, xcdroast, and rhythmbox.

v SuSE: From the main menu, choose Multimedia=>CD/DVD Burning.

v Xandros: Choose Launcher=>Applications=>Multimedia=>CD Writer.
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Creating and Modifying Graphics

\\3

|
Figure 18-6:
The GIMP's
main dialog
box in
Mandrake
10.1.
|

The GIMP is a graphics program that’s considered in many ways equivalent to
Adobe Photoshop. Many don’t consider The GIMP the friendliest program on
the planet, but at the very least, it has enough features to keep you busy exper-
imenting for weeks! To open The GIMP:

The GIMP may not already be installed. In Linspire and Xandros in particular,
you might need to use what you learned in Chapter 12 to add this software
before you can use it.

v Fedora: Choose Applications=>Graphics=>GIMP Image Editor.
+* Knoppix: From the main menu, choose Graphics=>GIMP Image Editor.

v Linspire: From the main menu, choose Programs=Multimedia & Design=>
CNR More=>GIMP, which is installed under Multimedia & Design.

v Mandrake: From the main menu, choose Multimedia~>Graphics=>The
GIMP v2.

v SuSE: From the main menu, choose Graphics=Image Editing.

v Xandros: Choose Launch=>Applications=>Graphics=>GIMP Image Editor.

When you start The GIMP for the first time, you have to walk through its

user setup routine. Fortunately, you can just click Continue each time, unless
you’re a graphics guru who has a particular reason to want to do things in a
different way. After you’ve clicked past all these dialog boxes, a collection of
one or more dialog boxes pops up containing the GIMP main dialog box (see
Figure 18-6) plus additional tool dialog boxes. | recommend closing all but the
main one for now, just to keep your screen and brain uncluttered.
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The GIMP is an incredibly complex program, with entire books written for the
people who really want to use it heavily. Great starter links for working with
The GIMP are

v GIMP Tutorials Pointer Page: http://empyrean.lib.ndsu.nodak.
edu/~nem/gimp/tuts

v RRU GIMP Tutorial: www.rru.com/~meo/gimp/Tutorial

 The official GIMP.org site’s tutorials page: www.gimp.org/tutorials/

v+ The GIMP Savvy Web site (with a full book available for reading
online): http://gimp-savvy.com/

Watchin’ Movies

A\

These days, you can watch many kinds of movies on your computer. Whether
it’s a Flash animation, a DVD, or a movie trailer, you've got the tools that you
need right at your fingertips (or just a click away). You may have even
installed some already while trying to access other multimedia features. Here
are some of the tools of the trade.

Watching a DVD in Linux is a bit of a legal quagmire if you live in the United
States. The Digital Milennium Copyright Act (DMCA) and other issues make
it tricky for any open source program to navigate the licensing maze when it
comes to movies that are encoded or protected in various fashions. However,
not all DVDs have such countermeasures enabled: There are DVDs that
Americans can watch under Linux with no trouble. (Note that I say watch,
and not copy or pirate.)

For more on the DMCA and the problems it causes, see anti-dmca.org.

To watch a DVD in Linux, first check Chapter 11 to see what your distribution
will do if you just pop a DVD into your drive. Of course, you can also start a
program by hand, though you may have to download it first:

v Fedora: Doesn’t ship with any DVD players by default. Use Chapter 12 to
add repositories so you can install Kaffeine, Xine, or Mplayer.

+* Knoppix: From the main menu, choose Multimedia=Video=>xine media
layer.

v Linspire: Purchase a legal DVD player from the Click And Run Warehouse
by going to the main menu and choosing Programs=> Multimedia &
Design=>CNR More=>DVD Player (see Figure 18-7). Or install Mplayer
from the same place.
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v Mandrake: From the main menu, choose Multimedia=>Videor>Kaffeine.
v SuSE: From the main menu, choose Multimediar>Video Player.

v Xandros: Launch=>Applications=>Multimedia=>Video Player.
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Chapter 19

Windows-0nly Media Formats
and Programs

In This Chapter

Running Microsoft Office and Web tools with CrossOver Office
Using Windows inside Linux with Win4Lin

Playing Windows games with Cedega

Creating a “virtual computer” inside Linux with VMWare
Trying out the free Windows inside Linux tool, WINE

A gentleman is a man who can play the accordion, but doesn't.

— Unknown

Fere is little more maddening for computer users than to find a file online
or have someone send a file, just to discover that they can’t use it. While
this issue is less of a problem for Linux users as each day passes, things do
sometimes still crop up that have to be dealt with so that you can move for-
ward instead of spinning your wheels. Also, you may want certain programs
that you just can’t live without and haven’t found a replacement that you're
happy with yet.

Fortunately, you have a number of options available in both of these scenar-
ios. If you’re looking for software, then a good place to start (aside from
Chapter 12) is 1inuxshop.ru/Tinuxbegin/win-Tin-soft-en/. Here, you
can see whether there really isn’t a Linux tool that can do the job. You may
be surprised. After looking at this site, you have two options. You can take
advantage of commercial packages that can help you to access these docu-
ments and features under Linux, or you can wade in and try to get Wine
working, which is the free base beneath all these tools. When it comes to file
formats, you also ultimately may have to go looking for ways to run Windows
tools under Linux to handle files that you otherwise can’t use under Linux
quite yet. Do a Web search on the file format (for example, .doc) and the
word 1inux for recommendations as well.
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Commercial Software

SMBER

|
Figure 19-1:
The
CrossQver
Office Install
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Xandros 2.5.
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A growing number of commercially available tools let you work with anything
from Microsoft Office to your Windows games under Linux. Mind you, ulti-
mately the Linux user’s goal is to not have to use any of these extra program
layers — but in the meantime, it’s nice not to be inconvenienced. I've reviewed
or at least used every one of these products (often more than once over the
years), so I'm not just going by their Web sites.

Many of these vendors offer server, as well as desktop products. I'm focusing
on the desktop. For more about their server products, check out their Web
sites.

CodeWeavers

CodeWeavers (www.codeweavers.com) provides an excellent product that I
use from time to time: CrossOver Office. This program allows you to use
Microsoft Office (along with a growing number of office applications) directly
under Linux. It also comes with a hefty number of plug-ins (see Figure 19-1)
that you might miss when it comes to Web surfing. It’s a bit jarring to run
Microsoft Word and Windows Media Player under Linux at first — because
there’s no native (without special software) way to do this otherwise — but
it’s certainly handy. You can even use the iPod’s iTunes through CrossOver
Office!

CrossOver Installation Wizard

: Install Software

bl The CrossOver Installation Adobe Acrobat Reader 5.0
g :’;"iafdh\'m“ guide WUT Adobe FrameMaker 7.1
roug 2 process o
1+ adding Windows software o Adobe Ehotbshop B
Adabe Photashop 7
(<0} your systam.
Cortona VREML Client
g To begin, select the option DCOMSS
A [t vouvant o install, and | preamweaver MX
'c i G ehrary Reader
LWl Software marked with a * Is eFax Messenger 2
c.: already installed | Flash WX

1 Showe all supported applications

I Install unsupported software

Cancal Help Mt >
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What I most appreciate about CodeWeavers (and all these companies, really)
is that they are very upfront about what works really well, what works except
for a few features, and what works not so well. All you have to do is check
their Web site. For those who always seem to want to scream “piracy” when it
comes to Linux, you actually do have to own the programs you want to run
(say, ‘Microsoft Office) and install them through CrossOver Office off of

their original CDs or DVDs. However, you don’t have to own the version of
Microsoft Windows the software would run under. CodeWeavers has built a
re-implementation of the necessary Windows functionality under the hood
instead.

Are you an iPod and iTunes junkie? There’s no Linux version of iTunes avail-
able, but CrossOver Office lets you run iTunes under Linux.

A plus to CodeWeavers CrossOver Office is that the applications run in indi-
vidual windows just like every other program on your machine. A minus is
that not all Windows software is supported, because hooks have to be built
under the hood for each new piece of software.

CrossOver Office comes with the Xandros Deluxe desktop (available for instal-
lation through the Xandros Networks, see Chapter 12) and is available for
purchase from the Xandros Networks store for other Xandros users.

WinbLin

Another option is Win4Lin from NeTraverse (www.netraverse.com/).
Win4Lin actually offers you a platform within which you install Microsoft
Windows (so have those CDs handy) and then run programs on top of it. As
of this writing, Win4Lin supports Windows 95, 98 (see Figure 19-2), and ME.
Soon, it will support newer versions of Windows as well.

A plus to Win4Lin is that it supports a more full range of Windows software. A
minus is that it runs in its own separate window, so its applications aren’t
integrated into the rest of your desktop. You also have to actually keep your
Microsoft Windows operating system CDs around because you need to be
able to install the operating system into Win4Lin — though you can then put
them in storage after you've done the installation. You also end up having to
have a special kernel (boot session) to run Win4Lin 5.0, so if you hate reboot-
ing, this program may not be the solution for you — though you could just
make this your default boot option.

Win4Lin is available for purchase for Linspire users through their Click
And Run Warehouse; from the main menu, choose Programs=>Utilities=>
CNR More=>Win4Lin.
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|
Figure 19-2:
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+ Windows 98 Setup

Cedega

More interested in games than office tools? There’s also TransGaming’s
Cedega (www.transgaming.com), which was once called WineX. This version
of the free Wine project (see the upcoming section “Installing and Using Wine”)
is specifically designed to support Direct X, which is used in Windows to make
programming for multimedia and games easier. Subscribers have access to
regular updates, allowing them to make use of their favorite games and also
add any games they like to the growing list of games that are being tested
with the system.

Go towww.transgaming.com/searchgame.php, scroll to the bottom of the
screen, and click the Here link. A listing of all games, in order, appears so that
you're able to find out what games are supported at what level. A handy
new(ish) feature is the Point2Play installer (see Figure 19-3), which you

can use to ready your computer for the Cedega experience.

A plus to Cedega is, again, that you don’t need to keep those Windows CDs
lying around. However, its support for individual games can be spotty, so be
sure to check the Web site before you invest in this product. Also, be sure to
make use of the help forums!
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|
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UMware

If you absolutely have to do something under Windows itself but only have
one computer and it’s running Linux (or vice versa, for that matter), there’s
VMware (www.vmware.com). This is a popular tool in technical support offices
where people need access to many different kinds of machines to test things.
It’s also popular with authors, like myself, because it allows us to grab those
tricky screenshots of the boot process and installer screens.

In VMware, you run a full session of another operating system (or even an
extra session of the same one you’re running on the main machine) within
your desktop — see Figure 19-4. If your machine is powerful enough, you
could have five different operating systems all running in their own windows
on a single computer.

A minus to VMWare is that it requires a bit of extra oomph in your system.
Check out its requirements and then try to go as far above them as you can.
It also runs in a self-contained window. A plus, though, is that this program
really is the next best thing to buying another computer.



364 Part IV: Getting Things Done
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E&Vou do not have Vhiware Tools installed.

Installing and Using Wine

And then there’s Wine (www.winehq.org), a complete rebuild of Microsoft
Windows 9x functionality that runs under Linux. Wine is in many ways the
mother of everything in the previous section. However, because it’s a free
and very complicated project, it’s not quite as friendly as the commercial
versions. It’s kind of like the others but with all the makeup and hairspray
removed.

Some Linux distributions offer Wine RPMs directly on their installation CDs
or through their packaging schemes. For the distributions covered in this
book, do the following to install WINE for the distributions that don’t have
it already installed, or to start it for the distributions that do have it. (See
Chapter 12 for more details on installing software.)
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v Fedora Core: Available through yum, depending on what repositories
you've added (see Chapter 12). Type yum search wine to find the
available packages. Then, install both of them. For example, on my AMD
Athlon machine, [ type yum -y install winesetuptk wine.athlon
in order to install the setup tool and the main program.

v Knoppix: From the main menu, choose WINE.

v Linspire: From the main menu, choose Programs=>Software
Development=>CNR More>WINE for Linspire.

v Mandrake: Available through the package installation program
(Chapter 12). Search for wine. (xwine is not the same as WineX.)

v SuSE: Available through YaST’s software installation routine (see
Chapter 12). You can find it in System=Emulators=>PC ©>WINE.

v Xandros: Not available. The adventurous are welcome to go to
www.winehq.org, click the Download link, and try to build this
program from source code (see Chapter 12).

You can find the Wine documentation at www.winehq.org/site/docs/
wine-user/index. Start in the “Configuring Wine” section.

Now comes the fun part — trying to run your old Windows software. You
don’t really run Wine, per se. Instead, you invoke Wine whenever you need to
use something from the Windows world. To install a Windows program through
Wine, insert the CD-ROM or floppy into the appropriate drive. Your distribu-
tion might open the File Manager for you, or you may need to open the File
Manager manually. Regardless, your goal is to run the installation routine,
which is typically SETUP. EXE. You can double-click this icon in the File
Manager and, when asked what program you want to use to open this file,
answer wine.

As [ write this, I'm trying some old home design program I bought back when
[ was silly enough to think I'd be able to afford to build a house before [ was
ninety. Because it’s difficult to describe a standard Wine session, I thought I'd
walk you through how this goes for me.

The installer loads and runs just fine. I stick with the defaults (because Wine
is still a work-in-progress and it’s best not to taunt it with getting too fancy)
and then wait while the installer adds all of the files to my SuSE system. Now,
to run my new old software. To run a Wine program, I first need to know what
the path is to that program. I can find it by looking in the ~/ .wine directory.
In this case, the program was installed into /home/dee/.wine/fake_
windows/Program Files/HOUSE. The file house.exe looks like the one

for launching the program.
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For example, you would search for sarge if you're using the version of
Knoppix that came with this book. Unfortunately, a lot of what you find
is going to be somewhat cryptic. Pick a repository or three.

. Once you have found something you're interested in, check to see

whether a red X is in its check box.

If so, that repository isn’t incredibly stable, and you may not want to
use it.

. If there is no red X, or you’re willing to risk an unstable repository just

in case it’s up and working, click the Download As Text link to the right
of the listing.

You're brought to a page that looks like the following (the indented items
are actually part of the previous line; there are only three lines here):

# Helix Software for Debian
deb http://helix.alioth.debian.org/deb sid main non-free
deb http://helix.alioth.debian.org/deb sarge main non-free

. Find the line in this listing that has the name of your Debian version

in it.

For example, the last line has sarge in it.

8. Open the /etc/apt/sources.list in your favorite text editor.
9. At the end of the file, add the line you found.

For example:

deb http://helix.alioth.debian.org/deb sarge main non-free

There are other repositories listed in here that you can make available
by removing the # at the beginning of their line. Only do this with lines
formatted like the preceding code line. Everything else is a “Comment,”
which is used to just leave notes so you can understand what you're
looking at.

10. Save and exit the file.

Go to the section “Keeping Knoppix Up to Date,” earlier in this chapter for
how to load up the new list of software and then go to the section “Installing
new Software on an Installed Knoppix System” for how to add software from
your new repositories.

Aren’t Sure a Machine Actually Works?

If you're having hardware trouble, you can try booting a machine from Knoppix
to get a hint of where the problem is. If the machine can boot with Knoppix,
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then the problem may be hard-drive oriented. If you run into identical prob-
lems with Knoppix that you did under Windows or another form of Linux,
then you have more hints there.

[ had problems on one machine with three different distributions, and after
a lot of frustration and observation, I realized that the machine only crashed
in the GUI in all three, and never when I was just using the command line.

I changed the machine’s video card and voila, everything was fine.

Exploving Tons of Linux Tools

Knoppix comes with an amazing array of tools for just one CD-ROM. You can
play with multimedia tools for television, sound editing, and more without
having to hunt down and install a new piece of software. When you find some-
thing you really like, then you can go about seeing whether you can get it and
add it for your own distribution. Heck, a lot of this software is available for
Windows, too!

You can also use Knoppix to test documents like Web sites and word-
processing files to make sure that they work right under Linux. You can
even check to see whether WINE (see Chapter 19) can handle a particular
Windows program that you're hoping to run, because WINE comes installed
by default in Knoppix. If the program works in Knoppix, you might then not
bother to install WINE under another distribution.
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’_I‘he 5th Wave By Rich Tennant

ORLOTENNANT

*When we started the company, we Weren't

going to call it 'Red Hat' Bub eventually

We decided it sounded better than Beavd
of Bees Linux."



In this part . . .

Fis part adds some extra material to support the rest
of this book. Starting with the ever-popular and useful
Appendix A, you find a reasonably comprehensive and
friendly compendium of common Linux commands, ready
for use as a desktop reference. Appendix B provides an
overview of and information about the DVD included with
this book (and how to get a set of CDs if you don’t have a
DVD-ROM drive), including basic booting instructions
when installing Red Hat Linux and a list of what’s on

the DVD.




Appendix A
Common Linux Commands

In This Appendix
Archiving and compression commands
Communication commands
File commands
System control commands

C omputing novices often marvel at the keyboard dance Linux experts typ-
ically perform. Sure, these experts know about modern advances like the
mouse and graphical interface, but these keyboard musicians prefer the home
keys and find that they can work faster with the keyboard. It takes some time
to reach this level of proficiency, but every expert was a novice at one time,
and any novice can become an expert by delving into the various commands
available and getting plenty of practice.

In this appendix, you find the commands listed by themes, according to what
they can actually do for you.

So, read on — and dazzle your friends with your command-prompt finesse.
When they ask you how and where you figured out all those commands, just
smile and mumble something about the voices in your head — and, of
course, keep this section dog-eared and within reach of your computer.

Linux Commands by Function

Because every command serves a specific purpose, organizing these tools
into groups according to their individual functions isn’t difficult. If you know
what you need to do but don’t know which command does the job, flip
through this section to start your search. From here, you can dig further by
referencing man pages and other help information (online sites and reference
books, for example) or by looking in this book’s index for further coverage.

To access a man page, type man command at a command prompt. For exam-
ple, man 1s shows you the help information for the file listing command.
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Archiving and compressing

Although disk space isn’t as much of a premium as it once was, bandwidth
and backup media still are. Subsequently, this group provides a potpourri of
tools for compacting and organizing data for storage, as shown in Table A-1.

Table A-1 Archiving and Compressing Tools
Command Purpose
bzip2 Compresses files into . bz 2 format. Used mostly for

incredibly large sets of text files (which is what source
code actually is).

compress Compresses files into . Z format. Pretty old and not
used much in the Linux world.

gunzip Uncompresses . gz files and . tgz files.

gzip Compresses files into . gz format.

tar Packages files together in a group.

uncompress Uncompresses files from .Z format.

unzip Uncompresses files from . z1ip format.

zip Compresses files into . zip format.

Built-in bash commands

Some commands don’t even seem to exist if you try to look up their help
information in the man pages, and the commands don’t show up as files on
your system. Remember, as you type commands at the prompt, that you're
communicating with a type of program called a shell. (In my case, it’s bash,
the default Linux shell.) The shell has a set of commands, included in the fol-
lowing list, that you can use to communicate with it, as shown in Table A-2.

Table A-2 Shell Commands

Command Purpose

alias Creates command shortcuts.

env Lists your current environment variables and their settings.
export Whenever you're told to set an environment variable, use

this first so that the variable will be remembered properly.
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Command Purpose
history Lists off the last 1,000 commands you've typed.
unalias Removes command shortcuts.
P If you try to view the man page entry for some of these commands, you find

instead the help information for BASH BUILTINS loads. To search through
this massive manual, press the forward slash (/) key to open the man search
interface and then type the name of the command you want to search for.
Press Enter to start the search. The interface stops in the first spot where the
term is found. If you want to try again, press the N key to proceed to the next
occurrence of the word.

For example, you might be reading the massive bash man page (type man
bash to access this page), but perhaps you're only interested in items related
to prompts, which are the bits of text that appear to the left of your cursor in
a text window. An example prompt is

[dee@catherine deel$

So, you might type /prompt and press Enter to jump down to the first
instance of this word. If the text around the word doesn’t reflect what you're
looking for, you’d press the N key to jump to the next one, and so on.

Getting Help

When you’re digging around for help on a command, you can call on an inter-
esting range of shell commands for assistance, as shown in Table A-3.

Table A-3 Shell Help Commands

Command  Purpose

apropos Looks for commands that contain a keyword in their man page
descriptions.

info One way of finding help information. You can find instructions for this
tool atwww.gnu.org/software/texinfo/manual/info/

man The primary way of getting help in Linux and Unix.

whatis Gets a one-line description of a command.

Locating details about the command-prompt options of a command is a
never-ending pursuit. The man page system provides some helpful guides at
your fingertips for rapidly finding this detailed information.
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Files and file system

No matter which operating system you’re using, it’s hard to do anything with-
out being able to find your way through and work with the file system. The
following utilities help you find your way:

File organization

Boxing, packing, sorting, shipping — I'm always shuffling files around on my
system. File organization commands provide tools for moving files and file
system units around, as shown in Table A-4.

Table A-4 File Organization Tools

Command Purpose

cd Changes directories.

cp Copies a file.

df Shows partitions and how much space they have.

du Shows how much disk is being used in the current directory
and below.

In Creates a shortcut.

1s Lists the contents of a directory or information about a file.

mkdir Creates a directory.

mv Moves or renames a file.

pwd Shows the path for the directory you're currently in.

rm Deletes afile.

rmdir Deletes an empty directory.

File attributes

Files are much like candy bars. The wrappers provide information about the
ingredients, size, and package date — all descriptive of the tasty nugget
inside. (Perhaps the wrapper is even childproof.) Files keep all this wrapper
information in an inode. Along with the capability to change file inode infor-
mation, these commands can return data about the content of the file, as
shown in Table A-5.



Appendix A: Common Linux Commands

Table A-5 File Attributes Commands

Command Purpose

chgrp Changes the group associated with a file.

chmod Changes a file's permissions.

chown Changes who owns a file.

file Shows what type of file you're dealing with.

stat Shows some statistics about the file.

touch Creates an empty file of this name.

wC Shows how many words, lines, and so on are in this file.

File locators

Where, oh, where can my file be? These commands, shown in Table A-6, help
you locate files in Linux’s monster tree-structure file system:

Table A-6 File Locators Commands

Command Purpose

find Hard-core filesystem search tool.

locate Lighter weight filesystem search tool.

which Tells you the path for the program that would be run if you

typed this command.

File viewers

File browsing is a favorite pastime of many a system user. These tools pro-
vide a variety of utilities for viewing the contents of readable files of all sizes.
Unlike using a full-screen editor, you cannot damage the contents of a file
with these commands, shown in Table A-7, because they’re read-only tools:

Table A-7 File Viewers

Command Purpose

cat Dumps the contents of the file to your screen.
head Shows the first ten lines of a file.

(continued)

399
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Table A-7 (continued)

Command

Purpose

less

Shows the file a screen at a time.

more

Shows the file a screen at a time.

tail

Shows the last ten lines of a file.

File system commands

These commands, listed in Table A-8, provide information or perform actions
on the entire file system, from creation and tuning to repair and recovery.
Some of these commands return data only, whereas others also provide you
with surgical instruments for serious file-system hacking:

Table A-8

File System Commands

Command

Purpose

badblocks

Searches a partition for bad blocks.

e2fsck

Checks and repairs an ext2 or ext3 filesystem.

e?2label

Applies a filesystem label to an ext2 or ext3 partition.

eject

Ejects a CD or DVD.

fsck

Can check and repair many types of filesystems.

mkfs

Creates a filesystem (format a partition).

mount

Loads a partition into your filesystem.

sync

Saves all information out of buffers onto disks.

tune2fs

Adjusts ext2 and ext3 filesystem parameters.

umount

Removes a partition from the filesystem.

mtools

The mtools suite of utilities provides a nice way to transfer information to
your Microsoft friends. Although Linux has native support for Microsoft
Windows and DOS file systems, your Microsoft cohorts don’t have access
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to Linux (ext2 and ext?3) file systems. To keep everyone happy, you can buy
preformatted MS-DOS disks and use them with the mtools commands (see
Table A-9) so that you can swap them back and forth with your friends who
are using Windows:

Table A-9 mTools Commands

Command Purpose

mcd Changes directory in DOS format on a DOS disk.

mcopy Copies DOS files to and from Linux.

mde Deletes a DOS file.

mdeltree Deletes a DOS directory and its contents.

mdir Lists a DOS directory's contents.

mdu Shows how much space is taken and available for a
DOS partition.

mformat Formats a partition for DOS.

mlabel Applies a DOS volume label.

mmd Creates a DOS directory.

mmount Mounts a DOS disk or partition.

mmove Moves or renames a DOS file or directory.

System control

These commands provide system-wide information and control. Normal
users can run many commands to obtain system information; however, com-
mands that actively change the configuration of the system need to run while
you’re logged in as root — or have utilized the su command to temporarily
become the superuser.

Administration

Some administration commands, shown in Table A-10, don’t fall neatly into a
category.
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Table A-10 Administration Commands
Command Purpose
passwd Change a particular user’s password. Any user can run this com-

mand to change their own password. Only root can use it to
change someone else’s.

su Switch to another user account without logging out of this one.

Kernel module handling

You may sometimes need to add kernel support for an additional device (soft-
ware or hardware). If this need arises, you have a limited number of choices:
You can either rebuild the kernel or install a loadable kernel module. Although
rebuilding a kernel doesn’t exactly require a Ph.D. in nuclear science, consider
it a time-consuming nuisance that’s best to avoid. The commands in Table
A-11 enable you to include the kernel support you need while the system is
running, without having to rebuild the entire thing from scratch:

Table A-11 Kernel Support Commands
Command Purpose
depmod Regenerates your module dependencies.
insmod Loads a module by hand.
1smod Lists the modules your kernel has loaded.
modprobe Loads a module by hand along with its dependencies and settings.
rmmod Unloads a module by hand.
Processes

Most of your system activity requires processes. Even when your system
appears idle, a dozen or so processes are running in the background. These
commands, shown in Table A-12, enable you to check under the hood to
make sure that everything that needs to be running is running and that
you're not overheating or overtaxing resources:
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Table A-12 Process Commands

Command Purpose

at Has a command run at a particular time.

atq Works with the at queue.

crontab Sets up commands to run at regular intervals.

kill Stops a process by its number. Often used as ki11 -9 fora
harsh stop for something that won't die.

killall Stops a process by name rather than number.

nice Assigns a CPU use priority to a process.

pidof Gets a program’s ID number.

ps Gets a lot of programs’ ID numbers, usually used as ps aux.

pstree Shows the relationships between programs.

renice Changes a program’s CPU use priority.

top

Shows resource use over time.
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Appendix B
About the DVD-ROM

Fle DVD-ROM included with this book contains everything you need to
install and run Fedora Core 3, Knoppix 3.6, Linspire 4.5, Mandrake 10.1,
SuSE 9.2, and Xandros 2.5. Collectively, this content is the equivalent of 11
CD-ROMs that you would have to download for yourself. Because it can be
too confusing to try to focus on everything, the primary focus within this

book is on Fedora Core 3. This distribution includes the following:

v Fedora Core 3: A complete copy of the software for the latest and great-
est version of the consumer-level Red Hat Linux, for your computing
pleasure. If you are interested in the source code, you can download it
directly from Red Hat’s Fedora Project site at http://fedora.redhat.
com. We thought that you might not mind us using the space that would
have gone to multiple CD’s worth of source code to include lots and lots
of other software instead!

+ RPM (Red Hat Package Manager): The Red Hat software distribution
and installation management environment, wherein Linux updates and
new facilities are packaged for easy installation on your Linux machine.

v KDE (the K Desktop Environment) and GNOME (GNU Network Object
Model Environment): The two leading graphical user interfaces for
Linux. You can pick the one you like best!

v Mozilla Firefox: The best-of-breed Web browser for your Linux machine,
just waiting for your surfing pleasure.

v Samba: The best way to integrate Linux servers with Windows users.
Samba lets your Linux machine masquerade as a Windows server so
that Windows users can grab files and print documents hassle-free.

v Apache Web Server: The world’s most popular (or at least, most fre-
quently used) Web server software.

v Games!: Tons of games; enough to help you procrastinate for weeks!
v OpenOffice.org: A full-featured and popular office suite.

Or, you can download Fedora yourself by going to http://fedora.
redhat.com.
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But that’s not all. This DVD also contains the ISO images (the files you can
use to make your own CDs) for:
v The full version of Linspire 4.5, which you would normally have to buy!

v A LiveCD (see Chapter 4 for an explanation of a LiveCD) version of the
popular SuSE Linux 9.2 distribution, with its default KDE desktop.

v The “open circulation” (free) version of Xandros 2.5!

v The full version of Mandrake 10.1, another popular distribution.
(See Chapters 1 and 4 for more information on these distributions.)

You can use both Fedora and Knoppix directly off the DVD-ROM. The others
you can use your own CD burning software and (legally) use it to write the
ISO images to CDs. The files are contained with the DVD-ROM’s distros
directory. If, for some reason, you can’t use the DVD, you can get the distribu-
tions discussed in this book by going to:

v Fedora: http://fedora.redhat.com
v Knoppix: www. knoppix.net

v Linspire: www. linspire.com

v Mandrake: www.mandrake-Tinux.com
v SuSE: www.suse.com

v Xandros: www.xandros.com
Getting all of these (except Fedora) is covered in more detail in Chapter 4.

When it comes time to burn your CD-ROMs or DVD-ROM, make sure that you
tell your CD burner that you're working with ISO images (usually the option
has something to do with the word “image”). If you burn the CD and find that
it contains just one big file (the ISO file), it will not work. The ISO image actu-
ally contains all the files that would be on the CD, so if you put the CD in and
find that it contains many files, the CD was created properly.

In addition, if you want the source code for those distributions that are just
ISO images (Xandros, Linspire, SuSE, and Mandrake) sent to you, please com-
plete the online coupon at www.dummies.com/go/1linux3sourcecoupon.

System Requirements

Make sure that your computer meets the following minimum system require-
ments. If your computer doesn’t match up to most of these requirements, you
may have problems using the contents of the DVD-ROMs:
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v A PC with an Intel-compatible Pentium-class processor: | recommend
a 400MHz Pentium II or better for using Graphical mode, though for a
heavy use desktop system, “more is better.”

v At least 256MB of RAM: You need at least 192MB of RAM for Graphical
mode. (Linux can handle as much RAM as you can fit into a typical PC,
and more is almost always better than less.)

v~ At least 650MB (the barest minimum) of hard drive space: I recom-
mend 2.5GB and as much as 5GB if you want to install all the software
from the DVD-ROM. You need less space if you don’t install every pro-
gram, but you should go ahead and make 5GB of space available, to
give yourself more options.

v A DVD-ROM drive — double-speed (2x) or faster: The faster the DVD-
ROM drive, the faster your installation experience. A coupon is offered
in this book if you need to order CDs to replace the DVD.

v Just about any VGA monitor: Just about any monitor does the trick, but
you want one that’s capable of displaying at least 256 colors or grayscale.

v A keyboard and a mouse: You need both items so that you have a way
to communicate with your Linux system and tell it what to do!

v+ A 3%-inch floppy drive is handy, although not absolutely necessary:
You might need to start the installer with a floppy, though most people
won’t have to.

v Some kind of network connection: Again, the faster your Internet con-
nection, the less time it takes to update your installation to the most
recent versions. I use a cable modem for my Internet connection, and I
like the increased speed when it comes to dealing with the many and
varied sources of Linux software and updates online. See Chapter 8 on
the various ways to connect to the Internet.

If you need more information on PC basics, check out PCs For Dummies by
Dan Gookin (published by Wiley Publishing, Inc.).

Using the DUD-ROM

You can take either of two basic approaches to using the Fedora Core installa-
tion DVD-ROM. I cover each one in separate step-by-step lists. I tell you in
this section how to pick which set of instructions to follow. The two ways to
use this DVD-ROM are shown in this list:

v If you can boot from your DVD-ROM drive (which probably means that
you have a newer PC), follow the instructions in the following section.

v If you can’t boot from your DVD-ROM drive, for whatever reason, follow
the instructions in the upcoming section “Booting from a Linux floppy
disk.” Choosing this option means that you boot from a Linux boot
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floppy disk, with the DVD that came with this book already inserted into
your DVD-ROM drive. (To create a Linux boot floppy disk to enable this
approach, please check out the instructions in Chapter 2.) The floppy
disk handles the beginning of the process and then turns the rest of the
installation over to the DVD-ROM.

Booting from the DUD-ROM

To install items from the DVD-ROM to your hard drive, follow these steps:

1. Insert the DVD-ROM into your computer’s DVD-ROM drive.
2. Reboot your PC.

As long as your PC is configured to boot from the DVD-ROM, this step
starts the Linux installation process for you automatically.

3. If you want to install Fedora, type 1inux at the boot prompt. If you
want to boot into Knoppix without having to install anything, just
press Enter.

Congratulations! The Linux installation process is now under way, or you're
just about to use Linux without having to install a thing. For the rest of the
gory details on the fascinating task of installing Fedora, please consult
Chapter 3. If you had to order the CD-ROMs, then boot with the first CD for
the same effect as booting with the DVD.

Booting from a Linux floppy disk

To install the items from the DVD-ROM to your hard drive with a boot disk
(I show you how to make one in Chapter 2), follow these steps:

In case you have a problem
installing from the DVD

On some PCs, after booting from the compan-
ion DVD, Knoppix and Fedora Core installa-
tion may not work. If you have such problems
with the DVD, you can download Knoppix from
www . knoppix.net and burn your own CD-
ROM from there. For Fedora Core, please visit

www.dummies.com/go/1inux3source
coupon to obtain the CD set. Note that this
problem doesn't affect the other distributions’
ISO images that are in the DVD’s distros
directory.
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1. Insert the DVD-ROM into your computer’s DVD-ROM drive and insert
a bootable Linux floppy disk into your computer’s floppy drive.

See the instructions in Chapter 2 for creating a bootable Linux floppy disk.
2. Reboot your PC.

This step starts the Linux installation process for you automatically.

Congratulations! The Linux installation process is now under way. For the
rest of the gory details on this fascinating task, please consult Chapter 3.

And some people say that installing Linux is hard! What could be easier than
this? On the other hand, if all you want to do is investigate the contents of
the Linux installation DVD-ROM, simply insert it into your machine’s CD-ROM
drive. After that, you can browse through the DVD-ROM'’s contents right
there in Windows. The contents are described in the following section.

What Vou Find on the DUD-ROM

Here’s a summary of the software on the DVD-ROM, arranged by directory
organization. If you use Windows, the DVD-ROM interface helps you navigate
the DVD-ROM easily; you can use most of its contents only if you already
have Linux installed.

The contents of the DVD consist of all four installation CD-ROMs’ worth of
material for Fedora Core 3, plus the ISO files discussed earlier in this chapter.
Not all the software is installed automatically. You find out in Chapters 3 and
12 how to customize what’s added. Aside from that, the DVD has useful
install utilities and a handy-dandy README file that explains precisely what
you find. The directory structure may look similar to the following (except
for lacking my handy annotations, of course):

E:
|----> distros -- IS0 images for the included
distributions
----> Fedora
|====> RPME -- binary packages, incl:
0S, GUIs, Apache, etc.
|----> base -- info on release

| used by install process
| -- source code for the packages
in RPMS
----> 1images -- boot & ramdisk images

----> KNOPPIX -- the files used to boot you into
KNOPPIX instead of Fedora's installer

----> isolinux -- boot files

----> README -- general read me file

----> RELEASE-NOTES -- current info about this release

----> RPM-GPG-KEY -- GPG sigs for Red Hat pkgs
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Both CDs include GPG signatures, allowing the installer to check the contents
of the files against the stored security data to make sure that the files haven’t
been changed. (The assumption is that all changes would be for the worse,
such as Trojan horses or viruses.) Thus, signatures provide a way to make
sure that everything is safe and wholesome for your computer!

If You've Got Problems (Of the
DUD-ROM Kind)

[ tried my best to locate programs that work on most computers with the
minimum system requirements, as Red Hat did for its operating system. Alas,
your computer may differ, and some programs may not work properly for
some reason.

The two likeliest problems are that you don’t have enough memory (RAM)
for the programs you want to use or that you have other programs running
that are affecting the installation or running of a program. If you see error
messages like Not enough memory or Setup cannot continue, try one or
more of the following methods and then try using the software again:

v Close all running programs. The more programs you’re running, the
less memory is available to other programs. Installers also typically
update files and programs; if you keep other programs running, the
installation may not work properly.

v In Linux, close your GUI environment and run demos or installations
directly from a command line. The interface itself can tie up system
memory or even conflict with certain kinds of interactive demos. Use
the command prompt to browse files on the DVD-ROM and launch
installers or demos.

v Have your local computer store add more RAM to your computer. This
step is, admittedly, a drastic and potentially expensive one, depending
on the price of RAM at the time. If you have a modern PC with less than
64MB of RAM, however, adding more memory can really help the speed
of your computer and enable more programs to run at the same time.

If you still have trouble with the DVD-ROM, please call the Wiley Product
Technical Support phone number at 1-800-762-2974. Outside the United
States, call 1-317-572-3994. You can also contact Wiley Product Technical
Support through the Internet at www.wiley.com/techsupport. Wiley
Publishing provides technical support only for installation and other general
quality control items; for technical support on the applications themselves,
consult the program’s vendor or author.

To place additional orders or to request information about other Wiley prod-
ucts, please call 1-800-225-5945.
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* (asterisk), 282

. (dot), 280

= (equals sign), 286

! (exclamation point)
blue circle with, 243
red circle with, 236

? (question mark), 282

‘ (single quote), 287-288

~ (tilde), 280

o/ o

accessories, GNOME, 109
account. See root account; user account
addresses. See IP addresses
administration tool, SuSE, 259-260
administrator account. See root account
Amarok audio software, 350
Anaconda Red Hat installer program, 371
analog signal, dial-up modem, 151
Apache Web Server, 405
appearance, Mozilla browser, 168-169
applets

GNOMEE, 116, 294-296

icon, adding to panel, 294-295, 298

KDE, 298-299

removing, 296, 299
appliance, firewall, 55
applications. See programs
archiving files, 396
asterisk (*), 282
audio CD

autostart, 219-220

playing, 224, 225, 348-349

problems, solving, 347-348

ripping music tracks from, 352-354
authentication, e-mail, 178, 181
autocompletion

commands, 107

format, spreadsheet, 325

function, spreadsheet, 327

text, OpenOffice.Org Writer, 320
AutoPilot Presentation wizard, 328-330

autostart
programs in Linspire, 143
video or audio disks, 219-220

ol e

backgrounds, 301
base directories, 216-219
bash (Bourne again shell)
activating, 278-279
command history, 283-284
commands and filenames, automatic
completion of, 282-283
described, 277-278
GUI desktop, returning to, 279-280
Linux commands, 396-397
programs, starting, 281-282
redirecting and piping, 288-291
screen, clearing, 291
syntax and structure, 280-281
variables, 284-288
wildcard expansion, 282
Basic Input/Output System. See BIOS
beep
bash command, 283
unusual series of long and short, 96
Bell Telephone Laboratories, 12
/bin directory, 216
binary code, 14
BIOS (Basic Input/Output System)
to boot loader, 97-98
changes, saving, 37
floppy drive, checking order, 43
information, accessing, 36
partitions, viewing, 68
black screen
Linspire installation, 68
POST, 96
blue circle with white exclamation point
M, 243
Bluetooth wireless networking, 151
/boot directory
backup, 370
described, 216
boot environment, 375-376
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boot floppy, creating, 41-43
boot hangs, 377-378
boot loader
BIOS to, 97-98
Fedora Core password, configuring, 50-52
SuSE, choosing, 82
bootable distribution, 28-29
booting
from back-of-the-book DVD-ROM, 407-408
BIOS to boot loader, 97-98
custom boot disks, 98
described, 95-96
Fedora Core, 39-40, 43, 60-64
freezing computer, intentionally, 35
GRUB or LILO loads system kernel into
memory, 98-99
init, control passes to, 99-101
Knoppix machine, 390-391
from Linux floppy disk, 408
POST to BIOS, 96-97
Bourne again shell. See bash
bridge, wireless, 153
broadband Internet connection
firewalls and, 55
Linux compatibility, 149
browser. See Web browser
buddy, IM, 189
bulletin boards
Mozilla, configuring to read, 174-175
reading news, 177
subscribing to, 176-177
burning electrical components, 96
button
extensible, 319, 324, 335
menu, adding, 296

oo

cable modem
described, 150
setting up, 152-153

cached data, swapping, 102

Calc (OpenOffice.Org)
document area, 327
formula bar, 326-327
function bar, 326
main toolbar, 324-325
menu bar, 325-326
object bar, 326
starting, 114, 323-324

case-sensitivity, command-line
interface, 107
cat command, 309-310
CDh
burning, 354, 406
damaged, handling, 48
directory, 216, 218, 227
files, saving to, 194
ISOs, 66
listening to, 348-349
ripping music tracks from, 352-354
viewing, 222, 223
cell, inserting into spreadsheet, 325
checking e-mail, 184-186
clear command, 291
Click and Run Warehouse. See CNR
Warehouse
closing
and saving text files (nano), 311-312
saving text files without, 311
CNR (Click and Run) Warehouse
adding new software, 253-255
advantages of, 70
DVD player, buying, 356
opening, 122
programs, finding, 275
updating system with, 240-242
Win4Lin emulator software, 361
CodeWeavers Microsoft Office bridge
software, 360-361
colors, browser, 169
columns, viewing icons in, 202
command-line interface
case-sensitivity, 107
described, 105, 106
within GUI, opening, 107
history of recently used commands,
107-108, 283-284
readability, 106
shutting down, 102
troubleshooting, 373-374
commands
automatic completion, bash shell,
282-283
essential, 216
history, 107-108, 283-284
output redirection, 289-290
Composer Web page builder
described, 168
preferences, setting, 171
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compressing files
described, 233
preparing, 235-236
to share with others, 396
computer manufacturers,
Linux-promoting, 11
configuration tools
Internet connections, 155-156
Knoppix, 141-142
Linspire, 142-143
Mandrake, 144
Red Hat and Fedora, 145
SuSE, 145-146
Xandros, 146
connecting, Internet
configuration, 160
SSH, 271-272
connections, physical, 369
content
directory, listing, 280-281
floppy disk, viewing, 121, 124
text files, viewing, 309-310
content, Trash
deleting, 200, 207
viewing, 117,121, 124
Control Panel, Linspire, 143
Coordinated Universal Time (UTC), 55
copying files
Konqueror file manager, 205-206
Nautilus file manager, 198-199
copyright
GNU GPL, 14-15
multimedia, 345
core dump files, 284
creating files and folders
Konqueror file manager, 206
Nautilus file manager, 199
CrossOver Office (CodeWeavers) software,
360-361
custom boot disks, 98

o) e

data sources
documents, 320
spreadsheet, 325

date and time
file changes, viewing, 210
time server, enabling, 60-61
viewing, 114, 119

Debian GNU/Linux, 16. See also Knoppix
distribution; Linspire distribution
deleting
applets, 296, 299
files and folders, 199-200, 207
Linux, 103
programs, 274, 297
secondary panels, 115
Trash content, 200, 207
demo days, 93
desktop. See GNOME; KDE
DHCP (Dynamic Host Configuration
Protocol), 52, 159
dial-up modem
described, 151
setting up, 153, 157-160
Digital Subscriber Line (DSL)
described, 150
modem, setting up, 152-153
directory
command, finding, 285
contents, listing, 280-281
copying and moving, 198-199, 206
navigating through, 202
opening in Nautilus, 195
printing, 287
search path, 283
disconnecting from Internet, 160
Disk Druid partitioning tool, 51
disks. See CD; DVD; floppy disk; hard drive
distribution. See individual distributions
listed by name
document area
drawing program, 327, 337
math function program, 340-342
presentations program, 333
word-processing program, 323
documentation
distribution, 37
SuSE, advantage of, 78
Wine, 365
documents
drawing, 320, 325
fields, inserting, 320
Linspire, 121, 123
Mandrake, 125
recent, list in GNOME, 110
templates, 194
Xandros, 130
dot (1), 280
downloaded programs, opening, 233-234

413
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downloading
Mandrake distribution, 71-72 ® E ¢

Mozilla helper, 171 editing text files

gizxierll',gadding for menu, 296 command-line editor (nano), 310-312
. GUI editor (gedit), 312-314
in documents, 320, 325 efficiency, 12

n p_resentatlons, 331,332 electronic manual, 290-291
drawing program e-mail

document area, 337 checking, bash command, 285

function bar, 336 default programs included with

layput, 334 distributions, 178

main toolbar, 335 Evolution, setting up, 178-184

menu bar, 335-336 Internet connections, 177-186

object bar, 336 Linspire suite, opening, 121

ruler, 336 :
’ Mozilla, 168, 171
starting, 333-334 as root account, 134
drlyers sending and checking, 184-186
dlr'ectory, 216 environment variables, 284-286
printer, 140 equals sign (=), 286
sounq gard, 347 . . /etc subdirectories
DSL (Digital Subscriber Line) backup, 370
described, 150 describéd 216
modem, setting up, 152-153 Ethernet ha[rdware
du command, 280-281 cable. 152-153
dual-boot, Linux and Windows card, ’268

broadband connection, 149-150
free resizing tool (qtparted), 28-32
hard drive, sharing, 20

hardware, checking, 32-36
partitioning from scratch, 21-22
partitioning tool, 28

etiquette, newsgroup, 177
Evolution e-mail

opening, 114

setting up, 178-184
exclamation point (1)

blue circle with, 243

resizing partitions, 26-27 red circle with. 236
D\\//lgwmg partitions, 22-26 executable permissions set, 214
tostart. 219-220 execute permission, 212
autostart, 219 exiting GUI to command line, 293
burning, 354

extended partition, 21, 25

damaged, handling, 48 .
viewing, 222, 223, 224, 226 ‘;i{i?ﬁ;ﬁ’ﬂi'jé‘gﬁnisgw’ 924,355

DVD-ROM, back-of-the-book
booting from, 407-408
Fedora Core 3, 45, 408-409 o F o
ISO images, 406

software, 405 FAQ (Frequently Asked Question) page,
system requirements, 406-407 newsgroup, 177 ' '
troubleshooting, 409-410 f86config graphics configuration
Dynamic Host Configuration Protocol tool, 373
(DHCP), 52, 159 FDISK hard drive partition indicator, 24-25
dynamic IP address, 155 Fedora Core distribution

bash session, activating, 278
boot loader, default, 97
booting, first, 60-64
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described, 17
documentation, 37
DVD-ROM, back-of-the-book, 405
filesystem, navigating, 219-221
firewall, controlling and adjusting, 267
formatting disks, 229
GNOME and KDE, switching, 131
graphics configuration tool, 373
GUI, default, 106
hardware compatibility, 32-33
installing in, 247-253
Internet connections, configuring,
156-160

KDE Control Center, opening, 304
Mozilla, configuring, 166-172
rescue tool, 100
screen resolution, changing, 377
SELinux, 274
single user mode, booting into, 378
sound card, checking, 346
System Logs viewer, 275, 276
troubleshooting, 371-372
user accounts, creating, 134-137
Web browser, default, 166

Fedora Core distribution, installing
boot floppy, creating, 41-43
boot loader password, configuring, 50-52
booting, 39-40, 43
DVD-ROM, back-of-the-book, 408-409
firewall configuration, 52-55, 57
function keys, 44-45
graphical interface, 43-46
keyboard configuration, 46-47
language, selecting, 46, 55
network configuration, 52-53
options, listed, 48
partitioning, 49-50, 51
Personal Desktop, 48-49
root password, 57
software packages, 57-59
text interface, 44
time zone, 55-56
updating, 236-240

Fedora Core distribution, using

programs in

archive, creating, 235
CD music tracks, ripping, 352
CDs and DVDs, burning, 354
CDs, listening to, 348, 349
deleting unnecessary programs, 274
downloaded music, listening to, 351
DVDs, playing, 356

e-mail tool, default, 178
graphics editor, 355
instant messenger, 186, 187
Internet connection tools, 155
mixer, 346
network services manager, opening, 265
OpenOffice.Org Calc, opening, 323
OpenOffice.Org Draw, opening, 334
OpenOffice.Org Impress, opening, 327
OpenOffice.Org Math, opening, 337
OpenOffice.Org Writer, opening, 318
printing, 137, 138-140, 342
text editors, 310, 312
Wine, 365
fields, inserting into documents, 320
file
attributes, help commands, 398-399
GNOME, searching for, 110
rescuing from nonbooting machine,
379-380
viewers, 399-400
file browser, 110
file formats, supported in
OpenOffice.Org, 323
file manager
described, 193-194
Konqueror, 201-208
Nautilus, 194-201
Xandros, 209
file sharing program, 190
File Transfer Protocol (FTP) programs,
190, 269
filenames, automatic completion of,
282-283
filesystem
disk space shortage, 232
/etc subdirectories, 216
Fedora, 219-221
formatting disks, 229
help commands, 400
Knoppix, 221-223
long format file listings, 210
Mandrake, 223-225
/mnt and /media subdirectories, 217-218
partitions versus directories, 226-228
permissions, 211-213
reboot, failure to, 229-231
root directory, 216-217
searching, 123, 128
types, 215-216
/usr subdirectories, 218-219
Xandros, 226
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find and replace
in spreadsheets, 325
in word processing documents, 320
finding
CNR Warehouse programs, 275
directory command, 285
documentation, 37
hung programs Linspire, 123
Mandrake repositories, 255
Nautilus file manager, 110
OpenOffice.Org suite, 110
root partition, 381
security resources, 276
software, 261-262
sound card drivers in kernel, 347
Firefox Web browser
adding, 255, 258, 260
opening, 114
RSS, 190
software on back-of-the-book
DVD-ROM, 405
firewall
controlling and adjusting, 267-269
Fedora Core, configuring, 52-55, 57
ping and traceroute commands,
blocked, 161
service, 266
SSH, enabling, 269
Flash plug-in, 248, 254, 258, 260
flexibility, 12
floppy disk
boot, creating, 41-43
contents, viewing, 121, 124
custom boot, 98
directory, 216, 217
drive designations, 227
installation, 37, 40
Knoppix, viewing, 222
SuSE, viewing, 225
folder, viewing
Konqueror file manager, 202-204
Nautilus file manager, 196-197
previously accessed, 195-196
formatting disks, 229
forms, building, 320, 325
formula bar, spreadsheet, 326-327
free software, 9-10, 12
Free Software Foundation (FSF), 14
freeform drawing, 335
freezing computer
boot hangs, 377-378
to view boot process, 35

Frequently Asked Question (FAQ) page,
newsgroup, 177
frozen computer
GUI, 377
programs, finding in Linspire, 123
FSF (Free Software Foundation), 14
FTP (File Transfer Protocol) programs,
190, 269
function bar
drawing program, 336
math formula program, 339
presentations program, 332
spreadsheet program, 326
word-processing program, 321-322
function keys
Fedora Core, installing, 44-45
frozen computer, checking, 371
function, spreadsheet, 327

oG o

Gaim Instant Messenger, 187-189
games
Cedega, 362-363
GNOME, 109
Mahjongg, 282
software on back-of-the-book
DVD-ROM, 405
SuSE, 128
General Public License (GPL), 10, 14-15
The GIMP graphics editing program, 110,
355-356
GLUE (Groups of Linux Users
Everywhere), 93
GNOME (GNU Network Object Model
Environment)
adding to panel, 116
applets, 294-296
configuration tools, 145
described, 108-109
desktop icons, 116-117
KDE, switching, 130-131
Lock Screen tool, 112-113
Log Out tool, 113
menus, 109-111
panel menu, 115-116
panels, 113-115
programs, 296-297
Run Application tool, 111-112
software on back-of-the-book
DVD-ROM, 405
themes, adding, 301-303



GNU (GNU'’s Not Unix)
GPL, 10, 14-15
Linux and, 11, 13-14
GPL (General Public License), 10, 14-15
GRand Unified Boot loader (GRUB), 97-99
graphical user interface. See GUI
graphics. See also drawing; drawing
program
creating and modifying, 110, 355-356
embedded, showing in
OpenOffice.Org, 320
resizing to fit browser window, 169
SuSE, 128
testing, installer’s, 372-373
group file permissions, 211-213
Groups of Linux Users Everywhere
(GLUE), 93
GRUB (GRand Unified Boot loader), 97-99
GUI (graphical user interface). See also
GNOME; KDE
bash shell, returning from, 279-280
described, 105
directory location, 217
exiting to command line, 293
Fedora Core, installing, 43-46
not starting, 373
readability, 106
shutting down, 102
SuSE, installing, 81-82
system speed and, 106
text editors (gedit), 312-315
versions, choosing, 106-107
GYUM Fedora software installation
described, 247
Java support, adding, 251-252
RealPlayer support, adding, 252-253
repositories, adding, 247-249
software, obtaining, 249-251
gzip utility, 233

o o

Hackers (Levy), 13

handout view, presentation, 332

hard drive
accessing, 220-221
boot hangs, 377
designations, common, 227
removable, 21
sharing with Windows and Linux, 20
space shortage, 232

hard drive, partitioning
Fedora Core, 49-50, 51
Knoppix, 118
Linspire, 68
Mandrake, 74
resizing, 26-27
SuSE, 80-81
Windows dual-boot, 21-22, 28
Xandros, 88
hard drive partitions
accessing other, 226
directories versus, 226-228
listing, 230-231
root, finding, 381
hard link, 210
hardware
boot hangs, 377
checking in Windows dual-boot, 32-36
compatibility, 32-36
detection, disabling during Fedora
installation, 44-45
failure, correcting in BIOS, 97
Internet connections, 152-153
laptop issues, 36
Mandrake, 144
messages, shutting off, 266
platforms, Linux running on, 11
removing during troubleshooting, 369
settings, GNOME, 110
harvesting e-mail addresses, 175
HelixPlayer audio software, 351
help
bash, 281
GNOME, 110, 115
Linspire, 123
Mozilla, 171
Xandros, 130
hidden files, 280, 366
history
browser visits, 171
commands, recent, 108, 283-284
home directory
displaying, 117
Konqueror, 202
Mandrake, opening, 125
Nautilus, 194
path, 285
root, 216
Xandros file manager, 209
home page, Web browser, 170
HP JetDirect printer, 139

Index 4 ’ 7
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hung computer
boot hangs, 377-378
to view boot process, 35

o]e
icon
applets, adding to panel, 294-295, 298
buddy, 189
CD/DVD, 219
files, viewing as, 202
KDE, adding to desktop, 300
space for adding, 114
Web site, viewing, 169
IDE hard drive, 227, 228
IM (instant messaging)
default programs included with
distributions, 186-187
Gaim Instant Messenger, 187-189
troubleshooting connections, 189-190
images. See graphics
Impress (OpenOffice.Org)
AutoPilot Presentation wizard, 328-330
document area, 333
function bar, 332
main toolbar, 330-331
menu bar, 331-332
object bar, 332
ruler, 333
starting, 114, 327-328
views, 332-333
information flow, aiding with redirection
and pipes, 288-291
init program, 99-101
installation
disks, 37
distribution, programs with each, 17
documentation, finding, 37
Knoppix, 384-386
Linspire, 67-70
Linux and Windows dual-boot, 20-27
Linux-only computers, 19-20
Mandrake, 72-77, 257-258
SuSE, 78-85
Xandros, 86-91
install-fests, 93
instant messaging (IM)
default programs included with
distributions, 186-187
Gaim Instant Messenger, 187-189
troubleshooting connections, 189-190

Integrated Services Digital Network (ISDN),
150, 266
internal modem, 153
Internet connections
browsers, 165-173
configuration tools, 155-156
connecting and disconnecting, 160
described, 149-151
e-mail, 177-186
Fedora, 156-160
file sharing, 190
FTP programs, 190
GNOME tools, 110
hardware, 152-153
instant messaging, 186-190
IRC programs, 190
ISP, 153-155
Linux sites, helpful, 164
Mandrake tools, 125
newsgroups, 174-177
ping to certain addresses, 161-162
RSS readers, 190
software distributions, security and,
262-265
software modems, 152
traceroute, 162-164
Internet radio, listening to, 349-351
Internet Service Provider (ISP)
e-mail configuration, 178
information, obtaining, 154-155
selecting, 153-154
setting up connection, 159
interpolated string, 287-288
IP addresses
checking with ping, 161-162
obtaining, 154-155
setting up modem, 159
iptables service, 266
IRC programs, 190
ISDN (Integrated Services Digital Network),
150, 266
ISO files
burning, 66
DVD-ROM, back-of-the-book, 406
ISP (Internet Service Provider)
e-mail configuration, 178
information, obtaining, 154-155
selecting, 153-154
setting up connection, 159
iTunes, 360, 361
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Java, adding support for
CNR Warehouse, 254
GYUM Fedora software installation,
251-252
Mozilla Web browser settings, 172
SuSE, 260

o o

K Desktop Environment. See KDE
Kaffeine audio/video media player, 351
Kate text editor, 315
KDE (K Desktop Environment)
applets, configuring, 298-299
control center, 128, 145, 146
Fedora Core, selecting, 58
GNOME and, switching, 130-131
icons, adding to desktop, 300
Knoppix, 118-120
launching, 119
Linspire, 121-123
Mandrake, 124-126, 144
panel, adding elements, 299
programs, adding, 300
Red Hat Package Manager, sample of, 405
SuSE, 126-128
themes, adding, 303-305
Web site, 117
wizard, opening, 141
Xandros, 128-130
kernel
benevolent dictator of, 15
libraries, 216
Linux stability, 12
loading into memory, 98-99
module, handling, 402
parameters, setting during Fedora Core
installation, 45
sound card drivers, finding, 347
keyboard configuration
Fedora Core, 46-47
SuSE, 79-80
KLaptop applet, 114, 119
Kmail, 254
Knoppix distribution
archive, creating, 235
configuration tools, 141-142
default GUI, 106
described, 66

files, rescuing off non-booting machine,
379-380
filesystem, navigating, 221-223
formatting disks, 229
graphics configuration tool, 373
installing, 384-386, 388-389, 406
KDE, 118-120
machine, booting, 390-391
partitioning with, 28-32
as portable desktop, 383-384
screen resolution, changing, 377
sound card, checking, 346
SSH, enabling, 169
system rescues, 100
tools, 391
updating, 386-387
Knoppix distribution, using programs with
CD music tracks, ripping, 352
CDs and DVDs, burning, 354
CDs, listening to, 348, 349
downloaded music, listening to, 351
DVDs, playing, 356
e-mail tool, default, 178
graphics editing program, 355
instant messenger program, 186, 187
mixer, finding, 346
network services manager, opening, 265
OpenOffice.Org Calc, opening, 323
OpenOffice.Org Draw, opening, 334
OpenOffice.Org Impress, opening, 328
OpenOffice.Org Math, opening, 337
OpenOffice.Org Writer, opening, 318
printing, 137, 342
repositories, adding, 389-390
root password, recovering, 378, 381-382
text editors, 312
Web browser, default, 166
Wine, 365
Konqueror file manager
copying and moving files, 205-206
creating files and folders, 206
deleting files and folders, 207
deleting Trash contents, 207
navigating, 202
opening files and running programs, 205
opening in different distributions, 118,
121, 125, 127, 201-202
permissions, viewing and changing,
207-208
viewing folders, 202-204
kudzu service, 266
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language
browser, setting, 169
Fedora Core, selecting, 46, 55
Knoppix, viewing, 119
Mandrake, selecting, 73
laptops
battery monitoring service, 266
hardware issues, 36
resolution, changing, 377
latency, 162
layers, presentation, 332
laying pipes, 290
legal issues, multimedia, 345
less command, 310
Levy, Steven (Hackers), 13
libraries, 216
licensing issues
Fedora Core agreement, 61
GPL, 10
LILO (LInux LOader), 97-99
Lindows. See Linspire distribution
link, fake file listings, 210
Linspire distribution
advantages of, 66-67
archive, creating, 235-236
bash session, activating, 278
boot environment, changing, 375
configuration tools, 142-143
default boot loader, 97
default GUI, 106
documentation, 37
filesystem, navigating, 223
firewall, controlling and adjusting, 267
formatting disks, 229
graphics configuration tool, 373
hardware compatibility, 33
installing, 67-70
Internet connection tools, 155
KDE, 121-123, 304
rescue tool, 100
root password, forgotten, 378
screen resolution, changing, 377
SELinux, 275
software, adding, 253-255
software on back-of-the-book
DVD-ROM, 406
sound card, checking, 346
special features, 70
System Logs viewer, 275

updating, 240-242

user accounts, creating, 135
versions, 71

Web browser, default, 166

Linspire distribution, using programs with.

See also CNR Warehouse
CD music tracks, ripping, 352
CDs and DVDs, burning, 354
CDs, listening to, 348
deleting unnecessary programs, 274
downloaded music, listening to, 352
DVDs, playing, 356
e-mail tool, default, 178
graphics editing program, 355
instant messenger program, 186, 187
Konqueror programs, accessing, 201
mixer, finding, 346
network services manager, opening, 265
OpenOffice.Org Calc, opening, 323
OpenOffice.Org Draw, opening, 334
OpenOffice.Org Impress, opening, 328
OpenOffice.Org Math, opening, 337
OpenOffice.Org Writer, opening, 318
printing, 137, 342
text editors, 312
Wine, 365
Win4Lin emulator software, 361-362

Linux. See also individual distributions listed

by name
advantages of, 11-13
benevolent dictator, 15
boxes, connecting with SSH, 273
distributions, compared, 16-18
floppy disk, booting from, 408
GNU, 13-15
history of, 12
installer, frozen, 370-371
mascot, 10
open source communities, 15-16
standalone installation, 19-20
Web sites, 164

Linux commands

archiving and compressing files, 396

bash shell, 396-397

help, 397-400

kernel module handling, 402

manual pages, referencing (man), 395

Microsoft boxes, communicating with
(mtools suite), 400-401

processes, 402-403

system administration, 401-402

LInux LOader (LILO), 97-99
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Linux Users Group (LUG), 93
lisa service, 266
listing
directory content, 280-281
documents, recent, 110
drives, 117
fake file link, 210
known applications, 111
Linspire programs, 123
long format file, 210
partitions, 230-231
literal text string, 287
LiveCDs (bootable distributions)
described, 28
Knoppix software, installing, 388
pros and cons of using, 92
local printer, 137, 139
Lock Screen tool
GNOME, 112-113
Linspire, 123
Mandrake, 126
Lock Session tool, Mandrake, 128
log files
troubleshooting, 369
viewing with System Log Viewer, 275-276
Log Out tool
GNOME, 111, 113
Linspire, 123
Mandrake, 126, 128
Xandros, 130
logical partition, 21, 25
login
autostart programs, 143
GNOME, locking, 111
graphical, 108
secondary, Mandrake, 126
long format file listings, 210
LUG (Linux Users Group), 93

ol o

Macintosh computer, connecting to Linux
box, 273
Macromedia Flash plug-in, 248, 254,
258, 260
Mahjongg game, 282
mail. See e-mail
Mail and Newsgroups, Mozilla
described, 168
preferences, setting, 171
reading newsgroups, 174-175, 177

main toolbar
drawing program, 335
math formula program, 338-339
presentations program, 330-331
spreadsheet program, 324-325
word-processing program, 319-320
Mandrake distribution
advantages of, 71
archive, creating, 235
bash session, activating, 278, 279
configuration tools, 144
default boot loader, 97
default GUI, 106
described, 16-17
documentation, 37
downloading, 71-72
filesystem, navigating, 223-225
firewall, controlling and adjusting, 268
formatting disks, 229
GNOME and KDE, switching, 131
graphics configuration tool, 373
hardware compatibility, 33
installing, 72-77
KDE, 124-126, 304
Konqueror programs, accessing, 201
network services manager, opening, 265
partitioning, 26
printing, 137, 342
root account, 134
root password, forgotten, 378
screen resolution, changing, 377
SELinux, 275
software, adding with, 255-258
software on back-of-the-book
DVD-ROM, 406
sound card, checking, 346
SSH, enabling, 269
System Log viewer, 275
updating, 242-243
user accounts, creating, 135
versions, 77-78
Mandrake distribution, using
programs with
CD music tracks, ripping, 352
CDs and DVDs, burning, 354
CDs, listening to, 348, 349
deleting unnecessary programs, 274
downloaded music, listening to, 352
DVDs, playing, 356
e-mail tool, default, 178
graphics editing program, 355
installing, 257-258
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Mandrake distribution (continued)
instant messenger program, default, 186
Internet connection tools, 155
mixer, finding, 347
OpenOffice.Org Calc, opening, 323
OpenOffice.Org Draw, opening, 334
OpenOffice.Org Impress, opening, 328
OpenOffice.Org Math, opening, 337
OpenOffice.Org Writer, opening, 318
repositories, adding, 255-257
repositories, finding, 255
rescue tool, 100
text editors, 312
Web browser, default, 166
Wine, 365

manual pages, referencing (man)
bash commands, 281
Linux commands, 395

mascot, Linux, 10

Massachusetts Institute of Technology

(MIT), 14

Math (OpenOiffice.Org)
document section, 340-342
function bar, 339
main toolbar, 338-339
menu bar, 339
starting, 337-338

mathematical functions, preparing. See

OpenOffice.Org Math

MBR (Master Boot Record), 97

mdmonitor service, 266

mDNSresponder service, 266

media formats, Windows, 359

/media subdirectory, 217-218

menu
button, adding, 296
GNOME, 109-111
Knoppix tools, 141
Nautilus file manager, 194-195

menu bar
drawing program, 335-336
math formula program, 339
presentations program, 331-332
spreadsheet program, 325-326
word-processing program, 321

Microsoft boxes, communicating with

(mtools suite), 400-401

Microsoft Exchange server, 180

Microsoft Windows
Fedora boot copy, creating, 41-43
hardware, getting information about,

33-35

media formats and programs,
described, 359
printers, connecting, 139
tarballs, opening, 234
Microsoft Windows 98, 24-26, 364-366
Microsoft Windows 2000, 22—-24
Microsoft Windows dual-boot
broadband connection, 149-150
free resizing tool (qtparted), 28-32
hard drive, sharing, 20
hardware, checking, 32-36
partitioning from scratch, 21-22
partitioning tool, 28
resizing partitions, 26-27
viewing partitions, 22-26
Microsoft Windows software
CodeWeavers, using Microsoft Office
with, 360-361
gaming with Cedega, 362-363
installing with SSH, 270-271
media formats and programs,
described, 359
screenshots, grabbing (VMware), 363-364
Wine for Windows 98 functions, 364-366
Win4Lin emulator, 361-362
Microsoft Windows XP, 22-24
MIT (Massachusetts Institute of
Technology), 14
mixer, multimedia, 346-347
/mnt subdirectory, 217-218
modified buffer, 312
monitor
Fedora settings, 61-62
Linspire installation, 68
Mandrake settings, 76
POST, 96
mount point, partition, 227
mouse, SuSE installation, 80
movies, watching, 356-357
moving files
Konqueror file manager, 205-206
Nautilus file manager, 198-199
Mozilla Web browser
configuring, 166-172
newsgroups, participating in, 174-175
Web surfing, 173
MP3 support, 252-253
MPlayer-Plug audio software, 351
multimedia
CDs and DVDs, burning, 354
CDs, listening to, 348-349
graphics, creating and modifying, 355-356
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Internet radio, listening to, 349-351
legal issues, 345
Mandrake tools, 125
mixer, 346-347
movies, watching, 356-357
music, downloading, 351-352
music, ripping tracks from CDs, 352-354
RealPlayer support, 252-253
sound card and, 346
sound problems, solving, 347-348
SuSE, 128

multiuser environment, 11

music
CDs, listening to, 348-349
downloading, 351-352
ripping tracks from CDs, 352-354

o\ o

National Security Agency (NSA), 57
Nautilus file manager

copying and moving files, 198-199

creating files and folders, 199

deleting files and folders, 199-200

finding, 110

folder views, 196-197

listing drives, 117

menu, 194-195

navigating, 195-196

opening files and running programs,

197-198
permissions, viewing and changing,
200-201

Trash contents, deleting, 200
navigating

Konqueror file manager, 202

Nautilus file manager, 195-196
Navigator Web browser

described, 168

preferences, setting, 169-171
NeTraverse Win4Lin emulator, 361-362
Netscape. See Mozilla Web browser
network configuration

Fedora Core, installing, 52-53

Linux interoperability, 11

SuSE, installing, 83

Xandros, 88
network drive, accessing

in Fedora, 220

in Knoppix, 222

in Mandrake, 224-225

in Xandros, 226

network printer, 137, 139
network services
failure to load, 100
firewall, controlling and adjusting,
267-269
managing, 265-267
Network Time Protocol (NTP), 61
newsgroups
Mozilla, configuring to read, 174-175
reading news, 177
subscribing to, 176-177
nonprinting characters, displaying, 320
notes, slide presentation, 333
Novell Netware printer, connecting, 139
NSA (National Security Agency), 57
NTFS partition, accessing, 221
NTP (Network Time Protocol), 61

o () o

object bar

drawing program, 336

presentations program, 332

spreadsheet program, 326

word-processing program, 322-323
office suite. See OpenOffice.Org
office utilities

Mandrake, 125

SuSE, 128
Ogg Vorbis sound format, 354
open source communities, 15-16
opening files

editing text, 310-311

Konqueror file manager, 205

Nautilus file manager, 197-198
OpenOffice.Org

finding, 110

printing, 342-343

software on back-of-the-book

DVD-ROM, 405

OpenOffice.Org Calc

document area, 327

formula bar, 326-327

function bar, 326

main toolbar, 324-325

menu bar, 325-326

object bar, 326

starting, 114, 323-324
OpenOffice.Org Impress

AutoPilot Presentation wizard, 328-330

document area, 333

function bar, 332
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OpenOffice.Org Impress (continued)
main toolbar, 330-331
menu bar, 331-332
object bar, 332
ruler, 333
starting, 114, 327-328
views, 332-333
OpenOffice.Org Math
document section, 340-342
function bar, 339
main toolbar, 338-339
menu bar, 339
starting, 337-338
OpenOffice.Org Writer
document area, 323
function bar, 321-322
layout, 318-319
main toolbar, 319-320
menu bar, 321
object bar, 322-323
ruler, 323
starting, 114, 318
word processing, 318-323
operating system
described, 10
initialization phase, 98
Linux’ advantages over other, 11
Linux commands, 401-402
Mandrake tools, 125
“not found” error message, 98
Xandros controls, 130
/opt directory, 217
OS, upgrading, 262
other file permission, 212
outline view, presentation, 333
output redirection, 289
owner, file, 210
ownership, file, 212-213

oo

package managers, 17-18

packages, software
described, 233
Mandrake, 74-76, 144
preparing, 235-236

panel
adding programs, 296-297
applet icons, adding, 298
GNOME, 113-116
removing programs, 297

Partition Magic tool, 27, 28
partitioning

Fedora Core, 49-50, 51

Knoppix, 118

Linspire, 68

Mandrake, 74

resizing, 26-27

SuSE, 80-81

Windows dual-boot, 21-22, 28

Xandros, 88
partitions

accessing other, 226

directories versus, 226-228

listing, 230-231

root, finding, 381
passwords

choosing, 263-264

CNR, 241

e-mail, 181

good, creating, 136

IM, 188, 189

Knoppix, 141

Linspire, 143

personal account, 62-63
PC hardware detect tool, 35
PC Hardware in a Nutshell (Thompson and

Thompson), 21
PCMCIA card support, 267
PenguilNet telnet and SSH client for
Windows, 270-271

permissions, file

groups, 213

owners, 212-213

triads, 211-212

viewing and changing, 200-201, 207-208
personal account. See user account
Personal Desktop, Fedora Core

benefits of using, 40

installing, 48-49
ping to certain addresses, 161-162, 163
pipes

described, 288-289

electronic manual, 290-291

laying, 290
plug-ins

audio software, 350

browsers, 172-173
portability, 12
portable desktop, Knoppix, 383-384
POST (Power-Up Self Test), 96-97
power outages, 102-103



Index 425

pre-emptive multitasking, 11
preferences, GNOME, 110
presentation software. See OpenOffice.Org
Impress
primary partition, 21
printing
commands, 286-287
described, 137-140
Knoppix, 141-142
Linspire, 121
Mandrake, 144
from OpenOffice.Org suite, 342-343
process commands, 402-403
programs
active, reducing number, 370
adding to desktop, 297
adding to panel, 296-297
autostart, 143
bash shell, starting, 281-282
compressing and packaging files, 235-236
deleting unnecessary, 274
distribution versions, 17
downloaded files, opening, 233-234
DVD-ROM, back-of-the-book, 405
Fedora Core, installing, 57-59, 236-240,
247-253
files, handling, 198
finding, 261-262
free, 9-10
GNOME, 296-297
GYUM Fedora, obtaining, 249-251
hiding/restoring, 114
KDE, adding, 299, 300
Knoppix, 388-389
Linspire, adding with, 123, 253-255
Mandrake, adding with, 74, 242-243,
255-258
minimizing or maximizing all open, 119
removing from desktop, 297, 300
removing from panel, 297
security holes, 273-274
SuSE, adding, 81-82, 243-245, 260
Xandros, installing, 87, 245-246, 260-261

oQo

gtparted resizing tool, 28-32
question mark (?), 282

o R e

Radio-Locator Web site, 350
RAM disk, 100
read permission, 212
readability, interface, 106
reading newsgroup news, 177
RealPlayer
described, 350
GYUM Fedora software installation,
252-253
reboot
failure, 229-231
GNOME tool, 111
receiving e-mail, 184-186
red circle with white exclamation
point (1), 236
Red Hat
configuration tools, 145
described, 17, 18
Disk Druid partitioning tool, 51
Red Hat Network (RHN) Alert Notification
Tool, 236-240
Red Hat Package Manager (RPM)
downloading, 262
software on back-of-the-book
DVD-ROM, 405
redirection
command output, 289-290
described, 288-289
electronic manual, 290-291
Remote Login, enabling in Fedora, 54
remote printer, 137
removable rack hard drive, 21
removing
applets, 296, 299
files and folders, 199-200, 207
Linux, 103
programs, 274, 297
secondary panels, 115
Trash content, 200, 207
repositories
GYUM Fedora, 247-249
Knoppix, 389-390
Mandrake, 255-257
rescue mode, booting Fedora Core into, 45
reset command, 291
resizing
images to fit browser window, 169
Windows partitions, 26-32
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RHN (Red Hat Network) Alert Notification
Tool, 236-240
Rhythmbox audio software, 350
root account
avoiding, 134
caution against using, 134
file ownership, changing, 212-213
Mandrake Control Center, 144
password, setting, 57
root directory, 216-217, 232, 381
root password
Fedora Core, installing, 57
forgotten, 378
GNOME logout/reboot, 111
recovering, 381-382
Xandros, installing, 89
router, wireless, 153
RPM (Red Hat Package Manager)
downloading, 262
software on back-of-the-book
DVD-ROM, 405
RSS readers, 190
ruler
drawing program, 336
presentations program, 333
word-processing program, 323
Run Application tool, GNOME, 110, 111-112
Run Command tool, Mandrake, 126, 128
running programs
Konqueror file manager, 205
Nautilus file manager, 197-198

oS e

Samba software, 405
satellite modem, 151
saving
GUI text editors (gedit), 314-315
text files, closing and, 311-312
text files without closing, 311
SaX distribution, 17
/sbin directory, 217
scalability, 11
screen
bash shell, clearing, 291
file, viewing one at a time, 310
locking, 112
resolution, troubleshooting, 376-377
screenshots
Fedora Actions, 110
VMware, grabbing, 363-364

SCSI hard drive, 227, 228
search path, 283
Secure Shell. See SSH
Secure Socket Layer (SSL) e-mail
configuration, 180
security
Internet software distributions, 262-265
level, installing Mandrake, 73
log files, viewing with System Log Viewer,
275-276
Mozilla Web browser settings, 172
network services, 265-269
passwords, choosing, 263-264
resources, finding, 276
SELinux, 274-275
software holes, 273-274
SSH, 269-273
selecting multiple items, 117
SELinux (Security-Enhanced Linux)
Fedora installation, 57
security, 274-275
sending e-mail, 184-186
sendmail service, 267
server
Fedora Core, 48
Microsoft Exchange, 180
services
failure to load, 100
firewall, controlling and adjusting,
267-269
managing, 265-267
shapes, drawing specific, 335
shell scripts, 309
SHOUTeast Web site, 350
shutting down Linux, 102-103
Sidebar feature, Mozilla, 173
single quote (), 287-288
size, viewing files by, 2/3
Slackware, 17
smartd service, 267
smoke, puff of, 96
soft link, 210
software. See programs
Software and Systementwicklung
distribution. See SuSE
software modem, 152
sound
multimedia, troubleshooting, 347-348
settings, GNOME, 110
sound card
Fedora Core, testing, 63
multimedia, 346
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Sound Juicer software, 353-354
source code, 14
spamassassin service, 267
spammers, 175
spellcheck
spreadsheets, 325
word processing documents, 320
spreadsheet program. See OpenOffice.Org
Calc
/srv directory, 217
SSH (Secure Shell)
connecting in Windows, 271-272
enabling, 269-270
Linux boxes, connecting, 273
Macintosh, connecting to Linux box, 273
Remote Login, enabling in Fedora, 54
security, 269-273
Windows programs, installing, 270-271
SSL (Secure Socket Layer) e-mail
configuration, 180
stability, 12
Stallman, Richard (freedom software
pioneer and advocate), 13-14
startup

from back-of-the-book DVD-ROM, 407-408

BIOS to boot loader, 97-98
custom boot disks, 98
described, 95-96
Fedora Core, 39-40, 43, 60-64
freezing computer, intentionally, 35
GRUB or LILO loads system kernel into
memory, 98-99
init, control passes to, 99-101
Knoppix machine, 390-391
from Linux floppy disk, 408
POST to BIOS, 96-97
static IP address, 154-155
subscribing to newsgroups, 176-177
superuser. See root account; root
password
SuSE (Software and Systementwicklung)
distribution
administration tool, opening, 259-260
advantages of, 78
archive, creating, 236
bash session, activating, 278, 279
configuration tools, 145-146
default boot loader, 97
default GUI, 106
described, 17, 258-259
documentation, 37

filesystem, navigating, 225-226
firewall, controlling and adjusting, 268
formatting disks, 229
GNOME and KDE, switching, 131
graphics configuration tool, 373
hardware compatibility, 33
installing, 78-85
KDE, 126-128, 304
Konqueror programs, accessing, 201
network services manager, opening, 265
partitioning, 26
printing, 137, 342
rescue tool, 101
root account, background indicating, 134
root password, forgotten, 378
screen resolution, changing, 377
SELinux, 275
software on back-of-the-book
DVD-ROM, 406
sound card, checking, 346
System Log viewer, 275
updating, 243-245
user accounts, creating, 135
versions, 85
SuSE (Software and Systementwicklung)
distribution, using programs with
CD music tracks, ripping, 352
CDs and DVDs, burning, 354
CDs, listening to, 348, 349
deleting unnecessary programs, 274
downloaded music, listening to, 352
DVDs, playing, 356
e-mail tool, default, 178
graphics editing program, 355
instant messenger program, default, 186
Internet connection tools, 155
mixer, finding, 347
OpenOffice.Org Calc, opening, 323
OpenOffice.Org Draw, opening, 334
OpenOffice.Org Impress, opening, 328
OpenOffice.Org Math, opening, 337-338
OpenOffice.Org Writer, opening, 318
packages, adding, 260
text editors, 310, 312
Web browser, default, 166
Wine, 365
syntax and structure, bash shell, 280-281
system
described, 10
initialization phase, 98
Linux’ advantages over other, 11
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system (continued)
Linux commands, 401-402
Mandrake tools, 125
“not found” error message, 98
Xandros controls, 130

system administrator account
avoiding, 134
caution against using, 134
file ownership, changing, 212-213
Mandrake Control Center, 144
password, setting, 57

system administrator password
Fedora Core, installing, 57
forgotten, 378
GNOME logout/reboot, 111
recovering, 381-382
Xandros, installing, 89

system requirements, back-of-the-book

DVD-ROM, 406-407

system speed
desktops, selecting, 59
GUI, 106

system tools, 110

oJ e

tarball, 233-234, 262
taskbar, 114, 119
templates
document, 194
presentation, 329
terminal window
described, 107
virtual, 279-280
text files
contents, viewing, 309-310
editing (nano), 310-312
GUI editors (gedit), 312-315
text interface
bash session, 279
Fedora Core, installing, 44
text menus, 44
themes
browser, setting, 169
described, 300-301
GNOME, 301-303
KDE, 303-305
Thompson, Barbara Fritchman (PC
Hardware in a Nutshell), 21
Thompson, Robert Bruce (PC Hardware
in a Nutshell), 21

Thunderbird, 255, 258
tilde (~), 280
time and date
file changes, viewing, 210
time server, enabling, 60-61
viewing, 114, 119
time server, 60-61
time zone
Fedora Core, installing, 55-56
SuSE, installing, 83
toolbars
Mozilla, viewing, 168
Navigator Web browser, setting, 170
tooltips, 169
Torvalds, Linus (Linux creator), 10, 12, 15
traceroute Internet connection tool,
162-164
transition, slide, 329
Trash contents
deleting, 200, 207
viewing, 117,121, 124
traveling, changing time zone while, 55-56
tree view, file, 203
triads, file permission, 211-212
troubleshooting
basic tips for overall, 369-370
boot environment, changing, 375-376
boot hangs, 377-378
command-line view, 373-374
DVD-ROM, back-of-the-book, 409-410
Fedora Core, 371-372
graphics testing, installer’s, 372-373
GUI won't start, 373
hung GUI, 377
instant messaging connections, 189-190
Linux installer, frozen, 370-371
root password, forgotten, 378
screen resolution, 376-377
SuSE automatic update mode, 245
tutorials, Linspire
advantages of, 70
bailing out of, 142
tutorials, The GIMP, 356
Tux mascot penguin, 10

olf o

Uninterruptible Power Supply (UPS), 103

Universal Serial Bus. See USB storage
device

Universal Time, Coordinated (UTC), 55
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Unix
history, 12
printers, connecting, 139
updating
existing Linux version, 43
Knoppix, 386-387
UPS (Uninterruptible Power Supply), 103
USB (Universal Serial Bus) storage device
files, rescuing off non-booting machine,
379-380
formatting, 229
portable desktop, 383-384
recognizing, 219
user account
creating, 76, 89-90, 134-137
file permissions, 212
passwords, 62-63
switching, 130
/usr
directory, 217
subdirectories, 218-219
UTC (Universal Time, Coordinated), 55

oo

/var directory, 217
variables
bash shell, 284-288
environment variables versus, 284-286
values, storing and retrieving, 286-288
versions
GUI, 106-107
Linspire distribution, 71
Mandrake distribution, 77-78
SuSE distribution, 85
Xandros distribution, 91
video
autostart, 219-220
burning DVDs, 354
damaged, handling, 48
DVD, recognizing, 225
options, setting during Fedora
installation, 45
resolution, installing Fedora, 61-62
settings, GNOME, 110
volume control
modem, 158
panel, viewing, 114, 125

o/ o

Web browser
capability extensions, 172
default included with distributions, 166
Linspire, opening, 122
Mozilla, configuring, 166-172
opening, 114
plug-ins, 172-173
window, resizing images to fit, 169
Web site
icons, viewing, 169
KDE, 117
Web surfing, 173
WiFi wireless networking, 151, 153
wildcard expansion, bash shell, 282
Windows 98 (Microsoft), 24-26, 364-366
Windows 2000 (Microsoft), 22-24
Windows (Microsoft)
Fedora boot copy, creating, 41-43
hardware, getting information about,
33-35
media formats and programs,
described, 359
printers, connecting, 139
tarballs, opening, 234
Windows (Microsoft) dual-boot
broadband connection, 149-150
free resizing tool (qtparted), 28-32
hard drive, sharing, 20
hardware, checking, 32-36
partitioning from scratch, 21-22
partitioning tool, 28
resizing partitions, 26-27
viewing partitions, 22-26
Windows (Microsoft) software
CodeWeavers, using Microsoft Office
with, 360-361
gaming with Cedega, 362-363
installing with SSH, 270-271
media formats and programs,
described, 359
screenshots, grabbing (VMware), 363-364
Wine for Windows 98 functions, 364-366
Win4Lin emulator, 361-362
Windows XP (Microsoft), 22-24
Wine for Windows 98 functions, 362,
364-366
Win4Lin emulator (NeTraverse), 361-362
WinModem, 36, 152
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Winzip, 234
wireless networking

cards, setting up, 153

described, 151
word-processing program. See

OpenOffice.Org Writer

Workspace Switcher, 114, 119, 125
Workstation, Fedora Core, 48
write permission, 212
Writer (OpenOffice.Org)

document area, 323

function bar, 321-322

layout, 318-319

main toolbar, 319-320

menu bar, 321

object bar, 322-323

ruler, 323

starting, 114, 318

word processing, 318-323

° X‘ °
X Window System
described, 305
directory location, 217
Fedora Core, selecting, 58
Xandros distribution
advantages, 85
archive, creating, 236
bash session, activating, 279
boot environment, changing, 375
buying, 86
configuration tools, 146
default boot loader, 97
default GUI, 106
documentation, 37
file manager, 209
filesystem, navigating, 226
firewall, controlling and adjusting, 268
formatting disks, 229
graphics configuration tool, 373
hardware compatibility, 33
installing, 86-91
Internet connection tools, 155
KDE, 128-130
KDE Control Center, opening, 304
Linux distribution, 16

rescue tool, 101
root password, forgotten, 378
screen resolution, changing, 377
software, adding with, 260-261
software on back-of-the-book
DVD-ROM, 406
sound card, checking, 346
SSH, enabling, 269-270
updating, 245-246
user accounts, creating, 135
versions, 91
Xandros distribution, using programs with
CD music tracks, ripping, 352
CDs, listening to, 349
CrossOver Office, 361
deleting unnecessary programs, 274
downloaded music, listening to, 352
DVDs, playing, 356
e-mail tool, default, 178
graphics editing program, 355
instant messenger program, default, 186
mixer, finding, 347
network services manager, opening, 265
OpenOffice.Org Calc, opening, 323
OpenOffice.Org Draw, opening, 334
OpenOffice.Org Impress, opening, 328
OpenOffice.Org Math, opening, 338
OpenOffice.Org Writer, opening, 318
printing, 138, 342
text editors, 310, 312
Web browser, default, 166
XFCE desktop, 59
XFree86, 17, 305
Ximian Evolution, 254
Xine audio/video media player, 351
XMMS audio software, 351
XSLT Web pages, enabling, 172

o/ e

YaST (Yet Another Setup Tool) modules,
145, 260

Young, Robert (Red Hat cofounder and

chairman), 16
yum service, 267
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use the Book or the Software, even if WPI has been advised of the possibility of such
damages.

(© Because some jurisdictions do not allow the exclusion or limitation of liability for conse-
quential or incidental damages, the above limitation or exclusion may not apply to you.

7. U.S. Government Restricted Rights. Use, duplication, or disclosure of the Software for or on
behalf of the United States of America, its agencies and/or instrumentalities “U.S.
Government” is subject to restrictions as stated in paragraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause of DFARS 252.227-7013, or subparagraphs (c)
(1) and (2) of the Commercial Computer Software - Restricted Rights clause at FAR 52.227-19,
and in similar clauses in the NASA FAR supplement, as applicable.

8. General. This Agreement constitutes the entire understanding of the parties and revokes
and supersedes all prior agreements, oral or written, between them and may not be modified
or amended except in a writing signed by both parties hereto that specifically refers to this
Agreement. This Agreement shall take precedence over any other documents that may be in
conflict herewith. If any one or more provisions contained in this Agreement are held by any
court or tribunal to be invalid, illegal, or otherwise unenforceable, each and every other pro-
vision shall remain in full force and effect.



GNU General Public License

Version 2, June 1991
Copyright © 1989, 1991 Free Software Foundation, Inc.
59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public License is intended to guarantee your freedom to share and
change free software—to make sure the software is free for all its users. This General Public
License applies to most of the Free Software Foundation’s software and to any other program
whose authors commit to using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free soft-
ware (and charge for this service if you wish), that you receive source code or can get it if you
want it, that you can change the software or use pieces of it in new free programs; and that you
know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights
or to ask you to surrender the rights. These restrictions translate to certain responsibilities for
you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give
the recipients all the rights that you have. You must make sure that they, too, receive or can get
the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license
which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands
that there is no warranty for this free software. If the software is modified by someone else and
passed on, we want its recipients to know that what they have is not the original, so that any prob-
lems introduced by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the
danger that redistributors of a free program will individually obtain patent licenses, in effect
making the program proprietary. To prevent this, we have made it clear that any patent must be
licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

Terms and Conditions for Copying, Distribution and Modification

0. This License applies to any program or other work which contains a notice placed by the
copyright holder saying it may be distributed under the terms of this General Public License.
The “Program”, below, refers to any such program or work, and a “work based on the
Program” means either the Program or any derivative work under copyright law: that is to
say, a work containing the Program or a portion of it, either verbatim or with modifications
and/or translated into another language. (Hereinafter, translation is included without limita-
tion in the term “modification”.) Each licensee is addressed as “you”.



Activities other than copying, distribution and modification are not covered by this License;
they are outside its scope. The act of running the Program is not restricted, and the output
from the Program is covered only if its contents constitute a work based on the Program
(independent of having been made by running the Program). Whether that is true depends
on what the Program does.

You may copy and distribute verbatim copies of the Program’s source code as you receive it,
in any medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that
refer to this License and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.

You may modify your copy or copies of the Program or any portion of it, thus forming a work
based on the Program, and copy and distribute such modifications or work under the terms
of Section 1 above, provided that you also meet all of these conditions:

(@ You must cause the modified files to carry prominent notices stating that you changed
the files and the date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains
or is derived from the Program or any part thereof, to be licensed as a whole at no
charge to all third parties under the terms of this License.

(©) If the modified program normally reads commands interactively when run, you must
cause it, when started running for such interactive use in the most ordinary way, to print
or display an announcement including an appropriate copyright notice and a notice that
there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy
of this License. (Exception: if the Program itself is interactive but does not normally print
such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that
work are not derived from the Program, and can be reasonably considered independent and
separate works in themselves, then this License, and its terms, do not apply to those sec-
tions when you distribute them as separate works. But when you distribute the same
sections as part of a whole which is a work based on the Program, the distribution of the
whole must be on the terms of this License, whose permissions for other licensees extend to
the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of deriva-
tive or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program
(or with a work based on the Program) on a volume of a storage or distribution medium
does not bring the other work under the scope of this License.

You may copy and distribute the Program (or a work based on it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you also
do one of the following:

(@ Accompany it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange,; or,



(b) Accompany it with a written offer, valid for at least three years, to give any third party,
for a charge no more than your cost of physically performing source distribution, a com-
plete machine-readable copy of the corresponding source code, to be distributed under
the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(©) Accompany it with the information you received as to the offer to distribute correspond-
ing source code. (This alternative is allowed only for noncommercial distribution and
only if you received the program in object code or executable form with such an offer, in
accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications
to it. For an executable work, complete source code means all the source code for all mod-
ules it contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the executable. However, as a special exception, the source
code distributed need not include anything that is normally distributed (in either source or
binary form) with the major components (compiler, kernel, and so on) of the operating
system on which the executable runs, unless that component itself accompanies the exe-
cutable.

If distribution of executable or object code is made by offering access to copy from a desig-
nated place, then offering equivalent access to copy the source code from the same place
counts as distribution of the source code, even though third parties are not compelled to
copy the source along with the object code.

You may not copy, modify, sublicense, or distribute the Program except as expressly pro-
vided under this License. Any attempt otherwise to copy, modify, sublicense or distribute
the Program is void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under this License will not
have their licenses terminated so long as such parties remain in full compliance.

You are not required to accept this License, since you have not signed it. However, nothing
else grants you permission to modify or distribute the Program or its derivative works.
These actions are prohibited by law if you do not accept this License. Therefore, by modify-
ing or distributing the Program (or any work based on the Program), you indicate your
acceptance of this License to do so, and all its terms and conditions for copying, distributing
or modifying the Program or works based on it.

Each time you redistribute the Program (or any work based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the
Program subject to these terms and conditions. You may not impose any further restrictions
on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing
compliance by third parties to this License.

If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court
order, agreement or otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent obligations, then
as a consequence you may not distribute the Program at all. For example, if a patent license
would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this
License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circum-
stance, the balance of the section is intended to apply and the section as a whole is intended
to apply in other circumstances.



10.

11.

12.

It is not the purpose of this section to induce you to infringe any patents or other property
right claims or to contest validity of any such claims; this section has the sole purpose of
protecting the integrity of the free software distribution system, which is implemented by
public license practices. Many people have made generous contributions to the wide range
of software distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to distribute software
through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of
the rest of this License.

If the distribution and/or use of the Program is restricted in certain countries either by
patents or by copyrighted interfaces, the original copyright holder who places the Program
under this License may add an explicit geographical distribution limitation excluding those
countries, so that distribution is permitted only in or among countries not thus excluded. In
such case, this License incorporates the limitation as if written in the body of this License.

The Free Software Foundation may publish revised and/or new versions of the General
Public License from time to time. Such new versions will be similar in spirit to the present
version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version
number of this License which applies to it and “any later version”, you have the option of fol-
lowing the terms and conditions either of that version or of any later version published by
the Free Software Foundation. If the Program does not specify a version number of this
License, you may choose any version ever published by the Free Software Foundation.

If you wish to incorporate parts of the Program into other free programs whose distribution
conditions are different, write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of preserv-
ing the free status of all derivatives of our free software and of promoting the sharing and
reuse of software generally.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFOR-
MANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIB-
UTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES
OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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ISO Distribution: This book includes an ISO copy of Fedora Core 3 Linux from
the Fedora Project, which you may use in accordance with the license agree-
ments accompanying the software. For more information, see the Fedora
Project Web site (http://fedora.redhat.com/). Red Hat does not provide
support services for Fedora Core. You may purchase Red Hat® Enterprise
Linux® and technical support from Red Hat through its Web site
(www.redhat.com) or its toll-free number (1-888-2REDHAT).

Limited Warranty: (a) WPI warrants that the Software and Software Media
are free from defects in materials and workmanship under normal use for a
period of sixty (60) days from the date of purchase of this Book. If WPI
receives notification within the warranty period of defects in materials or
workmanship, WPI will replace the defective Software Media. (b) WPI AND
THE AUTHOR(S) OF THE BOOK DISCLAIM ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
WITH RESPECT TO THE SOFTWARE, THE PROGRAMS, THE SOURCE CODE
CONTAINED THEREIN, AND/OR THE TECHNIQUES DESCRIBED IN THIS BOOK.
WPI DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFT-
WARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE
SOFTWARE WILL BE ERROR FREE. (¢) This limited warranty gives you spe-
cific legal rights, and you may have other rights that vary from jurisdiction to
jurisdiction.
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